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Введение

Появление очередной версии любой программы — это всегда прекрасная возмож-
ность для пользователя усовершенствовать свое мастерство, изучив новые сред-
ства и функции продукта. Если же вы с программой еще не работали, имеет
смысл познакомиться именно с последней ее версией, ведь она наверняка более
совершенна. Освоив весь инструментарий программы Microsoft Office Excel 2003,
вы по-другому оцените собственную работу и обязательно реорганизуете ее.

Обсуждая структуру, содержание и принцип изложения материала книги, мы
рассчитывали, что ее читателями станут пользователи, имеющие навыки работы
с компьютером в среде операционной системы Windows, владеющие основами
работы с различными файловыми системами. Конечно, элементарные представ-
ления о программе Excel имеют и сотрудники предприятий, и служащие офисов,
которым довольно часто приходится производить те или иные расчеты. Ученики
школ и студенты вузов получают навыки работы с электронными таблицами
в рамках курса информатики. Правда, пользователи, решившие самостоятельно
освоить программу, чаще всего изучают лишь те функции и средства, которые не-
обходимы для решения каких-то конкретных задач. Добившись требуемого ре-
зультата, они, как правило, на этом останавливаются. Мало кто может с уверен-
ностью утверждать, что знает абсолютно все возможности электронной таблицы
и ее надстроек и выполняет свои расчеты самым простым и быстрым способом.
Изучить программу в полном объеме поможет настоящая книга.

Об этой книге
Об Excel можно писать бесконечно много и долго. С программой неразрывно ас-
социируются такие понятия, как обработка и анализ данных, формулы и встроен-
ные функции, таблицы подстановки и поиск решения, сводные таблицы и диа-
граммы, коллективная работа и публикация документов в Веб. Мы же, работая
над содержимым книги, в первую очередь руководствовались целью создания книг
серии «Учебный курс» — подготовка пользователя к профессиональной работе.
Мы стремились научить читателя использовать программу обработки электрон-
ных таблиц для решения практических задач в любой области деятельности.

Содержащийся в книге материал представлен в виде уроков, что предполагает
четкость и последовательность его изложения, выполнение практических работ
и закрепление пройденного материала. Каждый урок открывается списком рас-
сматриваемых тем. В основной части урока наряду с изложением теоретического
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материала дается пошаговое описание действии, которые ведут к решению кон-
кретных задач. Выполняя предлагаемые задания, а также упражнения из раздела
•«Самостоятельная работа*, вы тем самым будете закреплять прочитанный мате-
риал, углублять свои знания и совершенствовать умение работать с Excel. В кон-
це каждого урока, в разделе «Подведение итогов», перечисляется все, чему вы
научились в ходе урока. Этот список может использоваться для самопроверки
полученных знаний и приемов практической работы.

Скорее всего, вы подобно большинству пользователей начали изучать Excel под
«давлением»- определенных обстоятельств, поэтому какой-то один способ дости-
жения поставленной цели вас вполне устраивал. Но это вовсе не значит, что вы
использовали все предоставляемые Excel возможности и делали все максимально
эффективно, в самые короткие сроки, прилагая минимум усилий. Как правило,
существует несколько способов выполнения одной и той же задачи и часто один
из них — возможно, пока что вам не известный — гораздо эффективнее других.
Взяв в руки нашу книгу, ознакомьтесь со всеми возможностями программы, про-
верьте в действии новые команды и надстройки и выберите те, которые больше
всего подходят для решения ваших задач. Уверяем, вы не пожалеете о потрачен-
ном времени. Специалист любой отрасли непременно найдет для себя что-то но-
вое, что поможет ускорить его работу.

Краткое содержание книги
Расскажем о содержании каждого урока.

Урок 1, «Знакомство с Excel 2003», можно рассматривать как вводную часть книги.
В нем вы научитесь работать с таблицами Excel, настраивать рабочую область, кон-
фигурировать панель инструментов, пользоваться справочной подсистемой, вво-
дить данные в таблицу, перемещать диапазоны ячеек. В рамках этого урока будет
рассказано об элементах окна программы, командах управления окнами и доку-
ментами, а также о некоторых функциях программы.

В уроках 2 и 3, «Создание электронной таблицы» и «Ввод и редактирование дан-
ных», вы познакомитесь с принципами создания таблиц, в частности, узнаете, как
выделять ячейки и их диапазоны, несмежные области, строки и столбцы. Кроме
того, вы научитесь редактировать содержимое ячеек, перемещать, копировать,
вставлять и удалять ячейки, транспонировать таблицы и использовать средства
их автозаполнения, а также управлять рабочими листами книги Excel.

Урок 4, «Оформление таблицы», посвящен форматированию и оформлению таб-
лицы, созданию ее иерархической структуры. Мы расскажем о том, как присваи-
вать и создавать форматы, выравнивать содержимое ячеек, изменять шрифт, ис-
пользовать границы и цветовое оформление, форматировать столбцы и строки,
осуществлять автоматическое форматирование, вставлять примечания и ячейку,
устанавливать защиту ячеек и листов.

Чрезвычайно важен и интересен урок 5, «Формулы и функции», так как форму-
лы являются основным средством обработки и анализа вводимых в таблицу дан-
ных. Вы научитесь создавать формулы, использовать относительные и абсолют-
ные ссылки, применять формулы массива, присваивать имена ячейкам и затем
использовать их в формулах, вызывать функции и применять их в формулах, на-
ходить и исправлять ошибки, отслеживать зависимости, задавать ограничения
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при вводе данных. Для выполнения стандартных вычислений — как сложных, так
и простых — программа предлагает большое количество встроенных функций, ко-
торые можно вызывать в формулах.

В Excel аналогом простой базы данных является список, который представляет
собой группу строк, содержащих связанные данные. Из урока 6, «Работа со списка-
ми и базами данных», вы узнаете, как создавать списки вручную и с помощью
формы данных, сортировать строки и столбцы списка, используя сложные крите-
рии, выполнять отбор данных с помощью функции автоматического фильтра, как
задавать расширенные фильтры прямо на рабочем листе. Кроме того, вы научи-
тесь формировать запросы к внешним базам данных с помощью программы Micro-
soft Query, редактировать списки базы данных, форматировать таблицу результа-
тов, передавать данные запросов в программу Excel.

Изучив материалы по работе с базами данных, научившись создавать формулы
и использовать функции, можно приступать к самому интересному и важному эта-
пу — анализу данных. В уроке 7, «Анализ данных», вы научитесь устанавливать
надстройки, выполнять автоматическое вычисление, создавать итоги, группиро-
вать данные, производить подбор параметров, формировать таблицы подстанов-
ки и разрабатывать сценарии.

В уроке 8, «Создание диаграмм», вы познакомитесь с работой мастера создания
диаграмм, узнаете, какими они бывают, в каких случаях какой тип диаграммы ре-
комендуется применять, как сделать диаграмму максимально информативной и
наглядной. Ведь профессионально построенная диаграмма должна не просто ил-
люстрировать излагаемый материал, но и отображать соотношения различных
показателей, динамику их изменения.

В уроке 9, «Графические объекты», речь пойдет о красочном оформлении рабо-
чих листов за счет использования картинок из коллекции Clip Art, автофигур,
а также текста, оформленного с применением специальных эффектов приложения
WordArt.

Освоив материал урока 10, «Элементы управления на рабочем листе», вы узнае-
те, какие типы элементов управления используются в Excel, чем элементы управ-
ления ActiveX отличаются от аналогичных элементов панели инструментов Forms
(Формы), какими возможностями они обладают, освоите технику работы с ними.

Excel предоставляет в наше распоряжение множество инструментов формирова-
ния вида печатаемого документа. Как подготовить документ к печати, как выбрать,
установить и настроить принтер, как задать параметры страницы, вы узнаете из
урока 11, «Подготовка документа к печати».

Тема урока 12, «Работа с макросами, основы VBA», говорит сама за себя. В дан-
ном уроке речь пойдет о создании макросов и о программировании на VBA. К со-
жалению, многие пользователи не умеют писать программ и не считают нужным
этому учиться. А зря, затратив не так уж много времени и усилий, ряд операций
можно автоматизировать, то есть избавиться от необходимости выполнять часто
повторяющиеся, как правило, довольно рутинные действия, что позволит сосре-
доточиться на решении конкретных задач.

Приложения пакета Microsoft Office 2003 поддерживают несколько способов об-
мена данными. Внимательно изучив материалы урока 13, «Обмен данными», вы
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сделаете первый шаг к коллективной работе с документами. Обычно и эту воз-
можность Excel в полной мере использует лишь незначительная часть пользова-
телей. В уроке рассказывается об обмене данными между приложениями с помо-
щью буфера обмена, о передаче данных в виде фрагментов документа, о вставке
объектов с сохранением связей с приложениями, в которых они были созданы.

Интернет доступен любому современному специалисту. И тем не менее предлага-
ем подробно ознакомиться с материалами урока 14, «Интернет-технологии в Ex-
cel», с тем чтобы систематизировать свои познания об использовании сети Ин-
тернет при работе с программой Excel. Теперь вы сможете отправлять рабочие
листы в качестве сообщений электронной почты, применять возможность маршру-
тизации сообщений, открывать рабочую книгу в сети Интернет, работать с РТР-
узлами, публиковать данные в Интернете, создавать и использовать гиперссылки.

В уроке 15, «Коллективная работа», мы расскажем об организации совместной
работы с Excel-документами при использовании средств, предоставляемых веб-
узлами рабочей группы Microsoft SharePoint Team Services. Для того чтобы вклю-
читься в работу группы, достаточно иметь доступ к браузеру. Но Excel 2003 по-
зволяет работать на веб-узле группы более эффективно: сохранять и редактиро-
вать документы в клиентской программе, пересылать данные из нее на веб-узел.

Имея некоторый опыт работы с программой, вы сможете приступить к настройке
меню и панелей инструментов. Сделать Excel удобным для работы можно, даже
обладая минимальными знаниями и опытом. Элементарные настройки выполня-
ются в диалоговых окнах Options (Параметры) и Customize (Настройка), описанных
в уроке 16, «Индивидуальная настройка программы».

От издательства
Свои замечания, предложения, вопросы отправляйте по адресу электронной поч-
ты comp@piter.com (издательство «Питер», компьютерная редакция).

Мы будем рады узнать ваше мнение о книге!

Подробную информацию о книгах издательств «Питер» и «Издательская группа
BHV& вы найдете на веб-сайтах http://www.piter.com и http://www.bhv.kiev.ua.
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Добро пожаловать в мир электронных таблиц! Однако прежде чем вы полностью
окунетесь в работу с Microsoft Office Excel, необходимо изучить базовые команды
работы с файлами, узнать, из каких элементов состоит окно программы, и понять,
что собой представляет документ Excel. Кроме того вы должны уметь осуществ-
лять диалог с программой и пользоваться ее справочной системой. Все эти зна-
ния вы получите в этом уроке. Конечно же, первое, что нам нужно сделать, — это
запустить программу.

Запуск программы и выход из нее

Порядок запуска и завершения работы Excel ничем не отличается от порядка вы-
полнения этих операций в других приложениях Windows,

Запуск программы Excel
1. Щелкните на кнопке Start (Пуск) панели задач, чтобы открыть старто-

вое меню.
2. Установите указатель мыши на меню Programs (Программы) в старто-

вом меню.
3. В открывшемся меню активизируйте команду Microsoft Excel.

Существует и более быстрый способ запуска Excel, для применения которого не-
обходимо наличие панели инструментов Microsoft Office. Если эта панель установ-
лена на вашем компьютере, для запуска программы достаточно щелкнуть на кноп-
ке, вызывающей Excel.

Чтобы выйти из программы, воспользуйтесь одним из следующих способов:

О вызовите команду File > Close (Файл > Закрыть);

О щелкните на кнопке с крестиком в строке заголовка окна Excel;

О нажмите комбинацию клавиш Alt+F4.

Если последняя редакция документа (рабочего листа) не была сохранена, при по-
пытке пользователя завершить работу с Excel программа спросит о необходимости
сохранения внесенных изменений. Для того чтобы сохранить документ в новой
редакции, в окне сообщения следует нажать кнопку Yes (Да), при необходимости
выйти из программы без сохранения изменений — кнопку No (Нет), а для того
чтобы продолжить редактирование документа — кнопку Cancel (Отмена).

I ПРИМЕЧАНИЕ Запрос о том, нужно ли сохранить внесенные изменения, может появиться на
экране и в том случае, если содержимое листа после редактирования оста-
лось прежним (например, при условии, что вы введете некоторые данные,
а затем удалите их). Объясняется это тем, что Excel интерпретирует выполне-
ние любых операций с текстом как изменение содержимого документа.



Окно Excel и его элементы

Окно Excel и его элементы
Окно Excel 2003 (рис. 1.1) подобно окнам других приложений пакета Microsoft
Office 2003. Назначение его элементов описано в настоящем разделе.

Строка меню Панели инструментов Строка формул
Кнопки управления

окном Excel

Строка ш*ш»
г,пл п!гч Т'ЧиДизаголовка 1

1 Arid - in - В / Ц

' " . х •/

Облать
рабочего

листа

Кнопки
управления
окном
документа

Строка соаояния Ярлычки рабочих листов Полосы прокрутки Область задач

Рис. 1.1. Окно программы Excel 2003

Строка заголовка
Строка заголовка расположена в верхней части окна Excel и содержит имя при-
ложения и имя книги. На ее концах находятся стандартные кнопки: слева — кноп-
ка вызова системного меню, справа — кнопки управления окном. Системное меню
содержит команды Restore Window (Восстановить), Move Window (Переместить),
Size Window (Размер), Minimize Window (Свернуть), Maximize Window (Развернуть)
и Close Window (Закрыть), предназначенные для выполнения различных операций
с окном. Кнопки управления окном позволяют быстро активизировать некото-
рые команды системного меню. Первая слева кнопка соответствует команде
Minimize Window (Свернуть) и служит для сворачивания окна программы. При ее
нажатии окно Excel исчезает, а на панели задач появляется новая кнопка, «отве-
чающая» за его восстановление. Средняя кнопка позволяет отобразить окно в нор-
мальном режиме. Кнопка с крестиком предназначена для завершения сеанса ра-
боты с программой.
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Строка меню
Под строкой заголовка находится строка меню, содержащая имена меню про-
граммы. Следует отметить, что строка меню является разновидностью панели ин-
струментов. С ней можно обращаться точно так же, как с панелью инструментов:
перемещать в любое место экрана, вставлять и удалять ее элементы и т. д,

Для перехода в строку меню следует воспользоваться клавишей Alt или функцио-
нальной клавишей F10. Повторное нажатие клавиши Alt или F10 позволит вер-
нуться в режим редактирования текста.

Имена меню, как и кнопки панели инструментов, выделяются при размещении
на них указателя мыши. В результате щелчка на имени меню появляется список
относящихся к нему команд. Открыть меню можно и с помощью клавиши Enter
или клавиши со стрелкой вниз (i), а передвигаться по строке меню — с помощью
клавиши Tab. Одна из букв в именах меню, равно как и в названиях команд, под-
черкнута. Клавиша с этой буквой в сочетании с клавишей Alt служит для откры-
тия соответствующего меню или для вызова команды. Например, чтобы открыть
меню File, следует нажать клавишу Alt, а затем — клавишу с буквой «F».

Закрывается меню путем нажатия клавиши Esc. Правда, в результате нажатия
данной клавиши имя меню остается активным и в этом случае нельзя выполнять
операции в рабочей области. Для того чтобы вернуться в режим редактирования,
необходимо еще раз нажать клавишу Esc.

Чтобы закрыть меню с помощью мыши, не активизируя команду, нужно выпол-
нить щелчок в области листа. Для перехода из открытого меню в любое другое
достаточно переместить указатель мыши на имя нужного меню, после чего пре-
дыдущее меню будет закрыто.

Кнопка системного меню не содержит надписей. Однако это меню можно от-
крыть посредством клавиатуры, последовательно нажав клавиши Alt и Пробел.
Для открытия системного меню окна рабочей книги предназначена комбинация
клавиш Alt + -.

Чтобы активизировать команду, следует открыть меню, в котором она находится,
установить указатель мыши на имени команды и произвести щелчок или нажать
клавишу Enter. В результате активизации некоторых команд открываются допол-
нительные меню (подменю) или диалоговые окна, в которых устанавливаются
нужные параметры. После имени такой команды вы увидите треугольник или
многоточие, указывающие соответственно на то, что появится подменю или будет
открыто диалоговое окно (рис, 1.2).

Возле имен отдельных команд указываются функциональные клавиши или ком-
бинации клавиш, с помощью которых их можно активизировать. Во многих слу-
чаях это повышает скорость работы. Если команде соответствует кнопка панели
инструментов, слева от имени такой команды находится значок.

Панели инструментов
Под строкой меню обычно размещаются панели инструментов (см. рис. 1.1). Ка-
ждая панель инструментов содержит ряд кнопок, предназначенных для быстрой
активизации команд меню и функций программы.
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Рис. 1.2. Меню и подменю

Excel предоставляет пользователям возможность создавать собственные панели
инструментов и модифицировать существующие.

Строка формул
Ниже панелей инструментов находится состоящая из трех частей строка формул,
в которой производится обработка содержимого ячеек. Правая часть этой строки
служит для отображения и редактирования содержимого текущей ячейки.

' . '

Кнопка Кнопка Кнопка
Cancel Enter Insert Function

x ;/

Редактирование данных осуществляется или в ячейке, или в строке формул. Для
перехода в режим редактирования в строке формул следует нажать клавишу F2
или щелкнуть мышью в правой части этой строки. Чтобы установить режим ре-
дактирования в ячейке, необходимо выполнить на ней двойной щелчок, вследст-
вие чего в ячейке появится курсор ввода.
Строка формул также содержит кнопки для обработки содержимого ячейки,
Кнопка Cancel (Отмена) применяется для отмены последнего действия (это можно
сделать и с помощью клавиши Esc). Кнопка Enter (Ввод) служит для подтвержде-
ния ввода данных или изменения содержимого ячейки; ее действие аналогично
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действию клавиши Enter. С помощью кнопки Insert Function (Вставка функции)
можно активизировать мастер функций, предназначенный для ввода и редакти-
рования формул.

В левой части строки формул расположено поле имен, в котором указывается ад-
рес активной ячейки или размер выделенного диапазона. Например, если поле
содержит запись 2Rx3C, это говорит о том, что выделенный диапазон состоит из
2 строк и 3 столбцов. Если для некоторых диапазонов ячеек заданы имена, они
отображаются в списке поля имени, который открывается после щелчка на кноп-
ке со стрелкой, находящейся справа от этого поля.

Строка состояния
В нижней части окна программы находится строка состояния (см. рис. 1.1). В этой
строке слева отображаются различные сообщения, например о том, какая коман-
да выбрана. Если пользователь загружает созданную ранее книгу, в ней отобра-
жается ход процесса открытия документа. Строка состояния информирует также
о том, можно ли вводить данные или выбирать команду. Если такая возможность
существует, в этой строке появляется слово Ready (Готово).

Окно книги

Документ Excel называется рабочей книгой (workbook) и помещается в отдельном
окне (рис. 1.3). Книга, которая открывается при загрузке программы, имеет имя
Bookl (Книга!). Если создается новая книга, ей присваивается имя Book2 (Книга2).

I
НММШВДйИМИН

Рис. 1.3. Окно книги

Книга состоит из рабочих листов. По умолчанию их три: Sheet! (Лист1), Sheet2
(Лист2) и Sheet3 (ЛистЗ). Пользователь может вставить в книгу дополнительные
листы (максимально возможное их количество - 255).
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Таблицы в Excel создаются на рабочем листе. Рабочий лист разделен на строки
и столбцы, которые, пересекаясь, образуют ячейки. В ячейки вводится содержи-
мое таблицы. Рабочий лист состоит из 256 столбцов и 65 536 строк. По умолча-
нию строки нумеруются, а столбцы обозначаются одной или двумя латинскими
буквами. Адрес ячейки при ссылке на нее задается путем указания обозначения
столбца и номера строки (например, Al, B5). Диапазон ячеек (область смежных
ячеек) задается адресами верхней левой и нижней правой его ячеек, разделен-
ными символом двоеточия (например, А1:В5).

Переход от одной открытой книги к другой выполняется с помощью команд
меню Window (Окно), а переход с листа на лист — щелчком на ярлычке, после чего
соответствующий лист переносится на передний план.

Слева от ярлычков расположены четыре кнопки, которые используются для про-
крутки листов, когда ярлычки листов не помещаются в отведенной для них об-
ласти. Назначение кнопок станет вам понятным после рассмотрения приведенно-
го ниже рисунка.

Следующий лист

Первый лист— [н |< г М f- Последний лист

Предыдущий лист

СОВЕТ Если ярлычки всех листов не помещаются в отведенной для них области, уве-
личьте таковую путем уменьшения горизонтальной полосы прокрутки (потя-
нув ее за левый край).

Полосы прокрутки

Важными элементами окна Excel являются полосы, прокрутки (см. рис. 1.1). Рабо-
чий лист содержит более шестнадцати миллионов ячеек. Конечно, они не могут
одновременно отображаться на экране. Для того чтобы сделать нужные области
рабочего листа видимыми, воспользуйтесь горизонтальной или вертикальной по-
лосой прокрутки.

Для смещения на одну строку вверх или вниз следует щелкнуть на соответствую-
щей кнопке со стрелкой на вертикальной полосе прокрутки, а для смещения на
один экран вверх или вниз — непосредственно на полосе прокрутки. Бегунки по-
лос прокрутки определяют позицию активной ячейки или выделенного диапазо-
на в таблице (но не во всем рабочем листе) и используются для быстрого переме-
щения по таблице.

Область задач
Область задач — инструмент, который появился лишь в предыдущей версии Mic-
rosoft Office. Расположена она справа от рабочего поля (см. рис. 1.1). Название
области и набор предлагаемых пользователю инструментов зависят от решаемых
в данный момент задач. Например, область задач Search (Поиск) позволяет вы-
полнять поиск файлов, с помощью области задач Clipboard (Буфер обмена) можно
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выбирать объекты для вставки, а с помощью области задач, которая выводится
при запуске Excel, — быстро создавать новые документы или открывать файлы.

Если на данный момент область задач вам не нужна, можете ее закрыть, нажав
на значке с крестиком, расположенном справа от заголовка с ее названием. Для
повторного открытия области задач вызовите команду View > Task Pane (Вид > Об-
ласть задач) или нажмите комбинацию клавиш Ctrl+Fl.

Область задач, подобно диалоговому окну и панели инструментов, можно переме-
щать, то есть ее можно расположить в любом месте рабочей области приложения.

Управлять содержимым области задач можно с помощью стрелок, расположен-
ных слева под строкой ее заголовка, или пользуясь меню, которое открывается
после щелчка на ее заголовке (рис. 1.4).

Getting Started

Help

Search Results

Clp Art

Research

г Shared Workspace

5 ^ Document Updates

^ XML Source

Pnc_3.22..x!s

Bool<2,xts

:_3.9..xls

More...

*L
Рис. 1.4. Управляющее меню области задач Excel

Рабочая книга Excel

В этом разделе описаны основные операции, выполняемые при работе с докумен-
тами. Вы научитесь сохранять и открывать рабочие книги, узнаете, как сохранить
вместе с документом дополнительную информацию.

Сохранение книги

Г"1 Чтобы содержащуюся в книге информацию можно было использовать при
Я последующих сеансах работы с Excel, ее необходимо сохранить. В Excel ра-
бочая книга сохраняется в виде документа.
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Сохранить книгу можно одним из трех следующих способов:

О вызвать команду Fue > Save (Файл > Сохранить);

О нажать комбинацию клавиш CtrL+S;

О щелкнуть на соответствующей кнопке панели инструментов.

СОВЕТ Прежде чем произвести операцию сохранения. Excel запоминает активную
ячейку и активизирует ее при следующем открытии документа. Поэтому пе-
ред сохранением выделите область книги, которую вы хотели бы видеть на
экране сразу после загрузки Excel.

Книги в процессе сохранения можно переименовывать. Для этого следует вос-
пользоваться командой File > Save As (Файл » Сохранить как) или функциональ-
ной клавишей F12. В результате выполнения указанной операции открывается
диалоговое окно Save As (Сохранение документа), которое вы видите на рис. 1.5.
Это окно появляется также при вызове команды File > Save (Файл > Сохранить)
или нажатии соответствующей кнопки на стандартной панели инструментов,
если документ еще ни разу не сохранялся. По умолчанию Excel предлагает сохра-
нить документ под именем Bookn (Книгаи), где п — номер рабочей книги.

| f; j Мои документы т • • I
2l Obhaha

I
IMicrcsoft Excri Worttxx* f.xls)

Рис. 1.5. Диалоговое окно Save As

Книгам следует присваивать имена, по которым можно получить представление
об их содержимом. В дальнейшем это позволит быстрее осуществлять поиск.

Пользователи не всегда понимают значение и роль имени файла. И только когда
поиск нужного файла превратится в длительное путешествие по всем имеющим-
ся папкам, они смогут по достоинству оценить наш совет: файлу следует присво-
ить имя, которое поможет определить, какая именно информация в нем хранится.
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Имя книги и полный путь доступа к ней могут состоять максимум из 218 знаков.
В имени книги нельзя использовать следующие символы: косую черту (/), обрат-
ную косую черту (\), знак больше (>), знак меньше (<), звездочку (*), знак во-
проса (?), двойные кавычки ("), вертикальную черту (|), двоеточие (:) и точку
с запятой (;).

Примите во внимание, что при вводе имени документа расширение добавляется
автоматически, но оно не отображается в окне Save As (Сохранение документа).
Это означает, что если в поле File name (Имя файла) ввести имя Моя таблица.<1ос,
документ будет сохранен под именем Моя таблица.doc.xls. Другими словами, про-
грамма Excel сама решает, с каким расширением сохранить книгу.

Под полем ввода имени документа находится список Save as type (Тип файла),
в котором перечислены форматы файлов, поддерживаемые Excel. Наиболее важ-
ные из них описаны ниже:

О Microsoft Excel Workbook (*.xls) - формат, который по умолчанию используется
для хранения таблиц;

О Microsoft Excel 5.0/95 Workbook (*.xls), Microsoft Excel 4.0 Workbook (*.xlw), Microsoft
Excel 4.0 Worksheet (*.xls) — форматы, применяемые для сохранения таблиц при
работе с более ранними версиями Excel;

О Template (*.xlt) — формат для сохранения таблицы в качестве шаблона;

О Formatted test (Space delimited) (*.prn), Text (Tab delimited) (*.txt), CSV (Comma deli-
mited) (*.csv) — файлы в этих форматах рассматриваются как файлы ASCII, они
используются при обмене данными между Excel и другими приложениями.

I В диалоговом окне Save As (Сохранение документа) отображаются имена тех
f.^ffft файлов, которые содержит открытая папка (см. рис. 1.5). Для перехода
в другую папку выполните щелчок на ее имени или на кнопке Up one level (Пере-
ход на один уровень вверх). Если папка находится на другом диске, то сначала
необходимо в поле списка Save in (Папка) выбрать требуемый диск.

Чтобы сохранить документ в новой папке, нажмите кнопку Create New Folder
(Создать папку) и введите в окне New Folder (Создание папки) название но-

вой папки.

Выбрав в диалоговом окне Save As (Сохранение документа) команду Tools > Ge-
neral Options (Сервис > Общие параметры), можно перейти в диалоговое окно Save
Options (Параметры сохранения) и установить параметры сохранения файла.

Рис. 1.6. Диалоговое окно Save Options
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Если установлен флажок Always create backup (Всегда создавать резервную ко-
пию), при каждом выполнении операции сохранения программа записывает пре-
дыдущую версию документа в качестве резервной копии.

Для защиты данных в Excel применяются пароли двух видов: Password to open
(Пароль для открытия файла) и Password to modify (Пароль разрешения записи).
Документ, защищенный с помощью второго пароля, доступен только для чтения,
но его можно сохранить под другим именем. Для защиты можно использовать па-
роли обоих видов (причем они должны быть разными). После задания пароля
и нажатия кнопки ОК пароль следует ввести повторно, в ответ на запрос програм-
мы в диалоговом окне Confirm Password (Подтверждение пароля).

у — —
) ВНИМАНИЕ Помните, что при вводе пароля различаются строчные и прописные буквы.

Защита данных от несанкционированного доступа в Excel устанавливается с по-
мощью целого ряда интегрированных функций. Система защиты данных в про-
грамме является многоуровневой. Это значит, что можно защитить весь доку-
мент — с помощью пароля, который будет запрашиваться программой при откры-
тии файла, а можно защитить от редактирования, скажем, только некоторые
листы книги или ячейки.

После выполнения операции сохранения обе версии файла (на жестком диске
и в оперативной памяти) становятся идентичными. После внесения в документ
каких-либо еще изменений операцию придется повторить — лишь таким образом
можно обеспечить точность копий. Если файлу уже присвоено имя, нет необхо-
димости задавать его повторно в процессе сохранения.

Информация о документе
Вместе с документом можно сохравлть дополнительную информацию (название
документа, тема, имя автора, ключевые слова, заметки и т. д.). Для этого необхо-
димо, выполнив команду File > Properties (Файл > Свойства), открыть диалоговое
окно [Имя документа] Properties (Свойства: [Имя документа]), в котором и осуще-
ствляется ввод такого рода данных (рис. 1.7).

Автосохранение

Изменения, вносимые в документ в процессе его обработки, сначала сохраняются
только в оперативной памяти. Чтобы избежать потери части информации в слу-
чае отключения питания, документ следует периодически сохранять на диске.
Для этого предназначена функция автосохранения — документ автоматически
сохраняется на диске по прошествии определенного времени. Устанавливается
данная функция следующим образом. Сначала необходимо активизировать ко-
манду Tools > Options (Сервис »• Параметры), затем перейти на вкладку Save (Со-
хранение), установить флажок Save AutoRecover info every (Сохранять данные для
автовосстановления каждые) и, наконец, задать интервал времени (в минутах),
по истечении которого документ должен сохраняться (рис. 1.8).
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Рис. 1.7. Вкладка Summary окна свойств электронной таблицы

|aveAutoRectwer

• (. . ,.,-i. ••-
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Рис. 1.8. Вкладка Save диалогового окна Options

Сохранение рабочей области

Excel позволяет сохранять не только документы, но и конфигурацию открытых
книг и окон. Для этого предназначен файл, имеющий расширение .xLw (по умол-
чанию программа предлагает сохранить конфигурацию рабочей области в файле
с именем resume). В файле рабочей области хранится информация о том, какие



Рабочая книга Excel 29

рабочие книги открыты и какие параметры (размер, позиция и т. д.) установлены
для окон. Создавать такой файл следует перед завершением сеанса работы с боль-
шими документами. В начале следующего сеанса для воспроизведения рабочей
области в том виде, какой она имела на момент сохранения, достаточно открыть
файл рабочей области.

Чтобы создать файл рабочей области, следует активизировать команду File > Save
Workspace (Файл > Сохранить рабочую область) и в открывшемся диалоговом окне
(рис. 1.9) указать имя файла рабочей области. При необходимости можно вы-
брать другую папку или иное устройство. Все установки необходимо подтвердить
нажатием кнопки Save (Сохранить).

Save Wotkspace

3̂ Мои документы

ои рисунки

Рис. 1.9. Диалоговое окно Save Workspace

Закрытие рабочих книг
Для закрытия книг предназначены команда File > Close (Файл > Закрыть), а также
кнопка системного меню и кнопки управления окном, находящиеся в окне рабо-
чей книги.

Вы можете закрыть все рабочие книги одновременно. Для этого следует при на-
жатой клавише Shift щелкнуть на меню File (Файл). В нем вместо команды Close
(Закрыть) появится команда Close AIL (Закрыть все). Выполнив эту команду, вы
закроете все рабочие книги Excel. Если внесенные в книгу изменения не были
предварительно сохранены, на экране появится соответствующий запрос.

Открытие существующих документов
I Каждый из документов, сохраненных в предыдущих сеансах работы с Excel,

открывается в отдельном окне книги.
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Для открытия документа воспользуйтесь одним из следующих методов:

О выполните команду FHe > Open (Файл * Открыть);

О щелкните на кнопке Open (Открыть) панели инструментов;

О нажмите комбинацию клавиш CtrL+0.

Независимо от того, какой способ открытия документа будет применен, на экране
появится диалоговое окно, изображенное на рис. 1.10.

JAII Microsoft Excel Fles(*.xl*; *.xfe *.xfc; *,htm; *.htrnl; V] |__

Рис. 1.10. Диалоговое окно Open

Выберите в списке файлов или введите в поле File name (Имя файла) имя откры-
ваемого документа. Возможно, вам придется открыть другую папку или перейти
на иное устройство. Если нужно открыть документ, тип которого отличается от
типа файла Excel, то сначала следует указать необходимый тип в списке Files of
type (Тип файлов). Отметив требуемый документ, следует нажать кнопку Open
(Открыть).

Чтобы открыть за один раз несколько документов, необходимо при выделении их
имен удерживать нажатой клавишу Ctrl. Для выделения группы документов, сле-
дующих друг за другом, нужно выделить имя первого из них, а затем — имя по-
следнего, удерживая нажатой клавишу Shift. Выделив имена всех подлежащих от-
крытию документов, нажмите кнопку Open (Открыть).

В меню File (Файл) отображаются имена четырех документов, которые открыва-
лись последними. При щелчке на имени загружается книга — таким образом
обеспечивается быстрый доступ к часто используемым документам. Количество
имен документов в меню File (Файл) может быть увеличено. Оно определяется
в поле Recently used file list (Список ранее открывавшихся файлов содержит эле-
ментов, не более) вкладки General (Общие), которая находится в диалоговом окне
Options, вызываемом посредством команды Tools > Options (Сервис t Параметры).
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Открытие документов на удаленных компьютерах
Excel предоставляет пользователям возможность открывать рабочие книги, нахо-
дящиеся на FTP-серверах, а также HTML-файлы.

Ш Для поиска документов на удаленных узлах предназначена кнопка Search the
Web (Найти в Интернете), с помощью которой запускается браузер.

Создание нового документа
Ipyi Новые книги создаются с помощью команды File > New (Файл V Создать) или
мН кнопки New (Создать) панели инструментов. Реакция программы на нажатие
указанной кнопки и выполнение названной команды различна. В первом случае
Excel без вопросов создает новую книгу, во втором открывается область задач New
Workbook (Создание книги).

Workbook

New

$Й: FfO^ existing workbook,,.

ГетрШи!

', ',*'3jj[ Templates"on Office Online

Опту computer...

On my Web site's.,.

Эта область предоставляет следующие возможности. Выбрав ссылку Blank work-
book (Чистая книга), вы можете создать пустой документ. После нажатия ссылки
From existing workbook (Выбор книги) открывается окно New from Existing Workbook
(Создание из имеющейся книги). Выберите в этом окне уже существующий до-
кумент и нажмите кнопку Create New (Создать новый). Открывшийся документ
будет автоматически переименован, после чего вы сможете вносить в него измен-
нения. Данный метод удобно использовать при создании однотипных докумен-
тов. После щелчка на ссылке On my computer (Общие шаблоны) появляется окно
Templates (Шаблоны), в котором можно выбрать необходимый для работы шаб-
лон (рис. 1.11).

Использование профессионально разработанных шаблонов, поставляемым с Ex-
cel, позволяет заметно ускорить такие операции, как деловое планирование или,
скажем, финансовый анализ. Чтобы начать работу с любым из имеющихся шаб-
лонов, необходимо перейти на вкладку Spreadsheet Solutions (Решения) и выпол-
нить двойной щелчок на соответствующем ему значке.
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Balance Sheet ExpenseSt... Loan Sdes Invoice
Amortization

Рис. 1.11. Шаблоны, предоставляемые в диалоговом окне Templates

Шаблоны рабочих книг
Рабочие книги в Excel базируются на шаблонах. Шаблон содержит параметры
форматирования, макрокоманды, ряд других установок, используемых при соз-
дании книги.

Чтобы не составлять некий часто используемый бланк каждый раз заново, его
нужно сохранить в качестве шаблона. Для этого в диалоговом окне Save As (Со-
хранение документа), в списке Save as tape (Тип файла), следует указать требуе-
мый тип файла Template (Шаблон) и подтвердить свой выбор нажатием кнопки
Save (Сохранить). Excel автоматически присвоит файлу расширение .xlt и сохра-
нит его в качестве шаблона.

Шаблон открывается подобно обычному документу. Excel создает новую рабо-
чую книгу с установленными в шаблоне параметрами, которую можно сохранить
под любым именем.

Внести изменения в созданный шаблон позволяет команда File > Open (Файл >
Открыть). Для этого необходимо выбрать нужный шаблон в диалоговом окне
Open (Открытие документа) и нажать кнопку Open (Открыть). Шаблон будет за-
гружен в окно книги, где его можно соответствующим образом отредактировать.

Автоматическое открытие файлов
На вкладке General (Общие) окна Options (Параметры), в поле At Startup, open all
files in (Рабочий каталог), можно задать стартовую папку, использование которой
ускоряет загрузку документов. Хранящиеся в этой папке файлы открываются
сразу после запуска программы. В стартовую папку рекомендуется помещать до-
кументы, с которыми приходится работать ежедневно. Сохранение таких доку-
ментов в папке можно выполнить с помощью программы Проводник.

СОВЕТ 8 стартовой папке храните только необходимые для работы документы, в про-
тивном случае оперативная память будет использоваться нерационально.
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Поиск документа
При наличии большого количества информации на жестком диске поиск нужно-
го документа обычно занимает немало времени. Этого удается избежать, разумно
систематизировав папки и подпапки на диске и присвоив файлам имена, по кото-
рым можно получить представление об их содержимом.

Если необходимый документ все же не удается найти, вы можете воспользовать-
ся диалоговым окном File Search (Найти), которое открывается с помощью коман-
ды Tools > Search (Сервис > Найти), задаваемой в окне Open (Открытие докумен-
та). После открытия окна File Search (Найти) активной становится вкладка Basic
(Обычный) (рис. 1,12).

|

..:

Рис. 1.12. Вкладка Basic диалогового oi

Искомый текст или его фрагмент вводится в поле Search text (Текст) области
Search for (Искать). В поле Results should be (Типы файлов результатов) области
Other Search Options (Другие параметры поиска) указываются типы файлов, поиск
которых необходимо выполнить, а в поле Search in (Область поиска) этой же об-
ласти — используемое для данной цели устройство, а также имя папки, в которой
они, возможно, хранятся.
После ввода всех параметров необходимо нажать кнопку Search (Найти); резуль-
таты поиска отобразятся в поле Results (Результаты).

На вкладке Advanced (Расширенный), показанной на рис. 1.13, производится рас-
ширенный поиск по критериям, которые указываются в полях Property (Свойство),
Condition (Условие), Value (Значение). Результат войска во многом зависит от того,
какой переключатель является активным — And (И) или Ог (Или). Если установлен
переключатель And (И), ведется поиск тех документов, которые удовлетворяют

2 Зак. 345



34 Урок 1 * Знакомство с Excel 2003

всем критериям, если же активизирован переключатель Or (Или), осуществляет-
ся поиск документов, которые удовлетворяют хотя бы одному критерию.

Рис. 1.13. Вкладка Advanced диалогового окна File Search
i1

В поле Property (Свойство) указывается критерий поиска (например, имя доку-
мента, имя автора, тема, тип файла, шаблон и т. д.). В поле Condition (Условие) за-
дается условие для выбранного критерия. Например, если вы задали в качестве
критерия поиска Number of multimedia clips (Число клипов мультимедиа), то в дант
ном поле вам необходимо указать условие equals (равно), not equal to (не равно)
или, предположим, more than (больше). В поле Value (Значение) следует ввести
фрагмент искомого текста.

Для того чтобы сохранить критерий поиска, нажмите кнопку Add (Добавить). Не-
используемые группы критериев поиска можно удалить с помощью кнопки Remo-
ve (Удалить) или Remove AIL (Удалить все).

Поиск документа производится после установления критериев и параметров по-
иска. Для выполнения операции поиска достаточно нажать кнопку Search (Найти),.

Просмотр документов в окне открытия

В диалоговом окне Open (Открытие документа) документы могут отображаться
различными способами. Способ отображения выбирается посредством команд
Large Icons (Крупные значки), Small Icons (Мелкие значки), List (Список), Details
(Таблица), Properties (Свойства), Preview (Просмотр), Thumbnails (Эскизы) и Web
view (Веб-представление) соответствующего меню. Функции некоторых из этих
кнопок описаны в следующей таблице.
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Таблица 1.1. Кнопки, задающие способ отображения документов

Кнопка Что отображается

Large Icons (Крупные значки) Крупные значки документов

Small Icons (Мелкие значки) Мелкие значки документов

List (Список) Имена документов (без дополнительной информации)

Details (Таблица) Имена и параметры документов, такие как размер файла,
тип и дата внесения последних изменений

Properties (Свойства) Свойства документов (автор, название приложения,
в котором подготовлен документ, даты создания
и модификации, размер и т. д.)

Preview (Просмотр) Весь текст документа (он отображается справа от перечня
документов)

Thumbnails (Эскизы) Изображения, хранящиеся в папке (отображаются на значке
папки)

Структура рабочей книги
После запуска программы на экране отображается открытая пустая рабочая кни-
га. Мы уже говорили о том, что по умолчанию она содержит три рабочих листа
с именами Sheetl (Лист1), Sheet2 (ЛистЗ) и Sheets (ЛистЗ). Для того чтобы изме-
нить данную установку, выберите команду Tools > Options (Сервис > Параметры)
и на вкладке General (Общие) установите нужное значение в поле Sheets in New
Workbook (Листов в новой книге).

В Excel используются листы двух типов. Их назначение следующее:

О Sheet (Лист) — применяется для ввода и обработки числовых данных;

О Chart (Диаграмма) — предназначен для создания и хранения диаграмм, не вне-
дренных в рабочие листы.

Имя листа, назначенное по умолчанию, можно изменить. При этом желательно
выбрать имя, которое отражает тип находящейся на листе информации. В про-
цессе работы вы можете удалять и вставлять рабочие листы, а также перемещать
и копировать их (максимальное число листов равно 255). В частности, пустые и
ненужные листы лучше удалить. Однако при этом необходимо учитывать, что все
находящиеся на них данные будут утеряны. (Операции с рабочими листами под-
робно рассмотрены в уроке 3.)

Диалог с программой

Чтобы выполнить в Excel какую-либо операцию, необходимо дать программе ко-
манду. Это можно сделать разными способами, и в частности посредством выбора
команды, щелчка на кнопке панели инструментов, нажатия комбинации клавиш.
При выполнении перечисленных операций используются клавиатура и мышь.
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О работе с мышью
В данной книге, если не оговаривается противное, речь идет о левой кнопке мыши,
то есть указание «щелкните» следует понимать как -«выполните щелчок с помощью
левой кнопки мыши»-.

При работе с мышью на экране отображается указатель мыши, который переме-
щается в соответствии с ее передвижением. В процессе работы с Excel вид указате-
ля мыши может изменяться.

+ I

В обычном режиме работы указатель мыши имеет вид стрелки. С его помощью
удобно активизировать элементы окна программы и перемещать объекты. В об-
ласти рабочего листа указатель мыши имеет вид белого крестика и служит для
активизации ячеек. При размещении на маркере заполнения, находящемся в пра-
вом нижнем углу ячейки, указатель мыши преобразуется в черный крестик. Таким
образом программа сообщает о возможности использования функции автозапол-
нения. Указатель мыши может также приобретать вид курсора ввода (например,
при размещении в правой части строки формул). При изменении размеров окна
указатель мыши превращается в двунаправленную стрелку. Двунаправленная
стрелка с вертикальной линией появляется, если указатель мыши находится ме-
жду двумя элементами, границы которых можно изменить (например, между за-
головками строк или столбцов). Указатель в виде двух параллельных прямых со
стрелками используется для разделения рабочего листа с помощью специальных
маркеров на несколько подокон (панелей). Указатель мыши со знаком вопроса
позволяет вызвать окно контекстной справки.

Диалоговые окна
Если для выполнения определенной команды необходима дополнительная ин-
формация (имя такой команды в меню помечается многоточием), открывается
диалоговое окно.

Любое диалоговое окно включает строку заголовка и системное меню. Системное
меню открывается при нажатии комбинации клавиш Alt+Пробел. Команды сис-
темного меню позволяют переместить диалоговое окно, если оно накладывается
на часть страницы, которую вы хотели бы видеть во время установки параметров,
или даже закрыть его. Диалоговое окно закрывается и в результате нажатия ком-
бинации клавиш Alt+F4, клавиши Esc или щелчка на кнопке Close (Закрыть). При
этом выполнение команды отменяется, а установленные параметры становятся
недействительными.

Диалоговые окна могут содержать ряд вкладок (рис. 1.14). Вкладка напоминает
карточку каталога. Активной может быть только одна вкладка — она полностью
отображается в окне. Но в верхней части окна постоянно присутствуют заголов-
ки всех других его вкладок. Для перехода из вкладки на вкладку предназначены
комбинации клавиш Ctrl+Tab и Ctrl+Shift+Tab.
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Рис. 1.14. Вкладки диалогового окна Options

Элементами диалоговых окон являются поля ввода, поля списка, флажки, пере-
ключатели и кнопки.

Кнопки в диалоговых окнах служат главным образом для активизации опреде-
ленных функций. «Нажать» кнопку — значит выполнить на ней щелчок или вос-
пользоваться клавишей Enter. Названия некоторых кнопок содержат подчеркну-
тые буквы, а нажатие клавиши с этой буквой, как вы знаете, эквивалентно нажа-
тию кнопки.

Флажок — это контрольный индикатор, указывающий на определенный пара-
метр, которым он управляет, и имеющий вид маленького квадратика. Устанавли-
вается флажок посредством щелчка на его названии — об этом свидетельствует
появление в квадратике галочки. Повторный щелчок приводит к выключению
параметра (и исчезновению галочки).

Переключатель - это индикатор с определенным названием, имеющий вид круж-
ка с точкой. Он предназначен для выбора одного из нескольких альтернативных
значений. В области диалогового окна может быть активизирован только один
переключатель (см. рис. 1.14).

Различие между полями списка и полями ввода состоит в том, что первые содер-
жат список возможных значений и пользователю остается выбрать одно из них,
а в поля ввода значения вводятся с клавиатуры. Некоторые поля ввода связаны
с полями списка. Выбранное в поле списка значение сразу появляется в поле вво-
да. Если все элементы списка не помещаются в отведенную для него область,
справа от списка появляется полоса прокрутки.

Перед внесением данных поле ввода необходимо активизировать, чтобы в нем поя-
вился курсор ввода. Для удаления отдельных символов в поле ввода используются
клавиши Delete и Backspace. При необходимости удалить всю запись, вернее, заменить
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другой, ее нужно сначала выделить, выполнив двойной щелчок, а как только поль-
зователь начнет вводить новое значение, старая запись исчезнет.

Использование мыши заметно облегчает процесс установки необходимых пара-
метров в диалоговом окне. Посредством щелчка очень просто снять или устано-
вить флажок, выбрать переключатель или, предположим, перейти в требуемое
поле ввода.

Устанавливать параметры с применением клавиатуры также довольно просто. Пе-
рейти к следующему элементу диалогового окна позволяет клавиша Tab, а к пре-
дыдущему — комбинация клавиш Shift+Tab. Чтобы активизировать элемент диа-
логового окна, необходимо с помощью клавиш управления переместить курсор
на ее имя и нажать клавишу Пробел. Значительно упрощают работу с диалоговы-
ми окнами комбинации клавиши Alt и клавиш, соответствующих буквам, которые
подчеркнуты в названиях элементов.

Управление окнами и отображением таблицы

Зная принципы работы с окнами, вы без труда установите такое представление
окна программы, при котором размер рабочей области станет максимальным,
а работа с несколькими приложениями удобнее, и не растеряетесь, если после на-
жатия «не той» кнопки или клавиши окно программы неожиданно исчезнет с эк-
рана вашего компьютера.

Как правило, в процессе работы с Excel на экране отображается небольшая часть
электронной таблицы. Это сильно затрудняет просмотр данных, и пользователю
приходится постоянно прибегать к помощи полос прокрутки. Установив нужный
масштаб изображения таблицы, вы сделаете ее восприятие максимально легким.

Полноэкранное представление
Размер видимой части рабочей области зависит прежде всего от размера окна
книги. Чтобы отобразить максимально возможное количество ячеек, для окна
программы и рабочей книги необходимо установить полноэкранное представле-
ние. Количество видимых ячеек можно увеличить за счет удаления с экрана всех
функциональных элементов окна, воспользовавшись для этой цели вкладкой
View (Вид) диалогового окна Options (Параметры). Однако самый простой и эф-
фективный способ увеличения рабочей области — активизация команды View >
FullScreen (Вид * Во весь экран). В результате ее выполнения с экрана удаляются
все функциональные элементы окна программы, за исключением строки меню,
полос прокрутки и ярлычков (рис. 1.15).

I

Масштабирование изображения
Excel позволяет также увеличивать и уменьшать размер ячеек. Речь идет не об
изменении высоты и ширины строк и столбцов, а о масштабировании, при кото-
ром изменяется размер ячеек во всей таблице. Нормальное представление ячеек
соответствует значению масштабирования 100 %. Для выполнения масштабиро-
вания предназначены команда View * Zoom (Вид > Масштаб) и поле Zoom панели
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инструментов Standard (Стандартная). После выбора команды Zoom (Масштаб)
открывается одноименное диалоговое окно (рис. 1.16).

Рис. 1.15. Окно рабочей книги в режиме полноэкранного представления

Рис. 1.16. Диалоговое окно Zoom

При установке значения масштабирования 200 % количество видимых ячеек со-
кращается вдвое (а следовательно, во столько же раз увеличивается их размер),
а при установке значения 50 % — возрастает вдвое.

Если необходимо изменить размер лишь некоторой части рабочего листа, следует
выделить этот диапазон и в диалоговом окне Zoom (Масштаб) активизировать пе-
реключатель Fit selection (по выделению). В результате выделенный диапазон
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ячеек будет увеличен или уменьшен таким образом, что займет всю видимую
часть окна рабочей книги. Путем установки значения, равного 100 %, можно вос-
становить первоначальный вид рабочего листа.

Сокрытие листов и книг
В случае совместного использования рабочих книг некоторые из них (или от-
дельные листы) могут быть скрыты. Такая книга или такой лист не отображают-
ся на экране и не могут быть активизированы посредством ярлычков или меню
Window (Окно). Благодаря этому пользователь может защитить данные не только
от редактирования, но и от просмотра.

Скрыть активный лист позволяет команда Format > Sheet/Hide (Формат > Лист/
Скрыть), а восстановить его отображение — команда Format > Sheet/Unhide (Фор-
мат > Лист/Отобразить). В диалоговом окне Unhide (Вывод на экран скрытого
листа) отображаются имена всех скрытых листов рабочей книги (рис. 1.17). По-
сле выделения имени и нажатия кнопки О К лист снова появляется на экране.
Если он защищен, то другой пользователь не сможет просмотреть его.

Рис. 1.17. Список скрытыхлистов в окне Unhide

Для того чтобы скрыть книгу, а затем восстановить ее отображение, следует вос-
пользоваться соответственно командами Hide (Скрыть) и Unhide (Отобразить) ме-
ню Window (Окно).

Разделение окна

При работе с большими таблицами легко потерять ориентацию. В этом случае
бывает очень сложно определить, к какой строке и к какому столбцу относится
информация, так как их названия отображаются только в начале таблицы. С по-
мощью команды Window > Split (Окно > Разделить) рабочий лист можно разделить
на два или четыре подокна с полосами прокрутки и зафиксировать в одном из
них часть таблицы с названиями строк и столбцов. Благодаря этому при просмот-
ре любой области таблицы будет легко определить, к каким строкам или столб-
цам относятся данные в подокнах.

В качестве примера рассмотрим электронную таблицу, приведенную на рис. 1.18.
Она приобрела такой вид после вызова команды Window * Split (Окно > Разделить).
Как видите, мы зафиксировали названия месяцев в верхней части окна, разместив
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горизонтальную линию разбивки между третьей и четвертой строками, а верти-
кальную (которая нам не нужна) — между первым столбцом и номерами строк.

(ПРИМЕЧАНИЕ Линии разбивки можно установить и с применен нем маркеров разбивки, ко-
торые находятся над вертикальной полосой прокрутки и справа от горизон-
тальной. При разбивке рабочего листа разделяются и полосы прокрутки.

Разместив линии разбивки должным образом, их местоположение нужно зафик-
сировать посредством команды Window > Freeze Panes (Окно » Закрепить).
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Рис. 1.18. Рабочий лист, разбитый с помощью команды Split на две части

Для изменения позиции зафиксированной линии разбивки следует активизиро-
вать команду Window v Unfreeze Panes (Окно ^ Снять закрепление областей) и пе-
реместить линию с помощью мыши в другую позицию. Удалить линию можно
либо путем выполнения на ней двойного щелчка, либо с помощью команды
Window > Unfreeze Panes (Окно > Снять закрепление областей).

Справочная подсистема программы Excel

Excel никогда (или почти никогда) не оставит вас в беде. Залог тому — наличие
электронного справочника, то есть справочной подсистемы программы. Необходи-
мость в таком справочнике очевидна. Ведь вы концентрируете свое внимание лишь
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на тех командах и функциях, которые используете в ежедневной работе с про-
граммой, и просто не в состоянии изучить и запомнить остальные.

Ш После нажатия клавиши F1 или кнопки Microsoft Office Excel Help (Справка
: Microsoft Excel) на стандартной панели инструментов появляется область

задач под названием Excel Help (Справка Excel), показанная на рис. 1.19, Если вве-
сти вопрос в поле Search for (Поиск) и нажать расположенную справа от него
кнопку со стрелкой, то в области задач отобразятся результаты поиска. Выберите
один из ответов, щелкнув на нем кнопкой мыши и на экране появится окно
Microsoft Office Excel Help (Справка Microsoft Excel) с нужной вам информацией.

,: Ексе| help

Assistance

Search for:

ТаЫе of Contents

Microsoft Office Online
M Connect to Microsoft Office

Online

"• Get the latest news about using
Excel

•" Automatic dly update this list
from the web

What's New

Contact Us

Accessibility help

Online Content Settings,

Рис. 1.19. Область задач Excel Help

После щелчка на ссылке ТаЫе of Contents (Показывать вкладки) в нижней части
области задач появляется список разделов справки. Щелкните на ссылке, кото-
рая снабжена значком закрытой книги, чтобы открыть интересующий вас раздел.
Затем среди ссылок, обозначенных значком вопроса, найдите нужную, и после
щелчка на ней кнопкой мыши на экране отобразится текст справки.

Одним из компонентов справочной системы Microsoft Excel является Assistance
(Помощник), который может постоянно присутствовать в рабочей области. Спра-
вочную систему можно вызвать, щелкнув на ссылке Assistance (Помощник) в об-
ласти задач.
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Справочную подсистему можно использовать по-разному. Даже вызывать ее мож-
но различными способами. В зависимости от способа вызова справки программа
Excel предлагает пользователю:

О инструкцию по выполнению основных операций;

О сведения о команде;
О информацию о диалоговом окне.

Ш Например, если пользователю понадобится помощь при работе с определен-
ным диалоговым окном, то для получения справочной информации (если

таковая имеется) сначала следует нажать кнопку со знаком вопроса, которая на-
ходится в правой верхней части этого диалогового окна, а затем щелкнуть мы-
шью на кнопке или флажке. На экране появится всплывающее меню с описанием
функции элемента.
В Excel насчитывается двадцать панелей инструментов с кнопками, позволяющи-
ми быстро активизировать команды. Но даже обладая хорошей памятью пользо-
ватель не сможет запомнить назначение всех кнопок. Поэтому в программе реа-
лизована система всплывающих подсказок, которые позволяют быстро разо-
браться, для чего предназначена та или иная кнопка. Всплывающие подсказки
появляются приблизительно через две секунды после установки указателя мыши
на кнопке панели инструментов.

|
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Подведение итогов
В этом уроке мы научились:

0 работать с документами в Excel;

0 настраивать рабочую область;
И конфигурировать панель- инструментов;

0 пользоваться справочной подсистемой.
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П Ввод данных в таблицу

П Использование функции
автозаполнения

П Перемещение диапазонов ячеек

П Использование формул
при вычислениях

П Форматирование таблицы

О Создание диаграммы

G Печать рабочего листа



Ввод данных в таблицу

На этом уроке вы познакомитесь с основными функциями программы. Излагае-
мый ниже материал предназначен в первую очередь для пользователей, которые
никогда не работали с электронными таблицами, а значит, хотели бы получить
о них достаточно полное представление. Чтобы помочь им в этом, мы составим
отчет о доходах и расходах предприятия за второе полугодие текущего года и пред-
ставим данные в виде диаграммы. Конечно, создаваемый документ не совсем от-
вечает требованиям финансовой и бухгалтерской отчетности — на его примере
можно лишь продемонстрировать основные приемы работы в Excel.

Ввод данных в таблицу
Итак, приступим к составлению отчета. После запуска программы Excel автома-
тически загружается чистая книга и активизируется ячейка А1 (см. рис. 1.1). Как
видите, эта ячейка обведена рамкой, которая называется указателем ячейки.

Сохраните рабочую книгу под именем Отчет за 2-е полугодие. Введите в ячейку А1
заголовок таблицы

Отчет о доходах и расходах предприятия

и нажмите клавишу Enter, после чего указатель будет перемещен в ячейку А2.

Нажмите клавишу со стрелкой вниз (-1), чтобы перейти из ячейки А2 в ячейку
A3, или активизируйте эту ячейку, выполнив на ней щелчок. Введите в ячейки
АЗ:А16 текст, представленный на рис. 2.1, завершая ввод очередной порции дан-
ных нажатием клавиши Enter — для перемещения указателя ячейки на одну стро-
ку вниз. При вводе информации в ячейки А10:А12 сделайте отступы, вставив не-
сколько пробелов.

•3 Microsoft UFfice txtel 2003 - Отчет чэ 2-е пояугодиел!*

Налог на добавленную стоимость
Валовой доход

Аре ида оборуд ования

Валовая прибыль
Налог на прибыль

Рис. 2.1. Таблица с введенными заголовками строк
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Заметьте, что если длина строки вводимого текста превышает ширину ячейки, то
текст выступает за ее правый край. Если не увеличить ширину ячейки столбца А
и ввести данные в ячейку столбца В, часть текста, находящегося в столбце А, ото-
бражаться на экране не будет. Щелкните на какой-либо ячейке столбца А, помес-
тите указатель мыши на границу заголовков столбцов А и В, а когда курсор приоб-
ретет вид двунаправленной стрелки с вертикальной линией, нажмите левую кноп-
ку мыши и увеличьте ширину столбца А так, чтобы заголовки строк поместились
в нем полностью.

Ввод названий месяцев с помощью функции
автозаполнения

В третью строку необходимо ввести заголовки столбцов, которыми послужат на-
звания месяцев (рис. 2.2). Их можно непосредственно ввести в ячейки B3:G3, од-
нако существует более удобный способ — функция автозаполнения. При ее исполь-
зовании для ввода названий всех месяцев достаточно ввести только одно из них.

1. Активизируйте ячейку ВЗ.

2. Введите название первого месяца второго полугодия — Июль.

3. Установите указатель мыши на маркере заполнения (черной точке в правом
нижнем углу) ячейки ВЗ, вследствие чего он приобретет вид черного крестика.

4. Удерживая левую кнопку мыши нажатой, переместите указатель в ячейку G3.
Диапазон ячеек B3:G3 будет выделен рамкой и отобразится инверсно. В про-
цессе перемещения указателя мыши вправо на экране будут появляться под-
сказки об автоматически вставляемых в ячейки значениях — Август, Сентябрь,
Октябрь и т. д.
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Рис. 2.2. Таблица после автозаполнения



Ввод данных в таблицу

При использовании функции автозаполнения Excel проверяет, является ли вве-
денное вами значение элементом одного из встроенных списков. Если это так,
выделенные ячейки заполняются соответствующими значениями из списка в за-
данной последовательности.

Ввод чисел с помощью функции автозаполнения

Функцию автозаполнения можно использовать и для заполнения ячеек, содержа-
щих однотипные числовые значения (в нашем примере таковыми являются ячей-
ки строк Заработная плата, Арендная плата и Аренда оборудования).

1. Введите указанные на рис. 2.3 числа в соответствующие ячейки и активизи-
руйте ячейку В9.

Отчет о доходах и расходах предприятия
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Валовая прибыль
йЬлог _нэгпри6ыль_ ̂
Чистая прибыль

Маркер заполнения
•.

Рис. 2.3. Рабочий лист до автозаполнения

2. Удерживая левую кнопку мыши нажатой, переместите указатель в ячейку
В11, выделив таким образом нужный диапазон ячеек, после чего отпустите
кнопку мыши.

3. Установите указатель мыши на маркере заполнения выделенного диапазона.

4. При нажатой левой кнопке мыши переместите маркер заполнения до столбца G
включительно и отпустите кнопку. Ячейки диапазона будут заполнены значе-
ниями (рис. 2.4).

5. В остальные ячейки (строки 5 и 12) введите значения, указанные на рис. 2.5.

На этом первый этап создания отчета завершается.
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Рис. 2.5. Таблица после ввода исходных значений

Перемещение диапазонов ячеек

В нашем примере необходимо сначала определить сумму расходов предприятия
за все месяцы, а затем — разницу между его доходами и расходами. Поскольку
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ячейки с информацией о доходах и расходах расположены непосредственно друг
под другом, мы можем выделить их посредством пустых строк в тематические
группы.

1. Активизируйте ячейку А8, удерживая левую кнопку мыши нажатой, перемес-
тите указатель в ячейку G15 и отпустите кнопку мыши.

2. Установите указатель мыши на нижней границе выделенного диапазона (ука-
затель должен приобрести вид стрелки).

3. Удерживая левую кнопку мыши нажатой, переместите указатель в строку 16.

В результате таких действий выделенный диапазон будет смещен на одну строку
вниз, а перед строкой Затраты на производство продукции появится пустая строка.
Переместите аналогичным образом диапазон ячеек A14;G16. Как теперь должна
выглядеть таблица, показано на рис. 2.6.
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Рис. 2.6. Таблица после перемещения диапазонов ячеек

Описанным способом можно перемещать как целые диапазоны, так и отдельные
ячейки. Если при этом удерживать нажатой клавишу Ctrl, будет производиться не
перемещение, а копирование.

Использование формул при вычислениях
Если в нескольких смежных столбцах должны быть выполнены однотипные вы-
числения, можно воспользоваться одной из функций Excel, позволяющих авто-
матизировать процесс обработки таблиц.
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Расчет сумм

Ж
* Теперь необходимо ввести в ячейки строки 9 формулы, с помощью которых

можно определять суммы расходов за каждый месяц. Сначала создадим
формулу для расчета суммы расходов за один месяц (столбец В), а затем посред-
ством функции автозаполнения введем аналогичные формулы в диапазон ячеек
C9:G9.
1. Активизируйте ячейку В9 и в стандартной панели инструментов щелкните на

кнопке AutoSum (Автосумма).

2. Переместите указатель мыши в ячейку В10 и, удерживая нажатой левую
кнопку мыши, выделите диапазон ячеек В10:Б13.

3. Нажмите клавишу Enter.

4. Используя функцию автозаполнения, введите данные в ячейки C9:G9. Для
этого активизируйте ячейку В9, установите указатель мыши на маркере за-
полнения, а затем, удерживая левую кнопку мыши нажатой, переместите мар-
кер заполнения в столбец G и отпустите кнопку (рис. 2.7).

I
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472lO 169200; 4б9шо
з C l i 300000: ЗООООО! 300000! 300000; 300000В том числе: Заработная плата

Чистая прибыль

Sheen

Рис. 2.7. Таблица после вычисления сумм расходов

I ПРИМЕЧАНИЕ Функция автосуммы обрабатывает лишь те ячейки, которые находятся в смеж-
ных диапазонах и содержат числовые значения.

Ввод формул, выполняющих арифметические операции
В рассматриваемом примере при помощи формул могут быть произведены все
необходимые расчеты. Ниже перечислены показатели данного отчета и показано,
как они вычисляются.
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О «Налог на добавленную стоимость (НДС)» рассчитывается по формуле «Ва-
ловая выручка»/(1+20%).

О «Валовой доход» определяется как разность между валовой выручкой и НДС.
О «Валовая прибыль» вычисляется как разность между показателями «Валовая

выручка» и «Затраты на производство продукции».

О «Налог на прибыль» составляет 30 % от значения показателя «Валовая при-
быль».

О «Чистая прибыль» определяется как разность между показателями «Валовая
прибыль» и «Налог на прибыль».

Введем в таблицу формулы для определения перечисленных показателей. Поря-
док действий при этом должен быть следующим. Сначала нужно щелкнуть на
требуемой ячейке, затем — в строке формул, после чего набрать формулу с помо-
щью клавиатуры и нажать клавишу Enter.

1. Введите в ячейку В6 формулу = В5/С1+0.2), а в ячейку В7 — формулу = В5 - Вб.

2. Выделите диапазон ячеек В6:В7 и посредством функции автозаполнения за-
полните ячейки C6:G7.

3. Введите в ячейки В15:В17 следующие формулы:

815 = В5-В9
816 = 615*0,3
817 = В15-В16

4. Выделите диапазон ячеек В15:В17 и, используя функцию автозаполнения, за-
полните ячейки C15:G17.
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Рис. 2.8. Заполненная таблица
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Форматирование таблицы

После ввода и обработки данных следует заняться оформлением таблицы. Безус-
ловно, это можно сделать и до ввода данных, однако значительно легче формати-
ровать заполненную таблицу.

1. Выделите диапазон ячеек A3:G17.
2, Выполните команду Format > AutoFormat (Формат > Автоформат), после чего бу-

дет открыто одноименное диалоговое окно (рис. 2.9).

•

Рис. 2.9. Диалоговое окно AutoFormat

3. Выберите в списке с примерами оформления таблиц тип Classic 1 (Классиче-
ский 1) и нажмите кнопку ОК.

В процессе автоматического форматирования Excel распознает (по формулам),
в каких ячейках находятся результаты вычислений, а в каких — данные, исполь-
зуемые при вычислениях. На основании результатов анализа содержимого ячеек
программа принимает решение о том, какие ячейки форматировать. В выбранном
нами формате Classic 1 (Классический 1) для выделения данных используются
линии и различное начертание (рис. 2.10). При автоматическом форматировании
кроме рамки и параметров шрифта изменяется и ширина столбцов — так, чтобы
пользователь мог видеть в ячейках весь текст.

Форматирование заголовка и присвоение денежного стиля
Следующий этап оформления таблицы состоит в форматировании заголовка от-
чета и присвоении всем ячейкам с числовыми значениями денежного стиля.
1. Активизируйте ячейку А1.

2. В поле списка с размерами шрифтов Font Size (Размер шрифта), расположен-
ном на панели инструментов Formatting (Форматирование), установите размер
шрифта равным 12 пунктам.



Форматирование таблицы

3. Посредством кнопок Bold (Полужирный) и Italic (Курсив) этой же панели за-
дайте жирное курсивное начертание.

4. Выделите диапазон ячеек B5:G17 и щелкните на кнопке Currency (Денежный
формат), расположенной на панели инструментов форматирования.

Из-за недостаточной ширины столбцов данные в большинстве ячеек будут заме-
нены символами диеза (#). Таким способом отображаются только числовые зна-
чения. Не вмещающиеся в ячейку текстовые данные будут урезаны.

аи шш' mm ,-j£UI
-'Туре з quesaco &r I

к —. а LIHM-.S, - ss

i лги j-.io - » ./ . a rî .sfc-.ss.ai
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Рис. 2.10. Таблица в формате Classic 1

Автоподбор ширины столбцов

Для того чтобы ячейки, содержащие символы диеза, приобрели обычный вид, не-
обходимо задать команду AutoFit Selection (Автоподбор ширины).

1. Установите указатель мыши на заголовке столбца В.

2. Переместите указатель мыши при нажатой левой кнопке от заголовка столб-
ца В до заголовка столбца G и выделите диапазон, включающий все ячейки
этих столбцов (рис. 2.11).

3. Вызовите команду Format > Column > AutoFit Selection (Формат > Столбец > Ав-
топодбор ширины).

В результате выполнения этой команды ширина столбца устанавливается с уче-
том размеров самого длинного его элемента. Поскольку в нашем примере перед
выполнением команды Auto Fit Selection (Автоподбор ширины) было выделено не-
сколько столбцов, для всех их будет установлена одна и та же ширина (рис. 2.12).
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Рис. 2.11. Таблица с выделенными столбцами
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Рис. 2.12. Отформатированная таблица

В Excel размеры отдельных ячеек нельзя устанавливать произвольным образом,
поскольку данные будут смещены в другие строки или столбцы, что приведет
к появлению ошибочных результатов. Поэтому размеры ячеек можно менять
только путем изменения высоты всей строки или ширины всего столбца.

Параметры форматирования ячеек можно задавать в индивидуальном порядке.
Ведь в ячейках рабочего листа часто находятся данные различных типов.
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Обязательным условием выполнения большинства операций по форматирова-
нию является предварительное выделение ячеек. Путем выделения вы указывае-
те программе, к каким ячейкам относится следующая операция.

Удаление сетки таблицы с рабочего листа
Чтобы увидеть результат форматирования, нужно убрать с рабочего листа сетку
таблицы.

1. Выполните команду Tools > Options (Сервис > Параметры), для того чтобы от-
крыть одноименное диалоговое окно.

2. Перейдите на вкладку View (Вид) и снимите флажок GridLines (сетка).

3. Нажмите кнопку ОК.

Этот флажок определяет, будет ли отображена сетка на экране, не влияя на ее вы-
вод на печать.

Создание диаграммы

Ш Excel предоставляет в распоряжение пользователей удобные средства созда-
ния и форматирования диаграмм. Продемонстрируем их возможности.

1. Выделите диапазон ячеек A3:G3. Содержащиеся в этой строке значения будут
использоваться в качестве надписей на оси X.

2. Удерживая нажатой клавишу Ctrl, выделите диапазон ячеек A5:G5.

3. Выделите диапазоны ячеек A9:G9, A17:G17 и только после этого отпустите
клавишу Ctrl

4. Для вызова мастера диаграмм, осуществляющего пошаговое руководство про-
цессом создания диаграммы, нажмите кнопку Chart Wizard (Мастер диаграмм),
расположенную на стандартной панели инструментов.

5. В первом диалоговом окне мастера выберите тип диаграммы (рис. 2.13).

6. Нажмите кнопку Next (Далее), с тем чтобы перейти во второе окно мастера
(рис. 2.14). В поле Data range (Диапазон) этого окна должны отображаться ад-
реса диапазонов, выделенных перед созданием диаграммы.

7. Нажмите кнопку Next (Далее). Третье окно мастера диаграмм состоит из не-
скольких вкладок, предназначенных для задания различных параметров диа-
граммы. Большинство из этих параметров устанавливает сама программа.

8. В поле Charttitle (Название диаграммы) вкладки Titles (Заголовки) введите на-
звание диаграммы Отчет о доходах и расходах п р е д п р и я т и я .

После щелчка на кнопке Next (Далее) открывается последнее диалоговое окно
мастера диаграмм, окно Chart Location (Размещение диаграммы), в котором можно
определить месторасположение создаваемой диаграммы — активный лист или
отдельный лист.

После нажатия кнопки Finish (Готово) диаграмма появится на рабочем листе
(рис. 2.15). Воспользовавшись рамкой, ее можно переместить.
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I ПРИМЕЧАНИЕ Вы можете изменить ориентацию надписей на оси X. Для этого сначала необ-
ходимо выполнить щелчок в области диаграммы, вследствие чего вокруг нее
появится рамка, дважды щелкнуть на названии месяца, чтобы открыть диало-
говое окно Format Axis (Формат оси), перейти на вкладку Alignment (Вырав-
нивание) и выбрать ориентацию текста.

Рис. 2.13. Окно для выбора типа диаграммы

Рис. 2.14. Второе диалоговое окно мастера диаграмм
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Отчет о доходах и расходах предприятия

• Затраты на
производство
продукции

D Чистая прибыль

Июль Август Сентябрь Октябрь Ноябрь Декабрь

Рис. 2.15. Готовая диаграмма

Печать рабочего листа

Ш Прежде чем выводить таблицу или диаграмму на печать, с помощью функ-
ции Print Preview (Предварительный просмотр) можно посмотреть, как соз-

данный документ будет выглядеть на бумаге.

1. Щелкните на кнопке Print Preview (Предварительный просмотр) стандартной
панели инструментов, и подготовленная к печати страница будет представле-
на на экране (рис. 2.16).

2. В окне предварительного просмотра щелкните на кнопке Setup (Страница) па-
нели инструментов.

3. В окне Page Setup (Параметры страницы) перейдите на вкладку Margins (Поля)
и введите в поля Left (левое) и Right (правое) значение 0.5. Путем уменьшения
размеров полей можно увеличить количество столбцов на странице.

4. Установите в области Center on page (Центрировать на странице) флажки
Horizontally (горизонтально) и Vertically (вертикально) и закройте диалоговое
окно, нажав кнопку ОК.

[ПРИМЕЧАНИЕ При необходимости диаграмму можно переместить в другое место. Нажмите
кнопку Close (Закрыть) для возврата в рабочую книгу, установите указатель
мыши на диаграмме,удерживая нажатой левую кнопку, перетащите диаграм-
му в новую позицию и отпустите кнопку.

5. Чтобы распечатать таблицу, щелкните на кнопке Print (Печать) в окне предва-
рительного просмотра или на соответствующей кнопке стандартной панели
инструментов в обычном режиме.
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Наконец-то вы держите в руках свою первую таблицу, созданную с помощью про-
граммы Excel. Более подробно о принципах работы с электронными таблицами
мы расскажем в следующих уроках.

; Microsoft OfBce Excel 2003

Рис. 2.16. Лист электронной таблицы перед печатью

Подведение итогов
В этом уроке мы научились:

0 вводить данные в таблицу;

0 пользоваться функцией автозаполнения;
0 перемещать диапазоны ячеек;

0 применять при проведении вычислений формулы;
0 форматировать таблицы;
0 создавать диаграммы;

0 выводить рабочие листы на печать.
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В предыдущих уроках вы ознакомились с окнам программы Excel 2003 и создали
простую таблицу. На ее примере в упрощенном виде был продемонстрирован
процесс создания таблицы от ввода данных до вывода таблицы на печать. Начи-
ная с настоящего занятия, вы будете изучать указанный процесс более детально.

Излагая материал этого урока, мы продемонстрируем приемы, которые использу-
ются при создании таблиц, подобных представленной на рис. 3.1. В рассматривае-
мой таблице содержится такая информация, как названия городов, в которых
проводились аукционы (в течение двух месяцев), даты их проведения, количест-
во проданного товара и число потенциальных покупателей. Значения, хранящие-
ся в ячейках С18:Е18, можно получить путем суммирования данных в соответст-
вующих столбцах.
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Рис. 3.1. Таблица-пример

Ввод данных в ячейку и перемещение
по рабочему листу

Скорость работы с информацией, хранящейся в таблицах Excel, во многом будет
зависеть от того, насколько полно вы овладеете методами ввода данных и прие-
мами, позволяющими перемещаться по рабочему листу.
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Ввод данных
Данные вводятся либо в активную ячейку, либо в строку формул. Как только
в ячейку будет введен хотя бы один символ, ее содержимое отобразится в строке
формул. Кроме того, в этой строке появятся три кнопки, с помощью которых осу-
ществляется обработка содержимого ячейки.

Ввод данных в ячейку
1. Активизируйте ячейку, дважды щелкнув на ней мышью.

2. Введите в ячейку или в строку формул данные.

3. Завершите ввод данных нажатием клавиши Enter или щелчком на кноп-
ке с изображением галочки в строке формул либо воспользовавшись
клавишами управления курсором. Последний способ позволит вам сме-
ститься в нужном направлении.

При необходимости отменить операцию ввода данных воспользуйтесь клавишей
Esc или кнопкой с крестиком, находящейся в строке формул.

IПРИМЕЧАНИЕ Прежде чем вводить данные с помощью цифрового блока клавиатуры,следу-
ет проверить, включен ли он (на клавиатуре должен светиться индикатор
Num Lock).

Ячейки электронной таблицы могут содержать самую разнообразную информа-
цию: текст, числовые значения, формулы. При вводе данных Excel автоматически
распознает их тип. Вводимые числовые значения автоматически выравниваются
по правому краю, а текстовые данные — по левому краю ячейки. Однако Excel
предоставляет возможность изменять способ выравнивания данных разных типов.

Если длина введенного в ячейку текста превышает ширину этой ячейки, то после
завершения операции ввода текст либо полностью отображается в таблице, за-
крывая расположенные справа пустые ячейки, либо урезается по правому краю
ячейки, если соседняя ячейка содержит какую-либо информацию. Урезанный
текст полностью отображается только в строке формул.

Возможна и такая ситуация, когда числовые значения, полученные в результате
вычисления формул, не помещаются в ячейке. Вместо них на экране будут ото-
бражаться (рис. 3.2) символы диеза (#).

Excel автоматически распознает форматы дат и времени и определенным образом
выводит данные этого типа на экран. Для представления дат и значений времени
существует несколько форматов. Формат, который нужно присвоить значению,
определяется на основе порядка ввода цифр и разделителей (табл. 3.1).

[ПРИМЕЧАНИЕ Значения, представленные в форматах даты и времени, можно использовать
в вычислениях.

В некоторых случаях автоматическое присвоение формата введенным данным не-
желательно. Перед такими данными следует ставить символ апострофа. Например,
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данные типа '1,1 будут интерпретированы программой как текст и выровнены по
левому краю. После удаления апострофа им автоматически будет присвоен соот-
ветствующий формат.
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Рис. 3.2. Отображение числовых значений
при недостаточной ширине ячейки

Таблица 3.1. Содержимое ячейки в зависимости от типа данных и способа их ввода

Введенное значение

1,

Л

1.

.1

1/1

1/1/3

2/2003

2-2

2:2

Представление

1

1

од

1.
л
1-Янв

1-Янв-2003

Фев-03

2-Фев

2:02

Тип данных

Числовое значение

Числовое значение

Числовое значение

Текст

Текст

Значение даты

Значение даты

Значение даты

Значение даты

Значение времени

Содержимое ячейки

1

1

ОД

1.

.1

01.ЯНВ

01.01.2003

фее. 03

О2.фев

2:02

Если в ячейку вводится формула, то сразу по завершении данной операции вы-
полняются вычисления, и в ячейке отображается результат вычислений. Форму-
ла в Excel должна начинаться со знака равенства. Так, после ввода формулы =1+6
в ячейке появится число 7, но в строке формул отобразится фактическое содер-
жимое ячейки — формула. Запись 1+6 программа интерпретирует как текст.
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Формула может начинаться также со знака плюс или со знака минус. Эти знаки
всегда относятся к первому числовому значению в формуле.

Иногда после ввода формулы появляется сообщение об ошибке. Например, про-
грамма воспримет значение -1/0 как формулу и сразу попытается произвести вы-
числения. Однако через некоторое время она выдаст сообщение #OIV/0! (#ДЕЛ/01),
по содержимому которого нетрудно определить характер ошибки. А после ввода
данных типа =Текст в ячейке появится сообщение #NAME? (#ИМЯ?), указывающее
на то, что имени ячейки или диапазона Текст не существует.

СОВЕТ Данные удобнее вводить в выделенные диапазоны, поскольку очередностью
выделения ячеек определяется направление перемещения указателя ячей-
ки. После заполнения последней ячейки диапазона и нажатия клавиши Enter
указатель ячейки возвращается в левую верхнюю его ячейку.

Перемещение по рабочему листу
Для перемещения по небольшим диапазонам ячеек достаточно клавиш управле-
ния курсором. Чтобы попасть в ту часть таблицы, которая не отображается на эк-
ране, но находится недалеко от видимой области, следует воспользоваться поло-
сой прокрутки.

Более быстрый способ перемещения по таблице — применение клавиш Page Up
(смещение вверх с шагом в один экран) и Page Down (смещение вниз с шагом в один
экран). При нажатии комбинации клавиш ALt+Page Down видимая часть таблицы
смещается вправо. Комбинация клавиш Alt+Page Up предназначена для перемеще-
ния в обратном направлении.

I ПРИМЕЧАНИЕ Клавиша Scroll Lock позволяет зафиксировать позицию указателя ячейки при
перемещении по рабочему листу с помощью клавиш управления курсором.

Если позиция ячейки известна, то перейти к ней можно с помощью команды
Edit > Go To (Правка > Перейти) либо посредством нажатия клавиши F5 или ком-
бинации клавиш CtrL+G. В каждом из трех случаев открывается диалоговое окно
Go To (Переход), в котором следует указать адрес или имя нужной ячейки (рис. 3.3).

Добиться значительного ускорения при перемещении по рабочему листу можно
за счет использования специальных комбинаций клавиш.

Для перехода в последнюю строку рабочего листа необходимо поочередно на-
жать клавишу End и клавишу со стрелкой вниз (-1). Если между активной ячей-
кой и последней строкой рабочего листа находятся заполненные ячейки, то в ре-
зультате нажатия указанных клавиш активизируется первая такая ячейка. В этом
случае для перехода к последней строке рабочего листа процедуру придется по-
вторить определенное количество раз.

Посредством последовательных нажатий клавиши End и клавиши со стрелкой
вправо (-») выполняется переход к последнему столбцу рабочего листа, однако
если указатель ячейки «натолкнется» при этом на заполненную ячейку, то она
будет активизирована.
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Рис. 3.3. Диалоговое окно Go To

Перейти в начало рабочего листа позволяет комбинация клавиш CtrL+Home. Что
касается комбинации клавиш Ctrl+End, то она зарезервирована для перехода не
к последней строке рабочего листа, а к последней заполненной ячейке таблицы
(к ячейке с наибольшими значениями номеров строки и столбца).

Для быстрого перемещения по листу предназначены также комбинации клавиши
Ctrl с клавишами управления курсором. Нажатие комбинации CtrL+i приводит
к активизации следующей заполненной ячейки, а если таковой в заданном на-
правлении нет, то осуществляется переход в последнюю строку таблицы. Анало-
гичным образом действуют комбинации клавиш CtrL+^, Ctrl+<— и Ctrl+T.

Хотелось бы обратить ваше внимание на возможность перехода с листа на лист
с помощью клавиатуры. В результате нажатия комбинации клавиш Ctrl+Page Up
активизируется предыдущий лист, а после нажатия комбинации Ctrl+Page Down —
следующий лист.

Клавиши и комбинации клавиш, используемые для перемещения по листам ра-
бочей книги, описаны в табл. 3.2.

Таблица 3.2. Клавиши, используемые для перемещения полистан рабочей книги

Клавиша или комбинация клавиш Перемещение

Ноте

Ctri+Home

CtrU-End

Ctrl+t

Ctrt+4-

Ctrl+->

В начало текущей строки

В ячейку А1

В последнюю заполненную ячейку таблицы

На одну ячейку вверх

На одну ячейку вниз

На одну ячейку вправо

На одну ячейку влево

Вверх до первой заполненной ячейки

Вниз до первой заполненной ячейки

Вправо до первой заполненной ячейки
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Клавиша или комбинация клавиш Перемещение

Ctrl+«- Влево до первой заполненной ячейки

Page Up Вверх на один экран

Page Down Вниз на один экран

Alt+ Page Up Влево на один экран

Alt-f Page Down Вправо на один экран

Ctrt+PageUp К следующему листу рабочей книги

Ctrl+ Page Down К предыдущему листу рабочей книги

Самостоятельная работа
1. Создайте новый файл рабочей книги и сохраните его на диске.

2. Пользуясь рис. 3.1, введите заголовок и шапку таблицы.

3. Введите названия нескольких городов в столбец А.

4. Введите какие-либо значения даты в столбец В. Попытайтесь ускорить дан-
ный процесс, пользуясь информацией, приведенной в табл. 3.2.

5. Потренируйтесь в применении различных способов перемещения по рабоче-
му листу.

Выделение ячеек и диапазонов ячеек
Выделение производится с целью обозначения диапазона, к которому должна от-
носиться следующая задаваемая команда или функция. Выделенный на рабочем
листе диапазон всегда имеет прямоугольную форму (рис. 3.4). Наименьшей струк-
турной единицей выделенного диапазона является ячейка. Активная ячейка (в ко-
торой находится указатель ячеек) считается выделенной. Все выполняемые ко-
манды относятся только к активной ячейке или к выделенному диапазону.

Способы выделения диапазона ячеек
Диапазон ячеек выделяется путем перемещения указателя мыши в нужном на-
правлении при нажатой левой кнопке. Такую операцию можно выполнить и с по-
мощью клавиатуры. Для этого следует установить указатель ячейки в начале вы-
деляемой области, нажать клавишу Shift и, удерживая ее в таком состоянии,
с помощью клавиш управления курсором выделить нужный диапазон.

Альтернативой клавише Shift является функциональная клавиша F8 (она приме-
няется для включения режима выделения и в некоторых других приложениях
Windows). После нажатия этой клавиши в строке состояния появляется индика-
тор ЕХТ (ВДЛ), свидетельствующий о том, что режим выделения включен. Теперь
с помощью клавиш управления курсором можно расширить выделенный диапа-
зон. Повторное нажатие клавиши F8 приводит к отключению режима выделения.

3 Зак. 345



66 Урок 3 • Ввод и редактирование данных

Рис. 3.4. Таблица с выделенными ячейками

Выделенные ячейки отображаются инверсно. Таким образом программа сообща-
ет пользователю, что последующая операция будет относиться только к указан-
ным ячейкам. Для отмены операции выделения достаточно выполнить щелчок
вне отмеченной области или нажать одну из клавиш управления курсором.

Если понадобится изменить размер выделенного диапазона, необходимо снова на-
жать клавишу Shift и удерживать ее в таком состоянии до тех пор, пока область не
достигнет нужного размера.

В Excel для быстрого выделения диапазона ячеек в режиме ЕХТ (ВДЛ) предусмот-
рен ряд комбинаций клавиш.

Выделить всю таблицу, от начала до конца, можно с помощью комбинации клавиш
Ctrl+Shift+End, а любую часть таблицы, от активной ячейки до начала, — комбина-
ции клавиш Ctrl+Shift+Home.

Если таблица не содержит пустых строк или столбцов, ее очень просто выделить
с помощью клавиш Ctrlf * (клавиша со звездочкой (*) находится на цифровом бло-
ке клавиатуры). В этом случае выделяется диапазон ячеек вокруг активной ячей-
ки, который тянется до первой пустой строки и первого пустого столбца.

Существует еще один способ быстрого выделения диапазона, с использованием
мыши. Состоит он в следующем. Указатель мыши устанавливается в левой верх-
ней ячейке выделяемого диапазона, и при нажатой клавише Shift выполняется
щелчок на его правой нижней ячейке. При этом не имеет значения, содержит ли
данный диапазон пустые строки или столбцы.
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Выделение несмежных диапазонов
Несмежные диапазоны ячеек выделяются в том случае, если действие команды
должно распространяться на ячейки, расположенные в разных частях таблицы
(рис. 3.5).

Книга 2603 -Результаты аукционов
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Рис. 3.5. В таблице выделены несмежные диапазоны ячеек

Но на выделенные несмежные диапазоны распространяется действие не всех ко-
манд. В частности, такие диапазоны нельзя перемещать или копировать. Однако
их можно удалять, форматировать, вводить в них данные.

Вот как можно выделить несколько несмежных диапазонов. Сначала нужно от-
метить первый диапазон и нажать комбинацию клавиш Shift+F8. В строке состоя-
ния появится индикатор ADD (ДОБ), свидетельствующий о включении режима
несмежных выделений. В этом режиме с помощью мыши или клавиатуры после-
довательно отмечаются все нужные диапазоны. Но устанавливать режим несмеж-
ных выделений не обязательно. Несмежные диапазоны можно также выделить
с использованием мыши при нажатой клавише Ctrl.

Выделение строк и столбцов
Строки и столбцы тоже можно выделять как с помощью мыши, так и с помощью
клавиатуры. Сначала рассмотрим, как данная операция выполняется посредст-
вом мыши. Чтобы выделить один столбец, достаточно произвести щелчок на его
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заголовке. Для выделения нескольких смежных столбцов следует активизиро-
вать заголовок первого столбца нужного диапазона и, удерживая левую кнопку
мыши нажатой, переместить указатель до заголовка последнего столбца диапазо-
на. Строки выделяются аналогичным образом.

При выделении столбца с помощью клавиатуры указатель мыши необходимо раз-
местить в области этого столбца и нажать комбинацию клавиш Ctrl+П робел. Для
выделения всей строки предназначена комбинация клавиш Shift+Пробел.

Если вам нужно выделить весь рабочий лист (рис. 3.6), щелкните мышью на пе-
ресечении заголовков строк и столбцов или воспользуйтесь комбинацией клавиш
CtrL+A.

Книга 20СЗ -Результаты аукционо

Рис. 3.6. Полностью выделенный рабочий лист

Выделение ячеек по заданным критериям

В Excel имеется возможность выделять ячейки, отвечающие определенному кри-
терию. При использовании этой функции следует выделить диапазон, в котором
должен производиться поиск нужных ячеек. В противном случае действие функ-
ции распространится на весь рабочий лист.

Критерий выбора задается в диалоговом окне Go To Special. (Выделение группы
ячеек), которое вы видите на рис. 3.7.
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.

Рис. З.7. Диалоговое окно Go To Special

Выделение ячеек по определенному критерию
1. Выделите диапазон ячеек.

2. Вызовите команду Edit > Go To (Правка > Перейти), в открывшемся диа-
логовом окне нажмите кнопку Special (Выделить), и на экране появит-
ся окно Go To Special (Выделение группы ячеек).

3. В области Select (Выделить) активизируйте переключатель, который за-
дает критерий выбора ячеек, после чего нажмите кнопку ОК.

На рис. 3.8 выделены ячейки, данные в которых получены с помощью формул.
Критерий выделения ячеек с формулами можно конкретизировать, воспользо-
вавшись четырьмя флажками, которые становятся доступными после установки
переключателя Formulas (формулы) или Constants (константы).

Ячейки с данными какого типа будут выделены в результате вычисления формул
при установке одного или нескольких флажков переключателя Formulas (форму-
лы), описано в табл. 3.3.

Таблица 3.3 Назначение флажков переключателя Formulas диалогового окна Go To Special

Флажок Результат вычисления формулы

Numbers (числа)

Text (текст)

Logicals (логические)

Errors (ошибки)

Числовое значение

Текст

Логическое значение

Сообщение об ошибке
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Рис. 3.8. Данные в выделенных ячейках получены с использованием формул

В диалоговом окне Go To Special (Выделение группы ячеек) имеется и ряд других
переключателей, с помощью которых можно автоматически выделить ячейки оп-
ределенного типа.

О Comments (примечания) — выделяются все ячейки, содержащие примечания
(как текстовые, так и звуковые). Для того чтобы это сделать, необходимо вы-
делить диапазон ячеек и нажать комбинацию клавиш Ctrl+Shift+?. По умолча-
нию ячейка с примечаниями помечается точкой в левом верхнем углу.

О Blanks (пустые ячейки) — выделяются все пустые ячейки в указанном диапазо-
не. Если диапазон никак не помечен, выделяются все пустые ячейки, которые
находятся между верхним левым углом листа (ячейка А1) и последней запол-
ненной ячейкой (рис. 3.9).

О Current region (текущую область) — предназначен для выделения вокруг актив-
ной ячейки прямоугольного диапазона. С помощью данного переключателя
можно выделить всю таблицу, если в ней отсутствуют пустые строки и столб-
цы. Ему соответствует комбинация клавиш Ctrl+* (необходимо нажимать кла-
вишу со звездочкой (*) на цифровом блоке клавиатуры).

О Current array (текущий массив) — используется для выделения целого массива,
в котором находится указатель ячейки. Этому элементу соответствует комби-
нация клавиш Ctrl+/.
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Рис. 3.9. В таблице выделены пустые ячейки

О Row differences (отличия по строкам) — с помощью данного переключателя
можно выделить ячейки строки, содержимое которых отличается от содержи-
мого активной ячейки. При этом поиск осуществляется только в строке с ак-
тивной ячейкой, содержимое которой используется в качестве критерия. Пе-
реключателю соответствует комбинация клавиш Ctrl+\.

О Column differences (отличия по столбцам) — выделяются все ячейки столбца,
содержимое которых отличается от содержимого активной ячейки. Поиск вы-
полняется только в столбце с активной ячейкой, содержимое которой являет-
ся критерием. Данному переключателю соответствует комбинация клавиш
Ст.г1+5п1тЪ+(Символ +).

О Precedents (влияющие ячейки)'— после установки этого переключателя по-
средством комбинации клавиш Ctrl+[ в положение Precedents (влияющие ячей-
ки) выделяются все ячейки, ссылки на которые содержит формула в активной
ячейке.

О Dependents (зависимые ячейки) — выделяются все ячейки, формулы в которых
содержат ссылки на активную ячейку. Прежде чем удалить ячейку из таблицы,
выделите ее и, нажав комбинацию клавиш Ctrl+], проверьте, не содержат ли ссыл-
ки на нее формулы из других ячеек. При использовании двух последних пере-
ключателей можно выделить не только те ячейки, которые непосредственно
связаны с активной, но и ячейки других уровней, с формулами, содержащими
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косвенные ссылки на активную ячейку. Для этого следует использовать соот-
ветствующую клавишу с квадратной скобкой ([ или ]) в комбинации с клави-
шами Ctrl+Shift

О Last cell (последнюю ячейку) - предназначен для выделения последней ячей-
ки таблицы. Причем ячейка должна содержать данные или параметры форма-
тирования.

О Visible celts only (только видимые ячейки) — чтобы изменения в таблице косну-
лись лишь видимых ячеек, их нужно выделить с помощью именно этого пере-
ключателя.

О Objects (объекты) - выделяются все объекты на рабочем листе, в том числе
созданные в других приложениях и вставленные с помощью механизма OLE.

Самостоятельная работа
1. Воспользовавшись рабочим листом, созданным в процессе выполнения пре-

дыдущей самостоятельной работы, или любым другим готовым листом, содер-
жащим данные, выделите на нем диапазон ячеек.

2. Выделите диапазон ячеек, не являющийся смежным с предыдущим.

3. Отмените выделение ячеек.

4. Выделите несколько столбцов таблицы, а затем отмените выделение.

5. Выделите несколько строк таблицы и также отмените выделение.

6. Выделите на листе ячейки с формулами.

Редактирование содержимого ячеек
Существуют различные способы редактирования содержимого ячеек. Наиболее
быстрый и простой из них — запись новой информации поверх старой.

При обнаружении каких-либо несущественных ошибок данные в ячейке лучше
не переписывать, а редактировать. Для этого нужно активизировать режим ре-
дактирования, выполнив на ячейке двойной щелчок, вследствие чего в ней поя-
вится курсор ввода (рис. 3.10). Перейти в указанный режим позволяет также
функциональная клавиша F2.

Рис. 3.10. Ячейка в режиме редактирования

I ПРИМЕЧАНИЕ В режиме редактирования содержимое ячейки отображается полностью, не-
зависимо от того, заполнена ли соседняя ячейка, расположенная справа.
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В режиме редактирования для выделения символов в ячейке используются кла-
виши управления курсором в сочетании с клавишей Shift, а для удаления тако-
вых — клавиши Delete и Backspace.

По умолчанию Excel работает в режиме ввода. Это значит, что вводимый символ
вставляется в позицию курсора ввода, после чего сам курсор ввода автоматиче-
ски смещается на один символ вправо. При нажатии клавиши Insert активизиру-
ется режим замены. В данном режиме вводимые символы заменяют существую-
щие. В результате повторного нажатия клавиши Insert опять включается режим
ввода.

IПРИМЕЧАНИЕ При удалении содержимого ячеек параметры форматирования сохраняются.
Например, если в ячейке ранее содержалось значение, имеющее процент-
ный формат, этот же формат будет присвоен и новому значению. Данное об-
стоятельство следует учитывать и в случае необходимости удалять не только
значение, но и параметры форматирования — с помощью команды Edit >
Clear > Formats {Правка > Очистить > Форматы).

Перемещение и копирование
В Excel содержимое любой ячейки может быть перемещено или скопировано. Со-
держимое ячеек, в которые вставляются переносимые (или копируемые) данные,
автоматически удаляется. Чтобы избежать этого, в ту область электронной таб-
лицы, в которую вы хотите перенести данные, необходимо вставить пустые ячейки.

(ПРИМЕЧАНИЕ Если ячейки, в которые копируются данные, содержат некоторые значения,
на экране появится окно, в котором следует подтвердить необходимость вы-
полнения операции замены. Вы можете заменить содержимое ячеек или от-
менить операцию.

Excel позволяет перемещать и копировать содержимое столбца или строки, а так-
же выделенного диапазона ячеек. Диапазон ячеек можно перемещать и копиро-
вать в другие приложения через буфер обмена. Различие между операциями пе-
ремещения и копирования состоит в том, что в первом случае содержимое ячеек
в исходной позиции удаляется, а при копировании сохраняется. Обе операции
можно выполнить как с помощью мыши, так и с помощью клавиатуры.

Чтобы переместить диапазон ячеек посредством мыши, необходимо выделить
ячейки (только смежные), поместить указатель мыши в любое место на границе
отмеченного диапазона и, удерживая нажатой левую кнопку, перетащить весь
диапазон на новое место. Как только вы отпустите кнопку мыши, содержимое вы-
деленных ячеек будет удалено в исходной позиции и вставлено в текущей. Если
во время выполнения этой операции удерживать нажатой клавишу Ctrl, образует-
ся копия выделенного диапазона (рис. 3.11).

В Excel довольно легко перемещать и копировать данные из одних рабочих лис-.
тов и книг в другие.
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Копирование

Рис. 3.11. Перемещение и копирование данных

Перенос (копирование) данных из одной книги в другую
1, Откройте рабочие книги таким образом, чтобы их окна не накладыва-

лись одно на другое.

2, Выделите диапазон ячеек с данными в исходной рабочей книге.
3, Перетащите выделенный диапазон посредством мыши в другую рабо-

чую книгу и разместите в отведенном для него месте (для копирования
удерживайте нажатой клавишу Ctrl).

Перенос (копирование) данных на другой лист
(в пределах одной книги)

1. Выделите диапазон ячеек с данными в исходном листе.

2. Нажмите клавишу Alt и удерживайте ее в этом состоянии (для копиро-
вания удерживайте нажатой клавишу Ctrl).

3. Поместите указатель мыши на границу выделенного диапазона и, удер-
живая нажатой левую кнопку, сместите его на ярлычок того листа, на
который копируются данные.

4. Переместите указатель мыши в позицию вставки на другом листе, по-
сле чего отпустите клавишу Alt и левую кнопку мыши, В результате со-
держимое выделенных ячеек будет перенесено или скопировано в не-
обходимое место.
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Перенос (копирование) данных на другой лист
(в пределах одной книги) посредством команд меню Edit
1. Выделите ячейки, которые необходимо перенести.

2. Скопируйте выделенные ячейки в буфер обмена с помощью команды
Edit > Cut (Правка > Вырезать), которой, как вы знаете, соответствует
комбинация клавиш Ctrl+X, или команды Edit > Сору (Правка к Копиро-
вать), которой соответствует комбинация клавиш Ctrl+C, либо восполь-
зовавшись соответствующими командами контекстного меню. Данные,
содержащиеся в буфере, могут быть вставлены в необходимое место ра-
бочей области Excel или другого приложения. Признаком того, что со-
держимое ячеек находится в буфере обмена, является мерцающая рам-
ка вокруг этих ячеек.

3. Установите указатель ячейки в позицию вставки и выполните команду
Edit > Paste (Правка > Вставить). Для того чтобы вставить содержимое
буфера можно воспользоваться также клавишей Enter или комбинаци-
ей клавиш Ctrl+V.

(ПРИМЕЧАНИЕ Чтобы отменить выполнение операции после выбора команды Cut (Вырезать)
или Сору (Копировать), необходимо нажать клавишу Esc.

Данные, помещенные в буфер в результате выполнения команды Cut (Вырезать),
после осуществления операции вставки удаляются из него. При копировании со-
держимого ячеек с помощью команды Сору (Копировать) данные после выполне-
ния указанной операции сохраняются в буфере обмена, что позволяет вставлять
их и в другие ячейки электронной таблицы.

Специальная вставка
При перемещении и копировании ячеек описанным способом учитывается вся
содержащаяся в них информация. Это относится как к формулам и примечани-
ям, так и к параметрам форматирования. Но в Excel предусмотрена возможность
вставки лишь части содержимого ячейки. Такая потребность может возникнуть,
например, при необходимости поместить данные в отформатированную таблицу.
Избежать повторного форматирования можно только при условии, что вставляе-
мые данные будут находиться в неформатированном виде. В таком случае Excel
предлагает воспользоваться командой Paste Special (Специальная вставка).

^ПРИМЕЧАНИЕ Описанная возможность реализуется только при использовании команды
Сору (Копировать).

ПОДСКАЗКА Вставить только заполненные ячейки позволяет использование флажка Skip
blanks (Пропускать пустые ячейки).
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Использование команды Paste Special
1. Выделите диапазон ячеек, подлежащих перемещению.
2. Вызовите команду Edit > Сору (Правка > Копировать).
3. Переместите указатель мыши в левую верхнюю ячейку диапазона, в ко-

тором планируете выполнить вставку.
4. Выполните команду Edit > Paste Special (Правка > Специальная встав-

ка), в результате чего будет открыто диалоговое окно для определения
типа вставляемой информации (рис, 3.12).

5. Установите в диалоговом окне Paste Special (Специальная вставка) пе-
реключатель All (все), и вся содержащаяся в ячейке информация будет
перенесена в нужное место. При выборе же переключателя Formulas
(формулы), Values (значения), Formats (форматы) или Comments (при-
мечания) в указанное вами место будут перенесены соответственно
только формулы, числовые значения, параметры форматирования или
примечания.

6. Нажмите кнопку ОК.

Paste Special

i
Г

" т
' ;,iJjtf

Г

I т ]
Рис. 3.12, Диалоговое окно Paste Special

При активизации переключателя Values (значения) из исходного диапазона копи-
руется не сама формула, а только результат ее вычисления. Например, если ячей-
ка в исходном диапазоне содержит формулу =11+56, то в месте назначения поя-
вится число 67.

Транспонирование таблицы
Построив таблицу, мы, возможно, решим, что расположение строк и столбцов нас
не устраивает. К счастью, в Excel довольно легко произвести транспонирование
таблицы, то есть поменять ее строки и столбцы местами.



Транспонирование таблицы
1. Выделите всю таблицу.

2. Выполните команду Edit > Сору (Правка > Копировать), после чего уста-
новите указатель ячейки в незаполненной области рабочего листа.

3. Задайте команду Edit > Paste Special (Правка > Специальная вставка).

4. В открывшемся диалоговом окне установите флажок Transpose (Транс-
понировать) и закройте окно, нажав кнопку ОК. В результате на рабо-
чем листе появится транспонированная таблица (рис. 3.13).
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Рис. 3.13. Таблица после транспонирования

Вставка и удаление ячеек
Многие операции сопровождаются вставкой ячеек. Так, если в таблицу необходи-
мо добавить данные без замены уже находящихся в ней значений, путем вставки
ячеек можно создать область для новых данных. При вставке столбца следующие
за ним столбцы сдвигаются на одну позицию вправо, а при вставке строки сле-
дующие за ней строки сдвигаются на одну позицию вниз.
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Вставка и удаление столбцов (строк) таблицы
1. Выделите столько столбцов (строк), сколько нужно вставить.

2. Откройте контекстное меню, активизируйте команду Insert (Вставить),
и ваша таблица станет подобной представленной на рис. 3.14.

3. Для того чтобы удалить вставленные столбцы (строки), воспользуй-
тесь командой контекстного меню Delete (Удалить).

L? Microsoft Office Exr el 2O03 - Peiy

Покупатели \ Продано книг

1 523
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Рис. 3.14. Таблица после вставки столбца

В процессе вставки ячеек в диалоговом окне Insert (Добавление ячеек) определя-
ется направление смещения существующих ячеек (рис. 3.15).

[ПРИМЕЧАНИЕ Вставка ячеек невозможна, если ячейки последней строки (65 536-й) или по-
следнего столбца (IV-ro, где I и V — буквы латинского алфавита) содержат
данные.

При выполнении операции удаления необходимо сначала выделить подлежащие
удалению ячейки, а затем выбрать в контекстном меню команду Delete (Удалить).
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Рис. 3.15. Диалоговое окно Insert

ВНИМАНИЕ При удалении ячеек, содержащих данные, программа не выводит на экран
окно с вопросом о необходимости выполнения операции.

При удалении строк следующие за ними строки сдвигаются вверх, а при удале-
нии столбцов следующие за ними столбцы сдвигаются влево. В процессе удале-
ния ячеек открывается диалоговое окно для определения способа смещения со-
седних ячеек.

Самостоятельная работа
1. Воспользовавшись таблицей, созданной при выполнении первой самостоя-

тельной работы, заполните столбец А, применив метод копирования.
2. Скопируйте созданную таблицу на второй лист рабочей книги.

3. Выполните транспонирование скопированной таблицы.
4. Перейдите на первый лист книги и вставьте в середину таблицы пустую строку.

Использование средств автозаполнения
Программа Excel располагает набором средств, которые позволяют значительно
ускорить ввод данных. Об одном из них - маркере заполнения - было рассказа-
но в уроке 2. Сейчас мы рассмотрим средства автоматического заполнения ячеек
более подробно.

Ввод данных с использованием маркера заполнения
Вам уже известно, как с помощью маркера заполнения создаются одинаковые на-
боры данных на листе. При этом должна быть задействована одна выделенная
ячейка или диапазон ячеек, который копируется путем протягивания маркера за-
полнения в смежные ячейки.
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Однако с помощью маркера заполнения ячейки можно заполнять значениями,
которые связаны определенной зависимостью. Чтобы это реализовать, нужно вы-
делить как минимум две ячейки. Excel вычислит разность между значениями в этих
ячейках и с применением маркера заполнения начнет формировать значения
в других ячейках, прибавляя эту разность к значению каждой предыдущей ячей-
ки (то есть значения в заполненных ячейках образуют арифметическую прогрес-
сию). Если в процессе протягивания маркера заполнения удерживать нажатой
клавишу Ctrl, то диапазон заполняется путем многократного дублирования значе-
ний выделенных ячеек.

j ПРИМЕЧАНИЕ При перетаскивании маркера заполнения вниз или вправо значения в запол-
няемых ячейках возрастают, а при перетаскивании его вверх или влево —
наоборот, уменьшаются.

Рис. 3.16. Созданный с помощью маркера заполнения ряд значений
представляет арифметическую прогрессию

Контекстное меню автозаполнения
Доступ к различным средствам автозаполнения можно получить с помощью кон-
текстного меню, которое появляется в том случае, если во время захвата маркера
заполнения нажата правая кнопка мыши. Содержимое этого меню представлено
на рис. 3.17.

Тот же результат, что и протягивание мыши при нажатой клавише Ctrl (см. выше),
дает применение команды Copy Cells (Копировать ячейки). Воспользовавшись ко-
мандой Fitl Series (Заполнить), можно получить такой же результат, как и в случае
протягивания мыши при нажатой левой кнопке. Команда Fill Formatting Only (За-
полнить форматы) производит заполнение с учетом форматов исходных ячеек,
а команда Fill Without Formatting (Заполнить значения) - наоборот, без учета тако-
вого. Команды Fill Days (Заполнить по дням), Fill Weekdays (Заполнить по рабочим
дням), Fill Months (Заполнить по месяцам) и FiLl Years (Заполнить по годам) обес-
печивают заполнение ряда названиями дней, месяцев и т. и. Например, если на-
чальное значение - дата янв-2003, то для получения ряда фев-2003, мар-2003 и т. д.



нужно выбрать команду Fill Months (Заполнить по месяцам), а для получения ряда
янв-2004, янв-2005 и т. д. — команду Fill Years (Заполнить по годам).

pipy Cells

Fl! Aeries

Fill Formattirq Only

FiU Without Formatting

у near Trend

growth Trend

Series...

Рис. 3.17. Контекстное меню автозаполнения

Команды Linear Trend (Линейное приближение) и Gtowth Trend (Экспоненциаль-
ное приближение) применяются только по отношению к числовым значениям
и задают формирование ряда путем линейной аппроксимации и экспоненциально-
го приближения соответственно. Команда Series (Прогрессия) вызывает одноимен-
ное диалоговое окно, которое будет рассмотрено ниже.

Использование команд автозаполнения
Задать автоматическое заполнение ячеек можно и с помощью меню. Для этого
следует, предварительно выделив диапазон ячеек, вызвать команду Edit t Fill >
Down (Правка > Заполнить > Вниз) или нажать комбинацию клавиш Ctrl+D, опре-
деляющую направление заполнения. В результате вызова функции автоматиче-
ского заполнения с помощью меню появляется возможность использовать ее и для
заполнения несмежных диапазонов.

(ПРИМЕЧАНИЕ В подменю Fill (Заполнить) имеются также команды Right (Вправо), Left (Вле-
во), Down (Вниз) и Up (вверх), которые обеспечивают заполнение в опреде-
ленном направлении. Для заполниния ячеек, расположенных справа от ука-
занной ячейки, можно также воспользоваться комбинацией клавиш CtrL+R.

Для того чтобы получить возможность использовать средства автозаполнения,
позволяющие формировать ряды данных, следует вызвать команду Edit > Fill >
Series (Правка > Заполнить * Прогрессия). В результате откроется диалоговое ок-
но Series (Прогрессия), показанное на рис. 3.18.
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Рис. 3.18. Диалоговое окно Series

В области Series in (Расположение) указанного окна местонахождение заполняе-
мых ячеек можно задать с помощью переключателей Rows (по строкам) и Columns
(по столбцам). Переключатели области Туре (Тип) определяют тип заполнения.
По умолчанию в ней активизирован переключатель Linear (арифметическая). Вы
можете также задать геометрическую прогрессию, воспользовавшись переключа-
телем Growth (геометрическая), и последовательность дат, активизировав пере-
ключатель Date (Дата). При выборе переключателя AutoFill (автозаполнение) за-
полнение выполняется таким же образом, как при использовании маркера.

В поле Stop value (Предельное значение) диалогового окна Series (Прогрессия) вво-
дится число, задающее предельное значение ряда. Заполнение ячеек в выделен-
ном диапазоне осуществляется либо до заполнения всего диапазона, либо до дос-
тижения элементом ряда предельного значения. В последнем случае несколько
ячеек выделенного диапазона остаются пустыми.

По умолчанию поле Step value (Шаг) содержит значение 1. Однако если при вы-
боре арифметической прогрессии вторая ячейка выделенного диапазона также
содержит некоторое значение, то в качестве шага прогрессии будет использована
разность между значениями этих двух ячеек. Когда установлен флажок Trend
(Автоматическое определение шага), поле Step value (Шаг) недоступно, посколь-
ку программа автоматически вычисляет значение шага на основе введенных ра-
нее данных. Те данные, на основе которых определяется тренд, должны образо-
вывать ряд (упорядоченную последовательность).

При установке переключателя Linear (арифметическая) и флажка Trend (Автома-
тическое определение шага) начальные значения аппроксимируются прямой ли-
нией (метод наименьших квадратов) и формируемая последовательность соот-
ветствует значениям, которые возвращает функция TREND () (ТЕНДЕНЦИЯ()).

Если вместе с флажком Trend (Автоматическое определение шага) установлен пе-
реключатель Growth (геометрическая), то начальные значения аппроксимируются
степенным полиномом и полученный ряд соответствует значениям, которые воз-
вращает функция GROWTHQ (POCTQ).
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Создание ряда данных
1. Введите в первую ячейку диапазона, где необходимо создать ряд дан-

ных, значение (число или дату), с которого должен начинаться этот ряд.
2. После этого выделите данный диапазон ячеек.

3. Откройте диалоговое окно Series (Прогрессия), вызвав команду Edit >
Fill > Series (Правка > Заполнить > Прогрессия).

4. Установите тип и параметры прогрессии.

5. Щелкните на кнопке ОК.

Самостоятельная работа

1. В таблице, представляющей собой перечень, с помощью маркера автозаполне-
ния занесите данные в столбец, который содержит порядковые номера пози-
ций перечня.

2, Потренируйтесь в использовании диалогового окна Series (Прогрессия). Вы-
бирая различные параметры, создайте с его помощью несколько последова-
тельностей.

Управление рабочими листами

Со структурой рабочей книги вы ознакомились в уроке 1. Напомним, что книга
состоит из рабочих листов, в которых создаются необходимые таблицы. Вы мо-
жете выполнять с рабочими листами операции удаления, переименования, копи-
рования и перемещения, компонуя таким образом содержимое рабочей книги по
своему усмотрению.

Выделение группы рабочих листов
При вводе данных, которые должны быть представлены сразу на нескольких лис-
тах рабочей книги, удобно использовать такой прием, как выделение группы ра-
бочих листов. Если у вас появилась необходимость создать рабочую книгу с не-
сколькими рабочими листами и на каждом из них должна присутствовать одна
и та же информация (название фирмы, ее реквизиты, адрес и т. п.), то нет смысла
вводить эти данные на каждый лист в отдельности. Вы можете установить режим
группового выделения и ввести данные только один раз. Однако по завершении
ввода общих данных не забудьте отменить группировку листов. В противном слу-
чае все записи, которые были введены в один лист, окажутся в других листах группы,
и не исключено, что произойдет потеря имеющейся на этих листах информации.

I ПРИМЕЧАНИЕ Признаком выделения группы листов является присутствие надписи [Group]
([Группа]) в заголовке книги или окна Excel.
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Для того чтобы отменить группировку листов, щелкните правой кнопкой мыши
на любом ярлычке рабочего листа группы и в открывшемся контекстном меню
(рис. 3.19) выберите команду Ungroup Sheets (Разгруппировать листы) или щелк-
ните на ярлычке любого невыделенного листа.

Ungroup Sheets

Insert.,,

Qslete

Rename

Иоуеогсору..,

Select All Sheets

Tab Color,,.
"

View Code

Рис. 3.19. Контекстное меню ярлычка рабочего листа

Группировка и отмена группировки рабочих листов

1. Выделите рабочий лист посредством щелчка на его ярлычке.

2. Чтобы выделить несколько рабочих листов, щелкая на их ярлычках,
удерживайте нажатой клавишу Ctrl

3. Для выделения всех листов рабочей книги щелкните правой кнопкой
мыши на ярлычке любого рабочего листа и в открывшемся контекст-
ном меню выберите пункт Select All Sheets (Выделить все листы).

4. Для отмены группировки рабочих листов щелкните правой кнопкой
мыши на ярлычке любого выделенного листа и в открывшемся контек-
стном меню выберите команду Ungroup Sheets (Разгруппировать листы).

Вставка и удаление рабочего листа
Чтобы вставить лист в рабочую книгу, необходимо щелчком правой кнопки мыши
открыть контекстное меню ярлычка, выбрать команду Insert (Добавить) и, когда
появится диалоговое окно Insert (Вставка), указать тип листа или шаблона (рис.
3.20). В результате выполнения этих действий новый лист будет вставлен в книгу,
перед активным листом.

На вкладке General (Общие) диалогового окна Insert (Вставка) располагаются об-
щие шаблоны, а на вкладке Spreadsheet Solutions (Решения) — специализирован-
ные, с помощью которых вы можете получить лист для создания балансового от-
чета или, скажем, оформления счета-фактуры.

Если вам необходимо вставить обычный рабочий лист, выберите команду Insert >
Worksheet (Вставка > Лист), и он появится перед текущим.
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Рис. 3.20. Диалоговое окно Insert

СОВЕТ Для того чтобы новый рабочий лист располагался в перечне листов послед-
ним, переместите его в нужную позицию. Как это делается, рассказано ниже-

При необходимости удалить один или несколько выделенных листов восполь-
зуйтесь командой Edit > Delete Sheet (Правка > Удалить лист) или щелкните на яр-
лычке любого из выделенных листов правой кнопкой мыши и в открывшемся
контекстном меню выберите команду Delete (Удалить).

В случае удаления рабочего листа, содержащего данные, открывается диалоговое
окно, в котором следует подтвердить решение о выполнении этого действия.
Здесь пользователю предоставляется последняя возможность отменить опера-
цию удаления.

Перемещение и копирование листа

Операции копирования и перемещения рабочих листов можно выполнять как
внутри одной рабочей книги, так и в нескольких различных книгах. Если возник-
нет необходимость переместить или скопировать лист, то это можно сделать с по-
мощью команды Move or Copy (Переместить/скопировать лист), после вызова ко-
торой открывается одноименное диалоговое окно (рис. 3.21).
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Move or Copy

Рис. 3.21. Диалоговое окно Move or Copy

В списке То book (в книгу) этого окна укажите, в какую из открытых на данный
момент книг надо переместить или скопировать лист. В поле Before sheet (Перед
листом) необходимо указать имя листа, перед которым будет вставлен активный
лист. Чтобы поместить лист в конец книги, выберите пункт (move to end) (пере-
местить в конец). При активизации флажка Create a copy (Создавать копию) ак-
тивный лист копируется. Скопированный рабочий лист будет иметь то же имя,
что и исходный рабочий лист, но с собственным номером, который указывается
в скобках после имени.

Для перемещения рабочего листа в пределах рабочей книги достаточно перета-
щить на новое место его ярлычок. Во время перемещения листа над ярлычками по-
является указатель позиции вставки. Для копирования рабочего листа в пределах
рабочей книги достаточно при перетаскивании удерживать нажатой клавишу Ctrl

Копирование и перемещение рабочих листов
1. Для перемещения рабочего листа в пределах рабочей книги перетащи-

те его ярлычок в новое место (помеченное маленьким треугольником).
Удерживая нажатой клавишу Ctrl, можно скопировать рабочий лист
методом перетаскивания.

2. Для перемещения или копирования рабочего листа в другую рабочую
книгу выделите этот лист и вызовите команду Edit > Move or Copy Sheet
(Правка > Переместить/скопировать лист). В списке То book (В книгу)
выберите имя рабочей книги, в которую следует поместить новый лист,
а в списке Before sheet (Перед листом) укажите позицию вставки. Если
необходимо выполнить копирование листа, установите флажок Create
а сору (Создавать копию). Щелкните на кнопке ОК.
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Переименование листа
Переименовать лист можно несколькими способами: выполнив команду Format >
Sheet > Rename (Формат > Лист > Переименовать), выбрав в контекстном меню яр-
лычка (см, рис. 3.19) команду Rename (Переименовать) или дважды щелкнув на
ярлычке. В результате выполнения любого из перечисленных действий имя лис-
та в ярлычке будет представлено инверсно, и вы сможете набрать с клавиатуры
новое имя. Завершите его ввод нажатием клавиши Enter.

Самостоятельная работа
1. Создайте новую книгу и удалите из нее второй и третий листы.

2. Переименуйте первый лист книги, присвоив ему имя «Итоги».

3. Создайте две копии листа «Итоги».

4. Выделите их в группу и введите на первом листе шапку таблицы.

5. Разгруппируйте листы и посмотрите, какие данные они теперь содержат,

Подведение итогов
В этом уроке мы научились;

0 перемещаться по рабочему листу;

0 выделять ячейки и диапазоны ячеек;

0 выделять несмежные области;

0 выделять строки и столбцы;

0 выделять ячейки по заданным критериям;

0 редактировать содержимое ячеек;

0 перемещать и копировать ячейки;

0 транспонировать таблицу;

0 вставлять и удалять ячейки;

0 применять средства автозаполнения;

0 выделять группы рабочих листов;

0 вставлять и удалять рабочие листы;

0 перемещать и копировать листы.



УРОК Оформление таблицы

П Присвоение и создание форматов

О Выравнивание содержимого ячеек

П Использование границ

П Цветовое оформление

G Форматирование столбцов и строк

П Использование стилей

П Создание структуры таблицы

П Защита ячеек и листов
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Excel предоставляет в распоряжение пользователей множество разнообразных
средств, которые позволяют создавать профессионально оформленные и нагляд-
ные таблицы. Условно их можно разделить на две категории: средства формати-
рования данных ячеек и средства, влияющие на внешний вид таблицы в целом.

Присвоение и создание форматов ячеек

Информация, введенная в ячейку таблицы, может быть представлена различным
образом. Для выбора формата данных ячейки используется диалоговое окно
Format Cells (Формат ячеек), которое вызывается с помощью команды Format»
Cells (Формат > Ячейки), команды Format Cells (Формат ячеек) контекстного меню
или комбинации клавиш CtrL+1.

[ПРИМЕЧАНИЕ Прежде чем выполнять в Excel команду, необходимо выделитьячейку или об-
ласть ячеек, на которую должно распространяться действие этой команды.
Сказанное справедливо и в отношении команд форматирования. Если диапа-
зон ячеек не выделен, параметры форматирования присваиваются активной
ячейке.

Если окно Format Cells (Формат ячеек) вызывается в первый раз, то открывается
его вкладка Number (Число), в левой части которой находится список используе-
мых в приложении форматов (рис, 4.1). Здесь представлены форматы следующих
категорий: General (Общий), Number (Числовой), Currency (Денежный), Accounting
(Финансовый), Date (Дата), Time (Бремя), Percentage (Процентный), Fraction (Дроб-
ный), Scientific (Экспоненциальный), Text (Текстовый), Special (Дополнительный),
Custom (Все форматы).

Олтепсу
Accounting
Date
Time
Percentage
Fraction
Scientific
Teit
Ереси
Custom

Рис. 4.1. Вкладка Number диалогового окна Format Cells
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После выбора некоторых категорий в правой части окна появляются дополни-
тельные списки, флажки и поля, призванные облегчить процесс установки тре-
буемого формата. Указав нужный формат, нажмите кнопку О К, и выделенная
ячейка будет отформатирована с его применением.

Форматирование числовых и текстовых данных
По умолчанию Excel присваивает данным, которые содержатся в ячейке, формат
General (Общий). Значения в этом формате отображаются в том виде, в каком они
вводятся с клавиатуры. Однако для чисел больше 1020 и меньше 10~19, а также для
чисел, которые не помещаются в ячейку, программа выберет экспоненциальный
формат.

Если вам нужно задать для числового значения количество отображаемых деся-
тичных знаков, разделитель групп разрядов и способ представления отрицатель-
ных чисел, воспользуйтесь форматом Number (Числовой).

Для представления денежных единиц применяются форматы Currency (Денежный)
и Accounting (Финансовый). Их выбор позволит вам задать вид валюты и число
десятичных знаков. Финансовый формат позволяет выровнять числа в столбце
по разделителю целой и дробной частей. На рис. 4.2 представлена таблица «Ре-
зультаты аукционов», столбец Сумма которой оформлен с применением формата
Currency (Денежный).

Книга 2003 -Результаты аукционов

С.-Петербург
Харьков
С.-Петербург

Рис. 4.2. Данные столбца Сумма представлены в формате Currency
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Если в ячейках таблицы хранятся данные, которые необходимо представить в виде
процентов, то формат Percentage (Процентный) для этих ячеек можно назначить
как до, так и после ввода данных. В первом случае значения потребуется вводить
в виде десятичных чисел (например, 0,2), а во втором — сразу в процентах (20).

Чтобы наглядно представить в таблице очень большие или очень маленькие чис-
ла, для них следует выбрать формат Scientific (Экспоненциальный). В этом фор-
мате число записывается в виде двух компонентов: мантиссы (число, находящее-
ся в диапазоне от 1 до 10) и порядка (определяет степень числа 10). Например,
число 15 000 000 записывается так: 1.5Е7.

Для представления чисел в виде обыкновенных дробей выберите формат Fraction
(Дробный) и тип дроби (например, 21/25, 4/8). Результаты применения различ-
ных форматов продемонстрированы на рис. 4.3.

Genera ! 1 200000,1;

jCurrency' ] 1.200 000,10р.
[Accounting; .J..20p,000,10p.j
Date 26ИЮН

..{fraction I 12000001/9:
„[Scientific ; ..1,?pE+p6|
5ехР 1200000,1 '
[special ..1.20:0000

Рис. 4.З. Представление данных в различных форматах

В Excel предусмотрены форматы и для представления почтовых индексов, а так-
же телефонных номеров. Эти форматы относятся к категории Special (Дополни-
тельный).

(ПРИМЕЧАНИЕ Числовым значениям при вводе, как правило, присваивается один из под-
держиваемых Excel форматов. Если формат программе «не знаком», значе-
ние интерпретируется программой как текст.

Если вы точно знаете, что в ячейке находятся текстовые данные, назначьте для
нее формат Text (Текстовый). Однако учтите, что после этого содержимое ячейки,
даже если оно представляет собой формулу, воспринимается программой как
текст, и вычисления в ячейке не производятся. Чтобы исправить ситуацию, фор-
мулу придется ввести еще раз.

СОВЕТ Используйте текстовый формат, если вам нужно, чтобы текстовая надпись на-
чиналась со знака «+»,«-» или «=».

Использование панели инструментов форматирования
В Excel существует более удобный способ форматирования ячеек — посредством
кнопок панели инструментов форматирования.
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Ш1 Кнопка Currency Style (Денежный формат) этой панели служит для присвое-
^ ния ячейкам денежного стиля. Используемый символ валюты зависит от

того, какая страна указана в диалоговом окне Regional and Language Options (Язык
и региональные стандарты) (это окно открывается в результате щелчка мышью
на значке с таким же названием в окне Control Panel (Панель управления).

е* Кнопка Percent Style (Процентный формат) предназначена для присвоения
И ячейкам процентного стиля.

* Кнопка Comma Style (Формат с разделителями) позволяет разделять разряды
^ чисел при помощи запятой.

4|вь ;Щ Кнопки Increase Decimal (Увеличить разрядность) и Decrease Decimal (Умень-
% шить разрядность) предназначены для увеличения и уменьшения коли-

чества цифр, отображаемых после десятичной запятой.

Форматирование или округление
Не следует путать понятия «форматированное значение» и «округленное значе-
нием. Когда число отформатировано, то оно только кажется округленным. Если
вы создаете ссылку на ячейку с отформатированным числом, оно будет приме-
няться в вычислениях в исходном виде, то есть со всеми знаками после запятой.
Поэтому, если в две отдельные ячейки занести число 2,3. а затем выполнить сло-
жение этих чисел в третьей ячейке, то она будет содержать значение 4,6. Однако,
применив ко всем трем ячейкам форматирование с уменьшением разрядности, на
экране в первых двух ячейках вы увидите значения 2, а результат сложения ока-
жется равным 5.

Эту особенность обязательно нужно учитывать при выполнении вычислений. На-
пример, при работе с денежными единицами достаточно указать два десятичных
разряда. Чтобы избежать описанной выше ошибки, при проведении некоторых
операций по определению как промежуточных, так и итоговых значений необхо-
димо производить не форматирование, а округление результатов. Это может быть
округление как до второго десятичного знака (скажем, до копеек, центов и т. д.),
так и до целых значений. В подобных ситуациях используется функция округле-
ния, которая описывается в уроке 5.

Представление даты и времени
В Excel отсчет дат ведется в днях, начиная с 1900 года. Таким образом, в ячейке
с датой фактически хранится число дней, прошедших с 1 января 1900 года до ука-
занной даты. Время рассчитывается аналогичным образом и записывается в виде
дробной части числа. Этот метод хранения обеспечивает возможность произво-
дить со значениями даты и времени различные вычисления. Чтобы увидеть зна-
чение даты в числовом формате, выберите для ячейки формат General (Общий).

• .1 I }О6щий
^Формат даты 05 07.2003 !_ 37807,00!
\Формат времени 10;55| 0,45|
Формат даты и времени 05.07.2003 10:55! 37807,45!
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Как вы знаете из урока 3, Excel автоматически распознает значения даты и време-
ни при их вводе, если они оформлены надлежащим образом. Тем самым пользо-
ватель избавляется от необходимости задавать значения данного типа в том виде,
в каком они хранятся в программе.

Чтобы у вас не возникло проблем при вводе дат и времени, всегда старайтесь ис-
пользовать один из типов форматова Date (Дата) и Time (Бремя), которые указа-
ны в списке Туре (Тип) вкладки Number (Число) диалогового окна Format Cells
(Формат ячеек).

Format Oils

тей

14 мгртэ 2001 г
14.3
14.3.01
14.03.01
14 пар
14 мар 01

" Г»!

Рис. 4.4. Форматы, которые рекомендуется использовать при вводе дат

Создание пользовательских форматов
Для того чтобы получить полный перечень форматов, предоставляемых програм-
мой Excel, выберите на вкладке Number (Число) диалогового окна Format Cells (Фор-
мат ячеек) категорию Custom (все форматы). Вы увидите, что в правой части
вкладки форматы представлены не так, как ранее, при выборе других категорий.
Спецификация формата задается в виде строки, которая содержит символы под-
становки и другие специальные символы (рис. 4.5).

В общем случае спецификация формата состоит из четырех частей, которые отде-
лены друг от друга символами точки с запятой (;). В этих частях определяются
форматы для представления положительных и отрицательных чисел, нулевых
значений и текста. Если спецификация состоит из одной части, то соответствую-
щий ей формат применяется ко всем числам. Когда определены только две части,
первая используется для форматирования положительных чисел и нулевых зна-
чений, а вторая — для представления отрицательных чисел. В случае пропуска
одной из частей вместо нее указывается символ точки с запятой.
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ttta.co
* t*Q_p_.;-S **0_р_.
* **0_p_.;[Red]-* »fO_p_.
* **0,00_p_.;-

I

,OQ_

Ш <- Ц ••:!•.', ,

Рис. 4.5. Представление форматов при выборе категории Custom

Аналогичная спецификация применяется при создании пользовательских фор-
матов в тех случаях, когда среди форматов, предлагаемых Excel, нужного вам ва-
рианта нет. Такая необходимость может возникнуть, в частности, при оформле-
нии текстовых строк вида 60 к м / ч , 25 руб. за к в . м или 6,20 руб. за десяток.

Пользовательские форматы создаются в поле Туре (Тип) категории Custom (все
форматы) с использованием кодов форматов, наиболее часто употребляемые из
которых перечислены в табл. 4.1.

Таблица 4.1. Коды, используемые при создании форматов

Код Что определяет и с какой целью применяется

# Значащие цифры

О Все цифры; вместо символов подстановки справа от десятичного разделителя
в случае необходимости указываются нули

Значащие цифры; выравнивает десятичные разделители или символы косой
черты (/)

Разделитель тысяч; также используется для отображения чисел в таком виде,
как будто число было разделено на тысячу или миллион

() Для форматирования отрицательных чисел

Разделяет числа символом дефиса

Для выделения текстовой строки

„ (символ Выравнивает содержимое ячейки, вместо него вставляется пробел, по ширине
подчеркивания) равный следующему символу

Пробел Служит для представления на экране разделителей тысяч

, Задает количество знаков до и после десятичной запятой



Присвоение и создание форматов ячеек 95

Код Что определяет и с какой целью применяется

М Месяц как ##

ММ Месяц как 00

МММ Месяц как трехбуквенная аббревиатура

ММММ Полное название месяца

МММММ Первая буква названия месяца

Д День как ##

ДД День как 00

ДДД День как аббревиатура

ДДДД Полное название дня недели

ГГ Год как 00

ГГГГ Год как 0000

Для выделения числовых значений можно использовать цвет. Некоторые денеж-
ные форматы предписывают выделять отрицательные значения красным цветом
и заключать в скобки. По умолчанию для отображения чисел используется чер-
ный цвет. Чтобы изменить цвет шрифта чисел, необходимо перед соответствую-
щим форматом указать название желаемого цвета в квадратных скобках: [Black]
([Черный]); [Blue] ([Синий]); [Red] ([Красный]); [White] ([Белый]); [Yellow] ([Жел-
тый]); [Green] ([Зеленый]). В частности, если задан формат [Blue]0,OQ;[Red]-0,00,
то положительные значения будут выделены синим цветом, а отрицательные -
красным.

Ниже приводится несколько примеров форматов и их краткое описание.

О Отбрасывается дробная часть числа, то есть выполняется округление
до целого значения

0,00 Отображается число с фиксированным количеством знаков после
запятой (остальные знаки дробной части отбрасываются); если число
не содержит дробной части, то после запятой добавляются нули

# ##0 Отбрасывается дробная часть числа; числа больше тысячи
отображаются с разделителем тысяч

# ##0,00;[Red]-# #0,00 Число отображается с разделителем тысяч и двумя знаками после
запятой; отрицательные числа выделяются красным цветом

Варьируя описанные форматы, значения можно отображать по-разному. Напри-
мер, при использовании формата 0,00 число 9,123 отображается как 9Д2, а в слу-
чае выбора формата # #00 - как 9. Пример, в котором одному значению присвое-
ны разные форматы, показан на рис. 4.6.

)ПРИМЕЧАНИЕ Как уже упоминалось, знак подчеркивания применяется с целью выравнива-
ния содержимого ячеек. Этот код используется при оформлении таблиц, ко-
торые содержат значения с разным количеством знаков (например, числа
с символами валюты и без таковых).
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Вид I Формат

........
2 о , о р

I

Рис. 4.6. Значению присвоены разные форматы

Создание собственного формата
1. Откройте диалоговое окно Format Cells (Формат ячеек) и перейдите на

вкладку Number (Число).
2. Выберите в поле Category (Числовые форматы) категорию Custom (все

форматы) и удалите содержимое поля Туре (Тип).
3. Введите новую спецификацию или измените существующую. Новый

формат будет автоматически включен в категорию Custom (все форма-
ты), а исходный останется доступным для использования.

4. Нажмите кнопку ОК.

Проиллюстрируем сказанное на примере. Предположим, вам нужно создать фор-
мат для представления значений температуры в градусах Цельсия. Делается это
следующим образом. Выберите категорию Custom (все форматы) и установите
курсор ввода в поле Туре (Тип), где находится код выделенного формата. Удалите
этот код и введите с клавиатуры такую последовательность символов:

#.«" С"

После нажатия кнопки ОК созданный формат будет присвоен выделенным ячей-
кам. При следующем открытии вкладки Number (Число) диалогового окна Format
Cells (Формат ячеек) он уже будет включен в список Custom (все форматы).

Условное форматирование
Excel позволяет производить форматирование ячейки с учетом хранящихся в ней
данных. Такое форматирование называется условным, потому что выполняется
оно на основании результатов проверки определенных условий (например, если
значение в ячейке больше или меньше определенного числа). В условии могут
проверяться и текстовые данные (например, соответствует ли содержимое ячей-
ки слову «Россия»), Применяя условное форматирование, можно влиять на атри-
буты шрифта и границ, а также на заливку ячеек.

Рассмотрим таблицу, содержащую прайс, в котором представлена информация
о предлагаемых моделях 17-дюймовых мониторов. Предположим, нас интересу-
ют модели, цена которых не превышает $150. Выполнив условное форматирова-
ние, мы можем выделить ячейки, соответствующие этому условию, определен-
ным цветом (рис. 4.7).

Чтобы применить условное форматирование к выделенным ячейкам, выберите ко-
манду Format > Conditional Formatting (Формат > Условное форматирование).
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Мониторы
Модель

17" Harisol 730E
H117" Hansel 730E

17" LG Ktatron 774FT
; '

117
LG Flatron 774-FT
LG Flatron F700B

,'" Samsung SyncMaster 753DFX
M|17"LG Studiovrorks_773E.

[17" LG Flatron T710PHEZ

Цена

$174.00
$163.00
$159,00

$151,00

Рис. 4.7. Результаты применения условного форматирования

Когда откроется диалоговое окно Conditional Formatting (Условное форматирова-
ние), показанное на рис. 4.8, в первом его списке выберите способ условного фор-
матирования - Cell Value Is (Значение) или Formula Is (Формула).

Conditional Formatting

l*| И} between

No Format Set

Рис. 4.8. Диалоговое окно Conditional Formatting

Условное форматирование по значению
Если вы хотите, чтобы при форматировании учитывалось значение ячейки (чис-
ло, текст или дата), выберите в первом списке пункт Cell Value Is (Значение).

Во втором раскрывающемся списке можно выбрать один из условных операто-
ров: between (между), not between (вне), equal to (равно), not equal to (не равно),
greater than (больше), less than (меньше), greater than or equal to (больше или рав-
но), less than or equal to (меньше или равно). В оставшихся текстовых полях вво-
дятся константы или формулы.
Щелкните на кнопке Format (Формат), и на экране появится вариант диалогового
окна Format Cells (Формат ячеек), в котором вместо шести вкладок будут присут-
ствовать только три, а именно Font (Шрифт), Border (Граница) и Patterns (Вид).
На этих вкладках вы сможете задать шрифт, границы, параметры затенения и цве-
тового оформления.

Выберите параметры форматирования, которые должны быть применены, в слу-
чае, если условие будет выполнено, а затем щелкните на кнопке ОК, чтобы вернуть-
ся в диалоговое окно Conditional Formatting (Условное форматирование). Щелкни-
те на кнопке ОК, и диалоговое окно закроется, а подходящие ячейки будут отфор-
матированы.

А как быть, если возникает необходимость в использовании дополнительного
форматирования? Например, если рост котировок нужно показать зеленым цве-
том, а падение — красным? Сформируйте в диалоговом окне Conditional Formatting

4 Зак. 345
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(Условное форматирование) первое условие, а после этого щелкните на кнопке
Add (А также) и введите еще одно (рис. 4.9).

No Format Set

Рис. 4.9. В окне Conditional Formatting задано сложное условие

Использование условия в качестве формулы
Предположим, что данные о продажах товаров за каждый месяц размещаются
в смежных столбцах. Как выделить в столбце В ячейки, где содержатся значения,
которые не менее чем на на 15 % больше значений из столбца А? Это помогло бы
нам выяснить, в какие месяцы наблюдался рост продаж данного товара.

Условное форматирование позволяет решить задачу очень быстро. Для этого дос-
таточно во втором поле окна Conditional Formatting (Условное форматирование)
выбрать условный оператор greater than or equal to (больше или равно), а затем в
третьем поле ввести формулу - А1*1,15.

Условное форматирование по формуле
В том случае, если для формирования условия в окне Conditional Formatting (Ус-
ловное форматирование) нужно использовать формулу, возвращающую значе-
ние True (Истина) или False (Ложь), в первом слева списке окна требуется вы-
брать элемент Formula Is (Формула). После этого во втором списке можно будет
задать условие. Например, для того чтобы ячейка Е8 выделялась цветом, если со-
держащееся в ней значение принадлежит диапазону (124;160), необходимо вве-
сти такое условие: =AND{E8>124; E8<160) (рис. 4.10).

Рис. 4.10. В окне Conditional Formatting задано условие форматирования по формуле
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Расширение диапазона условного форматирования

Условное форматирование не обязательно применять сразу ко всем ячейкам вы-
бранного диапазона. Сначала можно создать и настроить условный формат для
одной ячейки, а затем выделить нужный диапазон, в который будет входить уже
отформатированная ячейка. Выберите команду Format > Conditional Formatting (Фор-
мат > Условное форматирование), с тем чтобы открыть диалоговое окно, в кото-
ром будет представлена информация о созданном формате. Щелкните на кнопке
ОК, и форматирование будет распространено на остальные ячейки диапазона.

Условное форматирование ячеек
1. Выделите ячейки, которые необходимо отформатировать.

2. Выберите команду Format > Conditional Formatting (Формат > Условное
форматирование), и на экране появится диалоговое окно Conditional For-
matting (Условное форматирование).

3. Выберите пункт Cell Value Is (Значение) или Formula Is (Формула).
4. Выберите условный оператор.

5. В поле условия введите требуемое значение, а также ссылку на ячейку
или формулу.

6. Щелкните на кнопке Format (Формат), задайте необходимый формат
и щелкните на кнопке ОК.

7. Если нужно задать дополнительные условия или форматы, щелкните
на кнопке Add (А также) и повторите описанные в пунктах 3-6 опера-
ции, нужное количество раз.

8. Щелкните на кнопке О К, и диалоговое окно будет закрыто, а условное
форматирование будет применено к указанным ячейкам.

Самостоятельная работа
1. Для ячеек столбца Дата (см. рис. 4.2) задайте другой формат.

2. Создайте свой формат, например такой, чтобы в столбце Покупатели данные
имели вид ## чел.

3. Используя функцию условного форматирования, найдите города, в которых
было продано более 100 книг.

Выравнивание содержимого ячеек
Из урока 3 вы знаете, что в Excel вводимые данные выравниваются автоматиче-
ски: текст — по левому краю, а числа — по правому. Однако происходит это толь-
ко в том случае, если для заполняемых ячеек предварительно не были заданы
другие типы выравнивания. Способ выравнивания данных в ячейках определяет-
ся на вкладке Alignment (Выравнивание) диалогового окна Format Cells (Формат
ячеек), представленного на рис. 4.11. Открыть это окно позволяет команда Format >
Cells (Формат > Ячейки) или комбинация клавиш Ctrl+1.
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Рис. 4.11. Вкладка Alignment диалогового окна Format Cells
л

Выравнивание производится как по горизонтали, так и по вертикали. По умолча-
нию в поле Horisontal (по горизонтали) установлено значение General (по значе-
нию), а в поле Vertical (по вертикали) — значение Bottom (по нижнему краю). При
выравнивании по вертикали данные выравниваются по высоте ячейки, а при вы-
равнивании по горизонтали - по ширине. Различные способы выравнивания тек-
ста показаны на рис. 4.12.
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Рис. 4.12. Возможные способы выравнивания данных в ячейке

'ПРИМЕЧАНИЕ На вкладке Alignment (Выравнивание) диалогового окна Format Cells (Фор-
матячеек) также задается направление ввода текста. Для этой цели предна-
значено поле Text direction (направление текста), расположенное в области
Right-to-left (Направление текста).
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Выравнивание по горизонтали
Чтобы выровнять содержащиеся в ячейке данные по горизонтали, в поле Hori-
sontal (по горизонтали) необходимо выбрать один из следующих параметров.

О General (по значению) — текст выравнивается по левому краю, а числа по пра-
вому (выравнивание по умолчанию).

О Left (Indent) (по левому краю (отступ)) — содержимое ячейки выравнивается
по левому краю. В поле Indent (отступ) задается величина отступа. Выровнять
текст по левому краю можно также, нажав кнопку Align Left (по левому краю)
на панели форматирования.

О Center (по центру) — данные в ячейке выравниваются по центру.

' О Right (Indent) (по правому краю (отступ)) — данные в ячейке выравниваются
по ее правому краю.

О Fill (с заполнением) — ячейка заполняется копиями ее же содержимого, но ее
фактическое содержимое не меняется.

О Justify (по ширине) - разбивает содержимое ячейки на несколько строк и ус-
танавливает между словами такие промежутки, при которых ширина строк
равна ширине ячейки.

О Center Across Selection (по центру выделения) — выравнивает содержимое са-
мой левой ячейки по центру диапазона. Этим способом удобно создавать заго-
ловки таблиц. Однако результат будет успешным лишь в том случае, если
в других ячейках выделенного диапазона нет данных.

Выравнивание по вертикали
Выравнивание этого типа задается посредством выбора одного из параметров
в поле Vertical (по вертикали).

О Тор (по верхнему краю) — выравнивание по верхнему краю ячейки.

О Center (по центру) — выравнивание по центру ячейки.

О Bottom (по нижнему краю) — выравнивание по нижнему краю ячейки.

О Justify (по высоте) — выравнивание по верхнему и нижнему краям ячейки.

О Distributed (распределенный) — равномерное распределение текста по высоте
ячейки.

Ориентация текста
По умолчанию текст в ячейках располагается по горизонтали (об этом свидетель-
ствуют значение 0 в поле Degrees (градусов) области Orientation (Ориентация)
и позиция стрелки на шкале). Воспользовавшись вкладкой Alignment (Выравни-
вание) окна Format Cells (Формат ячеек), содержимое ячейки можно разместить
под определенным углом. Угол поворота устанавливается путем ввода значения
в поле Degrees (градусов) или вращения стрелки. В любом случае это значение на-
ходится в диапазоне от -90" до +90°.
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Объединение ячеек, автоподбор ширины и перенос текста
Еще одна интересная возможность Excel — выравнивание текста с объединением
ячеек. Если в доле Text control (Отображение) установлен флажок Merge cells (объе-
динение ячеек), то ячейки выделенного диапазона объединяются в одну ячейку,
а данные выравниваются относительно границ новой ячейки. Адресом образо-
ванной ячейки становится адрес ячейки, которая находилась в левом верхнем
углу диапазона. На рис. 4.12 показан результат объединения ячеек СЗ:ЕЗ.

Установка флажка Wrap text (переносить по словам) означает, что символы, кото-
рые не помещаются в строку ячейки, переносятся в следующую ее строку. После
установки флажка Shrink to fit (автоподбор ширины) размер шрифта автоматиче-
ски уменьшается, если ширины колонки недостаточно для корректного представ-
ления данных.

СОВЕТ Чтобы другим пользователям, работающим с вашей электронной таблицей,
было удобнее в ней ориентироваться, выравнивайте данные разных типов
по-разному, используя для этой цели кнопки панели инструментов Format-
ting (Форматирование).

Самостоятельная работа
1. Разместите названия городов в таблице, которая приведена на рис. 4.2, под уг-

лом 40°.

2. Выровняйте содержимое каждой ячейки таблицы по центру.

3. Объедините ячейки А1:С1.

Рекомендации по использованию шрифтов
При оформлении содержащихся в таблице данных очень важно правильно вы-
брать шрифт, что отразится на внешнем виде таблицы и сделает работу пользова-
теля более удобной. По умолчанию в приложении Excel применяется ТшеТуре-
шрифт Arial. Это шрифт без серифов (засечек). Наиболее распространенным пред-
ставителем категории шрифтов с серифами является Times New Roman.

В Excel можно использовать пропорциональные и непропорциональные шриф-
ты. В пропорциональных шрифтах, например в Arial и Times New Roman, каждо-
му символу отводится столько места, сколько действительно необходимо для его
размещения (скажем, строчная буква «и» занимает меньше места, чем прописная
«М»). В непропорциональных шрифтах, таких как Courier New, все символы име-
ют одинаковую ширину.

(ПРИМЕЧАНИЕ Установка шрифтов производится в диалоговом окне Add Fonts (Шрифты),
вызываемом из окна Control Panel (Панель управления) системы Windows XP.
Для этой цели здесь предназначена команда File > Install New Fonts (Файл >
Установить шрифт).
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Для представления данных в таблице целесообразно задавать непропорциональ-
ные шрифты — в таком случае проще подобрать ширину столбцов.

СОВЕТ Если вы хотите, чтобы по умолчанию использовался другой шрифт, вызовите
команду Tools » Options (Сервис > Параметры) и в диалоговом окне Options
(Параметры), точнее в поле Standard (Стандартный шрифт) вкладки General
(Общие), выберите другой шрифт.

В Excel можно задать шрифт как для всего рабочего листа, так и для его отдель-
ного фрагмента.

Определение шрифта для всего рабочего листа
1. Выделите весь лист.

2. Откройте список шрифтов на панели инструментов форматирования
или перейдите на вкладку Font (Шрифт) диалогового окна Format Cells
(Формат ячеек).

3. Выберите необходимый шрифт в поле Font (Шрифт) и нажмите кноп-
ку ОК.

Как будет выглядеть текст, набранный указанным шрифтом, можно увидеть в диа-
логовом окне Format Cells (Формат ячеек) в поле предварительного просмотра
вкладки Font (Шрифт), которая представлена на рис. 4.13.

Number'| AttgrWrent- j runt ;] ii4;:fr j <'.,Tl;t4'

Обычный ! • i

iKypo-B

Рис. 4.13. Вкладка Font диалогового окна Format Cells

Чтобы изменить шрифт отдельного фрагмента текста, выделите его и на панели
форматирования, в поле Font (Шрифт), укажите необходимый шрифт.
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Вы можете использовать в одной таблице шрифты различных типов, размеров
и начертаний (рис. 4.14). Размер шрифта обычно указывается в пунктах. Один
пункт соответствует 0,375 мм. По умолчанию в Excel применяется шрифт разме-
ром в 10 пунктов.

в одной ячейке - разные шрифты

Рис. 4.14. Использование различных шрифтов

iПРИМЕЧАНИЕ Допустимые размеры каждого из выбираемых шрифтов перечисляются в поле
Size (Размер). Для шрифтов TrueType можно задавать промежуточные раз-
меры (например, 11,5 пункта).

Большая часть шрифтов может иметь обычное, курсивное, полужирное и полу-
жирное курсивное начертание. Установка флажков из области Effects (Эффекты)
позволяет создавать над- и подстрочные надписи (флажки Superscript (верхний
индекс) и Subscript (нижний индекс)), а также зачеркивать фрагменты текста
(флажок Strikethrough (зачеркнутый)). Б поле списка Underline (Подчеркивание)
можно выбрать способ подчеркивания.

(ПРИМЕЧАНИЕ Excel позволяет изменить цвет символов, В частности, для текста, который
не должен выводиться на печать, можно установить белый цвет.

Границы и цветовое оформление
В Excel имеется целый арсенал средств, позволяющих улучшить визуальное вос-
приятие таблицы, Путем добавления рамок, за счет использования различных
цветов и теней можно заметно повысить наглядность таблицы, облегчить работу
с содержащимися в ней данными.

Границы

Используя различные типы линий при создании границ (рис. 4.15) и изменяя
ширину столбцов и высоту строк, пользователь может создать какой угодно бланк
(формуляр).

Рис. 4.15. Образцы границ
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СОВЕТ В одной электронной таблице не рекомендуется сочетать границы и сетку,
Уберите с экрана сетку посредством флажка GridLines (сетка), расположен-
ного на вкладке View (Вид) диалогового окна Options (Параметры), и грани-
цы будут лучше видны на экране.

Создание границ
1. Выделите ячейку или диапазон ячеек и откройте вкладку Border (Гра-

ница) диалогового окна Format Cells (Формат ячеек), представленного
на рис. 4.16.

2. Выберите тип линии и определите местоположение границ. Границы
выбираются посредством нажатия кнопок, на которых они изображены.

3. После щелчка на кнопке ОК граница (или ее фрагмент) появится в таб-
лице (рис. 4.17).

Format Celts
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Рис. 4.16. Вкладка Border диалогового окна Format CeLLs

Ш Границы можно создавать и с помощью кнопки Borders (Границы) панели
инструментов форматирования.

В Excel имеется возможность определить границы для всех ячеек выделенного
диапазона. Для этого достаточно открыть вкладку Border (Граница) диалогового
окна Format Cells (Формат ячеек) и щелкнуть на кнопке Outline (внешние) и/или
кнопке Inside (внутренние). В результате для каждой ячейки указанного диапазо-
на будут созданы границы выбранного стиля (рис. 4.18).
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Рис. 4.17. Граница между заголовками столбцов и значениями таблицы

И Microsoft Office Ewe) 2003

Книга 2003 -Результаты аукционов

Рис. 4.18. Границы созданы для каждой ячейки диапазона
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Как будут выглядеть ячейки при задании для них различных границ, можно уви-
деть в поле предварительного просмотра вкладки Border (Граница) диалогового
окна Format Cells (Формат ячеек), показанной на рис. 4.19.
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Рис. 4.19. Для ячеек выделенного диапазона заданы разные границы

В Excel можно создавать копии границ. Во-первых, граница копируется вместе
с содержимым при копировании ячейки. Во-вторых, копии границ образуются
при автозаполнении. Второй способ является самым быстрым способом копиро-
вания границ.

Следует принять во внимание, что в результате перемещения ячеек заданные для
них границы также перемещаются в новую позицию. При этом в исходной пози-
ции параметры форматирования удаляются. Перемещение ячеек из отформати-
рованного диапазона может привести к появлению в таблице так называемых
дыр (рис. 4.20).

Для перемещения только содержимого ячеек следует использовать команду Paste
Special (Специальная вставка) меню Edit (Правка) или контекстного меню.

Удалить границу можно двумя способами. Первый способ заключается в примене-
нии команды Edit > Clear > Formats (Правка > Очистить >• Форматы). Правда, в этом
случае удаляются и другие параметры форматирования ячейки. Если вам необхо-
димо удалить только границу, воспользуйтесь вторым способом, при котором
следует отменить параметры, установленные на вкладке Border (Граница) диало-
гового окна Format Cells (Формат ячеек).
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Книга 2003 -Результаты аукционов

Рис. 4.20. Перемещая ячейки, будьте внимательны!

Цветовое оформление
В Excel предусмотрена возможность цветового оформления отдельных ячеек и фо-
на рабочего листа. Для того чтобы задать цвет подложки (фоновый рисунок рабо-
чего листа), необходимо вызвать команду Format > Sheet > Background (Формат >
Лист > Подложка). В результате появится диалоговое окно Sheet Background (Под-
ложка), в котором следует выбрать графический файл и нажать кнопку Insert
(Вставить). Для удаления фонового рисунка необходимо вызвать команду For -
mat > Delete Background (Формат > Удалить фон).

ВНИМАНИЕ Фон подложки не печатается и не сохраняется на отдельныхлистах и элемен-
тах, сохраняемых в виде веб-страницы. Однако при публикации всей книги
как веб-страницы фон подложки сохраняется.

Начиная с предыдущей версии в Excel появилась возможность выделять ярлыч-
ки страниц книги различным цветом и таким образом маркировать однотипные
листы. Для этого нужно активизировать команду Format > Sheet > Tab Color (Фор-
мат > Лист > Цвет ярлычка) и выбрать необходимый цвет в палитре, которая бу-
дет открыта в результате выполнения команды. Если вы хотите использовать для
нескольких ярлычков один цвет, то при нажатой клавише Ctrl вначале отметьте
нужные страницы, а затем примените к ним выбранный цвет.
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Цвет и узор заполнения ячеек устанавливаются на вкладке Patterns (Вид) диало-
гового окна Format Cells (Формат ячеек), показанной на рис. 4.21.

Atyrirtwrt { ft? t ;• '

Рис. 4.21. Вкладка Patterns диалогового окна Format Cells

Цветовое оформление ячеек
1. Выделите ячейку или диапазон ячеек.

2. Откройте диалоговое окно Format Cells (Формат ячеек) и перейдите на
вкладку Patterns (Вид).

3. Выберите цвет фона в области Color (Цвет) и узор заполнения в облас-
ти Pattern (Узор).

4. Нажмите кнопку ОК.

,| Цвет шрифта, а также цвет фона ячеек можно задать с помощью кно-
^ пок панели инструментов форматирования.

ВНИМАНИЕ Если для шрифта и заливки ячейки выбрать один и тот же цвет, содержимое
ячейки сольется с фоном. Чтобы проверить, содержит ли ячейка данные, не-
обходимо активизировать ее, вследствие чего содержимое должно появить-
ся в строке формул. Этот интересный эффект можно использовать при печа-
ти таблиц, отдельные фрагменты которых необходимо скрыть.

При печати таблицы на черно-белом принтере цвета заменяются оттенками серо-
го. Поэтому в случае отсутствия цветного принтера при определении фона ячеек
рекомендуется использовать узор заполнения. Палитра Pattern (Узор) содержит
целый набор таких узоров (рис. 4.22).
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Рис. 4.22. Палитра Pattern

Как сочетаются выбранные цвет и узор, можно увидеть в поле Sample (Образец)
вкладки Pattern (Вид).

Самостоятельная работа
1. Б созданном нами ранее рабочем листе (см. рис. 4.17) отделите числовые дан-

ные от итоговых значений, применив для этого границы.

2. С помощью кнопок панели инструментов форматирования задайте цвет шриф-
та и фон ячеек.

Форматирование столбцов и строк
Наглядность таблицы во многом зависит от того, насколько удачно выбраны ши-
рина столбцов и высота строк. Excel предоставляет пользователям возможность
определить оптимальное соотношение этих параметров. Но программа не позво-
ляет изменить ширину лишь одной или нескольких ячеек столбца и высоту од-
ной или нескольких ячеек строки. Таким образом предотвращается возможность
смещения данных в другие столбцы и строки.

Изменение ширины столбца
Изменять ширину столбца более удобно с помощью мыши. Двойной щелчок мы-
шью на правой разделительной линии заголовка столбца приведет к установке
его оптимальной ширины.

)ПРИМЕЧАНИЕ С помощью мыши можно одновременно изменить ширину нескольких столб-
цов. Для этого следует выделить те из них, ширина которых должна быть оди-
наковой, и установить посредством мыши желаемую ширину для одного
столбца. Как только вы отпустите кнопку мыши, заданная ширина будет уста-
новлена для всех выделенных столбцов.
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Изменение ширины нескольких столбцов при помощи мыши
1. Выделите необходимое количество столбцов.
2. Поместите указатель мыши между заголовками последнего из выде-

ленных и следующего за ним столбцом таким образом, чтобы он при-
обрел вид двунаправленной стрелки.

3. Удерживая левую кнопку мыши нажатой, переместите край выделен-
ного столбца влево или вправо. При смещении вправо ширина столбца
увеличивается (рис. 4.23), а при смещении влево - уменьшается.

4. Отпустите кнопку мыши.
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Рис. 4.23. Таблица после изменения ширины нескольких столбцов с помощью мыши

При изменении ширины столбцов с помощью мыши обычно приходится немного
поэкспериментировать, прежде чем будет достигнут желаемый результат. Задав
команду Format t Column > AutoFit Selection (Формат > Столбец * Автоподбор шири-
ны), определение оптимальной ширины столбца (устанавливается с учетом дли-
ны содержимого ячеек) можно поручить программе. Причем для каждого столб-
ца устанавливается своя оптимальная ширина.

Единицей измерения ширины столбца является величина, равная ширине символа
стандартного шрифта листа. По умолчанию ширина столбца равна 8,11 символа.
Изменить это значение можно в диалоговом окне Column Width (Ширина столбца).
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Определение точного значения ширины столбца
1. Выделите столбец таблицы.

2. Посредством вызова команды Format > Column > Width (Формат > Стол-
бец > Ширина) откройте окно Column Width (Ширина столбца), изобра-
женное на рис. 4.24.

3. Введите новое значение ширины столбца и нажмите кнопку ОК.

Column Width

Рис. 4.24. Диалоговое окно Column Width

Изменение высоты строки

Высота строк таблицы зависит от размера используемого шрифта. Изменяется
она тем же способом, что и ширина столбца. Кроме того, высота строки изменяет-
ся при установке другого размера шрифта.

При недостаточной высоте строки содержимое ячеек (как числа, так и текст) уре-
зается (рис. 4.25). В этом случае с помощью команды Format ^ Row > AutoFit (Фор-
мат > Строка > Автоподбор высоты) можно задать автоматический подбор опти-
мальной высоты строки.
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Определение точного значения высоты строки
1. Выделите строку таблицы.

2. Активизируйте команду Format > Row > Height (Формат > Строка > Вы-
сота), вследствие чего откроется диалоговое окно Row Height (Высота
строки), представленное на рис. 4.26.

3. Введите новое значение высоты строки и нажмите кнопку ОК.

Row Height т

Cancel

Рис. 4.26. Диалоговое окно Row Height

Сокрытие столбцов и строк таблицы

В Excel существует возможность скрывать столбцы и строки таблицы. Благодаря
этой функции можно отменять отображение конфиденциальной информации,
повышать наглядность сложных таблиц, выводя на экран только самые важные
данные. Скрытые данные на печать не выводятся.

Чтобы скрыть строки или столбцы, нужно выделить их, а затем вызвать команду
Format > Row (Column) > Hide (Формат * Строка (Столбец) > Скрыть). Если нужно
запретить отображение всего листа, следует задать команду Format > Sheet > Hide
(Формат > Лист > Скрыть).

I ПРИМЕЧАНИЕ Иногда вместо функции отмены отображения столбцов и строк целесообраз-
но использовать функцию структурирования, круг возможностей которой
значительно шире.

Если вы отмените отображение строк или столбцов, то исчезнут и соответствую-
щие им заголовки. Следовательно, если после столбца В идет столбец D, нетруд-
но догадаться, что столбец С скрыт.

Чтобы восстановить отображение строки или столбца, нужно выделить две смеж-
ные ячейки соседних строк или столбцов и выбрать команду Unhide (Отобразить)
в соответствующем подменю меню Format (Формат).

Самостоятельная работа
1. Создайте новый рабочий лист и введите в любую ячейку текст, который бы

выходил за ее правую границу. Задайте оптимальную ширину ячейки, исполь-
зуя разные способы: с помощью мыши, с применением команды автоподбора
ширины, путем определения точного значения ширины столбца.

2. Скройте строку с заголовками столбцов в таблице «Результаты аукционов».
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Автоматическое форматирование
Если вам трудно отформатировать таблицу вручную, воспользуйтесь функцией
автоформатирования. В таком случае Excel автоматически создаст красивую и на-
глядную таблицу, а вы сможете уделить больше внимания ее содержимому.

Возможности автоформатирования
Excel предоставляет в распоряжение пользователей большое количество готовых
форматов, включающих такие параметры: Number (формат чисел), Font (шрифт),
Alignment (выравнивание), Border (рамки), Patterns (узоры), Width/Height (ширину
и высоту). Операция автоформатирования задается командой Format > AutoFormat
(Формат * Автоформат).

Функция автоматического форматирования позволяет во много раз увеличить
скорость оформления электронной таблицы. Вид таблицы можно изменить, по-
средством флажков области Formats to Apply (Изменить).

Использование автоформата
1. Выделите всю таблицу.
2. Вызовите команду Format > AutoFormat (Формат > Автоформат), вслед-

ствие чего будет открыто одноименное диалоговое окно (рис. 4.27).

3. Выберите из предложенных образцов оформления таблицы необходи-
мый вам формат, например Classic 1 (Классический 1).

4. Нажмите кнопку ОК.

5р. 19р. lEast 7f
17 fWest 6

9 24 isouth 8

Рис. 4.27. Окно AutoFormat
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Excel распознает в электронной таблице ячейки с формулами и форматирует их
соответствующим образом (рис. 4.28).
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Рис. 4.28. Автоматически отформатированная таблица

Автоформатирование в любой момент можно отменить. Для этого следует выде-
лить автоматически отформатированный диапазон ячеек, вызвать команду Format >
AutoFormat (Формат > Автоформат) и в появившемся диалоговом окне, в поле со
списками форматов, выбрать формат None (Нет).

Даже если ни один из предложенных стилей форматирования не отвечает вашим
требованиям, выберите наиболее приемлемый из них и измените некоторые его
параметры. И в этом случае вы потратите меньше времени, чем необходимо для
форматирования таблицы вручную.

Сохранение исходных параметров при автоформатировании
В некоторых случаях при автоматическом форматировании изменять ранее при-
своенные таблице параметры не рекомендуется. Такие параметры следует исклю-
чать из списка тех, которые изменяются в процессе автоформатирования.
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Изменение параметров автоформатирования
1. Выполните щелчок на кнопке Options (Параметры) в диалоговом окне

AutoFormat (Автоформат), в результате чего последнее будет дополнено
областью Formats to apply (Изменить), которая содержит перечень пара-
метров автоформатирования (рис. 4.29).

2. Путем снятия флажков в этой области можно указать, какие парамет-
ры следует исключить из автоформата.

1
Jan F«b Mar Total

East 7 7 5 19
West В 4 7 17
South 8 7 9 24
Total 21 18 21 60

— -

East
West
South
Total

Jan Feb Mar Total
7 7 5 19
6 4 7 17
В 7 9 24

21 1B 21 60

т

Рис. 4.29. Область Formats to apply в окне AutoFormat

Самостоятельная работа
1. Выполните автоформатирование использовавшейся нами ранее таблицы, вы-

брав, например, формат Classic 3 (Классический 3).

2. Отмените автоформатирование таблицы.

Стили форматирования

В отличие от автоформатов, которые обычно присваиваются целым таблицам,
стили, также задающиеся посредством комбинации параметров форматирования,
как правило, назначаются отдельным ячейкам.
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Использование стилей
Открыв новую рабочую книгу, вы уже начинаете работать со стилем, который но-
сит название Normal (Обычный). Этот стиль будет использоваться для формати-
рования всех ячеек до тех пор, пока вы не установите какой-либо другой.

Определить, какой стиль используется и посредством каких параметров он зада-
ется, можно в диалоговом окне Style (Стиль), которое открывается вследствие
вызова команды Format > Style (Формат > Стиль). Это окно вы видите на рис. 4.30.

We Shading

:-• (-, •

Рис. 4.30. Параметры форматирования стиля Normal

В поле Style name (Имя стиля), содержащем список имен существующих стилей
(Currency (Денежный), Percent (Процентный) и т. д.), указывается имя стиля вы-
деленных ячеек. Чтобы присвоить ячейкам новый стиль, следует отметить его
имя в списке и нажать кнопку ОК.

В области Style includes (Стиль включает) перечислены параметры форматирова-
ния, которые задаются при выборе стиля. Чтобы добавить к ним какой-либо еще
параметр, следует установить соответствующий флажок, а чтобы исключить не-
нужный параметр, флажок необходимо снять.

Создание новых стилей

Диалоговое окно Style (Стиль) применяется также для создания новых стилей.
В качестве основы для нового стиля может быть использован один из уже суще-
ствующих.

Область применения пользовательских стилей распространяется только на ту ра-
бочую книгу, в которой они были созданы. Чтобы пользовательские стили стали
доступными и в других книгах, нужно воспользоваться средствами копирования
стилей.

Для того чтобы скопировать стиль из одной рабочей книги в другую, обе книги
необходимо открыть. Затем в окне книги, в которую стиль копируется, следует
вызвать команду Format > Style (Формат > Стиль) и в открывшемся диалоговом
окне нажать кнопку Merge (Объединить). Когда появится диалоговое окно Merge
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Styles (Объединение стилей), нужно выбрать имя исходной книги и щелкнуть на
кнопке ОК. В результате стиль из указанной рабочей книги будет скопирован в те-
кущую (рис. 4.31).

Рис. 4.31. Диалоговое окно Merge Styles

Создание стиля
1. Откройте посредством команды Format t Style (Формат > Стиль) диало-

говое окно Style (Стиль).

2. Введите название нового стиля в поле Style name (Имя стиля).

3. Используя флажки, удалите элементы форматирования, которые вклю-
чать в стиль не нужно.

4. Щелкните на кнопке Modify (Изменить) и в появившемся диалоговом
окне Format Cells (Формат ячеек) установите параметры форматирова-
ния. Воспользовавшись кнопкой О К, закройте это окно.

5. Чтобы сохранить новый стиль, щелкните на кнопке Add (Добавить).
6. Щелкните на кнопке ОК, и созданный стиль будет применен к выбран-

ному диапазону ячеек, а диалоговое окно Style (Стиль) закроется.

Самостоятельная работа
1. Задайте для ячеек, содержащих денежные суммы, соответствующий стиль.

2. Выделите в таблице диапазон ячеек и создайте для них новый стиль, задав
другой шрифт, например Times New Roman 12, и изменив цвет фона ячеек.

Создание иерархической структуры таблицы

При работе с большими таблицами их полное отображение затрудняет воспри-
ятие, поэтому возникает необходимость скрыть некоторые столбцы или строки.
В Excel это можно сделать, создав иерархическую структуру таблицы.
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Понятие структурирования
Под термином «структурирование» подразумевается распределение данных по
уровням иерархической структуры. Путем отмены (восстановления) отображе-
ния отдельных уровней можно добиться представления на экране только необхо-
димой информации. Структурирование позволяет значительно упростить работу
с содержащимися в таблице данными.

Процесс структурирования будет рассмотрен на примере таблицы, изображенной
на рис. 4.32. В ее строках 7, 10 и 13 содержатся итоговые сведения по отдельным
городам, а в строке 15 — по России.
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Рис. 4.32. Исходная таблица-пример

Разбиение на уровни структуры может выполняться как по горизонтали, так и по
вертикали (в нашем примере — только по горизонтали). На первом уровне будут
находиться итоговые данные по стране, на втором — итоговые данные по городам,
на третьем — данные о каждом аукционе.

Автоматическое структурирование
Наиболее простой способ создания иерархической структуры таблицы заключа-
ется в применении функции автоматического структурирования. В этом случае
уровни структуры должны быть «заложены» изначально, при построении табли-
цы. Наша таблица удовлетворяет этому требованию: она содержит исходные дан-
ные (один уровень) и результаты суммирования (второй уровень).
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Для того чтобы структура таблицы была создана автоматически, достаточно раз-
местить внутри нее указатель ячейки. Это послужит для Excel указанием на то,
что данную таблицу нужно структурировать. Если структурируемая таблица со-
держит большое количество пустых ячеек, то диапазон ячеек, который должен
быть разбит на уровни структуры, следует предварительно выделить.

Автоматическое структурирование
1. Разместите указатель ячейки в области таблицы (или выделите опре-

деленный диапазон ячеек).

2. Задайте команду Data > Group and Outline t Auto Outline (Данные > Группа
и структура > Создание структуры), и программа выполнит структури-
рование таблицы (рис. 4,33).
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Рис. 4.33. Структура таблицы, созданная с помощью команды Auto Outline

В результате выполнения команды Auto Outline (Создание структуры) на экране
отобразятся все уровни структуры. Слева от заголовков столбцов появятся кноп-
ки с номерами уровней структуры, позволяющие отображать и скрывать таковые.
Линейки уровней (слева от заголовков строк) показывают, какие группы ячеек
охватывает каждый уровень структуры. Один уровень структуры может вклю-
чать несколько групп (в нашем примере - уровень 3). Входящие в группу данные
обозначаются точками и не могут быть разбиты на уровни (рис. 4.34).
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Номер уровня Линейка уровня

Отдельные значения Кнопка для сокрытия группы

Рис. 4.34. Символы структуры

Если уровень структуры содержит несколько групп, вы можете скрыть некото-
рые из них.

Чтобы скрыть одну из групп уровня, следует выполнить щелчок на соответ-
1 ствующей ему кнопке со знаком минус. В результате этого с экрана будут

удалены и все более низкие уровни. После отмены отображения уровня или груп-
пы появится кнопка со знаком плюс, предназначенная для восстановления ото-
бражения скрытого элемента структуры.

Отменяя (возобновляя) отображение уровней структуры, можно показать только
необходимые данные таблицы (рис. 4.35).
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Рис. 4.35. В таблице представлены лишь итоговые значения

^ПРИМЕЧАНИЕ Данные первого уровня нельзя скрыть.

Группирование данных

Excel предоставляет пользователям возможность самостоятельно группировать
данные по уровням структуры, вставлять и удалять отдельные уровни. Делается
это так же просто, как и при использовании функции автоматического структу-
рирования.

Прежде чем приступать к созданию иерархической структуры вручную, данные
следует разбить на группы. Группировать их позволяет команда Data > Group and
Outline > Group (Данные > Группа и структура > Группировать), вследствие вызова
которой открывается диалоговое окно Group (Группирование)(рис. 4.36). Програм-
ма просит указать, какие значения — в строках или в столбцах — должны быть
сгруппированы.
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Рис. 4.36. Окно Group

) ПРИМЕЧАНИЕ Группировать можно только данные из смежных диапазонов.

Изменение параметров структурирования
1. Вызовите команду Data > Group and Outline > Settings (Данные > Группа

и структура > Настройка).

2. Б открывшемся диалоговом окне Settings (Настройка) путем выбора
флажков задайте параметры структурирования (рис. 4.37).

Рис. 4.37. Окно Settings

Флажки Summary rows below detail (итоги в строках под данными) и Summary
columns to right of detail (итоги в столбцах справа от данных) определяют положе-
ние итоговых строк и столбцов структуры относительно данных таблицы. При
установке флажка Automatic styles (Автоматические стили) итоговые ячейки столб-
цов и строк автоматически форматируются посредством встроенных стилей.

Удаление структуры
Структура таблицы может быть удалена полностью или частично. Для ее полного
удаления необходимо выделить весь рабочий лист или установить указатель ячей-
ки в таблице и вызвать команду Data t Group and Outline > Clear Outline (Данные >
Группа и структура > Удалить структуру). Отдельные уровни удаляются посред-
ством этой же команды, но перед ее вызовом нужно выделить только удаляемые
группы. Команда Ungroup (Разгруппировать) используется для отмены результа-
тов объединения в группы.
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Самостоятельная работа
1. Посредством группирования данных скройте в нашей таблице несколько строк

с названиями городов.

2. Используя функцию автоматического структурирования, создайте четырех-
уровневую иерархическую структуру.

Вставка примечаний
В ячейках рабочего листа может находиться самая разнообразная информация.
Поэтому часто возникает потребность в дополнительных пояснениях к содержи-
мому ячеек, особенно в тех случаях, если с одной таблицей работают несколько
человек. Чтобы не нарушить структуру таблицы, дополнительную информацию
можно представлять в виде примечаний.

Вставка примечания
1. Выделите ячейку, в которую необходимо вставить примечание.

2. Вызовите команду Insert > Comments (Вставка > Примечание), и на рабо-
чем листе появится поле для ввода текста примечания. Признаком
примечания является маленький красный треугольник в верхнем пра-
вом углу ячейки (индикатор примечания).

В Excel существует три режима отображения примечаний: Comment indicator only
(только индикатор), Comment & indicator (примечание и индикатор) и None (не
отображать). Эти режимы устанавливаются на вкладке View (Вид) диалогового
окна Options (Параметры).

№^&y/////y//^jMy^^/^^/^

I 1

i *

Константин
Корольков;
Важные данные

,ндаям!ЯИв̂ шяиивии,

При установке первого режима отображается только индикатор примечания. Для
того чтобы получить возможность просматривать текст, в ячейке с индикатором
необходимо разместить указатель мыши. Во втором режиме тексты примечаний
и индикаторы отображаются в таблице постоянно. В третьем режиме информа-
ция о примечаниях на экран не выводится.

Изменить режим отображения примечаний позволяют также команды Hide com-
ment (Скрыть примечание) и Show comment (Отобразить примечание) контекстного
меню ячейки с индикатором примечания. Обе команды предназначены для уста-
новки лишь первых двух режимов.
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Защита ячеек и листов
В уроке 2 рассказывалось о защите всей рабочей книги с помощью пароля. В этом
разделе будут рассмотрены предлагаемые Excel средства защиты ячеек и листов.
Чтобы установить защиту для листа, следует задать команду Tools t Protection >
Protect Sheet (Сервис > Защита > Защитить лист), а для защиты целой книги мож-
но воспользоваться командой Protect Workbook (Защитить книгу). В результате вы-
зова команды Protect Sheet (Защитить лист) открывается диалоговое окно Protect
Sheet (Защита листа), в котором устанавливаются параметры защиты (рис. 4.38).

Select unlocked ceils
Г~ Format cells
[71 For mat columns
П Format rows
[""I Insert columns
П Insert rows

Insert hyperlinks

.-'

Рис. 4.38. Диалоговое окно Protect Sheet

С помощью флажков этого окна можно задать защиту содержимого ячеек, объек-
тов листа и сценариев. Если с целью защиты содержимого ячеек наряду с уста-
новкой флажка Protect worksheetand contents of locked cells (Защитить лист и содер-
жимое защищаемых ячеек) ввести и пароль в поле Password to unprotect sheet
(Пароль для отключения защиты листа), то изменить содержимое ячеек можно
будет только после указания данного пароля.

В поле Allow all users of this worksheet to (Разрешить всем пользователям этого лис-
та) диалогового окна Protect Sheet (Защита листа) посредством установки флаж-
ков осуществляется выбор действий, разрешенных всем пользователям.

Снять защиту рабочего листа позволяет команда Tools * Protection > Unprotect Sheet
(Сервис > Защита к Снять защиту листа).

Снятие блокировки некоторых ячеек при установке защиты листа

1. Выделите ячейки, блокировку которых нужно предотвратить.

2. Вызовите команду Format t Cells (Формат > Ячейки), чтобы открыть диа-
логовое окно Format Cells (Формат ячеек).

3. На вкладке Protection (Защита), показанной на рис. 4.39, снимите фла-
жок Locked (Защищаемая ячейка).
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Рис. 4.39. Вкладка Protection диалогового окна Format Cells

Эту операцию можно выполнить только после отмены защиты рабочего листа.
При последующей установке защиты листа выделенные ячейки не будут забло-
кированы.

Подведение итогов

В этом уроке мы научились:

0 присваивать и создавать форматы;

0 выравнивать содержимое ячеек;

0 изменять шрифты;
13 использовать границы и цветовое оформление;

0 форматировать столбцы и строки;

0 выполнять автоматическое форматирование;

0 создавать иерархическую структуру таблицы;

И вставлять примечания в ячейки;
0 устанавливать защиту ячеек и листов.



УРОК Формулы и функции

G Создание формул

С1 Использование ссылок

П Имена в формулах

П Использование функций

П Типы ошибок в формулах

П Исправление ошибок

П Отслеживание зависимостей

П Циклические ссылки
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Основным средством анализа и обработки вводимых в таблицу данных являются
формулы. С их помощью данные можно складывать, умножать и сравнивать,
производить над ними другие операции. Для выполнения стандартных вычисле-
ний — как сложных, так и простых — Excel предлагает большое количество встро-
енных функций, которые можно вызывать в формулах. О том, как максимально
эффективно применять эти, а также другие предоставляемые программой средст-
ва вычисления, мы расскажем в настоящем уроке.

Формулы

Формула — это выражение, которое начинается знаком равенства и определяет,
какие расчеты нужно произвести на рабочем листе. Формула в ячейке может
включать следующие элементы: числовые и текстовые значения, ссылки на дру-
гие ячейки, знаки математических и логических операций, а также обращения
к функциям.

При вычислении формулы используется порядок действий, принятый в матема-
тике. Для его Изменения можно применять круглые скобки. Знаки операций, ко-
торые допускается использовать в формулах, приведены в табл. 5.1. Операции
представлены в порядке уменьшения их приоритета.

Таблица 5.1. Арифметические и логические операции

Знак Операция

% Взятие процента

Отрицание
Л Возведение в степень

Умножение

/ Деление

+ Сложение

Вычитание

Равно

< Меньше

> Больше

<- Меньше или равно

>= Больше или равно

<> Неравно

Результатом вычисления формулы, включающей арифметические операции, яв-
ляется числовое значение. Формула с операторами сравнения дает в результате
логическое значение TRUE (Истина) или FALSE (Ложь).
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При работе с текстовыми данными можно использовать знак конкатенации (&),
задающий операцию соединения строк. На приведенном ниже рисунке с его по-
мощью в ячейке D3 формируется строка, содержащая фамилию и имя, разделен-
ные символом пробела. Заданная для ячейки формула отображается в строке
формул.

Виктор {Зарядный [Зару^ный Виктор I

В формулах применяются также адресные операции. Для их обозначения ис-
пользуются знаки, перечисленные ниже.

Таблица 5.2. Адресные операции '

Знак Операция

; Служит разделителем границ диапазона (например, B3:D10)

; Обозначает объединение диапазонов или несмежных ячеек (например, ВЗ;В5)

Пробел Задает пересечение диапазонов (например, запись A3:F5 D1:F6 определяет
диапазон D3:F5)

Знаки сложения и вычитания, как и знак равенства, служат для идентификации
формулы, то есть Excel рассматривает данные, начинающиеся с любого из этих
знаков, как формулу. После ввода формулы, которая начинается знаком сложе-
ния или вычитания, и нажатия клавиши Enter программа автоматически вставля-
ет перед формулой знак равенства.

Ввод и редактирование формул

Элементарные навыки работы с формулами вы получили в предыдущих уроках.
Мы продолжим изучение этой темы и расскажем более подробно о вводе и редак-
тировании формул. Предоставляемые Excel методы создания формул будут рас-
смотрены на примере таблицы, в которой указаны цены на видеокарты различ-
ных фирм-производителей, а также приводится информация о количестве про-
данных видеокарт за каждый месяц квартала (рис. 5.1).

Чтобы определить количество проданных за квартал видеокарт каждого вида, не-
обходимо произвести соответствующие вычисления в ячейках G4:G9. В частно-
сти, ячейка G4 должна содержать формулу, которая вычисляет сумму значений,
хранящихся в ячейках D4:F4. Создать ее можно, введя в ячейку с клавиатуры
следующее выражение:

=D4+E4+F4

(ПРИМЕЧАНИЕ При указании адресов ячеек можно использовать строчные буквы. После
ввода формулы Excel автоматически преобразует их в прописные.
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Рис. 5.1. Таблица-пример

Ввод каждой формулы завершается нажатием клавиши Enter, после чего в ячейке
появляется результат вычислений. Но фактическим содержимым ячейки по-преж-
нему является формула, которую можно увидеть в строке формул при активиза--
ции этой ячейки, а также в режиме редактирования содержимого ячейки (данный
режим устанавливается после нажатия клавиши F2).
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v Sheet 1.

По умолчанию на вкладке Edit (Правка) диалогового окна Options (Параметры)
установлен флажок Edit directly in cell (Правка прямо в ячейке). В этом случае
ввод формулы осуществляется непосредственно в активной ячейке, и по мере
ввода формула появляется в строке формул. Если данный флажок отключен, по-
сле ввода знака равенства курсор переходит в строку формул и последующие
действия по формированию формулы выполняются там.

5 Зак-345
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Существуют и другие, более быстрые методы ввода формул, в частности метод
«наведи и щелкни»- (point-and-click). Он особенно удобен, если формула должна
содержать ссылки на ячейки, находящиеся на большом расстоянии друг от друга.

Ввод формулы методом «наведи и щелкни»
1. Выберите ячейку, в которой надо отобразить результат.

2. Введите с клавиатуры знак равенства.
3. Щелкните в области первой ячейки, которую необходимо включить

в формулу. В результате вокруг этой ячейки появится пунктирная «бе-
гущая*' рамка, а в итоговой ячейке — адрес.

4. Введите знак операции.
5. Щелкните на следующей ячейке формулы.

6. Повторяйте шаги 4 и 5, пока вся формула не будет введена.

7. Завершите ввод формулы нажатием клавиши Enter или щелчком на
кнопке Enter (Ввод) в строке формул (кнопка имеет вид зеленой галоч-
ки), а не переходом к другой ячейке, — иначе ее адрес будет включен
в формулу!

IПРИМЕЧАНИЕ С помощью мыши в формуле можно создавать ссылки не только на отдельные
ячейки, но и на диапазоны ячеек.

Теперь формулу, созданную в ячейке G4, можно скопировать в ячейки G5:G9.
Каким образом она при этом преобразуется, описано ниже, в разделе «Относи-
тельные и абсолютные ссылки на ячейки».

Принцип редактирования формул и обычных данных практически одинаков.
Сначала ячейка с формулой выделяется, после чего последняя появляется в стро-
ке формул. В этой строке пользователь должен щелкнуть кнопкой мыши, внести
необходимые изменения, а затем нажать клавишу Enter. Если вы нажмете клави-
шу F2, то редактирование формулы можно будет произвести прямо в ячейке рабо-
чего листа.

Отображение формул
По умолчанию на рабочем листе отображаются не формулы, а результаты, и для
того чтобы увидеть формулу, необходимо сделать ячейку, в которой она находится,
активной. Чтобы иметь возможность просматривать все формулы непосредст-
венно на рабочем листе, на вкладке View (Вид) диалогового окна Options (Пара-
метры) следует установить флажок Formulas (формулы). В результате этого ши-
рина столбцов будет автоматически увеличена, благодаря чему их обзор заметно
улучшится. На рис. 5.2 рассматриваемая нами таблица-пример представлена в ре-
жиме отображения формул.

При переходе в данный режим появляется панель инструментов Formula Auditing
(Зависимости), которая будет описана далее.



Формулы 131

Рис. 5.2. Таблица в режиме отображения формул

СОВЕТ Для переключения в режим отображения формул удобно пользоваться ком-
бинацией клавиш Ctrl+*.

Относительные и абсолютные ссылки на ячейки
Ссылка на ячейку в формуле может быть относительной, абсолютной или сме-
шанной. До сих пор мы пользовались относительными ссылками, фактически за-
дающими смещение ячейки, на которую производится ссылка, относительно
ячейки, в которой эта ссылка указывается. По этой причине при копировании
формулы адрес ячейки, на которую делается ссылка, изменяется так, что смеще-
ние остается прежним. Относительные ссылки создаются по умолчанию. На сле-
дующем рисунке представлены формулы, которые были получены методом ко-
пирования формулы из ячейки G4.

;
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Цена, $
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35
D

-

Количество
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25

21
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16

32

16
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19

12
11
12

12

Июнь
24

29

14

17

12

12

Всего
=D4+E4+F4
=D5+E5-H=5
=D6+E6+F6
=D7+E7+F7
=D8+E8-ifS
=D9+E9+F9

•
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Абсолютная ссылка указывает на конкретную ячейку. При перемещении или ко-
пировании формулы такая ссылка не изменяется, поскольку она задает фиксиро-
ванную позицию на рабочем листе. Признаком абсолютной ссылки является на-
личие двух знаков доллара ($) - перед именем столбца и перед номером строки.
В смешанных ссылках имеется один знак доллара. Если он стоит, например, перед
именем столбца, то мы имеем абсолютную ссылку на столбец и относительную —
на строку.

Поясним принцип применения ссылок разного типа на примере нашей таблицы
и рассчитаем выручку, получаемую каждый месяц от продажи видеоплат всех ти-
пов. Формулы для расчета будут расположены в столбцах Н, I, J. Начнем с созда-
ния формулы для ячейки Н4. Нетрудно догадаться, что она должна выглядеть так:

=C4*D4

То есть мы должны умножить цену одной видеокарты на количество единиц,
проданных за месяц. Аналогичная формула для расчета выручки за второй месяц,
находящаяся в ячейке 14, будет иметь такой вид:

-С4*Е4

а формула для расчета выручки за третий месяц, вводимая в ячейку J4, — такой:

=C4*F4

Понятно, что поскольку цены на видеокарты располагаются в столбце С, каждая
формула должна ссылаться на данный столбец. Если оставить формулу в ячейке
Н4 без изменений и попытаться заполнить формулами ячейки 14 и J4, скопиро-
вав эту формулу, то в указанных ячейках будут получены некорректные форму-
лы (см. рисунок ниже).

Всего

=D4+E4+F4

=re+E5+F5

=D6+E6+F6

=D7+E7+F7

=D8+Ee+F8

=D9+E9+F9

Сумма,!

Апрель
=СГ04

Май
=D4*E4

Июнь

=E4'F4

Если же в формуле ячейки Н4 сделать ссылку на столбец С абсолютной, то мы
сможем путем копирования этой формулы заполнить правильными формулами
весь нужный нам диапазон. При копировании в первом операнде формулы изме-
няется только номер строки (С5, С6, С7 и т. д.), а ссылка на столбец остается по-
стоянной.

Если формула содержит абсолютную ссылку, при копировании эта ссылка не из-
меняется. Ссылки такого типа часто применяются с формулах, содержащих кон-
станты. Поместив константу (значение ставки налога или, скажем, величину кре-
дитной ставки) в ячейку листа, ссылаться на нее в формуле можно с помощью
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абсолютной ссылки. Если значение константы потребуется изменить, достаточно
отредактировать одну ячейку, и во всех формулах будет применяться новое зна-
чение.

1
1
1
и

i j,-

Всего
-D4+E4+F4
=D5+E5+F5
=D6+E6+F6
-D7+E7+F7
-D8+E8+F8

D9+E9+F9
1

1
!

Сумма,!

Апрель
=SC4*D4
=3C5'D5
=JC6'D6
=$C7Ti7
=SC8*D8
=$C9*D9

Май
-£C4*E4
=£C5*E5
=$С6*ЕБ
=SC7-E7
=$C3*E3
=JC9'E9

Июнь
=$C4*F4
=SC5'F5
=$CS*F6
=3iC7*F7
=$C8*F3
=IC9*F9

Всего

1 : i
\ 1 : 1

Рис. 5.3. Формулы со смешанными ссылками

Создание абсолютной или смешанной ссылки
1. Выберите ячейку, в которой будет размещен результат.

2. Начните ввод формулы. После указания адреса ячейки, который дол-
жен стать абсолютной ссылкой, нажмите один раз клавишу F4, чтобы
добавить к адресу строки и столбца знак доллара $. Нажимайте клави-
шу F4 до тех пор, пока не получите ссылку нужного вам типа.

3. Когда ввод формулы будет завершен, нажмите клавишу Enter.

4. Заполните формулой все остальные ячейки (с помощью маркера за-
полнения).

Ссылки на листы и книги
ч

Формулы могут содержать ссылки на другие листы рабочей книги и даже на дру-
гие книги. Создавая такие ссылки, нужно придерживаться определенных правил,
иначе не избежать появления ошибок при вычислениях. В ссылке на другой лист
имя листа указывается перед адресом ячейки и отделяется от него восклицатель-
ным знаком: Sheetl!D4.

В результате переименования листа его имя, являющееся составной частью ссыл-
ки в формуле, автоматически изменяется. Перемещение или копирование листа
не влияет на вид формулы, поскольку его имя остается прежним. При копирова-
нии или перемещении влияющих ячеек на другие рабочие листы имя листа в ссыл-
ке автоматически обновляется.

Если удалить лист, на содержимое которого существует ссылка в формуле, соот-
ветствующие ссылки будут заменены сообщением об ошибке #REF! (#ССЫЛКА!),
а результат вычислений не станет отображаться. После удаления содержимого
влияющей ячейки ее значение при вычислениях будет считаться равным 0.
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Ссылка на ячейку /фугой рабочей книги (внешняя ссылка) создается аналогич-
ным образом. Во время ввода формулы во второй рабочей книге следует активи-
зировать окно первой рабочей книги и выбрать ячейку, на которую нужно соз-
дать ссылку. Во внешней ссылке, помимо имени листа и адреса ячейки, указыва-
ется имя рабочей книги, которое заключается в квадратные скобки:

[имя_книги.х!5]имя_листа!$А$1

Если исходная рабочая книга сохранена, то ссылка содержит имя документа.
Полное имя документа указывается в формуле в том случае, если исходная кни-
га закрыта. При попытке сохранить книгу, содержащую ссылки на еще несохра-
ненные документы, программа попросит подтвердить необходимость данной опе-
рации.

(ПРИМЕЧАНИЕ Если часть ссылки, включающая имя книги и имя листа, содержит пробелы,
она заключается в кавычки. Например: '[Список]Адреса клиентов!'$А$2.

Создание ссылок на листы и книги
1. Выберите ячейку, в которой будет размещен результат.

2. Начните ввод формулы. Перейдите на лист (книгу), содержащий ячей-
ку, на которую необходимо сослаться, и, для того чтобы внести в фор-
мулу адрес данной ячейки, выполните на ней щелчок.

3. Завершив ввод формулы, нажмите клавишу Enter.

В случае закрытия зависимой рабочей книги и удаления исходной ссылка на уда-
ленный документ в формуле заменяется сообщением об ошибке #REF! (#ССЫЛ-
КА!). Если файл с исходной рабочей книгой был перемещен, ссылку в формуле
необходимо изменить вручную. Это нужно сделать и при открытии рабочей кни-
ги, которая содержит ссылки на еще закрытые книги.

Обновить существующие связи можно, не открывая- исходную рабочую книгу.
Эту операцию придется производить в том случае, если она не будет выполнять-
ся автоматически. Чтобы открыть диалоговое окно Edit Links (Изменение связей),
в котором можно произвести обновление связей, следует активизировать коман-
ду Edit > Links (Правка > Связи).

В указанном окне (рис. 5.4) перечисляются все связи текущей рабочей книги. Об-
новить их, не открывая исходные файлы, позволяет кнопка Update Values (Обно-
вить). Посредством кнопки Open Source (Открыть) можно активизировать рабо-
чую книгу, выделенную в диалоговом окне Edit Links (Изменение связей). После
нажатия кнопки Change Source (Изменить) открывается диалоговое окно Change
Source (Изменить источник), где пользователь может задать другой путь к доку-
менту, с которым установлена связь. После щелчка на кнопке Break Link (Разорвать
связь) происходит разрыв связи, сопровождающийся подстановкой значения, по-
лученного последним. Кнопка Check Status (Состояние) используется для проверки
всех связей.
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Edit Links

P

Close ;

Рис. 5.4. Диалоговое окно Edit Links

Формулы массива
Если над данными определенного диапазона нужно произвести однотипные опе-
рации, процесс формирования необходимых формул можно упростить, создав
для диапазона формулу массива, которая будет связана со всеми его ячейками.
Продемонстрируем преимущества применения такой формулы на примере нашей
таблицы. В столбцах Н, I и J хранятся суммы выручки от продажи видеокарт за
каждый из трех месяцев. Для определения общей суммы выручки за квартал по
первому наименованию следовало бы в ячейку К4 поместить формулу =H4+I4+J4,
а затем скопировать ее в другие ячейки столбца. Однако в подобных случаях
удобнее использовать формулу массива. Чтобы создать ее, нужно выделить ячей-
ки К4:К9 — диапазон, определяющий массив, и ввести следующую формулу (для
указания диапазонов их можно выделять мышью):

=H4:H9+I4;I9+J4:J9

Чтобы действие формулы распространялось на все выделенные ячейки массива,
ее ввод следует завершить нажатием комбинации клавиш Ctrl+Shift+ Enter. После
этого в каждой ячейке диапазона 14:19 появится приведенная ниже формула мас-
сива (фигурные скобки являются признаком формулы такого типа):

{=H4:H9+I4;I9+J4:J9}

. .1 j$f[=H4.H9-H4-|9+J4J9}
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Создание формулы массива
1. Выделите диапазон ячеек, в который требуется ввести формулу массива.

2. Введите формулу. Вместо ссылки на одну ячейку укажите диапазон
ячеек массива.

3. Нажмите комбинацию клавиш Ctrl+Shift+ Enter.

ВНИМАНИЕ Ячейки массива обрабатываются программой как единое целое. При попыт-
ке изменить одну из ячеек диапазона массива Excel выдает сообщение о не-
допустимости выполнения такой операции.

Изменить формулу массива можно в режиме редактирования. Однако, как толь-
ко вы попытаетесь завершить редактирование формулы нажатием клавиши Enter,
программа снова выдаст сообщение о недопустимости выполняемого действия.
Для того чтобы подтвердить необходимость внесения изменений в формулу мас-
сива, следует воспользоваться комбинацией клавиш Ctrl+Shift+Enter.

Мы рассмотрели формулу массива, возвращающую несколько значений. Однако
несложно создать и такую формулу, которая возвращала бы только одно значе-
ние., С ее помощью удобно, в частности, рассчитывать суммы произведений. Та-
кая формула представлена на рис. 5.5 в строке формул.
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Рис. 5.5. Формула массива, вычисляющая одно значение

Режимы пересчета формул
По умолчанию на вкладке Calculation (Вычисления) диалогового окна Options (Па-
раметры) активизирован переключатель Automatic (автоматически), который обес-
печивает автоматический пересчет формул после каждой операции ввода данных
(рис. 5.6). Правда, при этом ввод каждого нового значения требует пересчета свя-
занных с ними значений во всей рабочей книге. Так, после ввода нового значения
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в ячейку D4 нашей таблицы автоматически будут обновлены данные в ячейках
G4, Н4 и К4, поскольку формулы в них зависят от ячейки D4.

f^ijlit.

O_;,iCHlNitS ! С:-.:,'*.

Са|Ш |̂Щ|

: ;-, •! Шв •. 'Щ

Рис. 5.6. Вкладка Calculation диалогового окна Options

Однако если лист содержит много сложных формул, автоматический режим их
пересчета может стать причиной замедления работы программы. В таком случае
его целесообразно отключить. Сделать это можно путем установки переключателя
Manual (вручную). Если этот переключатель установлен, вычисления производятся
только после нажатия клавиши F9 или одной из кнопок вкладки Calculation (Вы-
числения) — кнопки Calc Now (F9) (Вычислить (F9)) или Calc Sheet (Пересчет листа).

При нажатии кнопки Calc Now (F9) (Вычислить (F9)) осуществляется пересчет
данных во всех открытых листах, включая таблицы данных, а также происходит
обновление диаграмм всех этих листов. Кнопка Calc Sheet (Пересчет листа) пред-
назначена для активизации операции пересчета данных на активном рабочем
листе, а также для преобразования связанных с ним диаграмм и таблиц данных.

Если переключатель Manual (вручную) активен, то при изменении содержимого
влияющей ячейки значение в зависимой ячейке не обновляется- Но в строке со-
стояния появляется сообщение Calculate (Вычислить), указывающее пользовате-
лю на то, что в рабочем листе произошли изменения и что для обновления дан-
ных пересчет следует выполнить вручную. После нажатия клавиши F9 сообщение
в строке состояния исчезает.

Установка флажка Recalculate before save (Пересчет перед сохранением) предпи-
сывает, что данные должны пересчитываться перед каждой операцией сохране-
ния документа.

При установке переключателя в положение Automatic except tables (автоматиче-
ски кроме таблиц) автоматически будут пересчитываться все зависящие форму-
лы, но не данные в таблицах. Для пересчета данных необходимо нажать кнопку
Calc Now (F9) (Вычислить (F9)) или клавишу F9.
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Самостоятельная работа
1. В таблице, содержащей данные об объеме продаж, произведите пересчет де-

нежных сумм, выраженных в долларах, в суммы в рублях. Значение, отражаю-
щее курс рубля по отношению к доллару, разместите на другом листе книги.

2. Проделайте эту же операцию при условии, что курс указывается в другой ра-
бочей книге.

3. Потренируйтесь в применении различных режимов отображения формул.

Имена в формулах
Указать адрес ячейки или диапазона — это не единственный способ сослаться на
них в формуле. В Excel существует возможность присваивать ячейкам, диапазо-
нам ячеек, формулам и константам имена и использовать их в качестве абсолют-
ных ссылок. Присваивать имена можно и несмежным диапазонам, а также ячей-
кам, расположенным в диапазоне, которому уже дано имя.

При выборе имени для диапазона ячеек следует придерживаться определенных
правил. Имя может содержать до 255 знаков и состоять из букв, цифр, символов
точки и подчеркивания. Начинаться оно должно с буквы или со знака подчерки-
вания. Кроме того, имя не должно быть похожим на ссылку (например, таким как
A3 или С$2), однако оно может состоять из нескольких слов, разделенных симво-
лами точки и подчеркивания. Регистр символов в имени Excel не различает.

Присвоение имен ячейкам и диапазонам ячеек
Чтобы присвоить имя ячейке или диапазону ячеек, нужно сначала их выделить.
После этого необходимо щелкнуть в крайнем левом поле строки формул, где на-
ходится адрес текущей ячейки. В результате в этом поле появится курсор ввода, а
адрес ячейки будет выделен. Введите имя диапазона, например Кол_Апрель, и на-
жмите клавишу Enter.

IKtjfl Offirp ЕНГРI 7ГШЗ - BOOfcl.xl)
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Существует и другой способ именования диапазонов: вызвать команду Insert >
Name > Define (Вставка > Имя > Присвоить) и ввести имя диапазона в поле Names
in workbook (Имя) диалогового окна Define Name (Присвоение имени), изображен-
ного на рис. 5.7.

:Цкол_Апрель|
' •'.-.'.. . -...

1

Рис. 5.7. Диалоговое окно Define Name

Поле Refers to (Формула) диалогового окна Define Name (Присвоение имени) пред-
назначено для отображения ссылки на выделенный диапазон ячеек в том виде,
в каком она будет входить в формулу. Первым указывается имя листа. Затем сле-
дуют адреса крайних ячеек диапазона, снабженные символами доллара, что ха-
рактерно, как вы знаете, для абсолютных ссылок. Если формируется относитель-
ная ссылка, символ доллара следует удалить.

Имена диапазонов ячеек активной книги перечисляются в списке под полем вво-
да имени. Если отметить имя некоторого диапазона ячеек, а затем закрыть окно,
щелкнув на кнопке О К, то указанный диапазон будет выделен.

Присвоение, изменение и удаление имен ячеек
1. Выделите ячейку (или диапазон ячеек), которой нужно присвоить имя.

2. Выберите команду Insert > Name t Define (Вставка > Имя > Присвоить).

3. В поле Names in workbook (Имя) введите имя и щелкните на кнопке Add
(Добавить).

4. При необходимости изменить имя выделите его в списке, замените но-
вым и щелкните на кнопке Add (Добавить).

5. Чтобы удалить имя, выделите его в списке и щелкните на кнопке Delete
(Удалить).

Присвоение имен константам и формулам
С помощью диалогового окна Define Name (Присвоение имени) можно присваи-
вать имена константам и формулам. Для этого в поле Names in workbook (Имя)
достаточно ввести нужное имя, а в поле Refers to (Формула) — константу или знак
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равенства и формулу. После нажатия кнопки Add (Добавить) это имя появится
в списке диалогового окна (рис. 5.8).

Рис. 5.8. Имена констант в диалоговом окне Define Name

Создание имен на основе заголовков

В качестве имени диапазона можно использовать содержимое нескольких входя-
щих в его состав ячеек, что значительно упрощает работу с таблицами. Выделите
в таблице диапазон ячеек и вызовите команду Insert > Name > Create (Вставка >
Имя > Создать). В результате откроется диалоговое окно Create Names (Создать
имена), изображенное на рис 5.9.

Create Names

Creat • Щ iipi

\? •[ ,\ i I

i ' |l ,n.!t-^

Рис. 5.9. Диалоговое окно Create Names

В этом диалоговом окне нужно указать, где в выделенном диапазоне расположе-
ны ячейки, текст которых должен использоваться в качестве имен. По умолча-
нию установлен флажок Top row (в строке выше), определяющий, что имена
столбцов диапазона будут сформированы из текстовых данных его верхней стро-
ки. Установите нужный флажок и подтвердите свой выбор нажатием кнопки ОК.
Сгенерированные описанным способом имена отобразятся в поле имен, располо-
женном в строке формул. В таблице, представленной на рис. 5.10, столбцы оза-
главлены как Апрель, Май и Июнь, а формула для суммирования данных в столбце D
содержит ссылки в виде имен диапазонов (см. строку формул).
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Рис. 5.10. Имена диапазонов, созданные на основе текстовых данных

На попытку присвоить диапазону уже назначенное имя Excel может отреагиро-
вать по-разному, в зависимости от того, каким способом пользователь пытается
это сделать. Если для присвоения имени используется строка формул, выделяет-
ся диапазон ячеек, которому данное имя уже было дано. Если имя задается Б окне
Create Names (Создать имена), оно присваивается новому диапазону ячеек, а ста-
рый диапазон остается без имени. В результате обновляются все ссылки на диа-
пазон ячеек с этим именем. Если же для назначения имени применяется команда
Create (Создать), на экране открывается диалоговое окно, в котором следует под-
твердить (или отменить) необходимость данной операции.

Создание имен из заголовков строк или столбцов
1. Выделите область, для которой нужно задать имя. Включите в нее

ячейки, содержимое которых будет использовано в качестве имен (это
могут быть верхняя или нижняя строка либо первый или последний
столбец области).

2. Выберите команду Insert > Name > Create (Вставка > Имя > Создать), для
того чтобы открыть диалоговое окно Create Names (Создать имена).

3. Установив соответствующий флажок, укажите строку (в строке выше
или в строке ниже) и/или столбец (в столбце слева или в столбце спра-
ва), где содержатся заголовки, которые будут использованы в качестве
имен строк и столбцов выделенного диапазона.

4. Щелкните на кнопке ОК. Имена будут созданы, а окно закрыто.

В книге целесообразно выделить рабочий лист для хранения сведений о том, ка-
кие имена каким диапазонам присвоены. Это можно сделать следующим образом.
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Перейдите на другой лист, вызовите там команду Insert > Name > Paste (Вставка >
Имя > Вставить), и на экране появится диалоговое окно Paste Name (Вставка име-
ни), которое вы видите на рис. 5.11.

Paste Mame

Рис. 5.11. Диалоговое окно Paste Name

Щелкните в этом окне на кнопке Paste List (Все имена), и в рабочий лист будет
вставлен весь список имен с указанием адресов диапазонов (рис. 5.12). При необ-
ходимости удалить какие-либо из имен воспользуйтесь кнопкой Delete (Удалить)
в диалоговом окне Define Name (Присвоение имени).

!Мин ставка

JHffiLt—"

Рис. 5.12. Вставленный в рабочий лист список имен с указанием диапазонов

Применение имен
Как уже было сказано, имена ячеек, диапазонов ячеек и констант можно исполь-
зовать в качестве ссылок в формулах и в качестве аргументов функций. Для
ввода имени в формулу предназначена команда Insert > Name > Paste (Вставка >
Имя > Вставить), после выбора которой открывается диалоговое окно Paste Name
(Вставка имени) со списком имен, созданных для данной книги. В нем надо отме-
тить нужное имя и нажать кнопку ОК. Это окно и вставленные с его помощью
имена показаны на рис. 5.13.

(ПРИМЕЧАНИЕ Если в формуле будет указано несуществующее либо некорректное имя, то
в ячейке с формулой вместо результата вычислений появится значение
ошибки «NAME? («ИМЯ?).
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Рис. 5.13. Вставка ссылки на константу

Применение имен в формулах
1. Начните ввод формулы.
2. Когда нужно будет ввести в формулу имя, выберите таковое в окне

Paste Name (Вставка имени), которое вызывается посредством команды
Insert > Name > Paste (Вставка > Имя > Вставить).

3. Нажмите клавишу Enter.

Если в формулах, содержащих ссылки на диапазон, использовались адреса ячеек,
то после присвоения диапазону имени их можно заменить этим именем. Причем
предварительно выделять ячейки с формулами не нужно, за исключением того
случая, когда ссылки необходимо заменить только в выделенном диапазоне. Да-
лее следует вызвать команду Insert > Name > Apply (Вставка > Имя > Применить),
с тем чтобы открыть диалоговое окно Apply Names (Применение имен), показан-
ное на рис. 5.14.

Apply Names

Рис. 5.14. Диалоговое окно Apply Names
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Выберите имя, которым будут заменены соответствующие ссылки в формулах,
нажмите кнопку ОК, и программа автоматически выполнит данную операцию.
Правда, относительные ссылки при этом будут преобразованы в абсолютные. Что-
бы избежать подобной ситуации, необходимо снять флажок Ignore Relative/Absolu-
te (Игнорировать тип ссылки), вследствие чего будет установлен режим замены
только абсолютных ссылок.

Самостоятельная работа

1. Пользуясь строкой формул, присвойте имя диапазону ячеек.

2. Присвойте имена столбцам диапазона, используя заголовки строк.

3. Составьте формулу, в которой применялось бы несколько имен.

Функции

Excel предоставляет в распоряжение пользователей множество специальных
функций, которые можно применять в вычислениях. Функция представляет со-
бой формулу, выполняющую определенные операции. Исходные данные переда-
ются в нее посредством аргументов. Обращение к функции осуществляется пу-
тем указания ее имени, после которого следуют круглые скобки. Если функция
имеет аргументы, они перечисляются в скобках и отделяются друг от друга точ-
кой с запятой:

-SUM(A6:A16;A21:A24)

В качестве аргумента можно задать числовое или текстовое значение, адрес ячей-
ки (абсолютный или относительный), адрес или имя диапазона. Вызываются
функции из формул, причем в одной формуле может быть несколько функций,
объединенных различными знаками операций. Если в качестве аргументов функ-
ции используются другие функции, то такие функции называются вложенными.

На формулы с функциями не накладываются никакие особые ограничения. Их
можно копировать обычным образом, учитывая тип ссылки (относительная или
абсолютная); допускается использование в качестве аргументов ссылок на диапа-
зоны из других листов и книг.

Вызов функций

Вызов функции в формуле, то есть ввод ее имени, скобок и аргументов, можно
выполнить с клавиатуры — либо непосредственно в ячейке, либо в строке фор-
мул. При этом адреса ячеек, содержимое которых должно использоваться в каче-
стве аргументов функции, удобно определять, выделяя ячейки с помощью мыши.
Аргументами функции могут быть адреса как смежных, так и несмежных диапа-
зонов ячеек. Адрес смежного диапазона состоит из адресов первой и последней
ячеек, разделенных двоеточием, а адрес несмежного диапазона включает адреса
несмежных ячеек, разделенные точкой с запятой. Оба символа разделения встав-
ляются в формулу автоматически, при указании диапазона ячеек с помощью мыши.
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В случае некорректной записи функции (предположим, пользователь забыл ука-
зать обязательный аргумент, количество закрывающих скобок не соответствует
количеству открывающих и т. д.) появляется сообщение об ошибке.

Microsoft Excel
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При работе с функциями рекомендуется использовать строку формул и мастер
функций. В этом случае аргументы устанавливаются в диалоговом окне, что пол-
ностью исключает появление ошибок, вероятность возникновения которых при
вводе функции с клавиатуры довольно высока.

Ввод функций с помощью строки формул и мастера

При вводе формулы в левой части строки формул отображается имя функции,
которая вызывалась последней. После щелчка на расположенной рядом с ним
стрелке раскрывается список, содержащий имена десяти недавно использовав-
шихся функций (рис. 5.15).

i
SUM

AVERAGE

Р=

HYPERLINK

COUNT

MAX
5IM

иге runcuons. , .

xv& ; =
•

Цена В той числе НДС '

1500oi' ™ • 2500"

jZJI pIIII
__ гг. t— — —j.

I
— 1

Рис. 5.15. Строка формул со списком недавно использовавшихся функций

Если нужная функция указана в этом списке, выберите ее. Имя функции появит-
ся в строке формул, а на экране откроется диалоговое окно Function Arguments
(Аргументы функции), которое будет содержать ее описание и поля для ввода ар-
гументов (рис. 5.16). Количество аргументов функции не должно превышать 30.
В диалоговом окне для ввода каждого из них предусмотрено отдельное поле.
Сначала таких полей всего лишь два, но по мере ввода аргументов их количество
увеличивается. После ввода в качестве аргумента адреса ячейки справа от поля
ввода отображается значение из этой ячейки. Обязательные аргументы выделены
полужирным шрифтом. Чтобы функция работала корректно, эти поля должны
быть заполнены.



146 Урок 5 ' Формулы vi функции

Function Arguments

т

. - и ' ,

Рис. 5.16. Диалоговое окно для ввода аргументов функции

Существует несколько способов определения аргументов функции. Самый про-
стой — ввод значений аргументов или их адресов в строку формул или поля аргу-
ментов непосредственно с клавиатуры. Кроме того, вы можете задать аргументы,
выделив с помощью мыши определенный диапазон ячеек на рабочем листе.

Если диалоговое окно для ввода аргументов закрывает ячейки, которые не-
обходимо выделить, щелкните на кнопке сворачивания, расположенной

в правой части каждого поля ввода, вследствие чего окно уменьшится до размера
поля ввода и вы сможете выделить нужный диапазон ячеек.
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О После этого окно ввода аргументов формул можно увеличить посредством
щелчка на кнопке развертывания, но прежде следует убедиться, что выделены

нужные ячейки (возможно, их придется выделить заново), Обратите внимание
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на то, что сразу после ввода первого аргумента в нижней части окна отображается
предварительный результат вычисления формулы. Щелкните в диалоговом окне
Function Arguments (Аргументы функции) на кнопке ОК. Как и при использовании
любой другой формулы, результат вычисления функции помещается в активную
ячейку.

Ш| Если нужной вам функции в списке строки формул не окажется, выберите
™Л в этом списке пункт More Functions (Другие функции), вследствие чего будет
открыто окно Insert Functions (Мастер функций) (рис. 5,17). Открыть это окно
можно и другим способом, а именно нажав кнопку Insert Function (Вставка функ-
ции) строки формул или вызвав команду Insert» Function (Вставка > Функция),

Insert Function

.Type a brief description of what you want to do and then
IllldckGo

1

ACOS
ACOSH
ADDRESS
AND
AREAS
ASIN

ftDSCnumber)

4t?U.rns the absolute value of f 'Wnl^-i, a'numbs ^ ."> I'-:-I->T

' !

Рис. 5.17. Диалоговое окно Insert Function

Все функции Excel сгруппированы по категориям, имена которых отображаются
в списке Or select a category (Категория). К категории Most Recently Used (10 недав-
но использовавшихся) относятся, как вы догадались, 10 функций, доступ к кото-
рым возможен из панели формул.

В поле Select a function (Выберите функцию) отображается перечень функций вы-
бранной категории. Если в списке категорий указан элемент АИ (Все), все функ-
ции в перечне приведены в алфавитном порядке. В нижней части окна дается
краткое описание выделенной функции и приводится ее синтаксис. Если этих
данных недостаточно, щелкните здесь же на ссылке Help on this function (Справка
по этой функции) или нажмите клавишу F1, и на экране появится окно справоч-
ной подсистемы с более полной информацией (рис. 5.18).

Если вы не знаете названия требуемой функции, ее можно найти, введя в поле
Search for a functions (поиск функции) диалогового окна Insert Function (Мастер
функций) краткое описание выполняемых ею действий и нажав кнопку Go (Най-
ти), после чего в поле Select a function (Выберите функцию) появится список всех
подходящих функций.
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J Microsoft tucel Help

т Show fill

SUM

See Alsp

Acids all the numbers in a range of cells.

Syntax

5UM( n umber 1, numberZ, ..,)

Number 1, number2, ... are 1 to 30 arguments for which you
want the total value or sum,

Remarks

• Numbers, logical values., and text representations of
numbers that you type direcdy Into the Sst of arguments are
counted, 5ee the first and second examples following.

• If an argument is an array or reference, only numbers In
that array or reference are counted. Empty cefls, logical
values;, text, or error values n the array or reference are
ignored. See the third example folowing.

• Arguments that are error values or text that cannot be
translated into numbers cause errors.

Example

The example may be easier to understand if you copy it to a
blank worksheet.

I" How?

Рис. 5.18. Окно со справочной информацией о функции

Выбрав нужную функцию, щелкните на кнопке ОК, и на экране появится уже зна-
комое вам диалоговое окно Function Arguments (Аргументы функции), предназна-
ченное для ввода аргументов.

Использование функций

1. Выберите ячейку, в которую нужно поместить результат.

2. Введите в ячейку или строку формул знак равенства.

3. Выберите требуемую функцию из раскрывающегося списка функций
в левой части строки формул.

ИЛИ

Если нужной функции в списке не окажется, выберите пункт More
Functions (Другие функции) либо щелкните на кнопке Insert Function
(Вставка функции) строки формул и, когда откроется диалоговое окно
Insert Function (Мастер функций), укажите в верхнем списке нужную
категорию, а в нижнем — функцию. Щелкните на кнопке ОК.

4. В диалоговом окне Function Arguments (Аргументы функции) введите
аргументы функции. При необходимости щелкните на кнопке свора-
чивания диалогового окна, затем выделите ячейки, которые надо вклю-
чить в аргумент. Для того чтобы вернуться в окно ввода аргументов,
щелкните на кнопке развертывания.

5. По завершении ввода аргументов щелкните на кнопке ОК.
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Использование функции автосуммирования

j. При выполнении экономических и технических расчетов часто возникает
« потребность в вычислении суммы некоторых значений. Excel предлагает бы-

стрый способ суммирования содержимого нескольких ячеек строки или столбца
с помощью кнопки AutoSum (Автосумма), расположенной на стандартной панели
инструментов. Пользователю нужно лишь выделить ячейки строки или столбца
с числами, которые необходимо сложить (при этом можно выделить и пустую
ячейку, предназначенную для размещения результата суммирования), и щелк-
нуть на кнопке AutoSum (Автосумма). Программа просуммирует значения и по-
местит результат в первую пустую ячейку справа или снизу (независимо от того,
была ли она предварительно выделена).

СОВЕТ Чтобы отделить результат от исходных значений пустой ячейкой, включите
в выделенный диапазон две такие ячейки. Программа всегда помещает ре-
зультат в последнюю пустую ячейку.

Для того чтобы вычислить сумму значений ячеек, которые расположены в не-
скольких строках или столбцах, сначала их следует выделить, а затем щелкнуть
на кнопке AutoSum (Автосумма).

Суммирование значений ячеек строк или столбцов
с помощью кнопки AutoSum
1. Выделите ячейки, значения которых подлежат суммированию, а также

пустую ячейку строки или столбца, в которой будет размещаться ре-
зультат.

2. Щелкните на кнопке AutoSum (Автосумма) стандартной панели инст-
рументов.

Кнопку AutoSum (Автосумма) можно использовать не только для суммирования
значений, но и для быстрого вызова других часто используемых функций, а имен-
но Count N u m s (Количество чисел), Average (Среднее), Count (Количество значе-
ний), Мах (Максимум) и Min (Минимум). Для получения доступа к функциям
щелкните на стрелке, которая расположена рядом со значком AutoSum (Автосум-
ма). При выборе в открывшемся списке пункта More Functions (Другие функции)
открывается окно Insert Function (Мастер функций).

Стандартные функции Excel

Все используемые в Excel функции в зависимости от их назначения делятся на
десять категорий. Перечень этих категорий с указанием операций, которые вы-
полняют относящиеся к ним функции, приведен в табл. 5.3.
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Таблица 5.3. Функции в Excel

Категория Назначение функций

Financial
(Финансовые)

Date &Time
(Дата и время)

Math &Trig (Математические
и тригонометрические)

Statistical
(Статистические)

Lookup & Reference
(Ссылки и массивы)

Database
(Работа с базой данных)

Text
(Текстовые)

Logical
(Логические)

Information
(Информационные)

Engineering
(Инженерные)

Вычисляют процентные ставки, ежемесячные отчисления,
амортизационные отчисления

Возвращают в различных форматах день недели, время
и дату

Определяют абсолютные величины, косинусы и логарифмы

Вычисляют средние значения, наибольшее и наименьшее
числа в диапазоне, коэффициенты распределения
Стьюдента; тестируют на предмет независимости выборок

Вычисляют и возвращают значения из диапазона; создают
гиперссылки для веб-документов

Выполняют различного рода анализ данных, находящихся
в списках или базах данных

Преобразуют регистр текста, обрезают символы с правого
или левого конца текстовой строки, объединяют текстовые
строки

Вычисляют выражения и возвращают значения True
(ИСТИНА) или False (ЛОЖЬ), которые используются
при выполнении другого действия или форматирования

Возвращают в Windows информацию о текущем статусе
ячейки, объекта или среды

Выполняют операции с комплексными переменными,
преобразования из одной системы счисления в другую
и т. д. (Входят в состав Office 2003, но должны
устанавливаться отдельно, с помощью надстройки Data
Analysis)

Если нужная функция недоступна, следует установить надстройку Data Analysis
(Пакет Анализа) и включить ее с помощью диспетчера надстроек.

Вложенные функции

Мы уже говорили о том, что функции могут быть вложенными, то есть одна
функция может служить аргументом другой. А теперь речь пойдет о применении
вложенных функций. Рассмотрим таблицу, содержащую информацию о темпера-
туре воздуха в некоторых городах мира. Рассчитаем среднюю температуру за не-
делю в каждом городе и определим, где она самая низкая. При вводе формул
удобно пользоваться кнопкой AutoSum (Автосумма). Введем с ее помощью в ячей-
ку 15 формулу =AVERAGE(B5:H5). После копирования данной формулы в ячейки
16:18 в столбце I получим средние значения температур во всех городах.

Чтобы определить, в каком городе за этот период наблюдалась самая низкая
средняя температура, в ячейку 110 следует ввести формулу =МIN(15:18). Таким об-
разом, задача решается в два этапа: сначала рассчитываются средние значения,
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а затем среди них ищется минимальное. Пользуясь вложенными формулами, рас-
чет можно выполнить в один прием. Для этого в ячейку НО нужно ввести следую-
щую формулу:

=MIN(AVERAGECB5:H5);AVERAGECB6:H6);AVERAeECB7:H7);AVERAGE(B8:H8)}

и

D I

(Рим

; Понедельник Вторник Среда Четверг '. Пятница Сойота : Воскресенье: Среднняя-
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Рис. 5.19. Таблица сданными о температуре воздуха в различных городах мира

I ПРИМЕЧАНИЕ Формируя вложенные функции, следует учитывать, что первой вычисляется
функция, указанная во внутренних скобках.

На следующем рисунке представлена вложенная формула, в которой использует-
ся логическая функция IF (ЕСЛИ). С ее помощью мы определяем, в каком городе
наблюдалась самая низкая средняя температура за неделю (формула отображает-
ся в строке формул).
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Предлагаем читателю разобраться в механизме работы этой формулы самостоятель-
но, основываясь на приведенном ниже описании синтаксиса функции IF (ЕСЛИ):

1Р(логическое_выражение;эначение_если_ИСТИНА:значение_если_ЛОЖЬ)

Функция возвращает значение, находящееся во втором аргументе, если логиче-
ское выражение в первом аргументе истинно, или значение, находящееся в третьем
аргументе, — в противном случае.

Существует ряд задач, для решения которых необходимо использовать вложен-
ные функции. К их числу относятся и такие, которые при вычислениях требуют
округления значений. Для выполнения этой операции в Excel предназначена
функция ROUND (ОКРУГЛ). В одном из ее аргументов задается количество деся-
тичных разрядов результата:

RQIMK число; количество_цифр)

На представленном ниже рисунке показано, как с помощью этой функции избе-
жать описанной ранее ситуации, когда при сложении двух чисел, равных 2,3, на
экране в качестве результата отображается значение 5. В ячейки В2 и ВЗ введено
значение 2,3, а формула, находящаяся в ячейке В4, представлена в строке формул.

Самостоятельная работа
1. Пользуясь специальной функцией, рассчитайте среднемесячную выручку, до-

лученную от продажи видеокарты каждого типа. Введите нужную функцию
сначала с клавиатуры, а затем с использованием строки формул.

2. В таблице с данными о температуре определите, какая максимальная темпера-
тура была зафиксирована в течение недели.

Ошибки в формулах

Как вы, наверное, уже заметили, результатом вычисления формулы, в процессе
ввода которой были допущены ошибки, является значение ошибки. Однако Excel
может распознать далеко не все ошибочные ситуации. Например, если непра-
вильно указан порядок выполнения операций, формула все равно будет вычисле-
на, так как формальных ошибок при записи ее компонентов допущено не было.
Чтобы легче было найти логическую ошибку, можно установить для рабочего
листа режим отображения формул, а не результатов, как это описано в разделе
«Отображение формул».
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Если при вводе формулы в ней обнаружена ошибка и Excel может предложить
способ ее исправления, на экран выводится окно, в котором описано, как это
можно сделать. Пользователь должен лишь принять предложение программы
или, наоборот, отвергнуть его. Подобным образом можно исправлять ошибки,
обусловленные, предположим, вводом лишней скобки или знака операции. Окно,
которое появляется на экране при наличии ненужного знака операции, представ-
лено на следующем рисунке.

В верхнем левом углу ячейки, где могут содержаться ошибки, появляется зеле-
ный треугольник. Если эту ячейку выделить, рядом с ней отобразится кнопка
Trace Error (Источник ошибки). Когда на данную кнопку помещается указатель
мыши, появляются описание предполагаемой ошибки и стрелка для открытия
меню действий кнопки. После щелчка на стрелке открывается список команд,
предназначенных для проверки и исправления ошибок. Набор команд зависит от
типа ошибки.

Help on this error

Show Calculation Steps...

Ignore Error

Edit in Formula Bar

Error Checking Options...

Show Formula Auditing Toolbar



154 Урок 5 • Формулы и функции

Типы ошибок
Значение ошибки зависит от типа ошибки, допущенной в формуле. Первым сим-
волом значения ошибки является диез (#), за ним следует текст. Этот текст мо-
жет завершаться восклицательным знаком или знаком вопроса. Ниже вы найдете
описание всех значений ошибок.

Это значение ошибки выводится в тех случаях, когда ширина столбца недоста-
точна для размещения результатов вычисления формулы и когда полученные
значения даты или времени являются отрицательными числами.

Меры по устранению ошибки. Увеличьте ширину ячейки или установите число-
вой формат, позволяющий поместить значение в ячейку начальной ширины. Если
полученные в результате вычисления формулы значения даты и времени являют-
ся отрицательными, то следует проверить правильность формулы и либо испра-
вить ее, либо назначить для представления итогового значения другой формат.

tfREF! (#ССЫЛКА!)
Это значение ошибки свидетельствует о том, что формула содержит ссылку на
несуществующие (например, удаленные) ячейки. Такие ошибки часто возникают
после создания внешних ссылок или ссылок на другой лист рабочей книги, а так-
же после копирования формул, когда при попытке изменить относительную ссыл-
ку программа создает ссылку на несуществующую ячейку.

Меры по устранению ошибки. Проверьте, правильно ли указан путь к документу
и введено его имя, не был ли переименован или удален лист, на который имеется
внешняя ссылка.

ftDIV/О' (ЯДЕЛ/0!)
Это значение ошибки появляется при делении на нуль (например, когда после
создания ссылки удаляется содержимое ячейки, адрес которой указан в знамена-
теле).

Меры по устранению ошибки. Проверьте содержимое влияющей ячейки. Если
в ней не хранится никакое значение, введите его. Попытайтесь установить причи-
ну удаления содержимого ячейки.

ftNUM! (ЯЧИСЛО!)

Это значение ошибки появляется в случае нарушения правил при задании опера-
ций, принятых в математике, или в результате некорректного определения аргу-
ментов функции (например, если в качестве аргумента функции, вычисляющей
квадратный корень, указано отрицательное значение). Причиной появления ошиб-
ки может послужить то обстоятельство, что результат вычислений выходит за до-
пустимый для Excel диапазон значений или что функция, использующая итера-
цию, не может рассчитать результат.

Меры по устранению ошибки. Уточните с помощью справочной подсистемы, ка-
ким требованиям должны отвечать аргументы функции, и проверьте, соответст-
вуют ли значения в зависимых ячейках этим требованиям.
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#NAME? (#ИМЯ?)

Данное значение ошибки указывает на то, что при вводе имени допущена ошибка
и программа не может найти нужное имя ни среди имен функций, ни среди имен
диапазонов. Сообщение об ошибке появляется и в том случае, если текстовое зна-
чение в формуле не заключено в кавычки или если в ссылке на диапазон отсутст-
вует символ двоеточия.

Меры по устранению ошибки. Проверьте правильность написания имени функ-
ции или введите функцию заново с помощью панели формул. Если речь идет об
имени диапазона ячеек, проверьте, присвоено ли указанное имя диапазону.

#NULL! (ЯПУСТО!)

Программа выдает это значение ошибки при неверном указании пересечения диа-
пазонов, то есть если указанные диапазоны не имеют общих ячеек.

Меры по устранению ошибки. Проверьте, правильно ли указаны диапазоны ячеек.

#N/A (#Н/Д)
Это значение ошибки появляется, когда не заданы один или несколько аргумен-
тов функции и когда происходит обращение к недоступной пользовательской
функции. Ошибку могут генерировать макрос, который вызывает функцию, воз-
вращающую данное значение ошибки, а также некоторые функции, если для них
задан недопустимый аргумент.

Пользователь может специально ввести во влияющую ячейку значение #Н/Д, ко-
торое отобразится в итоговой ячейке, — для указания того, что в таблицу еще бу-
дут вводиться данные.

Меры по устранению ошибки. Проверьте содержимое ячеек, адреса которых ис-
пользуются как аргументы, а также пользовательские функции и макросы.

#VALUE! (#ЗНАЧ!)

В случае ввода аргумента или операнда недопустимого типа программа выдает
значение ошибки #VALUE! (#ЗНАЧ!).

Меры по устранению ошибки. Проверьте, являются ли операнды и аргументы
используемого типа допустимыми.

Исправление ошибок
В результате двойного щелчка на ячейке с формулой, адреса всех указанных в фор-
муле ячеек и диапазонов выделяются определенным цветом, а вокруг этих ячеек
появляется рамка диапазона такого же цвета. Применение различных цветов для
выделения ссылок и указанных в формуле ячеек упрощает поиск ошибок: вы сра-
зу сможете определить, данные из каких ячеек используются в формуле и имеет-
ся ли в этих ячейках нужная информация.



156 Урок 5 • Формулы и функции

Внести изменение в ссылку на ячейку в формуле можно с помощью клавиатуры
или мьшш. Пользуясь клавиатурой, сначала нужно выделить подлежащую заме-
не ссылку, а затем либо щелкнуть на другой ячейке, либо ввести новый адрес.
Если в ссылке на ячейку нужно изменить лишь обозначение строки или столбца,
выделите этот элемент адреса и введите вместо него новый.
При использовании мыши ссылку в формуле можно изменить, переместив мар-
кер диапазона в нужную ячейку. Для увеличения или уменьшения заданного
в формуле диапазона ячеек применяются маркеры заполнения, находящиеся в уг-
лах рамки диапазона. При перемещении маркеров диапазона указатель мыши
должен принять вид двунаправленной черной стрелки. Завершив редактирова-
ние формулы, нажмите клавишу Enter на клавиатуре или щелкните на кнопке
Enter (Ввод) в строке формул.

Отслеживание зависимостей
Для поиска ошибок Excel предоставляет в распоряжение пользователей вспомо-
гательную функцию, с помощью которой можно графически представить связи
между влияющими и зависимыми ячейками. Влияющими называют ячейки, дан-
ные которых оказывают влияние на значение текущей ячейки. Зависимой являет-
ся ячейка с формулой, результат вычисления которой зависит от данных, находя-
щихся в других ячейках. Ниже на рисунке показаны влияющие ячейки для ячейки
110, которая является зависимой.

L; Nictosoft Offiri: Excel 2003 -
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Стрелки в данном случае начинаются во влияющих ячейках и указывают на теку-
щую. Как отображаются зависимые ячейки в том случае, когда текущая ячейка
является влияющей, показано на следующем рисунке. Вы видите, что теперь
стрелки начинаются в текущей ячейке и указывают на зависимые ячейки.

Понедельник] ВТОРНИК Среда ; Четверг Пятница | Суббота : Воскресенье | Среднняя

Команды для отслеживания таких зависимостей вызываются из подменю Formula
Auditing (Зависимости) меню Tools (Сервис), а также с помощью кнопок панели
инструментов Formula Auditing (Зависимости), представленной на рис. 5.20.

Рис. 5.20. Панель инструментов Formula Auditing

Чтобы открыть данную панель, следует воспользоваться командой Tools > Formula
Auditing > Show Formula Auditing Toolbar (Сервис > Зависимости формул > Панель
зависимостей). Описание кнопок панели приведено в табл. 5.4.

Обнаружение влияющих и зависимых ячеек
1. Выделите ячейку, для которой необходимо установить зависимости.

2. Вызовите команду Tools > Formula Auditing ^ Trace Dependents (Сервис >
Зависимости формул > Зависимые ячейки) при необходимости опре-
делить зависимые ячейки.

3. Для обнаружения влияющих ячеек воспользуйтесь командой Tools >
Formula Auditing > Trace Precedents (Сервис > Зависимости формул > Влия-
ющие ячейки).



158 Урок 5 * Формулы и функции

Таблица 5.4. Кнопки панели инструментов formula Auditing

Кнопка Название Описание

Error Checking
(Проверка наличия ошибок)

Trace Precedents
(Влияющие ячейки)

Remove Precedent Arrows (Убрать
стрелки к влияющим ячейкам)

Trace Dependents
(Зависимые ячейки)

Remove Dependent Arrows (Убрать
стрелки к зависимым ячейкам)

Remove AIL Arrows
(Убрать все стрелки)

Trace Error
(Источник ошибок)

New Comment
(Создать примечание)

Circle Invalid Data
(Обвести неверные данные)

Clear Validation Cirlces (Удалить
обводку неверных данных)

Show Watch Window (Показать
окно контрольного значения)

Evaluate Formula
(Вычислить формулу)

Открывает одноименное окно,
предназначенное для поиска и обработки
ошибок

Отображает стрелки зависимостей
от влияющих ячеек к текущей

Удаляет стрелки зависимостей от влияющих
ячеек к текущей

Отображает стрелки от текущей ячейки
к зависимым

Удаляет стрелки от текущей ячейки
к зависимым

Удаляет все стрелки зависимостей
на рабочем листе

Отображает стрелки зависимостей
от текущей ячейки к источнику ошибок

Позволяет ввести примечание к ячейкам

Задает обводку ячеек, содержащих данные,
которые противоречат установленным
ограничениям

Удаляет обводку некорректных данных

Открывает окно Watch Window (Окно
контрольного значения), позволяющее
просмотреть и оценить содержимое ячеек

Открывает одноименное окно, в котором
можно произвести оценку как формулы
в целом, так и отдельных ее частей

На панели зависимостей есть кнопка Error Checking (Проверка наличия ошибок),
после выбора которой открывается окно, содержащее описание ошибки, и кноп-
ки, позволяющие перейти в режим ее исправления, а также просмотреть другие
ошибки (рис. 5.21).

Функция отслеживания зависимостей позволяет графически обозначить связи
между влияющими и зависимыми ячейками, расположенными как на одном, так
и на разных листах. Если ячейка, зависимая от активной ячейки, находится на
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другом листе или в другой книге, она обозначается маленьким изображением
таблицы. В результате выполнения двойного щелчка на линии связи открывается
диалоговое окно Go To (Переход), в котором содержится ссылка на зависимую
ячейку. Если вы хотите отредактировать содержимое зависимой ячейки, выдели-
те в этом диалоговом окне соответствующую ей ссылку и нажмите кнопку О К,
вследствие чего произойдет переход в зависимую ячейку.

Error Checking

..,,. | ; Ц

• . . |

Рис. 5.21. Диалоговое окно Error Checking

Циклические ссылки
О циклической ссылке говорят в том случае, когда существует такая последова-
тельность ссылок, при которой формула в ячейке через другие ссылки или напря-
мую ссылается сама на себя. При наличии циклической ссылки программа не мо-
жет выполнить расчеты и отображает окно, показанное ниже.

Microsoft Енсе!
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Для работы с циклическими ссылками в Excel предусмотрена специальная па-
нель Circular Reference (Циклические ссылки). Для того чтобы отобразить ее, нуж-
но выбрать команду Tools > Customize (Сервис > Настройка) и на вкладке Toolbars
(Панели инструментов) установить флажок, расположенный слева от названия
данной панели.

Циклическая ссылки и панель Circular Reference (Циклические ссылки) продемон-
стрированы на рис. 5.22. Как видите, в строке состояния отображается слово
Circular (Цикл), за которым следует ссылка на одну из ячеек, образующих цикли-
ческую ссылку. Если слово Circular (Цикл) отображается без ссылки, то данная
циклическая ссылка указывает не на текущий лист.
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I

Просмотр и исправление циклических ссылок
1. На панели инструментов Circular Reference (Циклические ссылки) от-

метьте в списке Navigate Circular Reference (Найти циклическую ссылку)
первую ячейку.

2. Проверьте формулу, которая находится в этой ячейке. Если она не яв-
ляется причиной возникновения ошибки, выберите в списке следую-
щую ячейку.

3. Продолжайте проверку и, если нужно, правку формул до тех пор, пока
в строке состояния отображается слово Circular (Цикл).

Рис. 5.22. Циклическая ссылка на рабочем листе

Установка ограничений при вводе данных
Чтобы избежать появления ошибок при вводе данных в таблицу, для отдельных
ячеек можно установить ограничения на допустимые значения. Ограничения мо-
гут накладываться как на тип представляемых в ячейке данных, так и на диапазон
возможных значений. Пользователь должен выделить ячейки, вызвать команду
Data * Validation (Данные > Проверка) и выбрать в открывшемся окне Data Vali-
dation (Проверка вводимых значений) вкладку Settings (Параметры), изображен-
ную на рис. 5.23.

Прежде всего нужно определить допустимый тип данных в поле Allow (Тип дан-
ных). В поле Data (Значение) необходимо выбрать критерий проверки: greater
then (больше), not equal to (не равно) и т. д. В остальных полях (их количество за-
висит от критерия) должны быть установлены граничные значения.

На вкладке Input Message (Сообщение для ввода) следует ввести текст сообщения,
которое должно появляться на экране при активизации ячейки, на которую нало-
жены ограничения. Вкладка Error Alert (Сообщение об ошибке) предназначена для
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ввода сообщения, сигнализирующего об обнаружении ошибки, допущенной при
вводе данных.

Data Validation

'Settings'

. . • ' . • '

!

Рис. 5.23. Вкладка Settings окна Data Validation

В ячейках, на которые наложены ограничения, ошибочные данные могут поя-
виться в результате вычисления формулы. Чтобы найти такие ячейки, необходи-
мо, активизировав панель инструментов Formula Audit ing (Зависимости), щелк-
нуть на кнопке Circle Invalid Data (Обвести неверные данные). В результате ячей-
ки, содержащие некорректные значения, будут обведены рамкой.

Самостоятельная работа
1. В таблице с данными об объемах продаж видеокарт найдите все ячейки, содер-

жимое которых зависит от курса доллара.

2. Намеренно создайте формулу с циклической ссылкой и исправьте ее.

3. Установите для любой ячейки или диапазона ячеек ограничение на ввод отри-
цательных чисел.

Подведение итогов

В этом уроке мы научились:
i

0 создавать формулы;

0 использовать относительные и абсолютные ссылки;

0 применять формулы массива;

0 присваивать ячейкам имена и затем использовать таковые в формулах;

0 вызывать функции и применять их в формулах;

0 обнаруживать и исправлять ошибки в формулах;

0 отслеживать зависимости;

0 задавать ограничения на вводимые данные.

б Ззк. 345
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Большие массивы информации обычно хранятся в виде базы данных и обрабаты-
ваются специальными программами. В Excel аналогом простой базы данных яв-
ляется список. Он представляет собой группу строк, содержащих связанные дан-
ные. Отличительная особенность списка заключается в том, что каждый его
столбец содержит однотипные данные. Если провести аналогию между списком
и базой данных, то можно сказать, что столбцы списка являются полями базы
данных, а его строки — записями.

Классическим примером списка может служить список сотрудников, в котором
указаны их фамилии и имена, должности, даты рождения и другая информация
(рис. 6.1).
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Рис. 6.1. Таблица-пример

Предлагаемые Excel средства работы со списками значительно облегчают выпол-
нение рутинных операций по сортировке данных и поиску нужной информации.
Полученные при этом результаты можно использовать в расчетах. Например,
сначала можно задать поиск определенных значений в списке, а затем произвести
с этими значениями вычисления или создать на их основе диаграмму.

Таблицы-списки обрабатываются подобно обычным таблицам, то есть редакти-
рование данных в них осуществляется с помощью общеизвестных команд. Суще-
ствуют и специальные средства для работы со списками, которые предоставляют
пользователям дополнительные возможности. Так, над списком, рассматривае-
мым в качестве примера (см. рис. 6.1), можно произвести следующие операции:
включить в него новые адреса или удалить старые, найти в нем определенную ин-
формацию по заданным критериям.

Создание и заполнение списков
Прежде чем приступать к созданию списка, необходимо тщательно продумать его
структуру и определить, какие данные должны быть в него включены. Начинать
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нужно с формирования заголовков столбцов. Символы используемого в заголов-
ках шрифта должны быть другого цвета или иметь характерное начертание, на-
пример полужирное или курсивное. Если заголовки оформлены по-другому, про-
грамма автоматически определяет, что создается список, и оказывает помощь в его
заполнении.

Порядок ввода записей в список большой роли не играет, потому что для их упо-
рядочения достаточно выполнить несколько щелчков мышью. Все записи долж-
ны быть оформлены одинаково, но не так, как заголовки столбцов. При вводе
данных не следует добавлять пустые строки, строки, состоящие из символов де-
фиса или символов подчеркивания, поскольку это может затруднить в дальней-
шем сортировку и фильтрацию данных.

СОВЕТ Вводить данные в большую таблицу намного легче, если заголовки столбцов
видны на экране. Чтобы положение заголовков при просмотре таблицы не
изменялось, закрепите их выполнив команду Window > Freeze Pane (Окно t
Закрепить области).

Как уже было сказано, Excel распознает списки автоматически. Если необходимо,
предположим, отсортировать записи списка по определенному критерию, доста-
точно поместить указатель ячейки в ячейку внутри списка, и после активизации
функции сортировки Excel автоматически выделит весь список.

ВНИМАНИЕ При автоматическом определении (и выделении) списка признаком его кон-
ца является первая пустая строка. Поэтому следуетудалить из списка пустые
строки или выделить вручную ячейки, к которым должны быть применены
функции списка. Эти функции нельзя использовать, если выделены несмеж-
ные ячейки. ,

При автоматическом выделении области списка Excel сравнивает содержимое
первой и второй его строк. Если данные в этих строках различаются по типу или
по оформлению, программа воспринимает первую строку в качестве заголовков
столбцов и не обрабатывает ее. Но если при вызове команды Form (Форма) или
Subtotals (Итоги) из меню Date (Данные) Excel не обнаружит различий между за-
писями первой и второй строк, на экране появится сообщение о невозможности
найти названия для создания заголовков столбцов.

В таком случае программа выдаст запрос о том, следует ли использовать в качест-
ве заголовков столбцов данные первой строки выделенного диапазона ячеек. Вы
можете создать заголовки столбцов, щелкнув на кнопке ОК, или не делать этого.

Использование функции автозаполнения

При формировании списка, который содержит повторяющиеся значения, целесо-
образно применять функцию автозаполнения. Для ее включения на вкладке Edit
(Правка) диалогового окна Options (Параметры) необходимо установить флажок
Enable AutoComplete for cell values (Автозаполнение значений ячеек).

Когда функция автозаполнения активна, при вводе текста в ячейку программа
таблицы Excel проверяет содержимое других ячеек данного столбца. Если в них
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находится текст, первые символы которого совпадают с символами, введенными
пользователем, ввод данных завершается автоматически.

8] Ермолаева ; Надежда ; Координатор

103арубин Александр Водитель
11 [Козлов -Борис Водитель

Нажмите клавишу Enter, чтобы подтвердить необходимость ввода предложенного
программой текста. Но если он вам не подходит, проигнорируйте предложение
Excel и продолжайте самостоятельно вводить в ячейку необходимые данные.

Диалоговое окно формы данных
Значительно упростит вашу работу со списками диалоговое окно формы данных,
предназначенное для ввода и обработки информации. В этом окне находятся не-
сколько полей ввода, названия которых соответствуют заголовкам столбцов спи-
ска. Окно формы данных позволяет произвести поиск нужной информации, до-
полнить список новыми записями, удалить ненужные, а также отредактировать
имеющиеся.

Открывается диалоговое окно формы данных с помощью команды Data > Form
(Данные > Форма), после того как пользователь помещает указатель ячейки в лю-
бую позицию списка. В заголовке этого окна указывается имя текущего рабочего
листа (рис. 6.2).

Дата приема ни работу;- 15.11.199

Рис. 6.2. Форма данных

(ПРИМЕЧАНИЕ Если первая строка выделенного диапазона ячеек не содержит заголовков
столбцов, то в качестве имен полей в этом диалоговом окне используются
данные первой записи выделенного диапазона.
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В диалоговом окне формы данных также указываются общее количество записей
в списке и позиция текущей записи. Для перехода к нужной записи списка мож-
но воспользоваться полосами прокрутки, кнопками Find Next (Далее) и Find Prev
(Назад), клавишами PgUp и PgDown, а также клавишами управления курсором со
стрелками вверх (t) и вниз (Ф).

Редактирование записей
По умолчанию при отображении записи в диалоговом окне формы данных пер-
вое ее поле выделено и его можно изменять. Редактирование данных выполняет-
ся таким же образом, как и редактирование обычного текста. Для перехода к сле-
дующему полю окна предназначена клавиша Tab, а для возврата к предыдущему -
комбинация клавиш Shift+Tab.

Внесенные в запись изменения сохраняются при переходе к другой записи или
в результате нажатия клавиши Enter. После щелчка на кнопке Close (Закрыть)
диалоговое окно формы данных закрывается, все изменения, выполненные в те-
кущей записи, сохраняются. Отменить внесенные изменения можно с помощью
кнопки Restore (Вернуть) или клавиши Esc. Но если текущая запись не изменя-
лась, эта кнопка недоступна, а нажатие клавиши Esc приводит к закрытию диало-
гового окна формы данных.
Удалить из списка текущую запись позволяет кнопка Delete (Удалить). В этом
случае на экране появляется соответствующее предупреждение.

ВНИМАНИЕ Записи, удаленные с помощью кнопки Delete (Удалить) диалогового окна фор-
мы данных невозможно восстановить, используя команду Edit > Undo (Отме-
нить > Правка).

Если в спсок вставляется новая запись, необходимо щелкнуть на кнопке New (До-
бавить). Поля диалогового окна очистятся, и в них можно будет вводить данные.
После завершения операции ввода следует нажать клавишу Enter, и новая запись
появится в списке.

Поиск записей
При поиске определенных записей с помощью формы данных используются кри-
терии поиска. Чтобы выделить в нашем списке (см. рис. 6.1), скажем, всех сотруд-
ников с именем Ольга, следует воспользоваться кнопкой Criteria (Критерии), в ре-
зультате нажатия которой на экране появляется пустая форма данных. Введите
в поле Имя в качестве критерия слово Ольга (рис. 6.3). нажмите кнопку Find Next
(Далее), и в диалоговом окне отобразится первая запись, соответствующая задан-
ному критерию. Просмотреть все записи, удовлетворяющие определенному кри-
терию, можно с помощью кнопок Find Next (Далее) и Find Prev (Назад).

СОВЕТ Прежде чем начинать поиск записей по определенному критерию, сделайте
™" первую запись списка текущей. В противном случае придется следить за тем,

в каком месте списка вы находитесь, и в зависимости от этого постоянно
пользоваться кнопками Find Next (Далее) и Find Prev (Назад).
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Рис. 6.3. Критерий поиска задан

В описанном выше примере информация, используемая в качестве критерия по-
иска, была известна изначально. Если же необходимо найти, например, фамилию,
из которой вы знаете только начальную букву, то, задавая критерии, следует при-
менять символы подстановки: звездочку (*) — для замены произвольного коли-
чества неизвестных символов и знак вопроса (?) — для замены одного неизвест-
ного символа.

Например, если нужно отыскать данные обо всех сотрудниках, фамилии которых
начинаются с буквы «К», в качестве критерия поиска в поле Фамилия следует вве-
сти К*. Если вы сомневаетесь в правильности только одного символа (буквы),
введите в качестве критерия поиска знак вопроса (?). Данный символ подстанов-
ки можно указать в критерии несколько раз, определив таким образом точное ко-
личество неизвестных символов.

При работе с числовыми значениями в критериях поиска можно использовать
операторы сравнения, а именно: = (равно), < (меньше), > (больше), <> (не равно),
<- (меньше или равно), >= (больше или равно). Например, для проведения поиска
в списке, содержащем данные о сбыте товара, в качестве критерия можно задать
диапазон значений, указав максимальное и минимальное из них. В этом случае
будут выданы только записи, значения соответствующих полей которых находят-
ся в указанном интервале. Чтобы сузить область поиска, критерии можно ввести
в нескольких полях.

Самостоятельная работа
1. Создайте список, подобный приведенному на рис. 6.1. Несколько записей вве-

дите вручную, а остальные — с помощью диалогового окна формы данных.

2. Отобразите в диалоговом окне формы данных записи, относящиеся к сотруд-
никам, которые работают на должности менеджера.

3. Удалите одну из таких записей и добавьте запись о сотруднике, который зани-
мает должность водителя.
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Сортировка списков

Необходимость сортировки записей в списках может возникнуть при выполне-
нии самых различных задач, например, при поиске в длинном прайс-листе более
дешевых товаров или в процессе группировки записей о продажах, относящихся
к одному менеджеру. Сортировать можно как числовые, так и текстовые данные.
Причем текстовые данные сортируют в алфавитном порядке (от А до Z или от Z
до А), а числовые — либо в порядке убывания, либо в порядке возрастания.

Сортировка строк
По умолчанию строки выделенного списка сортируются по содержимому одного
из столбцов, но существует возможность отсортировать список по содержимому
двух и даже трех столбцов одновременно. При использовании функций списка
Excel выделит список автоматически. Однако пользователь может и самостоя-
тельно перед вызовом команды сортировки предварительно выделить диапазон
ячеек, подлежащих сортировке.

Критерии сортировки устанавливаются в диалоговом окне Sort (Сортировка диа-
пазона), показанном на рис. 6.4, которое вызывается командой Data к Sort (Дан-
ные > Сортировка).

'•••ly ii-Д his

Рис. 6.4. Окно для определения критериев
и уровней сортировки

Если яервая стро:ка выделенного диапазона содержит заголовки столбцов, то, для
того чтобы исключить ее из числа строк, подлежащих сортировке, следует уста-
новить в области My list has (Идентифицировать поля по) флажок Header row (под-
писям (первая строка диапазона)). Флажок No header row (обозначениям столбцов
листа) этой области позволяет выполнить сортировку с учетом данных первой
записи выделенного диапазона ячеек.
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Столбец, содержимое ячеек которого подлежит сортировке, выбирается в поле
списка области Sort by (Сортировать по). Здесь же следует задать порядок сорти-
ровки — Ascending (по возрастанию) или Descending (по убыванию). При этом
Excel автоматически определит тип данных — текст или числовые значения. Если
столбец, данные которого сортируются, содержит и текст, и числовые значения,
числовые значения должны предшествовать тексту.

СОВЕТ Если при сортировке в алфавитном порядке следует различать прописные
и строчные буквы, необходимо нажать кнопку Options (Параметры). В резуль-
тате откроется диалоговое окно Sort Options (Параметры сортировки), в ко-
тором нужно установить флажок Case sensitive (Учитывать регистр). Более
подробно об этом окне рассказывается в следующем разделе.

Сортировка строк диапазона
1. Установите указатель ячейки в область списка или выделите в нем об-

ласть, подлежащую сортировке.
2. Вызовите команду Data > Sort (Данные > Сортировка), после чего откро-

ется диалоговое окно Sort (Сортировка диапазона).
3. Выберите столбец, данные которого будут использоваться при сорти-

ровке, задайте порядок сортировки — Ascending (по возрастанию) или
Descending (по убыванию), а затем нажмите кнопку ОК.

На рис. 6.5 показан список, отсортированный по фамилиям сотрудников. Заго-
ловки при сортировке столбцов не учитывались.

Фамилия
6|Гаврилова
4] Дмитриев
З.Ермрлаева
3 Жуков

10||арубин
9]№1именко__

j5j Коваленко
ifj Км лов
JJOpnoB

[Имя [Должность
0льга [Кассир .

[Олег [Менеджер
[Надежда Координатор

Дата рожд. : Дата приема на работу... ._...._ ..... ........

^Ле..к£а.нДР :;§9ДЖ®Л,̂
!Менеджеэ
! Секретарь
! Водитель

|0льга_
[Наталья
!Борис

15,10.1970
"Щ5."1977;
''23.p2l"976l
'Ьз'03.198р'
22Х)2'.1979'

СИ.09.2001]
"01Ж2002:
"'шрз^оод!
12'бг:збо2!

_
21Смирнова

; Валентин^ |Врдитель
^тэ№та]&$гагкъ$

^07.1p.19i78| _ 01.05.2001!
03.10/1975!'" "45.fll999j"
I'̂ PAl̂ d '9iL9^2qo2T

05.05^000[

Рис. 6,5. Список, полученный в результате сортировки

A l Z
II д

Сортировку можно производить и с помощью кнопок Sort Ascending (Сор-
тировать по возрастанию) и Sort Descending (Сортировать по убыванию)

стандартной панели инструментов. Если список составлен в соответствии с тре-
бованиями Excel, то для его сортировки по определенному столбцу достаточно
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установить в этом столбце указатель ячейки и нажать нужную кнопку. Если пе-
ред использованием кнопки выделить некоторый диапазон ячеек, при сортировке
будут учитываться данные крайнего левого его столбца.

Сортировка столбцов
По умолчанию выполняется сортировка строк списка. Но можно задать и сорти-
ровку его столбцов. Выделите ячейки, подлежащие 'обработке, и откройте диало-
говое окно Sort (Сортировка диапазона). Посредством щелчка на кнопке Options
(Параметры) откройте диалоговое окно Sort Options (Параметры сортировки) и ак-
тивизируйте в области Orientation (Сортировать) переключатель Sort Left to right
(столбцы диапазона). Указанное окно представлено на рис. 6.6.

Sort Options

Рис. 6.6. Диалоговое окно Sort Options

Создание пользовательского порядка сортировки
Excel предоставляет нам возможность задать собственный порядок сортировки
данных в списке. Откройте диалоговое окно Sort Options (Параметры сортировки),
и вы увидите, что в поле списка First key sort order (Сортировка по первому ключу),
которое содержит все определенные пользователем последовательности, приме-
няемые при сортировке, выделен элемент Normal (Обычная). Откройте этот спи-
сок и, если ни один из предлагаемых вариантов (рис. 6.7) вас не устраивает, соз-
дайте собственный.

Чоп, Tue, Wed, Ti j j Fri, Set, 5urt||
Monday, Tuesday, Wednesday, Tl
Jan, Feb, Mar, Apr, May, Jun,
January, February, March, April, N

Пт, Сб, Be

яне, фев, мар, апр, май, июн,
Январь, Февраль, Март, Апрель!:
Пн, Be. Ср,„Чт, Пт, СГ6, Нл^ .̂ J

Рис. 6.7. Список пользовательских последовательностей сортировки

Выполните команду Tools > Options (Сервис > Параметры) и в появившемся диа-
логовом окне (рис. 6.8) перейдите на вкладку Custom Lists (Списки). В области
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Custom lists (Списки) этой вкладки перечислены возможные последовательности,
используемые при сортировке. Выберите элемент NEW LIST (Новый список), по-
сле чего в поле Listentries (Элементы списка) появится курсор. Введите элементы
списка в нужном порядке, завершая ввод каждого из них нажатием клавиши Enter.

Mon, Tue, Wed, Thu, Fri, Sat,
Monday, Tuesday., Wednesday,
Jan, Feb, Met, Apr, May, Jun, 3|
January, February, Marchj April i'
Пн, Вт, Ср, Чт, Пт, C6, Be jl
Понедельник, Вторник, Средеfl
янв, фее, мар, апр, май, июн,]
Январь, Февраль, Март, Апре'
Пм, ВБ, Ср, Чт, Пт, Сб, Нд
Понедток, BiBTopOK, Середа,

ЙВР

Рис. 6.8. Вкладка Custom Lists диалогового окна Options

Поле Import list from cells (Импорт списка из ячеек) позволяет создать новый спи-
сок с использованием данных таблицы. Поместите курсор ввода в указанное поле,
выделите ячейки, содержащие данные для создаваемого списка, нажмите кнопку
Import (Импорт), и нужный вам список будет создан. А после того как вы нажмете
кнопку Add (Добавить), он будет включен в перечень существующих списков.

Фильтрация данных
Процессы ввода записей в список и удаления из него, а также процесс поиска ин-
формации можно значительно упростить за счет использования фильтров, интег-
рированных в Excel. Преимущество применения фильтров по сравнению с ис-
пользованием формы данных заключается в том, что результаты запроса можно
скопировать в отдельную область таблицы и использовать в вычислениях. Запи-
си, которые не соответствуют заданному критерию, при фильтрации не отобра-
жаются, однако общий порядок их расположения остается прежним.

Функция автофильтра
Функция автофильтра позволяет с помощью определения ряда критериев произ-
водить отбор записей непосредственно в рабочем листе. Вызывается она с помо-
щью команды Data > Filter >AutoFHter (Данные * Фильтр > Автофильтр). Однако
фильтры устанавливаются только в том случае, если указатель ячейки находится
внутри списка.
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В качестве критерия автофильтра можно использовать содержимое любой ячей-
ки, кроме тех, в которых хранятся заголовки столбцов. Чтобы задать в качестве
критерия содержимое какого-либо столбца, щелкните на кнопке со стрелкой
в строке его заголовка и выберите из списка нужный элемент (рис. 6.9).
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Рис. 6.9. Поля списка после активизации функции автофильтра

Если, например, из списка столбца Должность выбрать элемент Менеджер, будут ото-
бражены записи, относящиеся к сотрудникам, которые имеют такую должность,
а в строке состояния появится сообщение о том, сколько записей, отвечающих за-
данному критерию, найдено (рис. 6.10).
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Рис, 6.10. Вид таблицы после применения функции автофильтра по критерию Менеджер
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Отбор записей можно продолжить, задавая критерии в других столбцах. Новый
критерий связывается с предыдущим посредством логического оператора And (И).

В Excel 2003 появилась возможность с помощью функции автофильтра выпол-
нять сортировку записей. Для этого в списке критериев нужно выбрать элемент
Sort Ascending (по возрастанию) или Sort Descending (по убыванию).

Элемент (ALI) (Все) в списке автофильтра позволяет отменить критерий отбора
записей для данного столбца. Отменить все критерии фильтрации для списка
можно с помощью команды Data > Filter > Show All (Данные > Фильтр > Отобразить
все), особенно полезной в том случае, когда задано несколько критериев.

Установив элемент (Тор 10) (Первые 10) в фильтре столбца, содержащего число-
вые значения, можно создать новый список, состоящий из 10 самых больших или
самых малых чисел предыдущего списка (значение 10 устанавливается по умол-
чанию). После выбора элемента (Тор 10) (Первые 10) откроется диалоговое окно
Тор 10 AutoFilter (Наложение условия по списку) с тремя полями ввода. Выбрав
в крайнем левом поле элемент Тор (наибольших) или Bottom (наименьших), мож-
но указать Excel, какие значения предыдущего списка должны быть представле-
ны в новом — максимальные или минимальные. Центральное поле предназначено
для указания количества пунктов, которое должен содержать список. Находя-
щиеся в правом поле диалогового окна Тор 10 AutoFilter (Наложение условия по
списку) элементы Items (элементов списка) и Persent (% от количества элемен-
тов) позволяют установить числовое или процентное ограничение на количество
выводимых на экран элементов списка.

При использовании функции автофильтра можно устанавливать и пользователь-
ские критерии. Откройте поле списка столбца, данные которого вы хотите от-
фильтровать, и выберите элемент (Custom) (Условие). Когда появится диалого-
вое окно Custom AutoFilter (Пользовательский автофильтр), которое вы видите на
рис. 6.11, задайте комплексный критерий, объединив его компоненты с помощью
логического оператора And (И) либо Ог (ИЛИ).

Custom AutoFilter

Рис. 6.11. Диалоговое окно для задания пользовательского автофильтра
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Использование функции автофильтра
1. Установите указатель ячейки в области списка.
2. Затем выберите команду Data > Filter > AutoFilter (Данные > Фильтр >

Автофильтр).
3. Откройте список автофилыра и укажите значение, которое должно ис-

пользоваться в качестве критерия отбора записей.

4. Чтобы отобрать значения столбца с помощью комплексного критерия,
воспользуйтесь элементом Custom (Условие), и в открывшемся диало-
говом окне Custom AutoPilter (Пользовательский автофильтр) определи-
те таковой.

5. При необходимости установите фильтры для других столбцов.
6. Если заданный критерии фильтрации для отдельного столбца нужно

отменить, выберите в списке его фильтров элемент АИ (Все).

7. ЧтоЙы отменить все критерии, воспользуйтесь командой Data > Filter >
Show All (Данные > Фильтр > Отобразить все).

8. При необходимости отключить автофильтр повторно вызовите коман-
ду Data > Filter > AutoFilter (Данные * Фильтр > Автофильтр).

На рис. 6.12 приведен пример таблицы, в которой с помощью пользовательского
автофильтра отобраны записи о сотрудниках, принятых на работу после 1 января
2000 года. При определении фильтра в диалоговом окне Custom AutoFilter (Поль-
зовательский автофильтр) были заданы условие is greater or equal to (больше или
равно) и дата 1/01/2000.
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Рис. 6.12. Результат применения пользовательского автофильтра
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Полученный таким способом список можно вставить в другую позицию рабочего
листа для последующей обработки, использовать при создании диаграммы или
распечатать.

Расширенный фильтр
Критерии фильтрации списка можно определить не только с помощью автофильт-
ра, но и непосредственно на рабочем листе. Преимущество этого способа состоит
в том, что пользователь всегда имеет четкое представление о применяемых кри-
териях и имеет возможность быстро изменять их.

Критерии задаются в отдельной области, которая должна содержать заголовки
столбцов списка. В нашем примере мы вставили в начало таблицы четыре пустые
строки и скопировали строку с заголовками столбцов в первую строку рабочего
листа (рис. 6.13).
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Рис. 6.13. Таблица, подготовленная для вызова команды расширенного фильтра

Теперь в пустые ячейки под соответствующими заголовками столбцов можно
вставить критерии — значения, которые будут использоваться для отбора запи-
сей. Для того чтобы объединить критерии с помощью оператора And (И), укажите
их в одной строке, а для объединения с помощью оператора Or (ИЛИ) представьте
их в различных строках. В случае необходимости вместе с критерием в ячейку
можно ввести оператор сравнения.

ВНИМАНИЕ При определении критерия знак равенства (=} не должен использоваться,
иначе программа воспримет его как формулу и при вводе текста выдаст со-

общение об ошибке.
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Задавая критерии отбора записей для столбцов, содержащих текстовые данные,
в качестве символов подстановки также можно использовать звездочку (*), кото-
рая заменяет любое количество символов, и знак вопроса (?), соответствующий
одному символу.

Например, с помощью критерия, указанного на рис. 6.13, можно отобрать записи
о сотрудниках, которые занимают должность менеджера или водителя и поступи-
ли на работу после 1 января 2000 года.

Для вызова функции расширенного фильтра выберите команду Data > Filter > Ad-
vanced Fitter (Данные > Фильтр > Расширенный фильтр) и, когда откроется диало-
говое окно Advanced Fitter (Расширенный фильтр), укажите диапазон критериев
и диапазон, в котором размещен созданный с помощью фильтра список (рис. 6.14).

Advanced Filter

Рис. 6.14. Диалоговое окно Advanced Filter

Если указатель ячейки находится в области списка, в поле List range (Исходный
диапазон) будут содержаться адреса первой и последней ячеек данного списка.
Фильтруемый список всегда можно определить заново, установив курсор ввода
в поле List range (Исходный диапазон) и выделив с помощью мыши ячейки в ра-
бочем листе. Чтобы задать диапазон ячеек, содержащих критерии, установите кур-
сор ввода в поле Criteria range (Диапазон условий) и отметьте нужные ячейки,
в том числе заголовки столбцов.

X ) ВНИМАНИЕ Указывая диапазон критериев, следует выделять только заполненные строки,
поскольку пустая строка интерпретируется программой как критерий, свя-
занный с другими критериями логическим оператором Ог (ИЛИ). Если диапа-
зон критериев содержит пустую строку (такая строка соответствует любым
данным), в итоговом списке будут представлены все записи исходного списка.

Далее необходимо задать позицию для выбранных записей. По умолчанию в об-
ласти Action (Обработка) установлен переключатель Filter the List in-place (фильт-
ровать список на месте), обеспечивающий фильтрацию путем сокрытия отдель-
ных строк списка. При выборе переключателя Copy to another Location (скопиро-
вать результат в другое место) в поле Copy to (Поместить результат в диапазон)
следует указать адрес ячейки, начиная с которой будут располагаться соответст-
вующие критериям записи. (Заметьте, что для хранения критериев отбора, равно
как для размещения результатов, можно задать другой лист рабочей книги.)
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В случае установки флажка Unique records only (Только уникальные записи) из по-
лученного списка будут исключены записи с повторяющимися элементами.

Использование расширенного фильтра
1. Скопируйте заголовки столбцов в область, которую вы планируете ис-

пользовать для формирования критериев фильтрации. При необходи-
мости путем вставки добавьте нужное количество строк.

2. Ниже строки с заголовками задайте критерии фильтрации.
3. Установите указатель ячейки в область списка и выберите команду

Data > Filter > Advanced Filter (Данные > Фильтр > Расширенный фильтр).

4. В окне Advanced Filter (Расширенный фильтр) проверьте, правильно ли
выбран диапазон списка, и в поле Criteria range (Диапазон условий) за-
дайте область, содержащую нужные критерии. Не забудьте, что она
должна включать заголовки столбцов и не содержать пустых строк.

5. При необходимости воспользуйтесь переключателем, который позво-
ляет разместить отобранные записи в заданном диапазоне, и флажком,
предписывающим исключить повторяющиеся записи.

В таблице, которая представлена на рис. 6.15, записи, отобранные с помощью рас-
ширенного фильтра, размещены ниже исходного списка.
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Рис. 6.15. Результаты работы расширенного фильтра
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Самостоятельная работа
1. Используя созданный выше или какой-либо другой список, например любой

прайс-лист, установите для него автофильтр.

2. С помощью автофильтра выберите записи об определенном товаре или о кате-
гории товаров.

3. Найдите среди этих товаров 10 самых дорогих или самых дешевых,

4. Отмените критерии, заданные в пунктах 2 и 3, и создайте фильтр, отбираю-
щий записи о товарах, цена которых попадает в заданный диапазон значений.

5. Применив расширенный фильтр, отберите записи об определенных товарах,
которые имеют цену ниже заданной. Разместите результаты на другом листе.

Импорт данных с помощью Microsoft Query
В Excel реализована возможность доступа к информации, которая хранится в ба-
зах данных, созданных другими приложениями, в том числе Microsoft Access,
dBASE, Microsoft SQL Server. Для этой цели можно использовать интегрирован-
ную в Excel программу Microsoft Query, которая представляет собой отдельное
приложение и предназначена для создания запросов к внешним источникам дан-
ных, таким как файлы баз данных.

Для доступа к внешним базам данных программа Microsoft Query использует
драйвер ODBC (Open DataBase Connectivity - открытое взаимодействие с база-
ми данных), предназначенный специально для работы с базами данных указанно-
го типа. Вместе с Microsoft Query по умолчанию устанавливаются три таких
драйвера — для Microsoft Access, dBASE и Microsoft Excel.

Отправив запрос к базе данных, пользователь получает таблицу результатов -
набор данных, доступных для обработки. С помощью фильтров Microsoft Query
из общего массива извлеченных данных можно выбрать только нужные и таким
образом значительно сократить общий объем переносимой в Excel информации.
Можно поступить и по-другому: перенести все извлеченные данные в Excel, а за-
тем обработать их с помощью функций фильтрации.

Создание запросов
Попробуем с помощью Microsoft Query создать запрос для получения списка кли-
ентов из базы данных Microsoft Access, воспользовавшись для этой цели базой
данных Northwind.mdb, находящейся в папке \Program FiLes\Microsoft Office\0ffice\
Samples.

Для того чтобы создать запрос, запустите Microsoft Query, активизировав коман-
ду Data > Import External Data > New Database Query (Данные > Внешние данные * Соз-
дать запрос).

J ПРИМЕЧАНИЕ ЕСЛИ программа Microsoft Query не установлена на вашем компьютере. Excel
предложит ее инсталлировать.
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Перед открытием главного окна Microsoft Query на экране появится диалоговое
окно Choose Data Source (Выбор источника данных). Нужный драйвер ODBC мож-
но выбрать на вкладке Databases (Базы данных), которую вы видите на рис. 6.16.

Choose Data Source

j ОЕДЙ Cubes

;NewData Source)
dBASE Files"
Excel Files*
MS Access Database*
North

т

• •

Рис. 6.16. Диалоговое окно Choose Data Source

По умолчанию в окне Choose Data Source (Выбор источника данных) установлен
флажок Use the Query Wizard to create/edit queries (Использовать мастер запросов),
определяющий, что запрос к базе данных создается с помощью мастера.

После щелчка на кнопке Options (Параметры) открывается окно Data Source Op-
tions (Источник данных), где можно отметить папки, в которых будет произво-
диться поиск драйверов ODBC. Щелчок на кнопке Browse (Обзор) приводит к вы-
воду на экран окна Browse Data Sources (Просмотр источников данных), позволяю-
щего расширить круг поиска.

В окне Choose Data Source (Выбор источника данных) можно указать один из не-
скольких существующих источников. Но если он, как, например, MS Access Data-
base*, не связан ни с какой базой данных, то на экране появится диалоговое окно
Select Database (Выбор базы данных), в котором таковую нужно будет определить
(рис. 6.17).

Select Database

И ' . ••- •,.,'-

Books

> Excel 2003 Учеб!

ff Example r
. , I ' U4.-::.'.

!ШAccess Databases Г.гш
'

Рис. 6.17. Диалоговое окно Select Database
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Для создания нового источника данных щелкните на элементе <New Data Source>
(<Новый источник данных>), после чего на экране появится диалоговое окно Create
New Data Source (Создание нового источника данных), показанное на рис. 6.18.

Create New Data Source

i • i Clients list

'A >Select-s driver to Iheiype.otdat5fi^

2. Driver do Microsoft Access ("rndb)

'';! C3pi Cihnact andentijt a^intoirriation Feqijestedby tbedriyfe|::.". I' ''/•'.

3,

Г" •S.avet̂ j user [P|sntf-password in the daie-souice dafnlion

i: : " OK I

Рис. 6.18. Диалоговое окно Create New Data Source

Задайте в этом окне имя источника данных (поле с номером 1), установите необ-
ходимый драйвер (поле с номером 2) и щелкните на кнопке Connect (Связь). От-
кроется диалоговое окно для установки драйвера ODBC, содержимое которого
зависит от выбранного драйвера. В нашем примере это окно ODBC Microsoft Access
Setup (Установка драйвера ODBC для Microsoft Access), представленное на рис. 6.19.
Нажмите в нем кнопку Select (Выбрать), в открывшемся диалоговом окне найдите
папку \Program FHes\Microsoft OfTtce\Orfice\Samples и выберите файл Northwind.mdb.
После возврата в окно ODBC Microsoft Access Setup (Установка драйвера ODBC для
Microsoft Access) нажмите кнопку ОК.

ODBC Microsoft Access Setup

Рис. 6.19. Диалоговое окно ODBC Microsoft Access Setup
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В результате таких действий вы опять попадете в окно Create New Data Sourse (Соз-
дание нового источника данных) и сможете при желании выбрать таблицу базы
данных, которая используется по умолчанию (поле с номером 4). Когда все уста-
новки будут выполнены, нажмите кнопку С\К, и список в окне диалогового окна
Select Database (Выбор базы данных) будет дополнен именем нового источника
данных.

Выберите нужный источник данных (в нашем примере это Clients list) и щелкните
на кнопке ОК. Откроется первое окно мастера создания запроса Query Wizard —
Choose Columns (Создание запроса: выбор столбцов). Вы видите его на рис. 6.20.

uery Wizard * Choose Columns
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Addiess

Country
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Рис. 6.20. Диалоговое окно Query Wizard — Choose Columns

Для того чтобы включить необходимые поля таблицы в запрос, нужно в левом
списке щелчком на знаке плюс отобразить все ее поля, поочередно отметить нуж-
ные и переместить их с помощью кнопки > в правый список. Если вам потребует-
ся очистить список Columns in your query (Столбцы запроса), нажмите кнопку «.

СОВЕТ Чтобы переместить в правый список все поля таблицы, отметьте ее в левом
списке и щелкните на кнопке >.

Мы в качестве примера выбрали несколько полей из таблицы Clients. Теперь
нужно щелкнуть на кнопке Next (Далее) и указать в окне Query Wizard — Filter Data
(Создание запроса: отбор данных) критерии отбора записей (рис. 6.21).

В большинстве случаев из базы данных извлекают не все записи, а лишь те из них,
которые отвечают заданным критериям, например записи о заказах за оговорен-
ный период времени или записи, относящиеся к товарам определенной категории.

^ПРИМЕЧАНИЕ С помощью Microsoft Query можно извлекать записи, поля которых включают
какие-то конкретные символы, или, предположим, записи, содержащие пус-
тые поля. При необходимости условия можно объединить, применив логиче-
ские операторы.
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Query Wizard - Filter Data
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I Company Name
(Address

Рис. 6.21. Диалоговое окно Query Wizard — Filter Data

Чтобы задать критерий отбора, сначала в списке Column to filter (Столбцы для от-
бора) нужно выбрать название поля, а после этого в области Only include rows where
(Возвращать только записи, удовлетворяющие условиям) указать условия отбо-
ра. Для этого в первом раскрывающемся списке необходимо задать операцию от-
бора, а во втором выбрать предлагаемое значение или ввести свое. Сделав выбор,
нажмите кнопку Next (Далее). В нашем примере мы задали отбор записей о ком-
паниях, развернувших свою деятельность на территории Германии.

Извлекаемый из базы набор записей обычно сортируют, например, в алфавитном
порядке либо по возрастанию или убыванию числовых значений. Поля, по кото-
рым производится сортировка, и порядок таковой задаются в окне Query Wizard —
Sort Order (Создание запроса: порядок сортировки), показанном на рис. 6.22. Вы-
берите алфавитный порядок сортировки записей сначала по полю CompanyName,
а затем по полю City и нажмите кнопку Next (Далее).

Query Wizard - Sort Order

|CompanyName

Рис. 6.22. Диалоговое окно Query Wizard — Sort Order
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В окне Query Wizard — Finish (Создание запроса: заключительный шаг) в распоря-
жение пользователя предоставляются три переключателя (рис. 6.23). При выборе
переключателя Return Data to Microsoft Excel (Вернуть данные в Microsoft Excel)
данные, полученные в результате выполнения запроса, будут переданы в Micro-
soft Excel, а при выборе переключателя View data or edit query in Microsoft Query
(Просмотр или изменение данных в Microsoft Query) — в Microsoft Query. При
установке же переключателя Create an OLAP Cube from this quer (Создание куба
OLAP из данных запроса) загружается мастер OLAP (On-Line Analytical Pro-
cessing), с помощью которого можно указать, в каком виде данные будут отобра-
жаться в сводной таблице и на сводной диаграмме. О создании таких сводных
таблиц и диаграмм будет рассказано в следующем уроке.

Query Wi7,ii-il - Finish

Рис. 6.23. Диалоговое окно Query Wizard — Finish

В этом же окне мастера имеется кнопка Save Query (Сохранить запрос). В резуль-
тате ее нажатия открывается окно, в котором задаются имя файла и папка для
размещения запроса (по умолчанию — папка Query). Запросы хранятся в файлах
с расширением ,dqy. Для того чтобы вызвать сохраненный запрос, нужно в Excel
задать команду Data > Import External Data > Import Data (Данные > Внешние данные >
Выполнить сохраненный запрос).

Если вы выберете переключатель Return Data to Microsoft Excel (Вернуть данные
•в Microsoft Excel), то после нажатия кнопки Finish (Готово) будет осуществлен
переход в Excel и откроется диалоговое окно Import Data (Возврат данных в Mic-
rosoft Excel), представленное на рис. 6.24.

При выборе переключателя Existing worksheet (Имеющийся лист) данные, полу-
ченные из внешнего источника, помещаются на текущую страницу, а при выборе
переключателя New worksheet (Новый лист) — на новый лист. Если вы активизи-
руете ссылку Create a PivotTable report (Отчет сводной таблицы), будет создана
сводная таблица.
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Import Data
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Рис. 6.24. Диалоговое окно Import Data

Окно Microsoft Query
При выборе в диалоговом окне Query Wizard — Finish (Создание запроса: заключи-
тельный шаг) переключателя View data or edit query in Microsoft Query (Просмотр или
изменение данных в Microsoft Query) после нажатия кнопки Finish (Готово) поя-
вится окно запроса программы Microsoft Query (рис. 6.25).
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Рис. 6.25. Окно запроса данных в Microsoft Query

Окно запроса разделено на три области — таблиц, условий и данных. В области
таблиц отображаются названия и перечни полей базы данных, упоминаемых в за-
просе. Условия отбора записей указываются в следующей области, а под ними,
в области данных, находится таблица результатов. В ее столбцах представлены
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выбранные пользователем поля базы данных. Строки таблицы соответствуют за-
писям базы данных.

Областями окна запроса можно управлять — изменять их размер путем
перетаскивания границ, а также скрывать и отображать их на экране с по-

мощью команд меню View (Вид) или кнопок стандартной панели инструментов.

~V Microsoft Query

В нижней части окна Microsoft Query имеется строка состояния, в которой ото-
бражаются подсказки и режимы работы клавиш.

Добавление таблиц и столбцов
При необходимости в область таблиц можно добавить еще одну или несколько
таблиц базы данных. Вызовите команду Table > Add Tables (Таблица > Добавить таб-
лицы) и в открывшемся окне выберите нужные таблицы. Удаляются таблицы с по-
мощью команды Table > Delete Tables (Таблица > Удалить таблицы).

Как было сказано выше, изначально таблица результатов содержит поля, задан-
ные при формировании запроса. Если вы хотите включить в нее дополнительные
поля, то это можно сделать в окне программы Microsoft Query.

Добавление столбцов в таблицу результатов

1. Выделите одно или несколько полей в области таблиц (при выделении
нескольких полей удерживайте клавишу Ctrl нажатой). Если вы хотите
включить в таблицу результатов все поля таблицы, выберите в перечне
ее полей элемент *

2. Перетащите выделенные поля в область таблицы результатов, помес-
тите указатель мыши в столбец, перед которым хотите их вставить,
и отпустите кнопку мыши.

3. Вызовите команду Table > Add Column (Таблица > Добавить столбец), за-
тем в диалоговом окне Add Column (Добавить столбец), показанном на
рис. 6.26, выделите в списке Field (Поле) столбец, данные которого бу-
дут применяться для создания значений нового столбца, в поле Column
heading (Заголовок столбца) введите заголовок нового столбца и выбе-
рите операцию в списке Totals (Групповая операция). После проведе-
ния всех установок нажмите кнопку Add (Добавить).
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Add Column

Рис. 6.26. Диалоговое окно Add Column

Для того чтобы удалить столбец из таблицы результатов, его нужно сначала вы-
делить щелчком на заголовке, а затем выбрать команду Records > Remove column
(Записи > Удалить столбец).

Определение или изменение условий отбора записей
Microsoft Query позволяет создавать и изменять критерии отбора записей из базы
данных. Это можно делать как путем вызова команд меню, так и непосредственно
в области условий.

Определение условий отбора записей с помощью команды меню
1. Вызовите команду Criteria > Add Criteria (Условие > Добавить условие).

2. В списке Field (Поле) диалогового окна Add Criteria (Добавление усло-
вия) выберите поле, значения которого будут применяться при отборе
записей (рис. 6.27).

3. В списке Operator (Оператор) укажите оператор сравнения, а в поле
Value (Значение) введите величину критерия или выберите ее из спи-
ска, нажав кнопку Values (Значение).

4. С помощью переключателя And (И) либо Or (ИЛИ) укажите способ объ-
единения нового условия с уже имеющимся. Нажмите кнопку Add (До-
бавить).

ftdd CHteria

Mjl||JJAddiess 1

j equals

-Value:- {ObereStr.57

Рис. 6.27. Диалоговое окно Add Criteria
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Чтобы ввести условие в области отбора, выберите в строке Criteria Field (Условие)
окна запроса данных (см. рис. 6.25) свободный столбец, разверните список его
значений, щелкнув на кнопке с тремя точками, и укажите нужное поле. В строке
Value (Значение) введите оператор сравнения и укажите величину критерия.

Форматирование таблицы результатов

Для того чтобы просматривать записи в таблице результатов было удобнее, мож-
но изменить ширину ее столбцов и высоту строк, скрыть или, наоборот, отобра-
зить ее отдельные столбцы, изменить порядок их расположения.

Изменение ширины столбца

1. Выделите столбец, щелкнув на его заголовке.

2. Вызовите команду Format > Columns Width (Формат > Ширина столбца),

3. В окне Columns Width (Ширина столбца) введите нужное значение в по-
ле с одноименным названием либо нажмите кнопку Best Fit (По шири-
не), в результате чего ширина столбца будет установлена с учетом мак-
симального из содержащихся в нем значений.

Изменить высоту строки можно путем перетаскивания ее границы. Но существу-
ет и другой метод: вызвать команду Format >• Row Height (Формат > Высота строки)
и установить необходимое значение в открывшемся окне.

Для всей таблицы результатов (но не для отдельных ее ячеек) можно задать дру-
гой шрифт. Делается это с помощью команды Format t Font (Формат > Шрифт).

При необходимости не нужные на данный момент столбцы таблицы результатов
можно скрыть. Для этого достаточно выделить один или несколько столбцов и вы-
звать команду Format > Hide Columns (Формат > Скрыть столбцы). А для того что-
бы отобразить скрытые столбцы, следует выбрать команду Format > Show Columns
(Формат > Показать столбцы) и, когда появится диалоговое окно Show Columns
(Отображение столбцов), где видимые столбцы помечены флажками (рис. 6.28),
выделить требуемый столбец и нажать кнопку Show (Показать).

Snow Columns

Рис. 6.28. Диалоговое окно Show Columns

Если на этапе формирования вы не совсем удачно выбрали порядок расположе-
ния столбцов, их можно переставить в таблице результатов. Выделите нужный
столбец щелчком на его заголовке и перетащите мышью в нужную позицию.
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Сортировка результатов запроса
Данные в таблице результатов сортируются в соответствии с параметрами, ука-
занными в окнах мастера формирования запроса. К тому же сортировку данных
можно выполнить с помощью программы Microsoft Query.

Сортировка таблицы результатов
1. Вызовите команду Records > Sort (Записи > Сортировать), и на экране

появится диалоговое окно Sort (Сортировка), показанное на рис. 6.29.

2. Выберите в списке Column (Столбец) столбец, по которому должна
производиться сортировка (например, столбец CompanyName).

3. Установите порядок сортировки, активизировав переключатель Ascen-
ding (по возрастанию) или Descending (по убыванию).

4. Щелкните на кнопке Add (Добавить), и имя столбца появится в списке
Sort in query (Сортировка в запросе). Если вы хотите удалить элемент
из данного списка, выделите его и щелкните на кнопке Remove (Удалить).

5. Шнлкните на кнопке Close (Закрыть).

IF
• . Ц ';•• ;

Рис. 6.29. Диалоговое окно Sort

Ш Сортировку можно производить и с помощью панели инструментов про-
граммы Microsoft Query. Выберите нужный столбец в таблице результа-

тов и щелкните на кнопке Sort Ascending (Сортировать по возрастанию) или Sort
Descending (Сортировать по убыванию). Таким же методом записи можно отсор-
тировать и по нескольким столбцам, но в этом случае столбцы следует предвари-
тельно упорядочить в соответствии с последовательностью сортировки.

Просмотр записей в таблице результатов

Если результаты запроса к базе данных не помещаются в окне программы Micro-
soft Query, записи можно просматривать, пользуясь для перемещения по таблице
результатов кнопками со стрелками либо вертикальной и горизонтальной полоса-
ми прокрутки. Кроме того, это можно делать с помощью клавиш (табл. 6.1).
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Таблица 6.1. Клавиши и комбинации клавиш, применяемые для перемещения
по таблице результатов

Клавиши Столбец, к которому осуществляется переход

Ноте Первый столбец текущей строки

End Последний столбец текущей строки

Tab Следующий столбец

4- Текущий столбец следующей записи

Т Текущий столбец предыдущей записи

Ctrl+End Первый столбец первой записи

Ctrl+Home Последний столбец последней записи

Для перемещения по таблице результатов удобно пользоваться кнопками и поля-
ми навигации, расположенными в нижней левой части ее окна. Нажмите клави-
шу F5 и, когда в поле номера записи появится курсор ввода, укажите номер запи-
си, к которой хотите перейти.

Редактирование таблицы результатов

Изменение содержимого столбцов, а также удаление и добавление строк в табли-
цу результатов может привести к изменению записей базы данных, с которой эта
таблица связана. Поэтому, выполняя указанные операции, вы должны думать об
их последствиях.

Для перехода в режим редактирования записей необходимо выполнить команду
Records > Allow Edit ing (Записи > Разрешить правку). После этого вы сможете уда-
лять ненужные строки, пользуясь командой E d i t » Cut (Правка > Вырезать), добав-
лять новые путем ввода в пустую строку таблицы результатов, вносить различ-
ные изменения, редактируя данные в ячейке столбца.

СОВЕТ Изменение, внесенное в строку последним, с помощью команды Edit > Undo
{Правка > Вернуть) можно отменить до перехода в другую строку.

Передача данных в Excel

Данные таблицы результатов можно передать в Excel. Вызовите команду File > Re-
turn Data to Microsoft Excel (Файл > Вернуть данные в Microsoft Excel), с тем чтобы
открыть диалоговое окно Import Data (Возврат данных в Microsoft Excel), показан-
ное на рис. 6.24. Как уже было сказано, выбор переключателя Existing worksheet
(Имеющийся лист) предполагает размещение результатов запроса на текущем
листе. Однако имеет смысл разместить их отдельно, поэтому активизируйте пе-
реключатель New worksheet (Новый лист). Когда вы нажмете кнопку ОК, програм-
ма Microsoft Query завершит свою работу и таблица результатов появится на ра-
бочем листе Excel.
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Если программа Microsoft Query вызывается из Excel, то после копирования в это
приложение данные таблицы результатов потеряют связь с базой данных, и для
их обновления вновь придется выполнять запрос в программе Microsoft Query.

Однако, как вы знаете, Microsoft Query - это отдельное приложение, поэтому его
можно вызывать автономно. В таком случае передача данных осуществляется
с использованием буфера обмена. Вставить данные из буфера в рабочий лист Excel
позволяют команды Edit > Paste (Правка > Вставить) и Edit > Paste Special (Правка >
Специальная вставка).

В первом случае вставляемые данные теряют связь с базой данных. После выбора
второй из указанных команд открывается окно Paste Special (Специальная встав-
ка), в котором рекомендуется установить переключатель Paste Link (Вставить
связь). Это позволит вам в будущем обновлять данные с помощью команды Edit >
Link (Правка v Связи).

Самостоятельная работа
1. Выберите из базы данных Northwind.mdb, находящейся в папке \Program FUes\

Microsoft Office\Office\SampLes, информацию о служащих. Воспользуйтесь таб-
лицей Product Sales for 1997 и извлеките из нее все столбцы.

2. В области условий создайте критерий отбора записей, например, отобразите
в таблице результатов сведения о товарах, проданных в первом квартале.

3. Отсортируйте записи по категории, по наименованию товара или по объему
продаж.

4. Перенесите данные из таблицы результатов на отдельный лист рабочей книги
Excel.

Подведение итогов

В этом уроке мы научились:

0 создавать списки вручную и с помощью формы данных;

0 редактировать списки и осуществлять поиск в них;

0 сортировать строки и столбцы списка;

0 определять сложные критерии сортировки;

0 выполнять отбор данных в списке с помощью функции автофильтра;

0 создавать расширенные фильтры прямо на рабочем листе;

0 формировать запросы к внешним базам данных с помощью программы Micro-
soft Query;

0 редактировать запросы и форматировать таблицу результатов;

0 передавать данные запроса в программу Excel.
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В этом зфоке речь пойдет о средствах анализа данных, предоставляемых в наше
распоряжение Excel. Именно благодаря их разнообразию программа стала мощ-
ным инструментом, который можно применять не только для ввода и редактиро-
вания электронных таблиц, но и для решения ряда других задач. И лишь понимая,
как функционируют такие средства, можно выбрать то из них, которое больше
всего подходит для конкретной ситуации.

Установка надстроек

Многие функции приложения становятся доступными только после загрузки до-
полнительной программы — надстройки. К числу надстроек относятся, в частно-
сти, процедуры поиска решения и диспетчер отчетов. Чтобы загрузить надстрой-
ку, следует вызвать команду Tools > Add-Ins (Сервис > Надстройки) и установить
соответствующий флажок в диалоговом окне Add-Ins (Надстройки). После нажа-
тия кнопки ОК и загрузки надстройки меню будет дополнено командами, работу
которых она поддерживает.

j Analysis ToolPak-VBA
1 Conditional Sum Wizard
I Euro Currency Tools
} Internet Assistant VBA
1 Lookup Wizard
1 MapPoint Data Service
1 Solver Add-in

ШШ i j i . :: ipti

Если в списке Add-Ins available (Доступные надстройки) нужной надстройки не
окажется, нажмите кнопку Browse (Обзор) и выберите ее файл. Надстройки хра-
нятся в файлах с расширением .xta или .xll.

Автоматическое вычисление

Для вычисления некоторых промежуточных значений или, скажем, проверки
правильности расчетов не обязательно создавать формулы или использовать
калькулятор. Достаточно выделить нужный диапазон ячеек, открыть контекстное
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меню функции автовычисления, щелкнув правой кнопкой мыши в соответствую-
щей области строки состояния, и указать, какую именно информацию о данных
требуется получить. Команды этого контекстного меню описаны в табл. 7.1.

Таблица 7.1. Команды автоматического вычисления

Команда Описание

Sum (Сумма)

Мах (Максимум)

Min (Минимум)

Count Nums (Количество чисел)

Count (Количество значений)

Average (Среднее)

None (Нет)

Вычисляет сумму всех числовых значений

Определяет максимальное значение

Определяет минимальное значение

Подсчитывает количество числовых значений

Подсчитывает количество ячеек, содержащих данные

Вычисляет среднее арифметическое числовых значений

Отменяет режим авто вычисления ^_^__^__

Как с помощью функции автовычисления можно быстро установить сумму со-
держащихся в столбце значений, нетрудно понять из рис. 7.1.

Рис. 7.1. Использование функция автовычисления

Итоги

Microsoft Excel может автоматически вычислять промежуточные и общие итоги.
Однако эта операция выполняется только с теми данными, которые организова-
ны в виде списка (см. урок 6), и только над столбцами, содержащими числа. Пе-
ред определением промежуточных итогов требуется отсортировать список таким
образом, чтобы сгруппировать значения в столбцах, по которым нужно рассчи-
тать итоговые значения.

7 Зак. 345
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Создание итогов
В качестве примера рассмотрим таблицу с данными о реализации торговой орга-
низацией пылесосов. В ней представлены записи о количестве изделий нескольких
марок, проданных в разные регионы. За обслуживание региона отвечает опреде-
ленный менеджер по торговле, за каждым менеджером закреплено три региона.
Ниже будет рассказано, как определить количество проданного товара каждой
марки и рассчитать сумму выручки по каждому изделию. Поскольку итоговые
значения будут рассчитываться по изделиям, мы предварительно отсортировали
строки по столбцу, содержащему их наименования.

£2 Microsoft Oflitc Ексе! 2003 - Анализ данным.*!* теш;

СОВЕТ Прежде чем задавать автоматическое вычисление итогов, обязательно отсор-
тируйте данные в таблице. В противном случае итоговые значения будут оп-
ределяться при каждой смене значения.

Для того чтобы Excel автоматически вычислял итога, выберите одну из ячеек
списка и вызовите команду Data * Subtotals (Данные > Итоги). В результате произ-
веденных действий будет открыто диалоговое окно Subtotal (Промежуточные ито-
ги), показанное на рис. 7.2.
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Рис. 7.2. Диалоговое окно Subtotal

В списке At each change in (При каждом изменении в) выбирается заголовок столб-
ца, для которого необходимо вычислять промежуточные итоги после каждого из-
менения данных на рабочем листе. В списке Use function (Операция) устанавлива-
ется функция, которая будет использоваться при вычислении итоговых значе-
ний. Описание всех доступных в указанном окне функций приведено в табл. 7.2.

Таблица 7.2. Функции, используемые для вычисления итоговых значений

Функция Описание

Sum (Сумма)

Count (Количество значений)

Average (Среднее)

Мах (Максимум)

Min(Минимум)

Product (Произведение)

Count Nums (Количество чисел)

StdDev (Смещенное отклонение)

StdDevp (Несмещенное отклонение)

Var (Смещенная дисперсия)

Varp (Несмещенная дисперсия)

Суммирует все значения и выдает общий итог

Определяет количество элементов ряда

Вычисляет среднее арифметическое для ряда

Определяет наибольшее значение в ряде

Определяет наименьшее значение в ряде

Вычисляет произведение всех значений ряда

Устанавливает в выделенной области количество ячеек,
содержащих числовые значения

Определяет значение стандартного отклонения выборки

Определяет значение стандартного отклонения
для генеральной выборки

Определяет значение дисперсии для выборки данных

Определяет значение дисперсии для генеральной
выборки

В списке Add subtotal to (Добавить итоги по) необходимо установить флажки для
тех столбцов, значения которых будут использоваться при вычислении итогов.
По умолчанию строки, содержащие итоговые значения, размещаются под строка-
ми с исходными данными. Если их нужно разместить над исходными данными,
следует отключить флажок Summary below data (Итоги под данными). При выводе
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на печать каждую группу итоговых данных можно расположить на отдельной
странице. Для этого нужно установить флажок Page break between groups (Конец
страницы между группами). Флажок Replace current subtotals (Заменить текущие
итоги) управляет удалением ранее созданных итоговых значений. Для удаления
всех строк с такими данными предназначена кнопка Remove All (Убрать все),

Создание итоговых данных
1. Отсортируйте список по столбцу, при изменении значений в котором

должны вычисляться итоги.
2. Установите указатель ячейки в область списка и вызовите команду

Data > Subtotals (Данные > Итоги).
3. В списке At each change in (При каждом изменении в) выберите стол-

бец, по которому должны вычисляться итоги, а в списке Use function
(Операция) — нужную функцию. Столбцы, значения которых будут
использоваться в качестве аргументов этой функции, установите в спи-
ске Add subtotal to (Добавить итоги по). Нажмите кнопку ОК.

После того как мы задали расчет итогов по столбцам, содержащим количество
проданных изделий и сумму продаж, таблица дополнилась строками, содержащи-
ми итоговые значения по каждому изделию. В последней из числа вставленных
строк находится общий итог (рис. 7.3).

Microsull OINce Енсс! 2003 -

Гылесос Scar1stl_ моющий 16QQ ВтДШДл
Пылесос Scarlett моющий 1600 ВтДОлДи

Рис. 7.3. Таблица-пример после автоматического вычисления итогов
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Заметьте, что общий итог вычисляется не на основе промежуточных итоговых
значений, а с учетом всех исходных данных столбца. Таким образом, если вы бу-
дете вычислять среднее значение, то при расчете общего итога будут использо-
ваться все данные столбца, то есть программа не вычисляет «среднее среднего».

При создании итогов таблица структурируется. В этом вы сможете убедиться,
взглянув на экран. Создание уровней структуры приводит к повышению нагляд-
ности таблицы. Чтобы отобразить на экране только итоговые данные, следует вы-
полнить щелчок на кнопке второго уровня структуры, вследствие чего данные
третьего уровня (исходные значения) будут скрыты. Для того чтобы восстано-
вить отображение исходных значений, необходимо выполнить щелчок на кнопке
третьего уровня. Щелкая на кнопках + и -, можно скрывать избыточную, неакту-
альную информацию и формировать нужный отчет с определенной степенью де-
тализации.
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Вложенные итоги
Рассмотрим еще одну интересную возможность Excel — комбинирование несколь-
ких итоговых значений, то есть создание вложенных итогов. Сначала определим,
какое количество изделий продал каждый из менеджеров, а затем — сколько из-
делий он продал в каждый регион. Чтобы получить такие данные, нужно удалить
итоговые значения, вычисленные ранее. Для этого вызовите диалоговое окно
Subtotal (Итоги), щелкните на кнопке Remove All (Убрать все) и закройте его с по-
мощью кнопки ОК. Далее таблицу следует отсортировать по двум столбцам — Ме-
неждер и Регион. Затем нужно выбрать команду Data > Subtotals (Данные к Итоги),
а в появившемся окне произвести такие действия: в списке At each change in (При
каждом изменении в) выбрать столбец Менеджер, в списке Use function (Операция) —
функцию Sum (Сумма), установить флажки для столбцов Расход, ш т . и Расход, $,
после чего нажать кнопку ОК. Что будет получено в качестве результата, видно из
следующего рисунка.
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Еще раз вызовите диалоговое окно Subtotal (Итоги) и выполните в нем установ-
ки, указанные на рис. 7.4. Не забудьте снять флажок Replace current subtotals (За-
менить текущие итоги).

Рис. 7.4. Установки для определения
вложенных итогов заданы

После нажатия кнопки О К программа создаст итоговые данные второго уровня,
представленные на нашем следующем рисунке. Как видите, слева теперь отобра-
жаются четыре уровня структуры.
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Скрыв информацию более низкого уровня с помощью кнопок, расположенных
у левой границы окна, можно получить примерно такой отчет о деятельности ме-
неджеров, как показано на рис. 7.5, и при необходимости вывести его на печать.
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Рис. 7.5. Отчет о деятельности менеджеров
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Самостоятельная работа
1. Воспользовавшись прайс-листом, в котором перечень товаров разбит на кате-

гории, вычислите количество товаров каждой категории.

2. В таблице, аналогичной рассмотренной в этом разделе, определите, сколько
изделий и на какую сумму было продано в каждый регион.

3. Создайте вложенные итоги, добавив к итогам, полученным в пункте 2, разбив-
ку по изделиям.

Консолидация данных
Консолидация данных (обобщение) выполняется в том случае, если необходимо
подытожить данные, хранящиеся на разных листах или в различых книгах. С по-
мощью функции консолидации для значений из несмежных диапазонов можно
выполнить те же операции, что и при автоматическом определении промежуточ-
ных итогов, то есть вычислить сумму, минимальное, максимальное или среднее
значение и т. д.

В зависимости от способа организации исходные данные для консолидации мож-
но задавать тремя способами.

О С помощью формул, содержащих ссылки. Для расчета итоговых данных со-
ставляются обычные или так называемые трехмерные формулы, то есть фор-
мулы, которые содержат ссылки на диапазоны, включающие ячейки разных
листов. Этот метод следует использовать в тех случаях, когда исходные дан-
ные расположены бессистемно.

О По расположению ячеек. Исходные данные для функции консолидации за-
даются в диалоговом окне в виде ссылок на диапазоны. Для консолидации ис-
пользуется набор таких ссылок. При этом требуется, чтобы исходные данные
в каждом диапазоне имели одинаковую структуру.

О По заголовкам строк или столбцов. Ячейки, содержащие исходные данные
для функции консолидации, идентифицируются по заголовкам, а не путем
указания их адреса. В этом случае не обязательно, чтобы исходные данные на
разных листах были расположены одинаково.

Использование формул со ссылками

Преобразуем нашу таблицу с данными о продажах так, чтобы на ее примере про-
демонстрировать все методы выполнения консолидации данных. При этом мы
предполагаем, что данные об объемах продаж каждого менеджера расположены
на разных рабочих листах (рис. 7.6).

На отдельном листе нужно рассчитать общие объемы продаж каждого изделия.
Особенность этого набора данных: у нас нет гарантии, что на листе для каждого
менеджера представлены все наименования изделий, поэтому для расчета итого-
вых значений нужно использовать формулу со ссылками.
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Рис. 7.6. Таблица-пример

Создание формулы, выполняющей консолидацию данных
1. Выберите ячейку, в которой должна располагаться формула,

2. Вызовите функцию для выполнения итоговых вычислений, восполь-
зовавшись кнопкой Autosum (Автосумма) или строкой формул.

3. Чтобы задать аргументы функции, перейдите на лист, где расположе-
ны ячейки с исходными данными, выделите нужную ячейку и введите
символ точки с запятой. Повторяйте эту операцию для всех листов с ис-
ходными данными (на последнем шаге точку с запятой не вводите).

Трехмерные ссылки — это ссылки вида Лист! :ЛистЗ!03. Для их создания следует от-
крыть первый лист из числа выбираемых, нажать клавишу Shift и, выполняя
щелчки кнопкой мыши, указать остальные листы диапазона (должны быть распо-
ложены подряд). Затем клавишу Shift нужно отпустить и отметить на листе необ-
ходимую ячейку.

Формулы, полученные в нашем примере, представлены на рис. 7.7.
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Рис. 7.7. Трехмерные формулы, рассчитывающие итоговые значения

Использование команды Consolidate
Второй и третий методы задания исходных данных для консолидации — по распо-
ложению ячеек и по заголовкам строк или столбцов — реализуются в диалоговом
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окне Consolidate (Консолидация), которое вызывается с помощью команды Data
Consolidate (Данные > Консолидация). Вы видите это окно на рис. 7.8.

Consolidate

rmm

Рис. 7.8. Диалоговое окно Consolidate

В списке Function (Функция) указанного диалогового окна выбирается функция,
с помощью которой будет выполняться консолидация. В поле Reference (Ссылка)
задается ссылка на первый исходный диапазон, для определения которой удобно
пользоваться кнопкой свертывания диалогового окна, находящейся в правой час-
ти этого поля. После нажатия указанной кнопки на рабочем листе можно выде-
лить необходимый диапазон ячеек. Если консолидируемые диапазоны располо-
жены на разных листах книги одинаково, то после ввода адреса первого диапазо-
на выделять остальные диапазоны не нужно — достаточно перейти на новый лист
и нажать кнопку Add (Добавить).

Если вы хотите использовать определение исходных данных по заголовкам строк
или столбцов, то при указании диапазона в поле Reference (Ссылка) включите
в него эти заголовки. (Выбранный диапазон может охватывать не только исход-
ные, но и другие данные.)

Отметив диапазон исходных данных, следует нажать кнопку Add (Добавить), по-
сле чего он появится в списке All references (Список диапазонов). После того как
будут заданы все исходные данные, можно переходить к другим установкам.
В случае использования для определения исходных данных заголовков установи-
те флажок Top row (подписи верхней строки) или Left column (значения левого
столбца) либо оба флажка. В последнем случае выделенные диапазоны будут рас-
сматриваться как таблицы, у которых названия имеют и строки, и столбцы. Что-
бы обеспечить динамическую связь между исходными и итоговыми данными, ус-
тановите флажок Create links to source data (Создавать связи с исходными данными).
Преимущество способа консолидации с созданием связей состоит в том, что при
выполнении этой операции происходит и структурирование таблицы. Исходные
данные, находящиеся на разных листах, переносятся на второй уровень структуры,
и консолидированные значения вычисляются уже на основе данных этого уровня.
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Если исходные данные и результаты консолидации находятся в одной рабочей
книге, обновление может осуществляться автоматически, а если в разных, его
придется выполнять с помощью команды Edit > Links (Правка > Связи).

Консолидация данных по положению
-1. Выберите левую верхнюю ячейку диапазона, в котором будут размеще-

ны результаты консолидации.
2. С помощью команды Data > Consolidate (Данные > Консолидация) открой-

те диалоговое окно Consolidate (Консолидация).
3. Выберите в списке Function (Функция) функцию, предназначенную

для выполнения консолидации.

4. Задайте в поле Reference (Ссылка) ссылку на первый диапазон и на-
жмите кнопку Add (Добавить).

5. Повторяйте действия, указанные в пункте 4, пока не выберете все ис-
ходные данные.

6. Установите флажок Create links to source data (Создавать связи с исход-
ными данными), если необходимо связать исходные данные с резуль-
татами консолидации.

7. Нажмите кнопку ОК, и итоговые значения появятся в заданном диапа-
зоне.

Консолидация данных по заголовкам строк и столбцов
1. Выберите диапазон, в который необходимо поместить результаты кон-

солидации. Обязательно включите в него названия строк или столб-
цов, которые будут использоваться для отбора исходных данных.

2. Вызовите команду Data > Consolidate (Данные > Консолидация), для того
чтобы открыть диалоговое окно Consolidate (Консолидация).

3. Выберите в списке Function (Функция) функцию, используемую при
выполнении консолидации.

4. Задайте в поле Reference (Ссылка) ссылку на первый диапазон и на-
жмите кнопку Add (Добавить). При выборе области включите в нее на-
звания строк или столбцов (можете охватить и «лишние* данные).

5. Повторяйте действия, указанные в пункте 4, пока не выберете все ис-
ходные данные.

6. Установите флажок Top row (подписи верхней строки) или Left column
(значения левого столбца) либо оба флажка, в зависимости от того, где
расположены названия исходных данных.

7. Установите флажок Create links to source data (Создавать связи с исход-
ными данными), если необходимо связать исходные данные с резуль-
татами консолидации.

8. Нажмите кнопку ОК, и итоговые данные вместе с названиями строк
или столбцов появятся в заданном диапазоне.
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Для нашего примера лучше воспользоваться методом с применением заголовков,
поскольку строки на отдельных листах не упорядочены. В этом случае программа
сначала определит название строки или столбца для каждой ячейки диапазона
результата, а затем выберет из каждого исходного диапазона ячейки, которые на-
ходятся в строке или столбце с таким же названием. Результаты для примера
представлены на следующем рисунке в столбцах Е и G. Столбец F скрыт, но вооб-
ще-то его нужно удалить, поскольку рассчитывать для него итоги не имеет смыс-
ла. Заметьте, что в столбце G (см. строку формул) находятся константы, а не фор-
мулы, поскольку флажок Create links to source data (Создавать связи с исходными
данными) не установлен. Это означает, что в случае изменения исходных значе-
ний консолидацию следует произвести повторно.
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9!; !Пылесос Scarfslt 1450 Вт/2д
Итага

Цена.

62.97
6202
64.32
67.03
67.03

112.53
63.65
62.S7

Всего,
шт.

•
:••

'.7

•\

37

Всего, $

322

Наименование

Пылесос Scarlett 15DO Вт (7-ступ. филь
Пылесос Scarlatl 1500 Вг/2л
Пылесос Scarlett 1500 Вт/Зл
Пылесос Scarlatt 1600 Вт/5л
Пылесос Scarlett 1SOO ВтД,5л
Пылесос Scarlett моющий 1600 Вт/20лг
Пылесос Scarlett 1450 Вт/2.5л
Пылесос Scarlett 1450 Вт/2л

Самостоятельная работа
1. Для нескольких рабочих листов, содержащих однородные данные, рассчитай-

те итоговые значения с помощью специально созданных формул.
2. Для этих же рабочих листов выполните консолидацию данных с помощью ко-

манды Data > Consolidate (Данные > Консолидация). Выберите наиболее подхо-
дящий метод отбора исходных значений — с использованием ссылок на диапа-
зоны или по заголовкам строк либо столбцов.

Подбор параметра
При обработке табличных данных часто возникает необходимость в прогнозиро-
вании результата на основе известных исходных значений или, наоборот, в опре-
делении того, какими должны быть исходные значения, позволяющие получить
нужный результат.

Использование средства подбора параметра
Рассмотрим, как работает средство подбора параметра, позволяющее определить
исходное значение, которое обеспечивает заданный результат функции. В качестве
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примера возьмем таблицу, с помощью которой рассчитывается размер пенсион-
ных накоплений (рис. 7.9).

i О Microsoft Office Енсе! 2003 - Подбор парэметрэ.н1з

_ ff: X

Рис. 7.9. Таблица для расчета размера пенсионных накоплений

В этой таблице указаны возраст, начиная с которого в пенсионный фонд вносятся
платежи (А2), величина ежемесячного взноса (В2), период отчислений, рассчи-
танный по формуле

-6Q-A2

то есть мы предполагаем, что речь идет о мужчине, который выйдет на пенсию
в 60 лет (С2), а также величина процентной ставки (D2).

Сумма накоплений рассчитывается с помощью функции по следующей формуле:

=FV(D2;C2;-B2*12:;1)

Функция F V C ) (БС ()) возвращает будущее значение вклада, определяемое с уче-
том периодических постоянных платежей и постоянной процентной ставки. Син-
таксис данной функции выглядит так:

РУСставка;кпер:плата;нз:тип)

Перечислим ее аргументы: ставка — размер процентной ставки за период; кпер -
общее число периодов выплат годовой ренты; плата — выплата, производимая в ка-
ждый период (это значение не может меняться на протяжении всего времени вы-
плат), причем обычно плата состоит из основного платежа и платежа по процен-
там; нз — текущая стоимость или общая сумма всех будущих платежей, начиная
с настоящего момента (по умолчанию — 0); тип — число, которое определяет, ко-
гда должна производиться выплата (0 — в конце периода, задается по умолчанию,
1 — в начале периода).

Формула имеет такой вид, так как мы предполагаем, что проценты начисляются
не ежемесячно, а в начале, следующего года за предыдущий год. Допустим, нам
необходимо определить, в каком возрасте будущему пенсионеру надо начинать
выплаты, чтобы потом получить прибавку к пенсии в размере 1000 руб. Для этого
следует выделить ячейку, отведенную для представления результата (в нашем
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случае F2), и вызвать команду Tools > Goal Seek (Сервис > Подбор параметра). Ко-
гда появится диалоговое окно Goal Seek (Подбор параметра) (рис. 7.10), адрес вы-
деленной ячейки будет автоматически вставлен в поле Set cell (Установить в ячей-
ке). Укажите в поле То value (Значение) целевое значение - 1000. Поместите кур-
сор ввода в поле By changing cell (Изменяя значение ячейки) и выделите ячейку
А2, после чего ее адрес отобразится в указанном поле.

А =Е2ТШ2

-
ээраст

35

i

Месячные
отчисления

50

|

Период

25

! •

Проценты
на вклад

12%

j

Накопленная
сумма

89600

Ежемесячная
прибавка к

пенсии

896

i

\ \

Рис. 7.10. Диалоговое окно Goal Seek с заданными параметрами

(ПРИМЕЧАНИЕ При использовании функции подбора параметра необходимо, чтобы ячейка
с целевым значением содержала ссылку на ячейку с изменяемым значением.

После выполнения всех установок нажмите кнопку О К, и поиск нужного значе-
ния будет начат. Результат вычисления отобразится в диалоговом окне Goal Seek
Status (Результат подбора параметра), а также в исходной таблице (рис, 7.11). По-
сле нажатия кнопки ОК полученные значения будут вставлены в таблицу.

Рис. 7.11. Результаты подбора параметра
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Если поиск нужного значения продолжается слишком долго, прервать его на вре-
мя можно с помощью кнопки Pause (Пауза). Кнопка Step (Шаг) позволяет про-
смотреть промежуточные результаты вычисления.

Подбор параметра
1. Выберите целевую ячейку, то есть ячейку с формулой, результат кото-

рой вам нужно подобрать.

2. Вызовите команду Tools > Goal Seek (Сервис > Подбор параметра). В поле
Set cell (Установить в ячейке) появившегося диалогового окна будет
отображаться адрес целевой ячейки.

3. Задайте в поле То value (Значение) значение, которое должна содер-
жать целевая ячейка.

4. Укажите в поле By changing cell (Изменяя значение ячейки) адрес ячей-
ки, значение которой необходимо установить таким, чтобы в целевой
ячейке получить заданное значение.

5. Нажмите кнопку ОК, и нужный параметр будет подобран в диалоговом
окне Goal Seek Status (Результат подбора параметра). По окончании это-
го процесса в нем отобразятся результаты.

6. Нажмите кнопку ОК, если вы хотите заменить значения в ячейках на ра-
бочем листе новыми, или кнопку Cancel (Отмена) в противном случае.

Подбор параметра и диаграммы
Средство подбора параметра применяется и при работе с диаграммами. Как это
делается, продемонстрируем на таком примере. На основании данных о суммах
выручки от продажи изделий в три региона построим с помощью мастера диа-
грамм гистограмму (рис. 7.12). В интерактивном режиме с использованием мыши
настроим высоту полосы «Среднее», и посмотрим, как Excel изменит высоту по-
лосы «Чехов» для получения целевого значения. Далее необходимо дважды щелк-
нуть на последней полосе (один раз - для выбора ряда, а второй — для выбора
полосы из ряда), которая представляет средние значения, и увеличить ее высоту
путем перетаскивания маркеров размеров.

Когда кнопка мыши будет отпущена, откроется уже знакомое нам диалоговое
окно Goal Seek (Подбор параметра). В поле Set cell (Установить в ячейке) появит-
ся имя ячейки В5, а в поле То value (Значение) — число, соответствующее послед-
нему значению, которое отображалось в поле подсказки. Курсор ввода будет на-
ходиться в поле By changing cell (Изменяя значение ячейки), поэтому вам останет-
ся лишь ввести в данное поле значение В2. Щелкните на кнопке ОК, после чего
появится диалоговое окно Goal Seek Status (Результат подбора параметра), в кото-
ром будет содержаться нужная информация. Щелкнув на кнопке ОК для возврата
на рабочий лист, вы увидите, что в ячейках уже содержатся новые значения и что
в соответствии с ними настроена высота полос гистограммы (рис. 7.13).
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Рис. 7.12. Изменение высоты полосы, представляющей значение формулы

ГПадо-пьск •™™gpp*

"Чехов 36Э1

Рис. 7.13. Гистограмма настроена при помощи средства подбора параметра

Самостоятельная работа
1. Путем подбора параметра определите, какую сумму надо положить в банк под

12 % годовых, чтобы через 5 лет иметь вклад размером 100 000 руб.
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2. Для рассматриваемого в этом разделе примера путем подбора параметра опре-
делите, какими должны быть ежемесячные отчисления, чтобы за 10 лет полу-
чить прибавку к пенсии в размере 3000 руб.

Таблицы подстановки

Оценить влияние на некоторую величину нескольких параметров можно с помо-
щью таблиц подстановки. Если вы работаете с формулами и хотели бы знать, ка-
кие результаты можно получить в случае, если одно или два используемых в них
значения будут изменены в определенном диапазоне, то лучше всего использо-
вать таблицу подстановки.

Таблица подстановки Excel создается на основе ячейки с формулой, содержащей
ссылку на ячейку, определенную как поле ввода (ячейка ввода), и списка исход-
ных значений (они последовательно подставляются в ячейку ввода с целью соз-
дания списка результатов). Существует две разновидности таблиц подстановки,
а именно с одной переменной и с двумя переменными. В первом случае можно
изменить значение одной ячейки в формуле, во втором — двух.

Таблицы подстановки с одной переменной
Таблица подстановки с одной переменной используется для вычисления резуль-
татов, которые можно поместить в одну строку или столбец, скажем, для опреде-
ления размеров выплат по процентам при различных значениях процентных ста-
вок (исходные значения). Она представляет собой таблицу со 'списком исходных
значений в первой строке (или столбце). Эти значения последовательно подстав-
ляются в формулу, а результаты помещаются в следующую строку (или столбец).
Одни и те же исходные значения могут быть подставлены в несколько формул.
В таком случае каждый список результатов отображается в соответствующей
строке (или столбце).

Таблица подстановки с одной переменной может быть ориентирована по столбцу
или по строке (рис. 7.14). В обоих случаях в ячейку, расположенную слева от
строки или выше столбца, где содержатся исходные значения, ничего не вводит-
ся. Первая формула в следующей после пустой ячейке служит основой для фор-
мирования первого столбца или первой строки результата. Формула обязательно
должна содержать ссылку на ячейку ввода. В качестве ячейки ввода может высту-
пать любая ячейка рабочего листа.

Таблица подстановки с одной переменной формируется на основе трех компо-
нентов: ячейки ввода, одной или нескольких формул, которые содержат ссылку
на ячейку ввода, и списка исходных значений. При создании таблицы подстанов-
ки данные из списка исходных значений последовательно переносятся в ячейку
ввода. Excel производит вычисления по указанным формулам и заносит резуль-
таты в таблицу подстановки. Исходные значения и формула должны находиться
в соседних ячейках, как показано на рисунках выше. Перед вызовом команды
создания таблицы подстановки эти ячейки необходимо выделить.
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= i i = i i !
Таблица подстановки с одной переменной, ориентированная по столбцу 1

! : . :- \ \ Ячейка Евода|

Исходное значение 1
Исходное значение 2
Исходное значение 3

Исходное значение п
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Таблица подстановки с одной переменной, ориентированная по строке

—

j i ! ; ! Ячейка ввода

Формула 1

Формула 2
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Рис. 7.14. Таблицы подстановки с одной переменной

Как применяется таблица подстановки с одной переменной, показано на примере
таблицы для расчета пенсионных платежей. Предположим, нам необходимо оп-
ределить, как будут меняться накапливаемая сумма и ежемесячная прибавка к пен-
сии для различных периодов накопления (от 15 до 30 лет). Таблица, подготовлен-
ная для вызова команды подстановки, представлена на следующем рисунке.

Ежемесячная
прибавка к пенсии

В таблице подстановки используются две формулы. Обратите внимание на фор-
мулу в ячейке Е5: именно она содержит ссылку на ячейку С2, которая является
ячейкой ввода. Значение в ячейке F5 рассчитывается на основе данных ячейки Е5.
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[ПРИМЕЧАНИЕ Формулы для вычислений должны находиться в первой строке таблицы, по-
скольку значения в списке могут быть считаны только в направлении возрас-
тания номеров строк (столбцов).

Выделите диапазон, охватывающий исходные значения и формулы, и вызовите
команду Data > Table (Данные > Таблица подстановки). После этого появится диалого-
вое окно Table (Таблица подстановки), в котором нужно задать ссылку на ячейку
ввода (рис. 7.15). Поскольку исходные данные расположены в столбце, ссылку
нужно задать в поле Column input cell (Подставлять значения по столбцам в),

х. __ . _.. ...

) ВНИМАНИЕ Надеемся, что в текущей версии программы будет исправлена ошибка, допу-
щенная при переводе названий полей на русский язык: поле Column input
cell называется «Подставлять значения по строкам в», а поле Row input cell —
«Подставлять значения по столбцам в».

Рис. 7.15. Диалоговое окно Table

Создание таблицы подстановки с одной переменной
1. Создайте список исходных значений и формулы для расчета данных

таблицы. Разместите их на листе, как показано на рис. 7.14. Учтите, что
формулы должны содержать ссылку на ячейку ввода.

2. Выделите диапазон, включающий исходные значения и формулы.

3. Вызовите команду Data > Table (Данные > Таблица подстановки).

4. В диалоговом окне Table (Таблица подстановки) задайте ссылку на ячей-
ку ввода. Если исходные значения образуют столбец, введите ее в поле
Column input cell (Подставлять значения по строкам в), если же они об-
разуют строку — в поле Row input cell (Подставлять значения по столб-
цам в). (См. выше врезку «Внимание».)

5. Нажмите кнопку ОК, и область таблицы подстановки будет заполнена
значениями.

Внимательно изучив полученный результат, вы поймете, что для построения таб-
лицы подстановки использовалась формула

{=ТАВ1_Е(;С2)}

В качестве аргумента здесь выступает ячейка С2, в которую подставляются зна-
чения из списка. Вычисленный результат отображается в таблице подстановки.
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Таблицы постановки с двумя переменными
Если результаты вычислений должны зависеть от двух параметров, то необходи-
мо использовать таблицу подстановки с двумя переменными. Например, для ана-
лиза рассмотренной выше таблицы период выплаты можно принять за первое
множество переменных, а размер ежемесячного взноса — за второе, в результате
чего будет получена таблица с двумя переменными. В каждом столбце (или стро-
ке) этой таблицы будет содержаться информация о размере ежемесячных выплат
при различных процентных ставках для определенных сроков займа.

Структура таблицы подстановки с двумя переменными показана на рис. 7.16. Та-
кая таблица может содержать только одну формулу, которая помещается в ячей-
ку, расположенную в верхнем левом углу. (В таблице подстановки с одной пере-
менной эта ячейка остается пустой.)

ЯзШИШвЕ

Формула
Исходное значение 1
Исходное значение 2
Исходное значение 3

Исходное значение п

1 .... г- ; 1 1

Ячейка ввода для исходных значений столбца
Ячейка ввода для исходных значений строки

: > 1 i

Исходное
значение

1

Исходное
значение

2

ЩИ

Исходное
значение

3

Исходное
значение

п

1 !

„._„,..,
!„__ U— ~~~ i - i

Рис. 7.16. Таблица подстановки с двумя переменными

Таблица подстановки с двумя переменными формируется на основе пяти компо-
нентов:

О ячейки ввода для значений подстановки в строке, в которую будут подставле-
ны исходные значения, находящиеся в строке;

О ячейки ввода для значений подстановки в столбце, в которую будут подстав-
лены исходные значения, находящиеся в столбце;

О строки исходных значений;

О столбца исходных значений;

О одной формулы, которая содержит ссылки на ячейки ввода для значений под-
становки в строке и столбце.

Таблица подстановки с двумя переменными имеет одинаковое число строк и столб-
цов. Исходные данные берутся из заголовков столбцов и названий строк. Содер-
жимое других ячеек вычисляется следующим образом. Исходные значения из
строки и столбца последовательно подставляются в соответствующие ячейки вво-
да. Определяемый при помощи заданной формулы результат помещается в ячей-
ку, находящуюся на пересечении строки и столбца, из которых берутся исходные
значения.
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Рабочий лист, подготовленный к вызову команды создания таблицы подстанов-
ки с двумя переменными, представлен на следующем рисунке. Напомним, что мы
будем рассчитывать величину накоплений в зависимости от периода и размера
выплат в пенсионный фонд. Формула помещается в ячейку В6. Ячейкой ввода
для исходных значений, находящихся в столбцах, является ячейка С2, а ячейкой
ввода для исходных значений, находящихся в строках, — ячейка В2.

Месячные
отчисления

Период
Проценты

на вклад

12%

Наполненная
сумма

89600

Ежемесячная
прибавка к

пенсии

89600
15
16
17
1Е
19
2С

50 ВО 70 50 90 100

Порядок действий, выполняемых при создании таблицы подстановки с двумя пе-
ременными, аналогичен описанному выше. Различие состоит лишь в том, что
пользователь должен указать в диалоговом окне Table (Таблица подстановки) две
ячейки ввода.

Создание таблицы подстановки с двумя переменными
1. Создайте списки исходных значений и формулу для расчета данных

таблицы. Разместите их на листе так, как показано на рис, 7.16. Учтите,
что формула должна содержать ссылки на обе ячейки ввода.

2. Выделите диапазон, включающий исходные значения и формулу.
3. Вызовите команду Data > Table (Данные > Таблица подстановки).

4. В окне Table (Таблица подстановки) задайте ссылки на ячейки ввода —
для исходных значений, образующих столбец, в поле Column input cell
(Подставлять значения по строкам в), а для исходных значений, обра-
зующих строку, в поле Row input cell (Подставлять значения по столб-
цам в). (См. выше врезку «Внимание».)

5. Щелкните на кнопке О К, и после этого область таблицы подстановки
будет заполнена.

Таблица подстановки для нашего примера показана на рис. 7.17. Заметим, что диа-
пазон ячеек С7:Н12 содержит формулу

(=ТАБЛИЦАСВ2;С2)}
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В этом случае в формуле указываются два аргумента. Один из них представляет
собой ссылку на ячейку, в которую подставляются значения первого параметра,
расположенные в строке. Другим аргументом служит адрес ячейки, куда подстав-
ляются значения второго параметра, то есть значения из столбца.

Рис. 7.17. Заполненная таблица подстановки с двумя переменными

Редактирование таблиц подстановки
В таблице подстановки можно редактировать исходные значения в строках и столб-
цах. При этом она автоматически пересчитывается. Ни один из результатов изме-
нить нельзя. Поэтому таблица подстановки имеет большую степень защиты, чем
таблица, построенная путем копирования формулы в ячейки, которые должны со-
держать результаты.

Будучи скопированной в другое место рабочей книги (или в другую рабочую кни-
гу), таблица подстановки перестает быть таковой. Все входящие в нее формулы
копируются как формулы, причем ссылки на ячейки обновляются в соответствии
с новыми положениями. А все результирующие значения превращаются в кон-
станты рабочего листа, даже в том случае, если в исходной таблице они рассчиты-
вались с помощью формул.

Для удаления результатов из таблицы подстановки необходимо выделить все ее
ячейки и вызвать команду Edit > Clear > ALL (Правка > Очистить > Все). Если отме-
чены не все ячейки, то Excel выдает сообщение, что часть таблицы подстановки
изменить нельзя.

Заменить таблицу можно путем повторного выделения области, в которой она
должна располагаться, и выполнения описанных выше операций по ее созданию.

Самостоятельная работа
1. Создайте таблицу, с помощью которой определяется схема расчета за кредит,

затем составьте таблицу подстановки с одной переменной и установите с ее
помощью, как различные процентные ставки влияют на величину выплат про-
центов за кредит.
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2. Предположим, что вы планируете купить квартиру в кредит. Часть суммы нуж-
но заплатить сразу, о остальное — в течение определенного срока. На остаток
суммы насчитываются проценты за кредит. Составьте таблицу подстановки
с двумя переменными и рассчитайте с ее помощью варианты с различными
суммами первого взноса и сроками кредитования.

Поиск решения

Еще одним мощным средством анализа данных Excel является надстройка Solver
(Поиск решения). С ее помощью можно определить, при каких значениях ука-
занных влияющих ячеек формула в целевой ячейке принимает нужное значение
(минимальное, максимальное или равное какой-либо величине). Для процедуры
поиска решения можно задать ограничения, причем не обязательно, чтобы при
этом использовались те же влияющие ячейки. Для расчета заданного значения
применяются различные математические методы поиска. Вы можете установить
режим, в котором полученные значения переменных автоматически заносятся
в таблицу. Кроме того, результаты работы программы могут быть оформлены
в виде отчета.

Если надстройка Solver (Поиск решения) установлена, то она вызывается с помо-
щью команды Tools > Solver (Сервис > Поиск решения). Если же данная команда от-
сутствует в меню, загрузите надстройку (см. раздел «Установка надстроек» в на-
чале урока). Перед запуском процедуры поиска решения исходные данные долж-
ны быть представлены в виде таблицы, которая содержит формулы, отражающие
зависимости между данными таблицы.

С помощью команды Solver (Поиск решения) можно оптимизировать модель
сбыта или, скажем, график занятости, решить любую транспортную зддачу или
задачу, связанную с управлением производством и денежными средствами.

Пример поиска решения
Рассмотрим работу процедуры поиска решения на примере, взятом из файла \0f-
fice\Samples\Solvsamp.xls. Данный файл содержит рабочие листы, на каждом из ко-
торых представлены определенная задача и метод ее решения. Мы воспользуемся
листом Staff Shedul i ng (График занятости). В английской версии продукта файл,
как вы понимаете, содержит текст на английском языке. Но поскольку такой же
файл прилагается и к локальной версии Office, мы взяли текст из него, а форму-
лы оставили прежними (рис. 7.18).

Нам необходимо составить график занятости, который бы полностью удовлетво-
рял потребность в персонале при условии минимальных затрат на оплату труда.
Ставки сотрудников одинаковы и неизменны, поэтому снизить затраты можно,
лишь уменьшив число ежедневно занятых сотрудников. Каждый сотрудник рабо-
тает пять дней подряд с двумя выходными.

Здесь целевой является ячейка D20, в которой рассчитывается размер фонда за-
работной платы. В соответствии с содержащейся в ней формулой =015*019, коли-
чество сотрудников умножается на размер ставки. Изменяемые данные — это зна-
чения, определяющие количество работников в группе. Они содержатся в ячейках
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диапазона D7:D13. Рассмотрим, каковы ограничения для данной задачи. Во-пер-
вых, количество работников в группе не может быть выражено отрицательным
числом, то есть D7:D13>-0. Во-вторых, количество работников должно быть рав-
ным целому числу, то есть D7:013=Целое. В-третьих, количество ежедневно заня-
тых работников ни в коем случае не должно быть меньше ежедневной потребно-
сти, то есть F15:L15>-F17:L17.

[Припер 3: График инятости пв репная а Парка отдыха.
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Рис. 7.18. Таблица-пример

Для того чтобы запустить процедуру поиска решения, необходимо выделить це-
левую ячейку (в нашем примере D20) и вызвать команду Tools к Solver (Сервис *
Поиск решения), в результате действия которой будет открыто диалоговое окно
надстройки Solver (Поиск решения) (рис. 7.19).

Solver- Parameters

$D$7;$D$13 = integer
$D$7:$D$13 >- 0

$F$15:$L$15>=4F$17:*L$17

Рис. 7.19. Диалоговое окно Solver Parameters

В поле Set Target Cell (Установить целевую ячейку) данного окна указывается ад-
рес целевой ячейки. Переключатели Equal То (Равной) задают ее значение - Мах
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(максимальному значению), Min (минимальному значению) или Value of (значе-
нию). В последнем случае значение вводится в поле справа. В поле By Changing
Cells (Изменяя ячейки) указывается, в каких ячейках программа должна изме-
нить значения для получения оптимального результата.

ВНИМАНИЕ При нажатии кнопки Guess (Предположить) программа выделяет диапазон
ячеек, на которые имеется ссылка в целевой ячейке.

Заданные ограничения перечислены в списке Subject to the Constraints (Ограниче-
ния). При необходимости ввести дополнительное ограничение нужно посредст-
вом щелчка на кнопке Add (Добавить) открыть диалоговое окно Add Constraint
(Добавление ограничения).

В поле Cell Reference (Ссылка на ячейку) этого окна введите адрес ячейки, содер-
жимое которой должно удовлетворять заданному ограничению, а в поле Constraint
(Ограничение) укажите значение, выступающее в качестве ограничения, или ад-
рес ячейки с таким значением. Между этими двумя полями находится еще одно,
в котором устанавливается оператор, определяющий отношение между значени-
ем ячейки и ограничением. После нажатия кнопки ОК заданное ограничение поя-
вится в диалоговом окне Solver (Поиск решения).

'ПРИМЕЧАНИЕ Воспользовавшись кнопкой Add (Добавить), в одном сеансе работы с диало-
говым окном Add Constraint (Добавление ограничения) можно добавить не-
сколько ограничений.

Чтобы удалить ограничение, выделите его в списке Subject to the Constraints (Огра-
ничения) и нажмите кнопку Delete (Удалить). Если вы решили изменить ограни-
чение, отметьте его и нажмите кнопку Change (Изменить). После этого появится
диалоговое окно Change Constraint (Изменение ограничения), аналогичное окну до-
бавления ограничения.

Так как мы рассматриваем готовый пример, все необходимые значения в диалого-
вом окне надстройки Solver (Поиск решения) заданы, и, нажав кнопку Solver (Вы-
полнить), можно запустить процесс поиска решения. Когда нужное значение будет
найдено, появится диалоговое окно Solver Results (Результаты поиска решения),
а в таблице будут представлены значения, полученные методом расчета (рис. 7.20).

Чтобы принять эти значения, активизируйте переключатель Keep Solve Solution
(Сохранить найденное решение). Если вы хотите оставить старые значения, то вы-
берите переключатель Restore Original Values (Восстановить исходные значения).

Найденное решение можно сохранить в виде 4>айла. Для этого нажмите кнопку
Save Scenario (Сохранить сценарий) и в открывшемся окне задайте имя файла.
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Пример 3: График занятости персонала Парка отдыха

Для работников с пятидневном рабочей неделей и двумя в
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Рис. 7.20. Результаты поиска решения и диалоговое окно Solver Results

Процедура поиска решения
1. Создайте таблицу с формулами, которые устанавливают связи между

ячейками.

2. Выделите целевую ячейку, которая должна принять необходимое зна-
чение, и выберите команду Tools > Solver (Сервис > Поиск решения).
Поле Set Target Cell (Установить целевую ячейку) открывшегося диало-
гового окна надстройки Solver (Поиск решения) будет содержать адрес
целевой ячейки (рис. 7.19).

3. Установите переключатели Equal To (Равной), задающие значение це-
левой ячейки, — Мах (максимальному значению), Min (минимальному
значению) или Value of (значению). В последнем случае введите значе-
ние в поле справа.

4. Укажите в поле By Changing Cells (Изменяя ячейки), в каких ячейках про-
грамма должна изменять значения в поисках оптимального результата.

5. Создайте ограничения в списке Subject to the Constraints (Ограничения).
Для этого щелкните на кнопке Add (Добавить) и в диалоговом окне Add
Constraint (Добавление ограничения) определите ограничение.

6. Щелкнув на кнопке Solver (Выполнить), запустите процесс поиска ре-
шения.

7. Когда появится диалоговое окно Solver Results (Результаты поиска реше-
ния), выберите переключатель Keep Solve Solution (Сохранить найденное
решение) или Restore Original Values (Восстановить исходные значения).

8. Щелкните на кнопке ОК.
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Создание отчетов о результатах поиска решения
Если вы хотите сохранить результаты работы процедуры поиска решения в виде
отчета, то тип отчета можно выбрать в списке Reports (Отчеты) диалогового окна
Solver Results (Результаты поиска решения). Для того чтобы задать несколько от-
четов, удерживайте нажатой клавишу Ctrl Программа предлагает отчеты следую-
щих типов: Answer (Результаты), Sensitivity (Устойчивость) и Limits (Пределы).
Каждый отчет создается на отдельном листе. На рис. 7.21 для рассматриваемого
примера представлен отчет типа Answer (Результаты).

•
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Рис. 7.21. Отчет о результатах поиска решения
-

Параметры процедуры поиска решения
Задать параметры, определяющие способ выполнения вычислений, можно в диа-
логовом окне Solver Options (Параметры поиска решения). Это окно (рис. 7.22).
открывается щелчком на кнопке Options (Параметры) в диалоговом окне Solver
Parameters (Поиск решения). Основные параметры, которые здесь задаются, пере-
числены ниже.

О Max Time (Максимальное время) — максимальное время, в секундах, отведен-
ное на поиск решения задачи.

О Iterations (Предельное число итераций) — максимальное количество итераций,
возможных в течение поиска конечного результата. Предлагаемое по умолча-
нию значение 100 подходит для большинства простых задач.

О Precision (Точность) — точность результата.

О Tolerance (Допустимое отклонение) — величина допуска на отклонение от оп-
тимального решения, если множество значений влияющей ячейки ограничено
множеством целых чисел. При указании большего допуска поиск решения за-
вершается быстрее.
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О Convergence (Сходимость) — значение относительного изменения, при дости-
жении которого в последних пяти итерациях поиск решения прекращается.
Данный параметр применяется только к нелинейным задачам.

Solver Options

1\Ш Time: Г ок"

КШЩШШ I - и л:

оым!

(•' (Jfiv-itr-n

Рис. 7.22. Диалоговое окно Solver Options

СОВЕТ Для получения более полных сведений об этих и других параметрах восполь-
зуйтесь справочной системой, для вызова которой следует нажать кнопку Help
(Справка) в диалоговом окне Solver Options (Параметры поиска решения).

Совокупность установленных параметров и ограничений можно сохранить на ра-
бочем листе в качестве модели. Для этой цели предназначена кнопка Save Model
(Сохранить модель) рассматриваемого диалогового окна. После ее нажатия от-
крывается одноименное окно, в котором следует выбрать вертикально ориенти-
рованный диапазон ячеек для размещения модели либо одну ячейку (в этом слу-
чае программа выберет диапазон автоматически). Для загрузки модели нужно
нажать кнопку Load Model (Загрузить модель) и выделить диапазон ячеек, в кото-
ром хранятся параметры модели.

Самостоятельная работа
1. Попытайтесь разобраться, как с помощьЬ функции поиска решения находят-

ся оптимальные значения для некоторых из задач, представленных в файле
Solvsamp.xls.

2. Примените для решения своей задачи функцию поиска решения.

Сценарии
Сценарий представляет собой набор сохраненных программой Excel значений, ко-
торые она может автоматически подставить в ячейки рабочего листа. Сценарии
можно использовать для прогноза результатов моделирования и расчетов. Суще-
ствует возможность создать отчет по результатам работы сценария, который со-
держит как исходные, так и итоговые значения, что позволяет прослеживать за-
висимости между данными в таблице.
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Создание и использование сценария
Воспользуемся таблицей расчетов отчислений в пенсионный фонд и создадим
для нее несколько сценариев. Назовем их Стандартный, Наилучший и Критический.
При работе со сценариями удобно пользоваться именованными ячейками и диа-
пазонами ячеек, поэтому мы, выбрав таблицу и вызвав команду Insert > Name >
Create (Вставка > Имя > Создать), присвоили ячейкам с данными имена (обратите
внимание на строку формул: в ней отображается имя ячейки А2).

Для создания сценариев применяется команда Tools > Scenarios (Сервис > Сцена-
рий), в результате вызова которой открывается диалоговое окно Scenario Manager
(Диспетчер сценариев), показанное на рис. 7.23.

Рис, 7.23. Исходная таблица и диалоговое окно Scenario Manager

Для того чтобы создать на рабочем листе сценарий с исходными значениями, сле-
дует воспользоваться диалоговым окном Add Scenario (Добавление сценария), ко-
торое открывается в результате нажатия кнопки Add (Добавить). Поле Scenario
name (Имя сценария) этого окна (рис. 7.24) предназначено для ввода имени сце-
нария, а поле Changing cells (Изменяемые ячейки) — для указания ячеек, в кото-
рые будут подставляться значения, заданные в сценарии.

СОВЕТ При необходимости выбрать несколько неснежных ячеек удерживайте на-
жатой клавишу Ctrl.

В поле Comment (Примечание) можно ввести и отредактировать текст коммента-
рия к сценарию. По умолчанию диспетчер сценариев предлагает указать в этом
поле дату создания сценария и имя пользователя. Если рабочий лист защищен
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с помощью пароля, редактирование сценария можно запретить, установив в об-
ласти Protection (Защита) флажок Prevent changes (запретить изменение). В ре-
зультате активизации флажка Hide (скрыть) имя сценария не будет отображаться
в окне сценариев.

Рис. 7.24. Диалоговое окно Add Scenario

После нажатия в окне Add Scenario (Добавление сценария) кнопки ОК откроется
диалоговое окно Scenario Values (Значения ячеек сценария), содержащее исходные
значения (рис. 7.25). В поля этого окна, как следует из его названия, нужно вве-
сти числовые и текстовые значения, а также формулы, составляющие данный
сценарий, и нажать кнопку ОК.

Scenario Values

Рис. 7.25. Диалоговое окно Scenario Values

ВНИМАНИЕ Чтобы сохранить исходные данные в рабочем листе,перед созданием нового
сценария следует создать копию листа или даже сценарий на основе исход-
ных значений.

Имя созданного сценария отобразится в диалоговом окне Scenario Manager (Дис-
петчер сценариев). На представленном рисунке вы видите имена трех созданных
нами сценариев.
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Создание сценария
1. Создайте рабочий лист с данными и формулами, которые устанавлива-

ют связи между ячейками.
2. С помощью команды Tools к Scenarios (Сервис > Сценарий) откройте

диалоговое окно Scenario Manager (Диспетчер сценариев).

3. Нажмите кнопку Add (Добавить) и в появившемся диалоговом окне
Add Scenario (Добавление сценария) задайте имя сценария в поле Scena-
rio name (Имя сценария), а адреса изменяемых ячеек — в поле Changing
cells (Изменяемые ячейки). Щелкните на кнопке ОК.

4. В диалоговом окне Scenario Values (Значения ячеек сценария) задайте
значения для изменяемых ячеек и нажмите кнопку ОК. В появившемся
диалоговом окне Scenario Manager (Диспетчер сценариев) отобразится
имя сценария.

5. Щелкните на кнопке Close (Закрыть).

Чтобы отредактировать сценарий, необходимо сначала выделить его имя в диало-
говом окне Scenario Manager (Диспетчер сценариев) и щелкнуть на кнопке Edit (Из-
менить). Затем в открывшемся диалоговом окне Edit Scenario (Изменение сцена-
рия) нужно указать используемые в сценарии изменяемые ячейки. Данное окно
аналогично окну Add Scenario (Добавление сценария). Изменить исходные значе-
ния можно в диалоговом окне Scenario Values (Значения ячеек сценария), для пе-
рехода в которое следует щелкнуть на кнопке ОК.

Пользуясь такими сценариями, вы можете без труда вводить в рабочий лист раз-
личные наборы исходных данных. Значения будут вставлены в изменяемые ячей-
ки в том формате, который задан для этих ячеек. Разумеется, вы можете указать
другой формат.
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Использование сценария
1. Задав команду Tools > Scenarios (Сервис > Сценарий), откройте диалоговое

окно Scenario Manager (Диспетчер сценариев).
2. Щелкните на кнопке Show (Вывести), и данные сценария, а также пере-

считанные значения формул отобразятся на рабочем листе.

3. Щелкните на кнопке Close (Закрыть).

'ПРИМЕЧАНИЕ В окне Scenario Manager (Диспетчер сценариев) доступны также сценарии,
созданные с помощью процедуры поиска решения.

Обычно сценарии применяются только в том рабочем листе, в котором они были
созданы. Чтобы иметь возможность использовать сценарии из других рабочих
листов, их следует вставить в текущий лист. Делается это следующим образом.
Щелкните в окне Scenario Manager (Диспетчер сценариев) на кнопке Merge (Объе-
динить), и на экране появится диалоговое окно Merge Scenarios (Объединение сце-
нариев), в котором программа информирует пользователя о количестве сценариев,
созданных для каждого листа рабочей книги. Выберите лист, сценарии которого
вас интересуют, и нажмите кнопку ОК.

Создание итогового отчета по результатам работы сценариев
Наилучшей формой представления результатов работы диспетчера сценариев яв-
ляется отчет, который содержит данные, полученные в результате применения
всех сценариев текущего рабочего листа. Создается он на отдельном листе. Вы
можете создать итоговый отчет и отчет в виде сводной таблицы. Тип отчета зада-
ется в показанном на рис. 7.26 диалоговом окне Scenario Summary (Отчет по сцена-
рию) путем установки переключателя Scenario summary (структура) или Scenario
PivotTable report (сводная таблица).

Создание отчета о результатах работы сценариев
1. Откройте диалоговое окно Scenario Manager (Диспетчер сценариев), за-

дав команду Tools > Scenarios (Сервис > Сценарий).

2. Нажмите кнопку Summary (Отчет), и на экране появится диалоговое ок-
но Scenario Summary (Отчет по сценарию).

3. Выберите тип отчета. Чтобы получить итоговый отчет, установите пе-
реключатель Scenario sum тагу (структура), а для создания отчета в виде
сводной таблицы воспользуйтесь переключателем Scenario PivotTable
report (сводная таблица).

4. В поле Result cells (Ячейки результата) измените при необходимости
диапазон ячеек, значения которых должны быть представлены в отчете.

5. Щелкните на кнопке ОК.
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Рис. 7.26. Диалоговое окно Scenario Summary

Итоговый отчет для нашего примера представлен на рис. 7.27. Как видите, мы
включили в него значения ячейки, которая содержит величину прибавки к пен-
сии. Обратите внимание на то, что отчет оформлен в виде двухуровневой табли-
цы (уровни образуют как строки, так и столбцы).

Возраст
Месячные отчии

Накопленная^сумма
Ежемесячная прибавка к пенсии

Notes: Cutrent values column represents values of changing cells al
time Scenario Summary Report was created. Changing cells for each
scenario are highlighted in gray.

Рис. 7.27. Итоговый отчет

Самостоятельная работа
1. Создайте несколько сценариев для решения задачи, связанной с расчетом за

покупку квартиры в кредит. В качестве изменяющихся задайте ячейки, в кото-
рых содержатся сумма первого взноса и срок кредита. Результирующими
должны быть ячейки, в которых хранятся ежемесячная сумма возврата креди-
та и сумма процентов за кредит.

2. Создайте отчет в виде структурированной таблицы по результатам функцио-
нирования сценариев, разработанных в пункте 1.

Сводные таблицы и диаграммы

Сводная таблица является интерактивным средством, позволяющим получить
данные из некоторого источника (списка, таблицы, базы данных) и выполнить их
анализ и просмотр различными способами. С помощью сводной таблицы можно

8 Зак. 345
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просмотреть необходимую для анализа часть имеющейся информации, отфильт-
ровать данные и разместить результаты на различных рабочих страницах, отсор-
тировать данные, автоматически сгенерировать итоги. Для более наглядного пред-
ставления результатов наряду со сводной таблицей можно создать диаграмму.

Исходные данные для сводной таблицы
Сводную таблицу можно создать на основе области таблицы, целой таблицы или
нескольких таблиц. Построение сводной таблицы на основе внешних источников
данных выполняется с помощью Microsoft Query. Исходные данные для сводных
таблиц должны быть организованы в виде списка, каждая строка которого содер-
жит одни и те же категории информации, приведенные в определенном порядке.
В первой строке списка должны находиться заголовки столбцов. Они использу-
ются для создания полей сводной таблицы и идентификации отдельных элемен-
тов данных, то есть уникальных значений полей, взятых из списка. Несмотря на
то что поля создаются на основе столбцов, содержащиеся в них данные можно
размещать как в столбцах, так и в строках сводной таблицы.

Избегайте ситуации, когда рабочий лист содержит несколько списков, поскольку
в этом случае можно получить неожиданный результат при выполнении фильт-
рации и сортировки или при вычислении общих итогов. Удостоверьтесь, что спи-
сок отделен от других данных рабочего листа пустыми строками и столбцами, но
старайтесь не применять их непосредственно в списке. Если необходимо отде-
лить названия строк или столбцов от данных, используйте границы, а не пустые
строки или столбцы, и не заполняйте строки символами подчеркивания,

Мастер сводных таблиц и диаграмм
Создание и обработка сводных таблиц осуществляются с помощью специ-
ального мастера, который запускается командой Data > PivotTable and Pivot-

Chart Report (Данные > Сводная таблица). Параметры сводной таблицы задаются
в трех его диалоговых окнах. Мы продемонстрируем работу мастера на примере
таблицы, представленной на рис. 7.28, для чего составим сводную таблицу, отра-
жающую итоги работы менеджеров.

После вызова мастера появляется диалоговое окно PivotTable and PivotChart Wi-
zard— Step 1 of 3 (Мастер сводных таблиц и диаграмм — шаг 1 из 3), в котором ука-
зываются источник данных для сводной таблицы и тип отчета — сводная таблица
или диаграмма (рис. 7.29).

В области Where is the data that you want to analyze? (Создать таблицу на основе дан-
ных, находящихся) этого окна по умолчанию активизирован переключатель Mic-
rosoft Excel List or database (в списке или базе данных Microsoft Excel), посредством
которого задается поиск источника данных на рабочем листе. Если источник на-
ходится в файлах внешней базы данных, то необходимо выбрать переключатель
External data source (во внешнем источнике данных). Для того чтобы объединить
несколько одинаковых по структуре списков, выберите переключатель Multiple
consolidation ranges (в нескольких диапазонах консолидации). Если вы хотите в ка-
честве исходных данных использовать информацию, хранящуюся в другой свод-
ной таблице, нужно выбрать переключатель Another PivotTable report or PivotChart
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report (в другой сводной таблице или диаграмме). Сводная таблица может слу-
жить источником данных для новой сводной таблицы.

14irrosoft Office 1_нсе12UG'J - Сводные табянцыли
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Рис. 7.28. Данная таблица может служить исходной для создания сводной таблицы
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Рис. 7.29. Первое диалоговое окно мастера сводных таблиц

В области What kind of report do you want to create? (Вид создаваемого отчета) по
умолчанию активизирован переключатель PivotTable (сводная таблица). Оставьте
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его активным; как действует переключатель PivotChart report (with PivotTabLe report)
(сводная диаграмма (со сводной таблицей)) мы рассмотрим позже.

После нажатия кнопки Next (Далее) осуществляется переход к следующему диа-
логовому окну мастера (рис. 7.30).

PivolTable dnd PivotChart Wizard - Step 2 of 3

Wh.;r4 к >h>' &Sa tiki! у;; '.'iv>\' in ij Щ

Рис. 7.30. Второе диалоговое окно мастера сводных таблиц и диаграмм

Во втором окне мастера сводных таблиц определяется диапазон ячеек, данные из
которого будут включены в сводную таблицу. Если перед запуском мастера ука-
затель ячейки находился внутри таблицы, то программа автоматически вставит
в поле Range (Диапазон) адрес таблицы. Когда данные для сводной таблицы нахо-
дятся в другой книге, следует, нажав кнопку Browse (Обзор), загрузить таковую
из диалогового окна выбора файла. Укажите диапазон ячеек, на основе которого
должна быть составлена сводная таблица, и, нажав кнопку Next (Далее), перейди-
те в следующее окно мастера.

Третье окно мастера сводных таблиц (рис. 7.31) предназначено для выбора ме-
сторасположения сводной таблицы — на новом листе (переключатель New work-
sheet (новый лист)) или на текущем листе (переключатель Existing worksheet (су-
ществующий лист)). В случае размещения таблицы на текущем рабочем листе
необходимо указать позицию ее левого верхнего угла.

PivotTable and PivotChart Wizard - Step 3 of 3

Рис. 7.31. Третье диалоговое окно мастера сводных таблиц

После нажатия в третьем окне мастера кнопки Finish (Готово) будут отображены
панель инструментов PivotTable (Сводные таблицы) и окно PivotTable Field List
(Список полей сводной таблицы), а на рабочем листе появятся области, в кото-
рые можно перетаскивать поля (рис. 7.32). Всего таких областей четыре:

О Drop Column Fields Here (Перетащите сюда поля столбцов);

О Drop Row Fields Here (Перетащите сюда поля строк);
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О Drop Page Fields Неге (Перетащите сюда поля страниц);

О Drop Data Items Here (Перетащите сюда элементы данных).

В области столбцов и строк размещают поля, по которым производится сравне-
ние или анализ. В область элементов данных перетаскивают поля, предназначен-
ные для расчетов итоговых показателей. Область страниц не обязательна для за-
полнения, ее используют при необходимости создать несколько отчетов, задан-
ных в предыдущих областях.

LJMiciosolf Office tncel 2003 - Сводные T.iGn*Ubi.nls

Рис. 7.32. Области перетаскивания и панель инструментов PivotTabLe

Какие поля куда следует перетаскивать, зависит от типа отчета. Так, для нашей
таблицы можно создать отчет, в котором будут отображаться данные об объемах
продаж каждого изделия, осуществляемых менеджерами в каждый из обслужи-
ваемых регионов. Для представления информации о продажах изделия в регион
нужна двухмерная таблица. Такую таблицу нужно создать для каждого из трех
менеджеров. Чтобы реализовать это, нужно использовать поле страниц. Итак, из
окна PivotTable Field List (Список полей сводной таблицы) перетаскиваем в поле
страниц поле Менеджер, в поле строк — поле Наименование, в поле столбцов — поле
Регион, а в область данных — поля Расход, ш т . и Расход, $. В результате таких дей-
ствий получим сводную таблицу, представленную на рис. 7.33.

I ПРИМЕЧАНИЕ Чтобы удалить поле из области перетаскивания, достаточно перетащите его
мышью за ее пределы.
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jSy Пылесос Scarlett 1500 Вт(7-ступ. фильтр]

Пылесос Scarlett моющий 1600 Вт/20л/2/

Рис. 7.33. Сводная таблица сформирована

Использование режима макета
Размещение полей непосредственно в рабочем листе дает определенные преиму-
щества при работе в режиме WYSIWYG и при наличии небольшого объема дан-
ных. Однако если вы будете оперировать большим количеством данных, наверняка
начнут возникать задержки, обусловленные необходимостью производить много
вычислений. Мастер сводных таблиц и диаграмм имеет режим макета, который
является более удобным и быстрым при работе с большим объемом данных. Если
при перетаскивании поля непосредственно в область данных рабочего листа туда
перемещаются также все данные, связанные с этим полем, то в режиме макета вы-
полняется только размещение кнопок полей, а относящиеся к ним данные не за-
трагиваются.

Для перехода в режим макета в третьем диалоговом окне мастера нужно нажать
кнопку Layout (Макет), в результате чего будет открыто диалоговое окно мастера
PivotTable and PivotChart Wizard — Layout (Мастер сводных таблиц и диаграмм — ма-
кет) (рис. 7.34).

В данном окне определяется структура создаваемой таблицы. В центре окна рас-
положены области ROW (Строка), COLUMN (Столбец) и DATA (Данные). Все заго-
ловки (метки) полей таблицы отображаются справа от перечисленных областей.
В правой части окна расположены кнопки полей, по одной для каждого поля ис-
точника данных. Структура сводной таблицы создается путем перетаскивания
кнопок полей в одну из четырех областей макета. Завершив данную операцию,
щелкните на кнопке ОК, чтобы закрыть окно Layout (Макет) и вернуться к третьему
диалоговому окну мастера.
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Рис. 7.34. Режим макета

Создание сводной таблицы
1. Установите указатель ячейки в область списка и вызовите команду

Data » PivotTabLe and PivotChart Report (Данные > Сводная таблица), в ре-
зультате чего будет открыто первое диалоговое окно мастера сводных
таблиц и диаграмм.

2. Выберите в нем источник данных и укажите, что будет создавать свод-
ная таблица. Щелкните на кнопке Next (Далее).

3. Во втором диалоговом окне мастера при необходимости выберите диа-
пазон ячеек для исходных данных. Щёлкните на кнопке Next (Далее).

4. В третьем окне мастера укажите, куда следует поместить сводную таб-
лицу: на новый рабочий лист или на существующий. Во втором случае
укажите также начальную ячейку для размещения таблицы.

5. Щелкните на кнопке Layout (Макет) для открытия одноименного диа-
логового окна. Перетащите кнопки полей в области макета таблицы.
Вы должны разместить хотя бы по одному полю в областях ROW (Стро-
ка), COLUMN (Столбец) и DATA (Данные). Заполнять область PAGE (Стра-
ница) не обязательно. Нажмите кнопку ОК (Готово), а затем — кнопку
Finish (Готово). После этого сводная таблица с заданными параметра-
ми появится на рабочем листе.
ИЛИ
Щелкните на кнопке Finish (Готово), в результате чего отобразятся па-
нель инструментов PivotTable (Сводные таблицы) и окно PivotTabLe Field
List (Список полей сводной таблицы), а на рабочем листе появятся об-
ласти перетаскивания строки, столбца, страницы и данных. Перетащи-
те в них нужные поля, и таблица будет сформирована.

О том, как можно оперировать данными сводной таблицы, мы расскажем позже,
а сейчас речь пойдет об устанавливаемых для нее параметрах.
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Параметры сводной таблицы
При необходимости изменить параметры создаваемой сводной таблицы или диа-
граммы нажмите в третьем окне мастера (см. рис. 7.31) кнопку Options (Парамет-
ры), а если вы работаете с готовой таблицей, вызовите команду Table Options (Па-
раметры сводной таблицы), выбрав ее из списка команд панели инструментов
PivotTabLe (Сводные таблицы), — после выполнения любого из этих действий бу-
дет открыто диалоговое окно PivotTable Options (Параметры сводной таблицы), по-
казанное на рис. 7.35.

PivotTable Options

Рис. 7.35. Диалоговое окно PivotTable Options

Это окно состоит из двух областей — Format options (Формат) и Data options (Дан-
ные). В первой из них устанавливаются параметры форматирования и вид свод-
ной таблицы, а во второй — параметры источника данных сводной таблицы.

Посредством установки флажков Grand totals for columns (общая сумма по столб-
цам) и Grand totals for rows (общая сумма по строкам) задается автоматическое оп-
ределение промежуточных итогов, а с помощью флажка AutoFormat table (авто-
формат) — возможность использовать при форматировании таблицы параметры
автоформата. Если активизирован флажок Preserve formatting (сохранять форма-
тирование), заданные вами параметры форматирования сводной таблицы сохра-
няются и после перегруппировки данных. В результате установки флажка Sub-
total hidden page items (включать скрытые значения) в сводной таблице будут
учитываться значения, находящиеся в скрытых ячейках рабочего листа. При ак-
тивизации флажка Repeat item labels on each printed page (повторять подписи на ка-
ждой странице печати) на страницах, выводящихся на печать, слева будут повто-
ряться названия элементов для всех полей строк. Установка флажка Set print titles
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(печать заголовков) позволяет использовать имена полей и элементов отчета свод-
ной таблицы в качестве заголовков строк и столбцов при печати.

С помощью флажков For error values, show (для ошибок отображать) и For empty cells,
show (для пустых ячеек отображать) можно задать значения, которые будут выво-
диться на экран вместо стандартных сообщений об ошибках или пустых ячеек.

Флажок Save data with table layout (сохранять данные вместе с таблицей) из облас-
ти Data options (Данные) предоставляет возможность сохранить вместе с макетом
сводной таблицы все исходные данные, что необходимо в случае создания таблицы
на основе нескольких областей, полученных в результате консолидации. Если ус-
тановлен флажок Refresh on open (обновить при открытии), то при открытии свод-
ной таблицы ее значения автоматически обновляются в результате изменения
исходных данных. При активизации флажка Refresh every (обновлять каждые
мин.) становится доступным поле ввода, в котором указывается период обновле-
ния данных сводной таблицы или диаграммы, в минутах. Благодаря флажку
Enable drill to details (развертывание разрешено) на новом листе можно получить
подробную информацию о той ячейке из области данных, на которой выполняет-
ся двойной щелчок.

Флажки группы External data options (Внешние данные) устанавливают режимы
доступа к внешним источникам данных. Запрос на получение информации из
внешней базы данных может быть выполнен в фоновом режиме, что позволит не
приостанавливать работу. Режим фонового выполнения запросов устанавливает-
ся с помощью флажка Background query (фоновый запрос). Флажок Save password
(сохранить пароль) предоставляет возможность сохранить пароль как часть за-
проса к внешней базе данных, а флажок Optimize memory (оптимизировать память)
позволяет сэкономить память при создании сводных таблиц на основе баз дан-
ных небольшого объема.

Управление элементами данных
и итоговыми расчетами

Итак, сводная таблица создана (см. рис. 7.33). Обратите внимание на то, что спра-
ва от поля страницы и в остальных полях сводной таблицы находятся кнопки со
стрелками. После щелчка на такой кнопке появляется окно со списком элементов
данных соответствующего поля. Устанавливая и снимая флажки в этом окне,
можно управлять отображением элементов поля (для поля страницы отображае-
мый в окне элемент необходимо отметить и нажать кнопку ОК). Например, после
выбора в поле страницы фамилии менеджера отчет созданной нами сводной таб-
лицы приобретает такой вид, как показано на рис. 7.36.

По умолчанию в сводной таблице, в крайнем правом ее столбце и в самой нижней
строке, отображаются общие итоги. Если вам нужно скрыть эти данные, устано-
вите указатель ячейки в область сводной таблицы, вызовите контекстное меню и,
задав в нем команду Table Options (Параметры сводной таблицы), снимите в диа-
логовом окне PivotTable Options (Параметры сводной таблицы) флажки Grand totals for
columns (общая сумма по столбцам) и Grand totals for rows (общая сумма по строкам).
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Рис. 7.36. Сводная таблица после выбора в поле страницы фамилии менеджера

При расчете итоговых значений в сводной таблице по умолчанию применя-
ется операция суммирования исходных данных. Если вас это не устраивает,

установите указатель ячейки в соответствующую ячейку области данных, щелк-
ните правой кнопки мыши, вызовите из контекстного меню команду Field Settings
(Параметры поля), после чего выберите ;иетод обработки исходных данных в спи-
ске Summarize by (Операция) открывшегося диалогового окна PivotTable Field (Вы-
числение поля сводной таблицы) (рис. 7.37).

Excel позволяет выполнять над итоговыми данными также ряд других операций.
Щелкните на кнопке Options (Дополнительно) для расширения диалогового окна
PivotTable Field (Вычисление поля сводной таблицы), а затем выберите в раскры-
вающемся списке Show data as (Дополнительные вычисления) одну из представ-
ленных там функций. Для многих из них нужно установить значения в списках
Base field (поле) и Base item (элемент). Посредством первого списка задается стол-
бец в исходных данных, а посредством второго — значение в этом столбце.

В диалоговом окне PivotTable Field (Вычисление поля сводной таблицы) можно
также изменить используемый по умолчанию формат данных сводной таблицы
General (Общий). Для этого достаточно щелкнуть на кнопке Number (Формат)
и задать нужный формат, чисел в открывшемся диалоговом окне Format Cells
(Формат ячеек).

На этапе создания сводной таблицы изменить вид выполняемой над исходными
данными операции, произвести дополнительные вычисления, задать другой формат
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ячеек можно и с помощью мастера. Для этого в третьем его окне нужно перейти
в режим макета, воспользовавшись кнопкой Layout (Макет). Окно с параметрами,
в котором осуществляется удаление общих итогов, также вызывается в третьем
окне мастера — посредством нажатия кнопки Options (Параметры).

PtvotTabte Field

Ш •: ••

jsum of Расход, шт.

I

•

i j , .

- •

g

Пылесос Scarlett 15
Ты лес о с Scarlett ISC
Пылесос Scarlett

Рис. 7.37. Диалоговое окно PivotTable Field
после щелчка на кнопке Options

Форматирование данных сводной таблицы

1. Установите указатель ячейки в нужную ячейку области данных и щелч-
ком правой кнопки мыши откройте контекстное меню.

2. С помощью команды Field Settings (Параметры поля) откройте диало-
говое окно PivotTabLe Field (Вычисление поля сводной таблицы).

3. Укажите в списке Summarize by (Операция) операцию, которую нужно
производить над исходными значениями для вычисления элементов
данных сводной таблицы.

4. При необходимости задать дополнительные вычисления нажмите кноп-
ку Options (Дополнительно), после чего выберите в списке Show data as
(Дополнительные вычисления) нужную функцию, а также поле и эле-
мент, если это понадобится.

5. Чтобы изменить формат данных сводной таблицы, нажмите кнопку Num-
ber (Формат), в открывшемся диалоговом окне выберите нужный фор-
мат и щелкните на кнопке ОК.

6. Закройте диалоговое окно PivotTabLe Field (Вычисление поля сводной
таблицы), щелкнув на кнопке ОК.
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Детальное отображение данных сводной таблицы
При необходимости пользователь может задать более детальное представление
сводной таблицы. Например, для полей строк и столбцов можно задать отображе-
ние дополнительных столбцов из исходных данных. Выбор таких столбцов про-
изводится в диалоговом окне Show Detail (Показать детали) (рис. 7.38).

Рис. 7.38. Диалоговое окно Show Detail

Ш Установите указатель в ячейке с нужным полем и щелкните на кнопке Show
Detail (Показать детали) панели инструментов PivotTable (Сводные таблицы).

Выделите столбец исходных данных, который нужно отобразить, и щелкните на
кнопке ОК. В сводной таблице появится еще одно поле — для представления этих
данных.

Вы можете также получить при необходимости доступ к исходным данным, кото-
рые использовались при расчете значения конкретной ячейки области данных.
Дважды щелкните на любом ненулевом значении в области данных, и Excel от-
кроет новый рабочий лист с записями, использовавшимися при расчете значения
этой ячейки отчета. Рабочий лист с данными, которые применялись для расчета
одной из ячеек с общими итогами, показан на представленном ниже рисунке.

Цена, i: Расход, иг.'Расход, (I Менеджер

Э'£ Пылесос Scarlett 15008тУ2л

Ш Пылесос Scarlett 1450 8т/2.5л

Изменение и обновление сводной таблицы
Если после создания таблицы вам понадобится включить в нее новые поля строк
столбцов или страниц, то для этого можно воспользоваться списком полей, кото-
рый предоставляет панель инструментов PivotTable (Сводные таблицы), или вы-
звать мастер.
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Добавление в сводную таблицу полей, имеющихся
в источнике данных
1. Выделите любое поле в сводной таблице.

2. Отобразите панель инструментов PivotTable (Сводные таблицы). Щелк-
ните на кнопке Show Field List (Отобразить поля), чтобы вывести на эк-
ран список полей источника данных. Перетащите требуемое поле из
окна в нужную область сводной таблицы.

ИЛИ

Активизируйте команду Data > PivotTable and PivotChart Report (Дан-
ные > Сводная таблица), чтобы открыть третье окно мастера. Щелкни-
те на кнопке Layout (Макет), в открывшемся диалоговом окне добавьте
необходимые поля, а затем закройте окно и щелкните на кнопке Finish
(Готово).

Для того чтобы удалить любое поле, перетащите соответствующую ему кнопку на
рабочем листе за пределы сводной таблицы.

-/т. Сводная таблица динамически связана с базой данных, использовавшейся
;!'. при ее создании. Если значения в базе данных изменились, выберите команду

Data » Refresh Data (Данные * Обновить данные) или щелкните на кнопке Refresh
Data (Обновить данные) панели инструментов PivotTable (Сводные таблицы),
и Excel обновит сводную таблицу с учетом всех изменений.

Однако если в источнике данных появились новые строки или столбцы, этот
прием не сработает. В таком случае необходимо вернуться к мастеру свод-

ных таблиц и диаграмм и указать новый диапазон записей, который включается в
таблицу. Таким образом, для обновления диапазона, используемого сводной таб-
лицей, вызовите команду Data I» PivotTable and PivotChart Report (Данные » Сводная
таблица) или откройте список PivotTable (Сводная таблица) панели инструмен-
тов и выберите команду PivotTable Wizard (Мастер), в результате чего откроется
третье диалоговое окно мастера сводных таблиц.

Щелкните на кнопке Back (Назад) для возврата ко второму окну мастера и выбе-
рите источник данных заново или нажмите клавишу Shift и расширьте область
выделения. Щелкните на кнопке Finish (Готово) для закрытия окна мастера.

Автоматическое форматирование сводной таблицы

Ш С помощью автоматического форматирования сводную таблицу можно сде-
лать более наглядной и удобной для восприятия. Установите указатель ячей-

ки в область сводной таблицы и выберите команду Format >AutoFormat (Фор-
мат ¥ Автоформат) или же нажмите кнопку Format Report (Формат отчета) панели
инструментов PivotTable (Сводная таблица) и, когда появится диалоговое окно
AutoFormat (Автоформат), выберите в нем подходящий вариант оформления таб-
лицы и нажмите кнопку ОК.
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Рис. 7.39. Диалоговое окно AutoFormat

Создание сводной таблицы со страничной организацией

Ш В рамках нашего примера вместо одной сводной таблицы, где отображаются
данные о продажах всех менеджеров, можно создать набор сводных таб-

лиц — по одной для каждого из них. Реализовать эту задачу можно при условии,
что поле, для значений которого надо создать таблицы, будет находиться в облас-
ти страниц. Если это сделано, выделите любую ячейку сводной таблицы, щелкни-
те на ней правой кнопкой мыши и выберите в контекстном меню пункт Show
Pages (Отобразить страницы) или же щелкните на одноименной кнопке панели
инструментов. Затем в открывшемся диалоговом окне Show Pages (Отображение
страниц) выберите поле, для которого создаются отдельные сводные таблицы,
и щелкните на кнопке ОК. Excel вставит новые рабочие листы и создаст сводную
таблицу для каждого уникального значения указанного поля. Обратите внима-
ние, что программа также присваивает названия новым листам.

Создание отдельных сводных таблиц на основе значения
поля страниц
1. Сформируйте сводную таблицу таким образом, чтобы поля, которые на-

до использовать для разделения таблиц, находились в области страниц.

2. Выберите ячейку, щелкните на ней правой кнопкой мыши и выберите
в контекстном меню пункт Show Pages (Отобразить страницы).

3. Выберите поле, которое будет использовано для создания отдельных
сводных таблиц, и щелкните на кнопке ОК.
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Панель инструментов PivotTabLe
Форматировать сводную таблицу либо повторно вызывать мастер сводных таб-
лиц и диаграмм для выполнения изменений в ней позволяет панель инструмен-
тов PivotTabLe (Сводные таблицы). Используя эту панель, вы можете обновлять
исходные данные, показывать или скрывать детали таблицы, а также создавать
диаграммы.

Рис. 7.40. Панель инструментов PivotTabLe

Перечень кнопок панели инструментов PivotTabLe (Сводные таблицы) с указани-
ем их предназначения приведен в табл. 7.3. Многие из упоминаемых выше ко-
манд для работы со сводными таблицами можно вызвать после открытия списка,
находящегося в панели инструментов слева.

Таблица 7.3. Кнопки панели инструментов PivotTabLe

Кнопка Название Описание

PivotTabLe
(Сводная таблица)

Format Report
(Формат отчета)

Chart Wizard
(Мастер диаграмм)

Hide Detail
(Скрыть детали)

Show DetaiL
(Отобразить детали)

Refresh data
(Обновить данные)

Include Hidden Items in TotaLs
(Учитывать скрытые элементы
в итогах)

Always DispLay Items
(Всегда отображать элементы)

Открывает список, содержащий команды
для работы со сводными таблицами
и диаграммами

Отображает диалоговое окно AutoFormat
(Автоформат}, которое содержит список
встроенных форматов для сводных
таблиц

Создает новый лист со сводной диаграммой,
построенной на основе активной сводной
таблицы

Используется для сокрытия дополнительных
данных, добавленных в сводную таблицу
после щелчка на кнопке Show Detail
(Отобразить детали)

Отображает диалоговое окно Show Detait
(Отобразить детали) и добавляет в сводную
таблицу заданные поля

Обновляет данные сводной таблицы,
используя исходный список

Указывает на необходимость применения
скрытых элементов при подсчете
промежуточных и конечных итогов

Если кнопка не нажата, элементы данных
не отображаются при перетаскивании полей
в область строк и столбцов, а появляются
после добавления поля данных

продолжение
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Таблица 7.3 (продолжение]

Кнопка Название Описание

Ш Fields Settings Отображает диалоговое окно PivotTabLe Field
(Параметры поля) (Вычисление поля сводной таблицы),

в котором можно задать параметры
форматирования, сортировки и некоторые
другие

Hide/Show Field List Скрывает или отображает окно со списком
(Скрыть поля/Отобразить поля) полей источника данных

Если панель инструментов PivotTable (Сводные таблицы) не отображается, акти-
визируйте команду View > Toolbars > PivotTable (Вид * Панели инструментов > Свод-
ные таблицы).

Сводные диаграммы
Сводная таблица станет более наглядной, если рядом с ней будет расположена
сводная диаграмма. Для создания сводной диаграммы можно воспользоваться
знакомым вам мастером сводных таблиц и диаграмм. Правда, теперь в первом
диалоговом окне мастера (см. рис. 7.29) необходимо выбрать переключатель Pi-
votChart report (with PivotTabLe report) (сводная диаграмма (со сводной таблицей)).
А что касается принципа работы с мастером при создания диаграмм, то он анало-
гичен описанному выше, когда речь шла о создании сводных таблиц. После за-
вершения работы с мастером и нажатия кнопки Finish (Готово) создаются лист
с диаграммой и лист со сводной таблицей,

щ Если у вас имеется готовая сводная таблица, на ее основе нетрудно создать
сводную диаграмму — для этого достаточно щелкнуть на кнопке Chart Wizard

(Мастер диаграмм) панели инструментов PivotTabLe (Сводные таблицы). Между
сводной таблицей и сводной диаграммой существует динамическая связь: в ре-
зультате изменения данных в таблице соответствующим образом изменяется
диаграмма и наоборот. Так, после выбора в поле страниц листа диаграмм фами-
лии Комаров мы получили диаграмму, показанную на рис. 7.41. Более подробно
о работе с диаграммами в Excel будет рассказано в следующем уроке.

Самостоятельная работа
1. Создайте сводную таблицу для рабочего листа, в котором содержатся данные

о ежемесячных продажах, и сравните объемы продаж за несколько кварталов.

2. Произведите дополнительные вычисления в области данных (примените одну
из функций, вычисляющих процент).

3. Добавьте в таблицу несколько новых записей, а затем измените диапазон яче-
ек для сводной таблицы.

4. Создайте сводную диаграмму.
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Пыл*еос Sejrlttt 1600 Пылесос Scjrlett 1500 Пылесос S'irktt 15QO Пнл1соо Scarlett 1600 Пыпвсес Scarlett
Вт(7-отуп. фильтр) ВтЛл Вт/Эл Вт/5л «опций 1000 Вт/20лДл

Рис. 7.41. Сводная диаграмма

Подведение итогов
В этом уроке мы научились:
0 производить автоматическое вычисление;

0 создавать итоговые данные для таблицы;
0 выполнять консолидацию данных из нескольких таблиц;

0 подбирать для формулы нужный параметр;

0 строить таблицы подстановки;
0 применять функцию поиска решения;

0 создавать сценарии;
0 строить сводные таблицы и диаграммы.



УРОК Создание диаграмм

П Создание диаграммы посредством
мастера

П Типы диаграмм

О Обработка диаграмм

П Средства форматирования диаграмм
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Значение диаграмм как графической формы представления числовых данных
трудно переоценить. Они позволяют не только повысить наглядность излагаемо-
го материала, но и отобразить соотношение различных величин или динамику
изменения показателей. В Excel предусмотрены средства работы с диаграммами
различных типов.

Элементы диаграммы
Приведем наиболее важные понятия, которыми будем оперировать при описании
принципов работы с диаграммами. В зависимости от вида графического пред-
ставления данных диаграммы различаются по типу. Excel предоставляет пользо-
вателю возможность работать с диаграммами самых различных типов (рис. 8.1).
В рамках настоящего урока мы поговорим о наиболее интересных и часто ис-
пользуемых из них.

I •'

Рис. 8.1. Типы диаграмм

Диаграмма связана с данными, на основе которых она создана, и автоматически
обновляется при их изменении.

Excel создает диаграмму на основе определенных данных. Обратите внимание:
в примере, представленном на рис. 8.2, значения оси изменяются в пределах от О
до 140 DOO, что соответствует значениям ячеек выделенного диапазона на листе.
Если не указано иное, в качестве числового формата для оси Excel использует
формат верхней левой ячейки заданного диапазона значений.
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В качестве имен категорий программа использует заголовки столбцов или строк
данных. Существует возможность указать, должны ли заголовки столбцов и строк
применяться в качестве имен категорий, а также создать другие имена.

Заголовки столбцов и строк часто используются и в качестве имен рядов данных.
Имена рядов отображаются в легенде диаграммы.

Значения одной строки (столбца) таблицы на диаграмме должны быть представ-
лены как ряд данных. Значение каждой ячейки отображается в виде маркера. Мар-
керы данных одного цвета представляют один ряд данных (маркером может быть
точка, сегмент круга, столбик и т. д.).

Пример диаграммы с указанием основных ее элементов приведен на рис. 8.2.

Ряд данных

Ось
значений

Квартал 1 : Квартал 2 Квартал 3 Квартал 4
"1 JSOpoT 85ЙрР 92pOQ[7 JPTpQP "•"

84819! 99123; '1080001 '120000]

Квартал 1 Квартал 2 Квартал 3 Квартал 4

Имена категорий Ось категорий

Рис. 8.2. Основные элементы диаграммы

Название
диаграммы

Маркер
данных

Легенда

[ПРИМЕЧАНИЕ При выделении диаграммы на рабочем листе или листа диаграммы в книге
строка меню дополняется меню Chart (Диаграмма), которое содержит коман-
ды, предназначенные для работы с диаграммами.

Ниже будет рассмотрена диаграмма, построенная с использованием информации,
которая содержится в таблице-примере (рис. 8.3). В этой таблице приводятся све-
дения о количестве процессоров различных типов, проданных фирмой Computer
Ltd. в течение шести месяцев.

По умолчанию значения строки образуют ряд данных, а значения столбца — кате-
горию. В нашем примере категорию составляют значения, определяющие объемы
продаж за конкретный месяц. Названные значения указываются по вертикальной
оси У, а информация о типе процессора представлена в легенде, которая служит
для идентификации рядов данных (категорий). Каждый ряд данных на диаграм-
ме имеет определенный цвет или узор.
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Рис. 8.З. Таблица-пример

Целью построения такой диаграммы является сравнение объемов продаж процес-
соров каждого типа за разные периоды времени. Если же пользователь ставит пе-
ред собой иную задачу (например, сопоставить данные по нескольким типам про-
цессоров за определенный период времени), следует использовать информацию
об объемах продаж за конкретный месяц. В этом случае необходимо изменить
ориентацию данных на диаграмме.

Создание диаграммы

Мы уже говорили о том, что диаграмму можно разместить либо на рабочем листе,
либо в специальном листе диаграммы.

В первом случае при выводе на печать на одной странице нетрудно разместить
и таблицу, и диаграмму. Обратите внимание, что диаграмму, созданную на рабо-
чем листе, всегда можно скопировать на отдельный лист, а диаграмму из листа
диаграмм — разместить на рабочем листе в качестве графического субъекта.

)ПРИМЕЧАНИЕ Диаграмма связана с ячейками соответствующей таблицы динамически, то
есть изменения в таблице приводят к автоматическому изменению рядов дан-
ных на диаграмме. Поэтому, если таблица, которая соответствует диаграмме,
размещенной на отдельном листе, будетудалена,го исчезнег и лисг диаграм-
мы. А при копировании ячеек таблицы в другой рабочий лист Excel автомати-
чески изменяет формулы для рядов данных.



246 Урок 8 * Создание диаграмм

Мастер диаграмм

Ш Прежде чем вызывать мастер диаграмм, на рабочем листе необходимо выде-
лить ячейки, данные которых будут представлены на диаграмме. Выделен-

ный фрагмент должен содержать ячейки с названиями строк и столбцов, которые
впоследствии будут использованы в легенде диаграммы, а также на самой диа-
грамме в качестве меток осей.

При создании диаграммы можно использовать данные, расположенные в несмеж-
ных ячейках (рис. 8.4).

Microsoft (iffice Гхсе! 20ОЗ - процее.сорь*

г?[е frit View inse-t .-emist; Jooh l.'Vu

*̂TO!î ;il
^Arial Ш ^ ю

A6 - 1 Duron

,.,,01,'̂ ^b - . a x

. проданных фирмой Computer LTD (1-е полугодие 2003 года
&лапагн± - • ' ttfaiim 'ЛпЬель '"Май"'

ШИШШЯдаЩ||ЯИЯЯИИииИВН
Athton 78| 102: 120! 100 118

Рис. 8.4. Выделенные несмежные ячейки будут использованы для создания диаграммы

После нажатия кнопки Chart Wizard (Мастер диаграмм), расположенной на стан-
дартной панели инструментов, на экране появится первое диалоговое окно масте-
ра, в котором можно выбрать тип диаграммы (рис. 8.5). Данное окно содержит
две вкладки: Standard Types (Стандартные) и Custom Types (Нестандартные). В спи-
ске Chart type (Тип) первой вкладки следует выбрать тип диаграммы, а в поле
Chart sub-type (Вид) — ее вид. Диаграммы одного типа можно отформатировать
по-разному. Рекомендуется выбирать такой формат, который в наибольшей сте-
пени соответствует цели построения диаграммы. В дальнейшем формат диаграм-
мы можно будет изменить. Для нашего примера выберем объемную гистограмму,
ряды данных в которой расположены друг за другом.

Если ни один из стандартных типов диаграмм вас не устраивает, можно перейти
на вкладку Custom Types (Нестандартные) и создать собственный тип (рис. 8.6).
О том, как это делается, будет рассказано несколько позже.
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Рис. 8.5. Диалоговое окно Chart Wizard-Step I of 4-Chart Type
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Рис. 8.6. Вкладка Custom Types

Определив тип и формат диаграммы, щелкните на кнопке Finish (Готово), после
этого программа завершит работу над первым этапом создания диаграммы, ис-
пользуя установленные по умолчанию параметры автоформатирования. Для
предварительного просмотра диаграммы в выбранном формате следует восполь-
зоваться кнопкой Press and Hold to View Sample (Просмотр результата). Если удер-
живать ее нажатой, то в диалоговом окне появится поле Sample (Образец) с изо-
бражением будущей диаграммы.
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Для того чтобы перейти к следующему этапу создания диаграммы, нажмите кноп-
ку Next (Далее). На экране появится второе диалоговое окно мастера с изображе-
нием диаграммы выбранного типа (рис. 8.7). На вкладке Data Range (Диапазон
данных) данного окна укажите адреса ячеек, значения которых будут использо-
ваны при построении диаграммы. Если мастер диаграмм вызван после выделения
нужных ячеек, то в этом диалоговом окне отображаются адреса этих ячеек. При
необходимости предлагаемые адреса можно изменить.

Pur ft 7 Run га !l .* j Раплап\.* О*/ • DIUIa^Ka UaLa i\al IiJC

Переключатели Rows (строках) и Columns (столбцах) области Series in (Ряды в) по-
зволяют определить вариант построения рядов данных — по строкам или по столб-
цам. Если программа автоматически определяет, что будет использоваться в ка-
честве ряда данных, то соответствующий переключатель активизируется уже при
открытии окна. В нашем примере при использовании переключателя Rows (стро-
ках) категориями служат названия месяцев (ось X), а при использовании переклю-
чателя Columns (столбцах) в качестве категорий выступают названия процессоров.

Вкладка Series (Ряд) диалогового окна Chart Wizard — Step 2 of 4 — Chart Source Data
(Мастер диаграмм (шаг 3 из 4)) предназначена для добавления и удаления рядов
данных (рис. 8.8).

ВНИМАНИЕ Даже при беглом взгляде на созданную диаграмму виден ее недостаток: мень-
шие по высоте столбики располагаются за перекрывающими их большими.
Чтобы устранить этот изъян, следует с помощью кнопки Back (Назад) вер-
нуться на нужное количество шагов назад и выбрать другой тип и/или фор-
мат диаграммы. В нашем случае имеет смысл выбрать формат диаграммы, ко-
гда маркеры рядов данных располагаются рядом — их легче сравнивать.
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Рис. 8.8. Вкладка Series

Нажав кнопку Next (Далее), вы перейдете в третье диалоговое окно мастера, Chart
Wizard— Step 3 of 4— Chart Options (Мастер диаграмм (шаг З из 4)): параметры диа-
граммы), где можно задать параметры форматирования диаграммы (рис. 8.9). Это
окно содержит несколько вкладок, в каждой из которых определяется вид одного
из элементов диаграммы.

[ПРИМЕЧАНИЕ Общее количество и вид вкладок окна Chart Wizard — Step 3 of 4 — Chart
Options (Мастер диаграмм (шаг 3 из 4): параметры диаграммы) зависят от
типа диаграммы, выбранного в первом диалоговом окне мастера.

Откроем вкладку Titles (Заголовки). Здесь нам нужно указать название диаграм-
мы — Данные о продажах процессоров, а также названия осей. (Для оси Z необходимо
указать используемые единицы измерения — штук).

Вкладка Axes (Оси) предназначена для установки режима отображения меток на
осях диаграммы (рис. 8,10). По умолчанию отображаются все метки. В качестве
меток оси X можно использовать либо имена категорий, либо временные значе-
ния. В последнем случае цена деления оси будет равна определенному промежут-
ку времени (например, нескольким дням, месяцу или году). Такой тип меток при-
меняется автоматически, если значения, на основе которых строится диаграмма,
отформатированы как даты.

От выбранной во втором окне мастера диаграмм ориентации данных зависит, что
будет использоваться в качестве меток: заголовки столбцов или названия строк.
В нашем примере в качестве меток оси X выступают заголовки столбцов (назва-
ния месяцев), а названия строк (тип процессора) представлены в легенде.
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Рис. 8.9. Вкладка Titles
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Рис. 8.10. Вкладка Axes

Если же ряд данных расположен в столбце, то именами категорий служат типы
процессоров, а названия месяцев указываются в легенде.

Вкладка GridLines (Линии сетки) используется для нанесения на диаграмму мас-
штабной сетки (рис. 8.11). Если сетка нанесена, представленные на диаграмме
данные легче сравнивать. Сетка может иметь крупный шаг — Major gridlines (ос-
новные линии) или мелкий — Minor gridlines (промежуточные линии). Мелкий
шаг рекомендуется применять, когда диапазон значений невелик.

На вкладке Legend (Легенда) пользователь может указать, нужно ли для диаграм-
мы создавать легенду. Легенда содержит описание рядов данных, которые, как
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упоминалось выше, представлены на диаграмме различными цветами. Конечно,
легенда занимает определенную часть полезной площади, но в большинстве слу-
чаев ее использование позволяет значительно повысить информативность диа-
граммы. Здесь же задается местоположение легенды. По умолчанию легенда раз-
мещается справа от диаграммы.

Chart wiznrd step 3 of 4 chart Oi>tkwi4
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Рис. 8.11. Вкладка Gridlines

Если вы хотите, чтобы рядом с маркером данных на диаграмме отображалось со-
ответствующее числовое значение, установите на вкладке Data Labels (Подписи
данных), изображенной на рис. 8.12, флажок Value (значения). При установке
флажка Category name (имена категорий) рядом с каждым маркером будет нахо-
диться название соответствующей ему категории. Наличие флажка Series name
(имена рядов) свидетельствует о том, что рядом с каждым маркером указывается
название ряда, которому он принадлежит. Другие флажки этой вкладки стано-
вятся доступными только при выборе определенного типа диаграммы. Например,
при создании круговой или кольцевой диаграммы можно установить флажок Per-
centage (доли), после чего каждый маркер данных будет снабжен меткой, указы-
вающей процентное соотношение данного значения и суммы всех значений. В по-
ле Separator (Разделитель) выбирается способ разделения содержимого подписи
данных. Пользователь может выбрать один из разделителей, предлагаемых про-
граммой, или задать любой другой,

Иногда рядом с диаграммой необходимо расположить таблицу, содержащую зна-
чения, на основе которых эта диаграмма построена. Такая потребность возникает,
в частности, тогда, когда диаграмма размещается на отдельном листе или когда
для ее создания используются лишь часть таблицы или данные из разных таблиц.
В этом случае на вкладке Data Table (Таблица данных) нужно установить флажок
Show Data Table (Таблица данных). При установке флажка Show legend keys (Ключ
легенд) возле названия ряда данных. в таблице появляется значок, цвет которого
соответствует цвету этого ряда на диаграмме.
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Рис. 8.12. Вкладка Data Labels

Нажав кнопку Next (Далее) еще раз, мы открываем последнее окно мастера диа-
грамм, с тем чтобы задать в нем местоположение диаграммы; на отдельном листе
(переключатель As new sheet (отдельном)) либо на листе с таблицей (переключа-
тель As object in (имеющемся)). В последнем случае нужный лист выбирается из
поля списка (рис. 8.13).

Рис. 8.13. Последнее диалоговое окно мастера диаграмм

Закройте диалоговое окно, нажав кнопку Finish (Готово), после чего созданная
диаграмма появится на рабочем листе (рис. 8.14). Диаграмму, как и другие объек-
ты, можно разместить в любом месте листа путем перемещения ее с помощью
мыши. Кроме того, существует возможность методом перемещения маркеров из-
менять размеры области диаграммы.

}ПРИМЕЧАНИЕ Создать на рабочем листе диаграмму можно и с помощью панели инструмен-
тов Chart (Диаграммы). Отобразите эту панель на экране и выделите в табли-
це ячейки, содержимое которых должно быть представлено на диаграмме.
Откройте список возможных типов диаграмм и выберите нужный. После того
как вы отпустите левую кнопку мыши, диаграмма будет создана с использо-
ванием параметров форматирования, установленных по умолчанию.



Создание диаграммы 253

Данные о продажах процессоров

Рис. 8.14. Диаграмма на рабочем листе

Построение диаграммы на листе диаграмм
В Excel создать диаграмму на отдельном листе диаграмм можно двумя методами:

О с помощью уже знакомого нам мастера диаграмм;

О путем копирования числовых значений из листа таблицы на отдельный лист
и применения автоформата.

Для создания диаграммы первым способом необходимо выделить ячейки табли-
цы, данные из которых должны быть представлены на диаграмме, открыть кон-
текстное меню ярлычка листа, выбрать команду Insert (Добавить), в появившем-
ся диалоговом окне (рис. 8.15) отметить значок Chart (Диаграмма), после чего
нажать кнопку ОК. В результате выполнения перечисленных действий будет вы-
зван мастер диаграмм, принципы работы с которым описаны выше.

^ПРИМЕЧАНИЕ Создать диаграмму можно и с помощью шаблона. Для этого в первом диало-
говом окне мастера диаграмм следует нажать кнопку Finish (Готово).

Можно поступить и по-другому: вставить в рабочую книгу чистый лист и создать
диаграмму на нем. Для этого следует поместить указатель ячейки в пустую ячейку,
открыть контекстное меню для ярлычка листа, вставить лист диаграммы и на-
жать в первом диалоговом окне мастера диаграмм кнопку Finish (Готово). По-
скольку выделенная ячейка не содержала числовых значений, область диаграммы
останется незаполненной. После этого необходимо вернуться к таблице, отметить
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нужные ячейки и с помощью команды Edit > Сору (Правка > Копировать) скопи-
ровать их содержимое в буфер обмена.

Щ Worksheet MSEncel Internet»,.. MS Excel
1.0 Macro Macro 5h... 5,0 Diabg

Рис. 8.15. Диалоговое окно Insert

Теперь осталось открыть лист диаграммы, вызвать команду Edit > Paste (Прав-
ка > Вставить) — и содержимое буфера обмена будет представлено в виде диа-
граммы (рис. 8.16).
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Рис. 8.16. Диаграмма, созданная в рабочей книге на листе диаграмм
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Копирование диаграммы, созданной на рабочем листе,
на лист диаграмм

Диаграмму, созданную на рабочем листе, впоследствии можно будет представить
на листе диаграмм, а диаграмму из листа диаграмм — наоборот, вставить в рабо-
чий лист. Для того чтобы скопировать диаграмму, созданную на листе диаграмм,
в рабочий лист, щелкните на ней мышью (как видно на рис. 8.17, вокруг диаграм-
мы появляются маркеры изменения размера) и поместите ее в буфер обмена, вос-
пользовавшись командой Edit > Сору (Правка > Копировать).

Рис. 8.17. Диаграмма помечена маркерами

Затем нужно перейти на рабочий лист, в который должна быть вставлена диа-
грамма, и выполнить команду Edit > Paste (Правка > Вставить). Обработка встав-
ленных таким способом диаграмм производится обычным образом.

Находящуюся в буфере обмена диаграмму при необходимости можно неодно-
кратно вставлять в разные рабочие листы — как текущей книги, так и любой другой.

I ВНИМАНИЕ Если диаграмма строится на основе таблицы, которая содержит скрытые
строки или столбцы, то значения в скрытых уровнях игнорируются. Другими
словами, на диаграмме будут представлены только те ряды данных, которые
выделены и отображаются на экране.
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Создание диаграммы
1. Выделите ячейки с данными, которые необходимо представить на диа-

грамме.
2. Щелкните мышью на кнопке Chart Wizard (Мастер диаграмм), располо-

женной на стандартной панели инструментов.
3. В первом окне мастера выберите тип и вид создаваемой диаграммы, за-

тем щелкните на кнопке Next (Далее).

4. Во втором окне мастера уточните диапазон ячеек с данными, представ-
ленными на диаграмме, и выберите способ отображения ряда данных.
Щелкните на кнопке Next (Далее).

5. На вкладках третьего окна мастера задайте для диаграммы дополни-
тельные параметры.

6. В четвертом окне мастера введите имя нового рабочего листа для диа-
граммы или же разместите ее на текущем рабочем листе. Щелкните на
кнопке Finish (Готово).

Самостоятельная работа
1. Воспользовавшись таблицей-примером из этого урока, создайте диаграмму,

которая будет содержать два ряда данных (например, Celeron и Athlon).

2. Выберите тип диаграммы Line (График) и задайте объемный вариант графика.

3. Введите название диаграммы (например, Процессоры).

4. Разместите диаграмму сначала на рабочем листе, а затем - на листе диаграмм.

Типы диаграмм
В Excel пользователи могут создавать диаграммы различных типов и по-разному
их форматировать. Выбирая формат, вы тем самым определяете способ отобра-
жения диаграммы данного типа. Когда на диаграмме представлен один ряд дан-
ных, все маркеры данных имеют одинаковый цвет. Если же рядов данных не-
сколько, маркеры выделяются различными цветами.

Формат созданной диаграммы в дальнейшем можно будет изменить. Краткое опи-
сание предлагаемых в Excel типов диаграмм приведено ниже.

Гистограмма
В гистограмме (ее также называют столбиковой диаграммой) отдельные значе-
ния представлены вертикальными столбиками различной высоты (рис. 8.18). Вы-
сота столбика определяется соответствующим ему значением. Диаграммы этого
типа удобно использовать для сравнения значений, относящихся к определенно-
му периоду времени. Для представления итогового значения, складывающегося
из отдельных составляющих, можно воспользоваться составной гистограммой,
столбцы в которой ставятся один на другой (рис. 8.19).
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Рис. 8.18. Гистограмма
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Рис. 8.19. Составная гистограмма

В объемной гистограмме маркерами служат параллелепипеды, высота каждого из
которых определяется представляемым им числовым значением.

При выборе соответствующего формата каждый ряд данных можно представить
как долю в общей сумме категории. Кроме того, в объемных диаграммах сущест-
вует возможность упорядочить ряды данных по оси Z. Преимущество диаграмм
этого типа заключается в возможности изменять угол обзора, что позволяет ото-
бражать ряды данных, скрытые за другими рядами (рис. 8.20).

Маркеры данных на объемных диаграммах могут быть конической, цилиндриче-
ской и пирамидальной формы.

9 Зак. 345
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Рис. 8.20. Объемная диаграмма с маркерами данных цилиндрической,
пирамидальной и конической формы

Линейчатая диаграмма
В отличие от гистограммы, где полоски (столбики) располагаются вертикально,
то есть параллельно оси Y, полоски в линейчатой диаграмме развернуты горизон-
тально, параллельно оси X. Длина полоски определяется соответствующим ей чи-
словым значением (рис. 8.21).
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Рис. 8.21. Линейчатая диаграмма

[ПРИМЕЧАНИЕ Таблицы данных могут отображаться одновременно с диаграммами трех ти-
пов, а именно с линейчатыми диаграммами, графиками и гистограммами.
Обычно таблицы связаны с осью категорий.
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В объемной линейчатой диаграмме маркер любого значения отображается как па-
раллелепипед, размещенный параллельно оси X. Длина такого параллелепипеда
определяется представляемым им числовым значением. Диаграммы этого типа
мы видим только спереди (рис. 8.22).
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Рис. 8.22. Объемная линейчатая диаграмма

График
Маркеры данных на графиках представляют собой линии, которые интерполиру-
ют определенные значения (рис. 8.23). Применять график не рекомендуется, если
описываемые им абсолютные величины не связаны между собой.

Рис. 8.23. График



260 Урок 8 • Создание диаграмм

В объемных графиках линии имеют форму лент. Такие графики также не следует
применять для представления не связанных друг с другом значений (рис. 8.24).

Рис. 8.24. Объемный график

Круговая диаграмма
Круговая диаграмма строится в виде круга, разбитого на несколько сегментов, ка-
ждый из которых соответствует определенному значению, входящему в суммар-
ный показатель (рис. 8.25). Сумма всех значений принимается равной 100 %.

Рис. 8.25. Круговая диаграмма

При построении круговой диаграммы используется только один ряд данных.
Если для представления значений в выделенных ячейках требуется несколько
рядов данных, диаграмма будет создана только для первого из них.

Круговые диаграммы широко используются в научных и научно-популярных из-
даниях по политологии, экономике и экономической географии. Таким образом
легко отобразить, скажем результаты выборов, поскольку эти диаграммы позво-
ляют наглядно отобразить распределение голосов избирателей.

Возможности изменения угла обзора трехмерной круговой диаграммы ограниче-
ны — можно показать только ее фронтальную проекцию.
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Кольцевая диаграмма
Кольцевая диаграмма — это разновидность круговой диаграммы. Здесь сумма всех
значений также принимается равной 100 %, а ряды данных представляются в ви-
де вложенных колец, которые разделены на сегменты с учетом их процентного
соотношения. Преимущество кольцевой диаграммы по сравнению с круговой со-
стоит в том, что она позволяет отображать несколько рядов данных одновремен-
но (рис. 8.26). Однако следует учитывать то обстоятельство, что с увеличением
количества рядов данных размеры областей, которые отводятся для каждого та-
кого ряда, уменьшаются.

Рис. 8.26. Кольцевая диаграмма
с несколькими рядами данных

Точечная диаграмма
В точечной диаграмме маркерами являются точки в декартовой системе коорди-
нат. Диаграммы такого типа больше всего подходят для представления взаимо-
связи между двумя или несколькими значениями (рис. 8.27).

Рис. 8.27. Точечная диаграмма

Из точечной диаграммы путем добавления соединительных линий можно легко
получить график.
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Пузырьковая диаграмма

Диаграмма этого типа напоминает точечную диаграмму (рис. 8.28). Отличие со-
стоит в том, что ее маркеры характеризуются двумя значениями. Первое опреде-
ляет положение маркера на плоскости, а второе — его размер.

Рис. 8.28. Пузырьковая диаграмма

Диаграмма с областями
В этой диаграмме в качестве маркеров используются области, закрашенные раз-
ными цветами (рис. 8.29). При построении диаграммы данного типа отдельные
значения таблицы рассматриваются как выборка из некоторого множества значе-
ний, получаемого путем интерполяции. Диаграмму с областями не следует при-
менять, если данные не связаны между собой. Ряды данных в ней можно предста-
вить как части целого.

Рис. 8.29. Диаграмма с областями
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СОВЕТ В диаграммах с областями ряды данных, соответствующие меньшим значени-
ям, всегда переносите на передний план — в таком случае они не будут пере-
крываться рядами данных, представляющими большие значения.

Объемные диаграммы с областями отличаются от плоских тем, что строятся они
в трехмерной системе координат.

Лепестковая диаграмма
Маркеры на диаграмме данного типа представляют собой лучи, исходящие из од-
ной точки. Каждый маркер ряда данных находится на оси и соединен с другими
маркерами замкнутой линией (рис. 8.30).

Апрель

Рис. 8.30. Лепестковая диаграмма

Объемная поверхностная диаграмма
Принцип построения объемных поверхностных диаграмм напоминает применяе-
мый в картографии принцип представления высоты местности над уровнем моря.
Совокупность всех значений отображается на диаграмме в виде поверхности, об-
ласти которой представляют собой ряды данных (рис. 8.31).

Самостоятельная работа
1. Создайте несколько диаграмм различного типа, используя таблицу, показан-

ную на рис. 8.3, и разместите их на одном рабочем листе.

2. Переместите какую-либо из созданных диаграмм в иное место и измените ее
размер.
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Рис. 8.31. Объемная поверхностная диаграмма

Обработка диаграмм
Как уже было сказано, любую диаграмму довольно просто модифицировать: из-
менить ее тип, ориентацию данных, параметры, добавить новые или удалить не-
нужные элементы. В Excel предусмотрена возможность дополнения диаграмм
другими рядами данных.

Диаграмму, созданную на рабочем листе, перед обработкой необходимо выделить,
щелкнув на ней мышью. В распоряжение пользователя предоставляются специ-
альные функции обработки диаграммы. Набор элементов строки меню при выде-
лении диаграммы изменяется — появляется новый элемент Chart (Диаграмма),
а отдельные команды в меню заменяются командами обработки диаграмм.

j ПРИМЕЧАНИЕ^ Многие команды форматирования элементов диаграмм, и в частности коман-
ды определения параметров шрифта и выравнивания текста, не отличаются
от уже известных вам аналогичных команд для ячеек таблицы, поэтому мы не
будем их описывать подробно.

Панель инструментов Chart

Для работы с диаграммами Excel предоставляет в распоряжение пользователя са-
мые разнообразные инструменты. Большинство из них содержится в меню Chart
(Диаграмма), а также на панели инструментов Chart (Диаграммы), показанной на
рис. 8.32.

Рис. 8.32. Панель инструментов Chart
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На панели инструментов Chart (Диаграммы) представлены кнопки, назначение
которых описано в табл. 8.1,

Таблица 8.1. Кнопки панели инструментов Chart

Кнопка Название Описание

Charts Objects
(Элементы диаграммы)

Format Object
(Формат области
построения)

Chart Type
(Тип диаграммы)

Legend
(Легенда)

Data Table
(Таблица данных)

By Row
(По строкам)

By Column
(По столбцам)

Angle Clockwise
(Текст по часовой
стрелке)

Angle Counterclockwise
(Текст против часовой
стрелки)

Выбор элемента диаграммы для
редактирования

Открытие диалогового окна форматирования
выделенного элемента диаграммы. Имя
кнопки и ее функции зависят от того, какой
именно элемент выделен

Изменение типа диаграммы и внешнего вида
отдельного ряда данных

Отображение (или сокрытие) легенды
диаграммы

Отображение (или сокрытие) под диаграммой
таблицы сданными

Построение диаграммы на основе рядов
данных, расположенных по строкам таблицы

Построение диаграммы на основе рядов
данных, расположенных по столбцам таблицы

Изменение ориентации выделенного текста
на 45° таким образом, чтобы он читался слева
направо и сверху вниз

Изменение ориентации выделенного текста
на 45° таким образом, чтобы он читался слева
направо и снизу вверх

Очень удобным инструментом для обработки диаграмм является также контекст-
ное меню выделенного элемента, открываемое правой кнопкой мыши. Команда
Format > «имя выделенного элемента диаграммы» (Формат > «имя выделенного эле-
мента диаграммы»-), равно как и двойной щелчок на выделенном элементе, откры-
вает одноименное диалоговое окно для установки параметров форматирования.

Изменение типа диаграммы
Пользователь может в любой момент изменить тип диаграммы. Выбрать другой
тип можно из палитры типов в панели инструментов Chart (Диаграммы) или из
списка диаграмм в окне Chart Type (Тип диаграммы), вызываемом посредством ко-
манды Chart > Chart Type (Диаграмма > Тип диаграммы).

Изменение типа диаграммы
1. Выделите диаграмму.

2. Вызовите команду Chart > Chart Type (Диаграмма > Тип диаграммы).
3. Выберите другой тип диаграммы и нажмите кнопку ОК.
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Внешний вид диаграммы после определения для нее другого типа, как правило,
кардинально изменяется. Однако существует возможность изменить способ пред-
ставления лишь отдельных рядов данных. Для того чтобы это сделать, выделите
щелчком мыши нужный ряд данных на диаграмме (в результате он будет помечен
черными квадратиками, а в строке формул появится ссылка на ячейки, к которых
находятся данные этого ряда) и вызовите команду Chart > Chart Type (Диаграмма >
Тип диаграммы). В открывшемся окне Chart Type (Тип диаграммы) установите
флажок Apply to selection (применить), и выбранный вами тип диаграммы будет
применен к выделенному ряду данных. После щелчка на кнопке О К выделенный
ряд данных, как вы понимаете, будет представлен по-другому.

ВНИМАНИЕ Если нужно,чтобы все ряды данных снова имели один тип, необходимо щелч-
ком мыши выделить диаграмму, выбрать в диалоговом окне тип диаграммы,
установить флажок Default formatting (сброс) и нажать кнопку ОК.

В дополнение к описанным выше возможностям Excel предлагает для каждого
типа диаграмм большое количество автоформатов. С помощью автоформата мож-
но значительно ускорить процесс оформления диаграммы, поскольку в нем уже
заданы по умолчанию параметры для отдельных элементов диаграммы. Если ни
один из автоформатов вас не устраивает, рекомендуем взять за основу наиболее
подходящий из числа предлагаемых и внести в него необходимые изменения и до-
полнения.

Создать новый автоформат или выбрать существующий позволяет показанная на
рис. 8.33 вкладка Custom Types (Нестандартные) диалогового окна Chart Type (Тип
диаграммы), которая открывается с помощью команды Chart > Chart Type (Диаграм-
ма > Тип диаграммы).

Lhe - Column

Lhe - Column on 2 Axes

ires on 2 Axes

•thrnt

Outdoor Bars

Pie Explosion

LyBmoolh Lines

Рис. 8.33. Вкладка Custom Types диалогового
окна Chart Type
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Выберите в левой части этой вкладки тип диаграммы, который будет использо-
ваться как основа для автоформата, после чего в правой части появится пример
отформатированной диаграммы. По умолчанию в области Select from (Вывести) ак-
тивизирован переключатель Built-in (встроенные), поэтому в диалоговом окне
представлены только встроенные автоформаты. Чтобы получить возможность
выбрать пользовательский формат или создать автоформат на основе формата
текущей диаграммы, следует активизировать переключатель User-defined (допол-
нительные).
Если вы хотите создать автоформат на основе какой-либо диаграммы, ее необхо-
димо предварительно выделить. После активизации переключателя User-defined
(дополнительные) появятся кнопки Add (Добавить) и Delete (Удалить). Щелкни-
те на кнопке Add (Добавить), и на экране появится диалоговое окно Add Custom
Chart Type (Добавление нового типа диаграмм), в котором следует указать имя ав-
тоформата и дать его описание (рис. 8.34). После нажатия кнопки ОК новый авто-
формат отобразится в поле предварительного просмотра. Если вам понадобится
удалить какой-либо автоформат, воспользуйтесь кнопкой Delete (Удалить).

Рис. 8.34. Диалоговое окно Add Custom Chart Type

Создание нового автоформата
1. Откройте диалоговое окно Chart Type (Тип диаграммы) посредством

команды'Chart t Chart Type (Диаграмма > Тип диаграммы) и перейдите
на вкладку Types (Нестандартные).

2. Выберите тип диаграммы и активизируйте переключатель User-defined
(дополнительные).

3. Нажав кнопку Add (Добавить), откройте окно Add Custom Chart Type (До-
бавление нового типа диаграмм).

4. Задайте в указанном окне имя и описание автоформата.
5. Нажмите кнопку ОК, и новый автоформат отобразится в поле предва-

рительного просмотра.
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Добавление и удаление рядов данных
Обычно диаграмма модифицируется автоматически, в результате изменения дан-
ных в таблице, на основе которой она была создана. Однако вставлять и удалять
данные можно лишь непосредственно на диаграмме. Чтобы удалить ряд данных,
выделите его и нажмите клавишу Delete. Для вставки дополнительного ряда дан-
ных вызовите команду Chart > Source Data (Диаграмма > Исходные данные), открой-
те вкладку Series (Ряд) диалогового окна Source Data (Исходные данные), которое
вы видите на рис. 8.35, и нажмите кнопку Add (Добавить). Например, при вводе
дополнительного ряда Athlon укажите в поле Name (Имя) адрес ячейки, содержа-
щей идентификатор ряда (-Sheetl! JAJ4), а в поле Values (Значения) введите адре-
са ячеек, содержащих ряд данных («Sheetl! $В$4: $G$4).

Рис. 8.35, Вкладка Series диалогового окна Source Data

После нажатия кнопки ОК на диаграмме появится еще один ряд данных. Если
подлежащие выделению ячейки скрыты диаграммой, следует либо задать адреса
вручную, либо щелчком на кнопке в поле ввода свернуть диалоговое окно.

СОВЕТ При выделении ячеек помните, что количество элементов нового ряда долж-
но быть равно количеству элементов уже имеющихся рядов данных.
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Добавление и удаление рядов данных
1. Чтобы добавить на диаграмме ряд данных, вызовите команду Chart >

Source Data (Диаграмма v Исходные данные).

2. Перейдите на вкладку Series (Ряд) и нажмите кнопку Add (Добавить).

3. Укажите в поле Name (Имя) имя либо адрес ячейки, содержащей на-
звание ряда данных, а в поле Values (Значения) — адрес ячейки, данны-
ми из которой будет дополнена диаграмма.

4. Нажмите кнопку ОК.

5. Чтобы удалить из диаграммы ряд данных, выделите его и нажмите кла-
вишу Delete.

Изменение порядка рядов
Порядок расположения рядов на диаграмме соответствует порядку расположе-
ния данных в таблице. Если объемная диаграмма содержит, предположим, два
ряда данных, то один из них будет представлен на переднем плане, а другой — на
заднем. Но если значения первого ряда больше значений второго, то второй ряд
данных окажется недоступным для обзора (рис. 8.36).

Рис. 8.36. Варианты расположения рядов данных на объемной диаграмме

Данную проблему можно решить путем перестановки строк в таблице, но значи-
тельно удобнее изменить порядок расположения рядов на самой диаграмме. По-
средством щелчка на маркере выделите ряд, позицию которого вы хотите изме-
нить, и выполните команду Format * Selected Data Series (Формат > Выделенный
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ряд). На вкладке Series Order (Порядок рядов) диалогового окна Format Data Series
(Формат ряда данных), которое в результате появится у вас на экране, будет ука-
зан текущий порядок отображения рядов (рис. 8.37).

Рис. 8.37. Диалоговое окно Format Data Series

Позицию выделенного ряда можно изменить с помощью кнопок Move Up (Вверх)
и Move Down (Вниз). В данном случае необходимо выделить элемент Июнь и нажать
кнопку Move Down (Вниз). Изменения, которые произойдут на диаграмме, отобра-
зятся в поле предварительного просмотра. Если вы удовлетворены результатом,
нажмите кнопку ОК.

Изменение порядка представления рядов
1. Выделите на диаграмме любой ряд.

2. Вызовите команду Format > Selected Data Series (Формат > Выделенный ряд).

3. В открывшемся окне перейдите на вкладку Series Order (Порядок рядов).
4. В области Series Order (Порядок рядов) выделите требуемый ряд и с помо-

щью кнопки Move Down (Вниз) или Move Up (Вверх) переместите его в нуж-
ную позицию, после чего щелкните на кнопке ОК.

Самостоятельная работа
1. Создайте объемную диаграмму типа Column (Гистограмма).
2. Преобразуйте полученную диаграмму, например, в диаграмму типа Ваг (Ли-

нейчатая).

3. Измените порядок расположения рядов на диаграмме.
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Средства форматирования диаграмм

Созданная в Excel диаграмма может быть отформатирована и дополнена различ-
ными элементами. В распоряжении пользователя имеются также средства, позво-
ляющие применять для оформления диаграммы узор заполнения, вставлять в лю-
бую позицию текст или графический объект. Некоторые из параметров этих эле-
ментов задаются в автоформате диаграммы, поэтому здесь мы рассмотрим только
те, которые может изменить пользователь.

(ПРИМЕЧАНИЕ Выполнив двойной щелчок мышью в области диаграммы, вы получите воз-
можность изменить цвет фона или фоновый узор.

Вставка легенды
Применять легенду целесообразно, когда на диаграмме имеется как минимум два
ряда данных. В этом случае легенда должна содержать информацию о том, какой
маркер какому ряду данных соответствует.

Предположим, нам на основе рассмотренной ранее таблицы нужно создать диа-
грамму с информацией об объемах продаж процессоров каждого типа за несколь-
ко месяцев. Содержимое легенды будет зависеть от типа диаграммы. В рассмат-
риваемом нами случае в легенде указывается, что представляют маркеры: типы
процессоров либо месяцы.

При создании диаграммы с помощью мастера легенду можно вставить посредст-
вом активизации флажка Show Legend (Добавить легенду), находящегося на вклад-
ке Legend (Легенда) третьего окна мастера. В готовую диаграмму легенда вставля-
ется с помощью команды Chart» Chart Options (Диаграмма > Параметры диаграм-
мы), после того как диаграмма будет выделена. Если же диаграмма создается на
основе выделенных ячеек, для текста легенды используются заголовки столбцов
или строк.

(ПРИМЕЧАНИЕ Если выделенные ячейки не содержат текст, категории и ряды данных нуме-
руются.

По умолчанию легенда размещается в правой части области диаграммы, но при
желании ее можно переместить в любую другую позицию. Размер легенды уста-
навливается путем перемещения маркеров изменения размера.

Чтобы представить легенду под диаграммой (рис. 8.38), растяните область леген-
ды по горизонтали и отрегулируйте ее размер по вертикали.

Выполнив двойной щелчок на элементе диаграммы, пользователь получит возмож-
ность отформатировать выбранный элемент путем установки параметров в соот-
ветствующем диалоговом окне. Так, после двойного щелчка на легенде будет от-
крыто диалоговое окно Format Legend (Формат легенды), в котором можно задать
новые параметры ее форматирования (рис. 8.39).
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Рис. 8.38* Диаграмма после изменения позиции и размера легенды
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Рис. 8.39. Диалоговое окно Format Legend
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В случае, когда на рабочем листе с диаграммой легенда занимает место, которого
и так не достаточно, ее лучше удалить. Для того чтобы удалить легенду, ее нужно
выделить и нажать клавишу Delete.

Вставка и удаление легенды
1. Выделите диаграмму.
2. Вызовите команду Chart > Chart Options (Диаграмма » Параметры диа-

граммы).

3. На вкладке Legend (Легенда) установите флажок Show legend (Доба-
вить легенду).

4. При необходимости удалить легенду выделите ее и нажмите клавишу
Delete.

Определение цвета и узора
Когда диаграмма содержит несколько рядов данных, они отображаются различны-
ми цветами. Цвет маркера определенного ряда данных устанавливается на вклад-
ке Color (Цвет) диалогового окна Options (Параметры), которое вызывается по-
средством команды Tools > Options (Сервис > Параметры).

В поле Chart fills (Заливка диаграмм) указаны цвета, применяемые по умолчанию
для представления первых восьми рядов данных.

{ПРИМЕЧАНИЕ Желательно, чтобы диаграмма включала не более восьми рядов данных, по-
скольку при большем их количестве восприятие представляемого материала
усложняется.

Используемые по умолчанию цвета представления рядов данных можно изме-
нить. Для этого с помощью мыши нужно выбрать необходимый цвет в диалого-
вом окне Colors (Цвета), которое открывается в результате нажатия кнопки Modify
(Изменить).

Цвет можно задать и для любого другого элемента диаграммы, активизировав по-
средством двойного щелчка на нем диалоговое окно форматирования данного
элемента. Например, после двойного щелчка на маркере данных появится диало-
говое окно Format Data Series (Формат ряда даннзых) с открытой вкладкой Patterns
(Вид), которое вы видите на рис. 8.40.

Изменение цвета ряда данных
1. Дважды щелкните на маркере данных.
2. В появившемся диалоговом окне на вкладке Patterns (Вид) выберите

цвет заливки.
3. Щелкните на кнопке ОК.
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Рис. 8.40. Диалоговое окно Format Data Series

Надписи на диаграмме
Надписи, позволяющие быстро определить, что означает гот или иной элемент
диаграммы, относятся к числу наиболее важных ее компонентов. При создании
диаграммы с помощью мастера диаграмм пользователь должен ввести текст ее за-
головка и текст для надписей. В качестве имен категорий и текста легенды ис-
пользуются заголовки столбцов и строк таблицы.

Хотя надписи помогают понять, что изображено на диаграмме, применять их не
всегда целесообразно, поскольку в некоторых случаях они загромождают диаграм-
му и усложняют ее визуальное восприятие.

Названия диаграммы и осей вводятся в поля вкладки Titles (Заголовки) диалого-
вого окна Chart Options (Параметры диаграммы), которое вызывается посредством
команды Chart > Chart Options (Диаграмма > Параметры диаграммы). После нажа-
тия кнопки ОК введенный текст появится на диаграмме. Если какое-либо из этих
названий нужно отредактировать, достаточно выполнить на нем двойной щелчок
и ввести нужные изменения. Удалить название можно с помощью клавиши Delete.

По умолчанию надписи на диаграмме располагаются горизонтально. Если же вам
необходимо разместить их под углом, дважды щелкните на нужной надписи, от-
кройте в появившемся диалоговом окне вкладку Alignment (Выравнивание) и за-
дайте угол поворота надписи (рис. 8.41).

Надписи на диаграмме располагаются в текстовом поле. После щелчка на этом
поле надпись можно перемещать по области диаграммы (рис. 8.42).

Однако надписи на диаграмме можно размещать не только в строго определен-
ном месте. Существует возможность ввести и свободно позиционируемую над-
пись. Для этого следует щелкнуть в области диаграммы, установить курсор ввода
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в строку формул, ввести требуемый текст и нажать клавишу Enter. В результате
надпись появится в области диаграммы и с ней можно будет работать (выделять,
перемещать и т. д.) точно так же, как с другими элементами диаграммы.

9нс. 8.41. Вкладка Alignment окна форматирования

Рис. 8.42. Диаграмма, имеющая название и надписи
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Если поместить курсор мыши на маркер данных, на экране появится название
ряда данных и значение, соответствующее этому маркеру. Режим отображения
названия ряда и его значения устанавливается с помощью флажков Show names
(названия) и Show values (значения) на вкладке Chart (Диаграмма) диалогового
окна Options (Параметры). Если у вас возникла необходимость задать отображе-
ние меток для отдельного маркера данных, откройте с помощью двойного щелчка
на этом маркере диалоговое окно Format Data Series (Формат ряда данных) и ука-
жите на вкладке Data Labels (Подписи данных) вид меток данных (рис. 8.43). Мет-
ка данных - это текст и/или числовое значение, присваиваемые каждому маркеру
данных (например, каждому столбцу гистограммы). Метки данных, как правило,
располагаются над маркерами, но их позицию и формат можно изменять.

form-it i Mta Scrips

Рис. 8.43. Вкладка Data Labels

Чтобы получить возможность форматировать надписи на диаграмме, нужно щелк-
нуть правой кнопкой мыши на текстовом поле и вызвать из контекстного меню
команду Format Axis (Формат оси). В результате откроется диалоговое окно, в ко-
тором следует выполнить необходимые установки. Например, на вкладке Patterns
(Вид) этого окна можно задать рамку и выбрать цвет фона надписи.

Ввод и изменение названий диаграммы и осей
1. Выполните команду Chart > Chart Options (Диаграмма > Параметры диа-

граммы) для открытия диалогового окна Chart Options (Параметры диа-
граммы).

2. Перейдите на вкладку Titles (Заголовки).
3. Введите в поля названия диаграммы и осей и нажмите кнопку ОК.
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Форматирование осей
Неотъемлемым элементом оси диаграммы является цена деления. При построе-
нии гистограммы шкала значений оси Y начинается с нуля и заканчивается зна-
чением, которое вычисляется следующим образом: максимальное значение из об-
ласти данных округляется до ближайшего большего числа, кратного цене деления.

{ПРИМЕЧАНИЕ В большинстве случаев оси отображаются на экране. Скрыть их позволяет
снятие флажков в области Primary Axis (по основной оси) на вкладке Axis
(Оси) диалогового окна Chart Options (Параметры диаграммы), которое вы-
зывается, как вы помните, с помощью команды Chart > Chart Options (Диаг-
рамма > Параметры диаграммы).

Изменить параметры отображения оси можно на вкладке Scale (Шкала) диалого-
вого окна форматирования Format Axis (Формат оси), которое открывается в ре-
зультате двойного щелчка на этой оси (рис. 8.44).

Рис. 8.44. Диалоговое окно Format Axis

СОВЕТ Значения шкалы оси задаются в полях Minimum (минимальное значение)
и Maximum (максимальное значение). Если вы хотите представить на диа-
грамме только значения определенного интервала, укажите его верхнюю
и нижнюю границы.

Если разница между наибольшим и наименьшим значениями шкалы слишком
велика, целесообразно использовать логарифмическую шкалу (рис. 8.45). Такая
шкала позволяет улучшить общий вид диаграммы, значения рядов данных кото-
рой существенно различаются. Чтобы получить возможность применять в диа-
грамме логарифмическую шкалу, следует установить в диалоговом окне Format
Axis (Формат оси) флажок Logarithmic scale (логарифмическая шкала). Однако при
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работе с такими диаграммами нужно быть очень внимательным, с тем чтобы не до-
пустить ошибок при интерпретации данных.

Рис, 8.45. Диаграммы с обычной (слева) и логарифмической (справа) шкалами

Цена основных и промежуточных делений (засечек) выделенной оси, а также их
вид определяются на вкладках Patterns (Вид) и Scale (Шкала) диалогового окна
Format Axis (Формат оси).

По умолчанию точка пересечения осей имеет координаты 0,0. Для изменения ко-
ординат следует ввести требуемое значение в поле Category (X) axis crosses at maxi-
mum value (пересечение с осью X (категорий) в максимальном значении) на вклад-
ке Scale (Шкала). Задавая положительное или отрицательное значение, ось X
можно перемещать вдоль оси Y. Если установить флажок Values in reverse order
(обратный порядок значений), то диаграмма будет представлена в зеркальном
отображении относительно оси X: положительные значения на оси Y будут рас-
полагаться ниже оси X, а отрицательные — выше.

Набор параметров для оси X зависит от выбранного типа диаграммы. Например,
при построении гистограммы на оси X будут отображены не числовые значения,
а категории. Следовательно, и вкладка Scale (Шкала) при форматировании оси X
приобретет несколько иной вид (рис. 8.46).

В полях вкладки Scale (Шкала) устанавливаются параметры размещения осей
и категорий. Например, ось Y можно переместить относительно оси X путем ука-
зания в первом поле категории, перед которой будет представлена ось Y. В сле-
дующих двух полях определяется взаимное расположение категорий и засечек.
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По умолчанию каждая категория на диаграмме с двух сторон отделена засечками.
Пользователь может поместить между двумя засечками несколько категорий,
в частности в том случае, когда категории тесно связаны между собой.

Рис. 8.46. Вкладка Scale для оси X

Чтобы облегчить восприятие диаграммы, наряду с засечками на ней можно вывес-
ти сетку для отдельных осей. Для этого нужно вызвать команду Chart > Chart Op-
tions (Диаграмма * Параметры диаграммы) и установить требуемые параметры
на вкладке Gridlines (Линии сетки) появившегося диалогового окна.

Изменение вида объемных диаграмм

Пользователь может изменить угол обзора объемной диаграммы. Такая потреб-
ность возникает, в частности, в том случае, если в диаграмме первый ряд данных
закрывает другие ряды. Изменяя угол обзора, можно добиться наилучшего пред-
ставления такой диаграммы на экране (рис. 8.47).

Угол обзора изменяется в результате поворота диаграммы вокруг одной из ее
осей. Повернуть диаграмму вокруг оси можно с помощью специальных маркеров
или посредством диалогового окна 3-D View (Формат трехмерной проекции).

В первом случае следует щелкнуть на одной из сторон объемной диаграммы и, ко-
гда в углах параллелепипеда, в котором находится диаграмма, появятся черные
маркеры, поместить курсор мыши на любой из них и начинать перемещать его
при нажатой левой кнопке мыши. На экране вследствие этого отобразится парал-
лелепипед, посредством изменения позиции одного из углов которого можно до-
биться желаемого расположения диаграммы (рис. 8.48).

Когда левая кнопка мыши будет отпущена, диаграмма на экране примет несколь-
ко иной вид.
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Рис. 8.47. Объемная гистограмма
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Рис. в.48. Вид гистограммы при выполнении операции поворота
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Параметры обзора можно изменить, воспользовавшись полями ввода и кнопками
диалогового окна 3-D View (Формат трехмерной проекции), представленного на
рис, 8.49. Открывается это окно в результате выполнения команды Chart > 3-0 View
(Диаграмма > Объемный вид).

Рис. 8.49. Диалоговое окно 3-D View

Указывая значения в полях Elevation (Возвышение), Rotation (Поворот) и Perspec-
tive (Перспектива), можно изменить вид и ориентацию объемной диаграммы в
пространстве.

Задав в поле Elevation (Возвышение) большое положительное значение (близкое
к 90), можно добиться эффекта созерцания диаграммы с высоты. Ввод отрица-
тельного значения (до -90) позволяет увидеть диаграмму снизу. Значение в поле
Rotation (Поворот) задает поворот диаграммы вокруг оси Z, обеспечивая тем са-
мым возможность взглянуть на нее «со стороны». При вводе в это поле значения О
ряды данных на диаграмме будут расположены фронтально. С помощью поля
ввода Perspective (Перспектива) можно регулировать «глубину» диаграммы. Если
установлен флажок Right angle axes (Изометрия), это поле недоступно.

СОВЕТ Для того чтобы установить параметры, определяющие ориентацию диаграм-
мы в пространстве, в начальные значения, необходимо щелкнуть на кнопке
Default {По умолчанию).

Изменение угла обзора объемной диаграммы
1. Выполните щелчок на одной из сторон объемной диаграммы.
2. Поместите курсор мыши на одном из маркеров, находящихся в углах

параллелепипеда, и начните перемещать его при нажатой левой кнопке
мыши.
ИЛИ
Вызовите команду Chart > 3-D View (Диаграмма > Объемный вид), чтобы
открыть диалоговое окно 3-D View (Формат трехмерной проекции), за-
дайте необходимые параметры и нажмите кнопку ОК.
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Форматирование категорий
Существует множество способов для представления рядов данных на диаграммах
различных типов. Продемонстрируем их на примере гистограммы, состоящей из
нескольких рядов данных. При создании этой диаграммы с помощью используе-
мого по умолчанию формата гистограммы столбцы рядов данных будут представ-
лены в категории плотно примыкая друг к другу.

Пользователь может изменить ширину столбца на гистограмме, наложить столб-
цы друг на друга, расположить ряды данных категории в ином порядке.

Применяемые для этой цели параметры устанавливаются в диалоговом окне For-
mat Data Series (Формат ряда данных), открыть которое можно посредством двой-
ного щелчка на маркере данных (рис. 8.50).

Чтобы изменить ширину столбцов, следует на вкладке Options (Параметры) вве-
сти в поле Gap width (Ширина зазора) новое значение, которое будет определять
расстояние от группы столбцов до засечки. В поле предварительного просмотра
можно узнать, какой вид в результате этого приобретет диаграмма.

Format Data Scries

. • • i

(
I ,

Рис. 8.50, Диалоговое окно Format Data Series

Если в поле Overlap (Перекрытие) установлено значение 0, столбцы одной катего-
рии располагаются вплотную. Когда задано любое положительное значение, столб-
цы накладываются друг на друга, а отрицательное значение определяет интервал ме-
жду столбцами категории. Допускаются значения в интервале от -100 до 100.

Путем установки на вкладке Axis (Ось) переключателя Primary axis (по вспомога-
тельной оси) задается отображение на диаграмме второй (вспомогательной) оси Y.
Такая потребность может возникнуть в том случае, если значения в рядах данных
двухмерных диаграмм существенно различаются или если на диаграмме отобра-
жены данные различного типа (например, количество изделий и объем продаж).
Предназначение вкладок Series Order (Порядок рядов), Patterns (Вид) и Data Labels
(Подписи данных) вам уже известно.
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Установка формата по умолчанию
При создании диаграммы можно использовать параметры, предлагаемые програм-
мой по умолчанию. Для этого следует сначала выделить ячейки в таблице, ука-
зать позицию диаграммы на рабочем листе и нажать кнопку Finish (Готово) в пер-
вом диалоговом окне мастера диаграмм или кнопку Chart Type (Тип диаграммы)
на панели инструментов Chart (Диаграммы).

Если какой-либо тип диаграмм используется часто, целесообразно определить
его (вместе с установленными параметрами форматирования) как тип, исполь-
зуемый по умолчанию.

По умолчанию диаграмма строится на основе текущей диаграммы. Создайте диа-
грамму, щелкните на ней и вызовите команду Chart > Chart Type (Диаграмма > Тип
диаграммы). Когда на экране появится уже знакомое вам диалоговое окно, от-
кройте в нем вкладку Custom Types (Нестандартная) и щелкните на кнопке Set as
default chart (Сделать стандартной). Подтвердите свое решение нажатием кнопки
Yes (Да) и укажите в диалоговом окне Add Custom Chart Type (Добавление нового
типа диаграмм) имя пользовательского формата (см. рис. 8.35),

После нажатия кнопки О К пользовательский формат появится в списке, а после
закрытия диалогового окна Chart Type (Тип диаграммы) он будет применяться по
умолчанию.

Самостоятельная работа
1. На основе таблицы, используемой в этом уроке в качестве примера, создайте

диаграмму любого типа.

2. Разместите слева от созданной диаграммы легенду, воспользовавшись для этой
цели либо мышью, либо диалоговым окном Format Legend (Формат легенды).

3. Измените цвет маркера какого-нибудь одного из рядов.

4. Измените ориентацию текста оси категорий.

5. Присвойте оси значений денежный формат.

Подведение итогов
В этом уроке мы научились:

0 создавать диаграммы посредством мастера диаграмм;

0 изменять тип диаграммы;

0 добавлять и удалять ряды данных;

И вставлять легенду;

0 изменять цвет и узор элементов диаграммы;

0 создавать надписи на диаграмме;

0 форматировать оси;

0 устанавливать формат по умолчанию.
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В Excel существует возможность красочно оформлять рабочие листы, используя
для этого различные графические объекты. Причем такие объекты можно созда-
вать непосредственно в самой программе Excel, а можно внедрять из других при-
ложений.

Встроенный графический редактор Excel

Для создания графических объектов в Excel предназначен встроенный графиче-
ский редактор, доступный при наличии панели инструментов Drawing (Рисова-
ние). Конечно, его возможности не сравнимы с возможностями такого графиче-
ского редактора, как, скажем, CorelDRAW, но для решения большинства задач его
вполне достаточно.

Панель инструментов Drawing
Для вызова этой панели инструментов (рис. 9.1) необходимо щелкнуть пра-
вой кнопкой мыши на любой другой панели инструментов и либо выбрать

в появившемся контекстном меню пункт Drawing (Рисование), либо задать коман-
ду View * Toolbars > Drawing (Вид > Панели инструментов > Рисование). Кроме того,
ее можно вызвать щелчком на кнопке Drawing (Рисование) стандартной панели
инструментов.

Рис. 9.1. Панель инструментов Drawing

Описание кнопок панели инструментов Drawing (Рисование) приведено в табл. 9.1.

Таблица 9.1. Назначение кнопок панели инструментов Drawing

Кнопка Название Описание

Draw
(Действия)

Select Objects
(Выбор объектов)

AutoShapes
(Автофигуры)

Line
(Линия)

Arrow
(Стрелка)

Rectangle
(Прямоугольник)

Вызов меню, в котором определяются
параметры графических объектов и их
расположение

Выбор нужных объектов (курсор мыши
принимает вид стрелки)

Активизация палитры готовых графических
объектов

Рисование прямой линии

Вставка линии со стрелкой на конце

Рисование прямоугольника

продолжение
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Таблица 9.1 (продолжение)

Кнопка Название Описание

"

OvaL
(Овал)

Text Box
(Надпись)

Insert WordArt (Добавить
объект WordArt)

Insert Diagram or Organization
Chart (Добавить диаграмму
или организационную
диаграмму)

Insert Clip Art
(Добавить картинку)

Insert Picture From File
(Добавить рисунок из файла)

RU Color
(Цвет заливки)

Line Color
(Цветлинии)

Font Color
(Цвет шрифта)

Line Style
(Тип линии)

Dash Style
(Тип штриха)

Arrow Style
(Вид стрелки)

Shadow Style
(Стиль тени)

3-D Style
(Объем)

Рисование овала

Создание надписи в текстовом поле

Создание фигурного текста

Вставка диаграммы или организационной
диаграммы из приложения Diagram Gallery
(Библиотека диаграмм)

Вставка картинки из библиотеки рисунков
Clip Art

Вставка рисунка из файла

Добавление, изменение или удаление заливки
выделенного объекта

Добавление, изменение или удаление цвета
линий выделенного объекта

Изменение цвета шрифта

Задание стиля и толщины линий

Задание типа штриховой линии

Определение типа стрелки

Выбор вида тени для выделенного объекта

Выбор эффекта объема для выделенного
объекта

Создание графических объектов

После нажатия одной из кнопок, предназначенных для создания графических
объектов (к их числу относятся кнопки Line (Линия), Arrow (Стрелка), Rectangle
(Прямоугольник), Oval (Овал)), указатель мыши принимает вид черного крести-
ка. Если в процессе рисования некоторых объектов удерживать нажатой клавишу
Alt, границы этих объектов совпадут с линиями сетки рабочего листа. Используя
при рисовании клавишу Shift, можно получить правильные геометрические фигу-
ры (например, окружность вместо эллипса, квадрат вместо прямоугольника).



Встроенный графический редактор Excel 287

При необходимости нарисовать несколько одинаковых объектов нажимать такое
же количество раз соответствующую кнопку панели Drawing (Рисование) не обя-
зательно. После выполнения двойного щелчка на этой кнопке объект можно на-
рисовать любое количество раз — это можно делать до тех пор, пока не будет ак-
тивизирована другая кнопка или нажата клавиша Esc.

, v Чтобы нарисовать отрезок прямой линии, сначала следует выполнить щел-
1 чок на кнопке Line (Линия), затем, установив указатель мыши в начальной

точке отрезка, нажать левую кнопку мыши, переместить указатель в конечную
его точку и отпустить кнопку мыши.

СОВЕТ Если конечная точка отрезка находится вне видимой области рабочего л иста,
смело перемещайте указатель мыши в нужном направлении, и видимая об-
ласть автоматически будет смещена в требуемое место.

Только что созданный отрезок остается выделенным. Об этом свидетельствуют
маркеры, расположенные в его начальной и конечной точках. В данном режиме
отрезок можно отформатировать с помощью команды Format > AutoShape (Формат >
Автофигура).

-̂  Для рисования стрелок предназначена кнопка Arrow (Стрелка). Стрелка соз-
дается так же, как отрезок прямой. Наконечник стрелки размещается в ко-

нечной точке этой фигуры. Если во время рисования стрелки (или линии) удер-
живать клавишу Shift нажатой, угол ее наклона будет изменяться с шагом в 15°.

г—1 Процесс рисования на рабочем листе прямоугольника чем-то напоминает
~~т процесс выделения диапазона ячеек. После нажатия кнопки Rectangle (Пря-
моугольник) в рамку заключается область, которая по площади равна создавае-
мому прямоугольнику. Размер прямоугольника можно изменять с помощью мар-
керов — они становятся видимыми при выделении данного объекта. Занимаемая
прямоугольником область заполняется белым цветом, а размещенные на заднем
плане объекты перестают отображаться.

Ш Рисовать овалы и окружности позволяет кнопка OvaL (Овал). В процессе рисо-
вания контур фигуры можно растягивать по горизонтали и вертикали. Чтобы

получить окружность, клавишу Shift при рисовании нужно удерживать нажатой.

Надписи используются для вставки в рабочий лист свободно позиционируемых
текстовых фрагментов. Содержимое надписи в любой момент может быть изме-
нено и отформатировано. Попробуем создать такой объект.

Ш Нажмите кнопку Text Box (Надпись) и нарисуйте прямоугольник известным
вам способом в том месте, где должен быть расположен текст. В результате

вы получите прямоугольное поле с маркерами для изменения размера на сторонах
и курсором ввода внутри. Введите с клавиатуры текст. Для перехода в новую стро-
ку используйте клавишу Enter, а для завершения ввода данных — клавишу Esc.

ВНИМАНИЕ Если вы хотите вставить символ табуляции в надпись, используйте комбина-
цию клавиш Ctrl+Tab, поскольку клавиша Tab применяется для выделения гра-
фических объектов.
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Создание графических объектов
1. Если панель инструментов Drawing (Рисование) закрыта, щелкните пра-

вой кнопкой мыши на любой другой панели инструментов и выберите
в контекстном меню пункт Drawing (Рисование) или щелкните на кнопке
Drawing (Рисование) панели инструментов Standard (Стандартная).

2. Щелкните на одной из кнопок, предназначенных для создания графи-
ческих объектов. При необходимости нарисовать несколько одинаковых
объектов щелкните на этой кнопке дважды.

3. Щелкните левой кнопкой мыши в области рабочего листа и перетащите
курсор мыши от начальной точки линии или фигуры до конечной,

4. Отпустите кнопку мыши.

Действия над графическими объектами
Меню Draw (Действия) панели инструментов Drawing (Рисование) предназначено
для вызова операций, связанных с манипулированием объектами. Ниже будет рас-
смотрен принцип использования каждой команды данного меню.

Команда Draw > Group (Действия > Группировать) применяется для объединения
двух и более выделенных объектов в группу, работа с которой производится как
с единым объектом. Прежде чем применить эту команду, следует выделить объ-
екты, которые должны быть сгруппированы. Выделить несколько объектов мож-
но с помощью мыши, удерживая при этом нажатой клавишу Shift. Для того чтобы
разгруппировать объекты, необходимо вызвать команду Draw > Ungroup (Действия t
Разгруппировать). Команда Draw > Regroup (Действия > Перегруппировать) пред-
назначена для объединения в группу объектов, которые были разъединены ко-
мандой Draw t Ungroup (Действия > Разгруппировать).

Нарисованные объекты располагаются на отдельных уровнях, поверх рабочего
листа. Для того чтобы получить возможность перемещать объекты, изменяя их
уровни, следует вызвать команду Draw > Order (Действия > Порядок), предназна-
ченную для открытия меню Order (Порядок). Выбираемые из него команды Bring
to Front (На передний план) и Send to Back (На задний план) позволяют переме-
щать отмеченные объекты соответственно на самый верхний и на самый нижний
уровни. Для перемещения объекта на один уровень используются команды Bring
Forward (Переместить вперед) и Send Backward (Переместить назад).

Воспользовавшись командой Draw V Snap > To Grid (Действия * Привязать > Привя-
зать к сетке), можно включить режим То Grid (Привязать к сетке), в результате
чего объекты и автофигуры при перетаскивании и рисовании будут выравнивать-
ся по границам ячеек. Режим привязки к фигуре включается посредством коман-
ды Draw > Snap > То Shape (Действия > Привязать > Привязать к фигуре), и вырав-
нивание в этом случае происходит не только по границам ячеек, но и по верти-
кальным и горизонтальным граням других фигур.
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Для перемещения объекта или группы объектов можно воспользоваться также
командой Draw > Nudge (Действия » Сдвиг), после вызова которой в раскрываю-
щемся меню нужно выбрать один из следующих пунктов: Up (Вверх), Down (Вниз),
Left (Влево), Right (Вправо). Если режим привязки к сетке или фигуре включен,
то перемещение выделенных объектов будет происходить с шагом в одно деление
сетки, а если этот режим отключен — с шагом в один пиксел.

Для выравнивания объектов один относительно другого применяется команда
Draw > Align or Distribute (Действия > Выровнять/Распределить). В меню, которое
будет открыто в результате ее вызова, следует выбрать способ выравнивания из
ряда перечисленных в табл. 9.2.

Таблица 9.2. Способы выравнивания объектов

Способ выравнивания Описание

Align Left
(Выровнять по левому краю)

Align Center
(Выровнять по центру)

Align Right
(Выровнять по правому краю)

Align Top
(Выровнять по верхнему краю)

Align Middle
(Выровнять по середине)

Align Bottom
(Выровнять по нижнему краю)

Distribute Horizontally
(Распределить по горизонтали)

Distribute Vertically
(Распределить по вертикали)

Выравнивание выделенных объектов
по левому краю

Выравнивание центров выделенных
объектов по вертикали

Выравнивание выделенных объектов
по правому краю

Выравнивание выделенных объектов
по верхнему краю

Выравнивание центров выделенных
объектов по горизонтали

Выравнивание выделенных объектов
по нижнему краю

Равномерное распределение выделенных
объектов по горизонтали один относительно
другого

Равномерное распределение выделенных
объектов по вертикали один относительно
другого

При необходимости повернуть или зеркально отобразить объект следует вызвать
команду Draw > Rotate or Flip (Действия > Повернуть/отразить) и после этого вы-
брать в раскрывшемся списке одну из предлагаемых команд.

Команда Free Rotate (Свободное вращение) поворачивает выбранный объект про-
извольным образом. При выборе команды Rotate Left (Поворот влево) или Rotate
Right (Поворот вправо) угол поворота в указанном направлении составляет 90".
Для зеркального отображения объектов предназначены команды Flip Vertical (От-
разить сверху вниз) и Flip Horizontal (Отразить слева направо).

Для преобразования выделенных соединительных линий таким образом, чтобы
они проходили по наиболее короткому маршруту между соединяемыми фигура-
ми (без пересечения их границ), применяется команда Draw к Reroute Connectors
(Действия * Спрямить соединения).

10 Зек. 345
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Действия над графическими объектами
1. Выделите объекты (объект), которые необходимо отформатировать.
2. Щелкните на кнопке Draw (Действия) панели инструментов Drawing

(Рисование) и в появившемся меню выберите нужную команду.

Автофигуры

При рисовании стандартных фигур целесообразно пользоваться коллекцией го-
товых геометрических фигур. Список групп автофигур (рис. 9.2) вызывается по-
средством щелчка на кнопке AutoShapes (Автофигуры).

Unes

connectors

Basic Shapes

Block Arrows

Flowchart

Stars and Banners

Callouts

№re AutoShapes,..

Рис. 9.2. Список автофигур

Автофигуры объединены в семь групп (рис. 9.3): Lines (Линии), Connectors (Со-
единительные линии), Basic Shapes (Основные фигуры), Block Arrows (Фигурные
стрелки), Flowchart (Блок-схемы), Stars and Banners (Звезды и ленты) и Callouts
(Выноски).

Автофигуры группы Lines (Линии) наряду с уже рассмотренными нами отрезка-
ми прямых и стрелками позволяют создавать разнообразные кривые.

Кнопка Curve (Кривая) используется для рисования кривой, проходящей через
указанные точки. Щелкните сначала в том месте, где кривая должна начинаться,
после чего перемещайте указатель мыши, щелкая в тех точках, в которых должны
быть изгибы.

Кнопка Freeform (Полилиния) предназначена для рисования и замкнутых, и не-
замкнутых контуров произвольной формы. Чтобы получить незамкнутый контур,
следует завершить рисование двойным щелчком в конечной точке. Рисование замк-
нутого контура завершается при совмещении конечной и начальной точек.

В результате нажатия кнопки Scribble (Рисованная кривая) пользователь получа-
ет возможность рисовать на рабочем листе Excel, как карандашом на бумаге.



Встроенный графический редактор Excel 291

Рис. 9.3. Группы автофигур Excel

Автофигуры, предназначенные для создания соединительных линий (рис. 9.4),
входят в группу Connectors (Соединительные линии). В Excel используются соеди-
нительные линии грех типов: прямые, ломаные и изогнутые. Соединительную
линию можно отформатировать — задать толщину и тип штриха. Для этого ее не-
обходимо выделить, щелкнуть на кнопке Line Style (Тип линии) или на кнопке
Dash Style (Тип штриха) панели инструментов Drawing (Рисование) и выбрать тре-
буемый вариант в открывшемся меню. Чтобы соединить два объекта, необходимо
выбрать в подменю Connectors (Соединительные линии) тип линии и выполнить
щелчок сначала на первом объекте, а загем — на втором. При перемещении объек-
тов соединительная линия перемещается вместе с ними.

Группа Basic Shapes (Основные фигуры) включает наиболее распространенные ав-
тофигуры (лист с загнутым углом, улыбающаяся рожица и т. д.).

Автофигуры для рисования разнообразных стрелок объединены в группу Block
Arrows (Фигурные стрелки). Поместив такую стрелку на рисунок, вы сможете из-
менять ее форму с помощью желтого маркера, который появляется при выделе-
нии стрелки. Группа Flowchart (Блок-схемы) содержит автофигуры, используе-
мые для создания блок-схем.

В группу Stars and Banners (Звезды и ленты) входят автофигуры для рисования
звездочек и флажков, а в группу Callouts (Выноски) - автофигуры для создания
фигур, в которые принято помещать реплики.
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Рис. 9.4. Соединительные линии

Вставка автофигур

1. Щелкните на кнопке AutoShapes (Автофигуры) панели инструментов
Drawing (Рисование).

2. Установите курсор на одной из групп автофигур, после чего в открыв-
шемся меню выберите необходимый объект из появившегося списка.

3. Поместите курсор мыши в то место рабочего листа, где вы хотите рас-
положить автофигуру, щелкните левой кнопкой мыши и, удерживая ее
нажатой, задайте нужный размер автофигуры.

Форматирование графических объектов
Диалоговое окно, в котором устанавливаются параметры форматирования гра-
фического объекта, открывается в результате вызова из строки меню или из кон-
текстного меню объекта команды Format > AutoShape (Формат > Автофигура), а так-
же после двойного щелчка на данном объекте. Структура и вид этого окна зави-
сят от типа выделенного объекта.

Если объект является стрелкой, то на вкладке Colors and Lines (Цвета и линии)
диалогового окна Format AutoShape (Формат автофигуры) активны поля для опре-
деления стиля, цвета и толщины линии стрелки, а также стиля, ширины и длины
наконечника (рис. 9.5).

При установке курсора ввода внутри текстового поля диалоговое окно содержит
всего одну вкладку - Font (Шрифт), а при выделении текстового поля - восемь
вкладок.
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Рис. 9.5. Параметры форматирования стрелки

По умолчанию позиции и размеры графических объектов зависят от позиций
и размеров ячеек, в которых они расположены. Например, если объект создан
в ячейке А1, то после вставки пяти строк перед первой строкой он будет смещен
в строку 6. Перемещение объекта вместе с ячейками происходит в том случае, если
объект связан с содержимым одной из них. Что касается размеров, то при измене-
нии высоты строки или ширины столбца соответствующим образом изменяются
и размеры самого объекта.
Пользователь может отменить указанную зависимость. Для этого следует перей-
ти на вкладку Properties (Свойства) диалогового окна Format AutoShape (Формат
автофигуры) и активизировать переключатель Don't move or size with cells (не пере-
мещать и не изменять размеры). Чтобы отменить зависимость размера графиче-
ского объекта от размеров ячеек, в которых он расположен, но при этом сохра-
нить зависимость позиции объекта от позиции ячейки, надлежит установить
переключатель Move but don't size with cells (перемещать, но не изменять размеры).

Форматирование графических объектов
1. Выделите графический объект, который необходимо отформатировать.

2. Вызовите команду Format > AutoShape (Формат к Автофигура) или дваж-
ды щелкните на объекте, для того чтобы открыть диалоговое окно For-
mat AutoShape (Формат автофигуры).

3. Задайте необходимые параметры форматирования объекта и щелкни-
те на кнопке ОК.
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СОВЕТ По умолчанию на печать выводятся все созданные объекты. С помощью флаж-
ка Print object (Выводить объект на печать), устанавливаемого на вкладке
Properties (Свойства), пользователь может задать другой режим вывода на
печать, в котором отдельные объекты не будут печататься.

Самостоятельная работа
1. Откройте панель инструментов Drawing (Рисование).

2. Нарисуйте на рабочем листе два графических объекта: окружность и квадрат.

3. Соедините полученные фигуры прямой соединительной линией.

4. Выровняйте фигуры по верхнему краю.

5. Выделите все графические объекты, которые вы нарисовали, и задайте для них
толщину линий 2 пункта.

Коллекция WordArt
Приложение WordArt предназначено для создания графических объектов из тек-
ста. Как правило, оно применяется для разработки логотипов и красочного выде-
ления заголовков или отдельных фрагментов текста. С его помощью вы можете соз-
давать специальные эффекты в тексте, улучшающие внешний вид документа.

Средства оформления текста
Для того чтобы открыть диалоговое окно WordArt Gallery (Галерея WordArt),
которое вы видите на рис. 9.6, установите курсор в области размещения тек-

ста и щелкните на кнопке Insert WordArt (Добавить объект WordArt) панели инст-
рументов Drawing (Рисование). Здесь вы можете выбрать вариант объемного оформ-
ления текста.

г и с. 9.о. Диалоговое окно WordArt Gallery
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Стиль надписи выбирается в окне WordArt Gallery (Коллекция WordArt), и в лю-
бой момент его можно изменить. После щелчка в названном окне на кнопке ОК
откроется диалоговое окно Edit WordArt Text (Изменение текста WordArt), предна-
значенное для ввода текста (который будет служить основой графического изобра-
жения), а также для определения параметров форматирования (рис. 9.7).

Заголовок

Рис. 9.7. Исходный текст в диалоговом окне Edit WordArt Text

Для оформления текста предназначены раскрывающиеся списки Font (Шрифт)
и Size (Размер), а также кнопки, задающие полужирное и курсивное начертание
символов. После щелчка на кнопке ОК на рабочем листе появится объект Word-
Art и откроется панель инструментов WordArt, с которой вы будете работать далее.
Описание кнопок этой панели приведено в табл. 9.3, а на рис. 9.8 показан пример
оформления текста.

Рис. 9.8. Оформленный текст на рабочем листе
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Таблица 9.3. Кнопки панели инструментов WordArt

Кнопка Название Описание

Insert WordArt
(Добавить объект WordArt)

Edit Text
(Изменить текст)

WordArt Gallery
(Коллекция WordArt)

Format WordArt
(Формат объекта WordArt)

WordArt Shape
(Форма WordArt)

WordArt Same Letter Heights
{Выровнять буквы WordArt по высоте)

WordArt Vertical Text
(Вертикальный текст WordArt)

WordArt Alignment
(Выравнивание WordArt)

Создание нового объекта WordArt

Открытие диалогового окна Edit WordArt Text
(Изменение текста WordArt) для
редактирования текста

Открытие окна коллекции WordArt

Открытие диалогового окна Format WordArt
(Формат объекта WordArt), позволяющего
установить параметры форматирования
объекта и выполнить его привязку
к рабочему листу

Открытие меню, в котором выбирается
форма для текстового фрагмента

Выравнивание по высоте всех букв
выделенного объекта WordArt

Расположение текста по вертикали (буква
над буквой) таким образом, чтобы он
читался сверху вниз

Открытие меню, содержащего как
стандартные команды выравнивания,
так и специальные

WordArt Character Spacing Открытие меню, в котором задается
(Межсимвольный интервал WordArt) межсимвольный интервал

Создание объекта WordArt
1. Установите курсор в в области размещения объекта WordArt.
2. Щелкните на кнопке Insert WordArt (Добавить объект WordArt) панели

инструментов Drawing (Рисование).

3. Выберите в коллекции WordArt нужный стиль и щелкните на кнопке ОК.

4. В открывшемся диалоговом окне Edit WordArt Text (Изменение текста
WordArt) введите текст, который будет преобразован в объект Word-
Art. Отформатируйте текст, задав для него шрифт, размер и стиль, по-
сле чего щелкните на кнопке ОК.

5. Отформатируйте объект WordArt, используя кнопки панели инстру-
ментов WordArt.
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Самостоятельная работа
1. Вставьте в область рабочего листа текст, созданный посредством Word Art.

2. Выровняйте все буквы созданного текста по высоте.

3. Выберите форму представления текста Triangle Up (Треугольник вверх).

4. Отредактируйте текст, который вы создали, а затем измените размер и тип
шрифта.

Вставка рисунков из файлов

В Excel существует возможность вставлять готовые рисунки из файлов. Причем
это могут быть как файлы коллекции картинок Clip Art, так и любые другие.

Вставка рисунков из коллекции картинок Clip Art
Чтобы добавить на рабочий лист одну из картинок коллекции Clip Art, следует
вызвать команду Insert > Picture * Clip Art (Вставка > Рисунок > Картинки) или на-
жать кнопку Insert Clip Art (Добавить картинку) панели инструментов Drawing (Ри-
сование). Появится область задач Clip Art (Вставка картинки), в которой необхо-
димо задать параметры поиска картинок, после чего нажать кнопку Go (Найти).
По окончании поиска результаты будут отображены в этой области задач (рис. 9.9).
Для того чтобы вставить картинку в рабочий лист, достаточно щелкнуть на ней
левой кнопкой мыши.

Рис. 9.9. Область задач Clip Art



298 Урок 9 • Графические объекты

Если вы хотите просмотреть всю коллекцию картинок, щелкните в нижней части
области задач Clip Art (Вставка картинки) на ссылке Organize clips (Коллекция кар-
тинок). На экране появится диалоговое окно Microsoft Clip Organizer (Коллекция
картинок Microsoft), в котором можно просматривать предлагаемые картинки,
структурировать их удобным образом, добавлять новые (рис. 9.10). Например,
можно создать коллекцию, объединяющую наиболее часто используемые картин-
ки, или включить режим автоматического добавления и структурирования фай-
лов мультимедиа на жестком диске. Рабочий лист со вставленными в него раз-
личными картинками из коллекции показан на рис. 9.11.

v*pe a question for hep f«j
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Рис. 9.10. Диалоговое окно Microsoft Clip Organizer

Вставка рисунка из коллекции картинок Clip Art
1. Задайте команду Insert > Picture > Clip Art (Вставка > Рисунок > Картин-

ки) или нажмите кнопку Insert Clip Art (Добавить картинку) на панели
инструментов Drawing (Рисование).

2. В появившейся области задач Clip Art задайте критерии поиска карти-
нок, после чего нажмите кнопку Go (Найти). Для того чтобы вставить
картинку на рабочий лист, необходимо щелкнуть на ней левой кноп-
кой мыши.

3. При необходимости просмотреть всю коллекцию Clip Art щелкните на
ссылке Organize clips (Коллекция картинок), расположенной в нижней
части области задач Clip Art (Вставка картинки). В появившемся окне
Microsoft Clip Organizer (Коллекция картинок Microsoft) найдите необхо-
димую картинку и поместите ее на рабочий лист.
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Рис. 9.11. Картинки из коллекции Clip Art на рабочем листе

Вставка изображений из файла
Если вам необходимо найти изображение, которое не входит в коллекцию Clip
Art, следует, воспользовавшись командой Insert > Picture > From File (Вставка > Ри-
сунок > Из файла), открыть диалоговое окно Insert Picture (Добавление рисунка)
(рис. 9.12), найти в нем нужный файл и нажать кнопку Insert (Вставить).

AllPictTesC'.emf;-.wmf;-.]pg;>.Jpeg;*.]fif;*.)pe;*.pig;".bmp

Рис. 9.12. Диалоговое окно Insert Picture
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СОВЕТ Если вы не знаете ни точного названия файла, ни места его расположения,
открывать все файлы подряд нет необходимости. Достаточно установить
способ отображения файлов Preview (Просмотр), и содержимое файла поя-
вится в правой части окна Insert Picture (Добавление рисунка}. Для этого
в окне Insert Picture (Добавление рисунка) нажмите кнопку Views (Представ-
ления), а в появившемся списке выберите пункт Preview (Просмотр).

Excel поддерживает большое количество графических форматов, но мы перечис-
лим лишь основные с указанием их расширения: Tag Image File Format (*.tif, *.tiff),
Encapsulated Postscript (*.eps), Windows Bitmap (*.bmp), Enhanced Metafile (*.emf),
Computer Graphics Metafile (*.cgm), PC Paintbrush (*.pcx), Autocad DFX (*.dfx),
CorelDRAW (*.cdr), Windows Metafile (*.wmf), Kodak PhotoCD (*.pcd), PNG file
format (*.png), Macintosh PICT (*.pic), Graphics Interchange Format (*.gif), JPEG
Interchange Format (*.jpg, *.jpeg).

Вставка изображения из файла
1. Активизируйте команду Insert > Picture > From File (Вставка > Рисунок >

Из файла).
2. В появившемся диалоговом окне Insert Picture (Добавление рисунка)

найдите необходимый файл и щелкните на кнопке Insert (Вставить).

Вставка сканированных изображений
Если к компьютеру подключен TWAIN-совместимый сканер или цифровая каме-
ра, то изображения можно сканировать и вставлять их в документы Excel. Дела-
ется это следующим образом. Сначала нужно вызвать команду Insert > Picture >
From Scanner or Camera (Вставка * Рисунок > Со сканера или камеры), затем в поя-
вившемся окне Insert Picture from Scanner or Camera (Вставка рисунка со сканера
или камеры) выбрать переключатель Web Quality (для передачи по Интернету)
или Print Quality (для печати). Далее, если будут использоваться установки скане-
ра» задаваемые по умолчанию, необходимо щелкнуть на кнопке Insert (Вставить),
но если понадобится изменить параметры сканирования, следует щелкнуть на
кнопке Custom Insert (Специальная вставка). Кнопка Insert (Вставить) может быть
недоступной, если сканер не обладает функцией автоматического сканирования.

Вставка сканированного изображения
1. Вызовите команду Insert t Picture > From Scanner or Camera (Вставка >

Рисунок > Со сканера или камеры).
2. Активизируйте переключатель Web Quality (для передачи по Интерне-

ту) или Print Quality (для печати).

3. Щелкните на кнопке Insert (Вставить) или Custom Insert (Специальная
вставка).



Вставка рисунков из файлов 301

Редактирование изображений
Изображение, выбранное из коллекции Clip Art или любого файла, можно отре-
дактировать с помощью панели инструментов Picture (Настройка изображения),
показанной на рис. 9.13. Чтобы ее вызвать, нужно щелкнуть правой кнопкой мыши
на картинке и выбрать в контекстном меню команду Show Picture Toolbar (Отобра-
зить панель настройки изображения).

Рис. 9.13. Панель инструментов Picture

Назначение кнопок панели инструментов Picture (Настройка изображения) ста-
нет вам понятным после ознакомления с табл. 9.4.

Таблица 9.4. Кнопки панели инструментов Picture

Кнопка Название Описание

Insert Picture From File
(Добавить рисунок из файла)

Color
(Цвет)

More Contrast
(Увеличить контрастность)

Less Contrast
(Уменьшить контрастность)

More Brightness
(Увеличить яркость)

Less Brightness
(Уменьшить яркость)

Crop
(Обрезка)

Rotate Left 90°
(повернуть влево)

Line Style (Тип линии)

Compress Pictures
(Сжатие рисунков)

Format Picture
(Формат рисунка)

Set Transparent Color
(Установить прозрачный цвет)

Reset Picture
(Сброс параметров рисунка)

Вставка рисунка

Задание вида изображения: Automatic (Авто),
Grayscale (Оттенки серого). Black & White
(Черно-белое) или Washout (Подложка)

Увеличение насыщенности (интенсивности)
цветов

Уменьшение насыщенности (интенсивности)
цветов

Добавление белого для увеличения яркости
цветов

Добавление черного для уменьшения яркости
цветов

Вырезывание из рисунка прямоугольной области

Поворот изображения на 90° влево

Определение формата рамки, окружающей
изображение

Уменьшение размера файлов рисунков

Быстрый переход к свойствам изображения

Установка прозрачного цвета для частей
изображения

Возвращение изображения к его исходному виду
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Редактирование изображения
1. Щелкните правой кнопкой мыши на картинке, с которой вы работаете,

и выберите из контекстного меню команду Show Picture Toolbar (Ото-
бразить панель настройки изображения).

2. Установите с помощью кнопок открывшейся панели необходимые па-
раметры изображения.

Самостоятельная работа
1. Вставьте в рабочий лист какое-либо изображение.

2. Увеличьте контрастность и уменьшите яркость изображения.

3. Преобразуйте изображение в черно-белое.

4. Приведите изображение к его исходному виду.

Подведение итогов

В этом уроке мы научились:
0 создавать графические объекты с помощью графического редактора Excel;

0 осуществлять различные операции над графическими объектами;

0 добавлять объекты WordArt;

0 вставлять рисунки из коллекции Clip Art;

0 добавлять изображения из файлов;

0 вставлять сканированные изображения;
0 редактировать изображения.
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Элементами управления называются размещаемые на рабочих листах и в диало-
говых окнах объекты, предназначенные для отображения, ввода и вычисления
данных. К их числу относятся надписи, поля со списками, переключатели, флаж-
ки, кнопки и некоторые другие объекты. С помощью элементов управления поль-
зователи могут запускать макросы и веб-сценарии.

Виды элементов управления
В Excel существует два вида элементов управления: ActiveX и элементы управле-
ния панели инструментов Forms (Формы).

Элементы управления ActiveX способны работать с макросами VBA и веб-сцена-
риями. Они являются независимыми программными компонентами, вызываемы-
ми из Excel. Кнопки для вставки этих элементов управления расположены на па-
нели инструментов Control Toolbox (Элементы управления). На рис. 10.1 она пока-
зана на фоне рабочего листа.

Рис. 10.1. Элементы управления панели инструментов Control Toolbox на рабочем листе

Элементы управления панели инструментов Forms (Формы), представленной на
рис. 10.2, обеспечивают совместимость с ранними версиями Excel (до Excel 97)
и могут использоваться на листах макросов XLM. Правда, их возможности более
ограничены, чем у элементов управления ActiveX, но, с другой стороны, их мож-
но добавлять на листы диаграмм.
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Рис. 10,2. Элементы управления панели инструментов Forms на рабочем листе

В Excel элементы управления можно размещать и на рабочем листе, и в диалого-
вом окне. В этом уроке речь пойдет об использовании элементов управления толь-
ко на рабочем листе.

(ПРИМЕЧАНИЕ Чтобы определить, является объект элементом панели инструментов Control
Toolbox (Элементы управления) или элементом панели инструментов Forms
(Формы), после его размещения на рабочем листе щелкните на нем правой
кнопкой мыши. Если контекстное меню не появляется или содержит команду
Properties (Свойства), значит, это элемент ActiveX. Если контекстное меню со-
держит команду Assign Macro (Назначить макрос), значит, это элемент управ-
ления панели инструментов Forms (Формы).

Элементы управления ActiveX

В отличие от панели инструментов Forms (Формы), панель инструментов Control
Toolbox (Элементы управления) наряду со стандартными элементами управления
ActiveX содержит и ряд дополнительных (например, элементы управления муль-
тимедиа, с помощью которых аудио- и видеофайлы можно воспроизводить непо-
средственно с рабочего листа). Кроме того, существует возможность добавлять на
рабочий лист элементы управления, используемые в других программах или соз-
данные для специальных целей.
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Панель инструментов Control Toolbox
Для того чтобы открыть панель инструментов Control Toolbox (Элементы управле-
ния), необходимо щелкнуть правой кнопкой мыши на любой другой панели ин-
струментов и в появившемся списке выбрать пункт Control Toolbox (Элементы
управления) или вызвать команду View > Toolbars > Control Toolbox (Вид > Панели
инструментов > Элементы управления).

Как выглядит панель инструментов Control Toolbox (Элементы управления), пока-
зано на рис, 10.3. Расположенные на ней кнопки широко используются в Excel,
и многие из вызываемых с их помощью средств хорошо знакомы пользователям
других приложений Windows.

Рис. 10.3. Панель инструментов Control Toolbox

Назначение кнопок панели инструментов ControlToolbox (Элементы управления)
описано в табл. 10.1.

Таблица 10.1. Назначение кнопок панели инструментов ControlToolbox

Кнопка Название Описание

Design Mode
(Режим конструктора)

Properties
(Свойства)

View Code
{Исходный текст)

Check Box
(Флажок)

Text Box
(Поле)

Command Button
(Кнопка)

Option Button
(Переключатель)

List Box
(Список)

Combo Box
(Поле со списком)

Перевод Excel в режим конструктора и отключение всех
элементов управления на рабочем листе

Активизация окна Properties с перечнем свойств листа
или свойств элемента управления, активного на данный
момент

Открытие окна редактора Microsoft Visual Basic

Размещение на рабочем листе флажка, который позволяет
задать или отменить определенный параметр

Добавление на рабочий лист прямоугольной области,
в которой можно вводить и редактировать текст

Создание кнопки, предназначенной для запуска
процедуры Visual Basic

Добавление на рабочий лист переключателя,
предназначенного для выбора одного иэ нескольких
параметров

Размещение на рабочем листе списка, где можно выбрать
один или несколько элементов

Создание на рабочем листе поля со списком,
предоставляющего пользователю возможность ввести
текст либо выбрать один или несколько элементов
из списка
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Кнопка Название Описание

Toggle Button
(Выключатель)

Spin Button
(Счетчик)

Scroll Bar
(Полоса прокрутки)

Label
(Надпись)

Image
(Рисунок)

More Controls
(Другие элементы)

Добавление на рабочий лист выключателя

Размещение на рабочем листе счетчика, который
используется для увеличения или уменьшения числовых
значений

Создание на рабочем листе вертикальной полосы
прокрутки

Добавление на рабочий лист метки, предназначенной для
вывода на экран только текста

Добавление на рабочий лист изображения

Добавление на рабочий лист дополнительных элементов
управления. Наличие в данном списке того или иного
элемента зависит от установленного программного
обеспечения

Каждый тип элементов управления является классом объектов, обладающим соб-
ственным множеством свойств, событий и методов. Когда вы размещаете элемент
управления на рабочем листе, Excel создает экземпляр данного класса объектов.
Вы можете создать столько экземпляров одного класса, сколько пожелаете, при-
чем каждый экземпляр будет обладать теми же свойствами, что и другие экземп-
ляры класса. Всем этим свойствам, кроме свойства Name, будут присвоены значе-
ния, принятые по умолчанию. При необходимости свойства элементов управле-
ния могут быть изменены.

При активизации большинства из описанных выше элементов управления видно,
что они реагируют на события, в частности на такое, как щелчок мышью. К при-
меру, объект Command Button (Кнопка) после щелчка примет вид нажатой кнопки,
объект Option Button (Переключатель) сделает видимой или, наоборот, невидимой
черную точку, а объект Text Box (Поле) отобразит на экране вертикальную линию
курсора для ввода текста.

Добавление элемента управления на рабочий лист
Чтобы расположить элемент управления на рабочем листе, нужно щелкнуть на
соответствующей ему кнопке панели инструментов и, когда указатель мыши при-
мет вид крестика, щелкнуть левой кнопкой мыши в том месте, где этот элемент
должен быть размещен. После того как элемент управления появится на рабочем
листе, его можно будет перетащить с помощью мыши в нужное место, изменив
в случае надобности размеры.

В результате нажатия кнопки элемента управления на панели инструментов
Control Toolbox (Элементы управления) Excel автоматически переходит в режим
конструктора. В этом режиме элементы управления будут отключены, что позво-
лит вам изменить их размер и расположить их на рабочем листе нужным образом.
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Находясь в режиме конструктора, вы можете перетаскивать любые элементы
управления, как захотите, но только не забудьте щелкнуть на кнопке Exit Design
Mode (Выход из режима конструктора), для того чтобы вернуть Excel в обычный
режим. В результате элементы управления станут активными и будут реагиро-
вать на щелчки мыши как обычно.

Добавление элемента управления на рабочий лист
1. Откройте панель инструментов ControLToolbox (Элементы управления).
2. Щелкните на кнопке панели инструментов, которая соответствует до-

бавляемому вами элементу управления.

3. Установите указатель мыши, принявший в результате выполнения пре-
дыдущего действия вид крестика, в том месте рабочего листа, где вы
хотите разместить элемент управления, после чего щелкните левой
кнопкой мыши.

Присвоение имен элементам управления
Расположенному на листе элементу управления ActiveX Excel по умолчанию при-
сваивает имя, состоящее из имени типа, к которому относится данный элемент,
и порядкового номера элемента (например, Labell, Labels, Labels и т. д.). Аналогич-
ным образом имена присваиваются листам и рабочим книгам. Такие имена, явля-
ясь уникальными, выполняют свою задачу, но все же они не отражают функций,
которые реализуются элементами управления.

Если в вашей таблице имеется, предположим, 10 текстовых полей для ввода дан-
ных (от TextBoxl до TextBoxlO), то имеет смысл переименовать их таким образом,
чтобы их имена несли смысловую нагрузку. Да и в макросах гораздо проще избе-
жать ошибок, если использовать имена, которые соотносятся с данными, содер-
жащимися в этих текстовых полях.

Для того чтобы переименовать элемент управления Label (Надпись), щелкните на
нем правой кнопкой мыши, в результате чего этот элемент будет выделен, а на эк-
ране появится контекстное меню. Выберите в нем пункт Properties (Свойства),
и на экран будет выведено окно Properties. В строке Name замените слово Labell
новым именем, например IblBalance. Префикс tbL полезно использовать в именах
всех меток. Это значительно упрощает работу с ними, определяя тип объектов,
к которому метки относятся. Нажмите клавишу Enter или щелкните мышью где-
нибудь вне области окна Properties

Облегчить процесс создания сложных программ поможет принятие соглашений
относительно использования имен при управлении объектами. Microsoft реко-
мендует всем объектам присваивать имена с префиксами, отражающими принад-
лежность к тому или иному классу. Преимущество использования согласован-
ных имен заключается в том, что все объекты одного класса в окне Properties
следуют друг за другом; кроме того, это существенно облегчает чтение и воспри-
ятие макросов.
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Переименование элемента управления
1. Выделите элемент управления, который необходимо переименовать,
2. Откройте диалоговое окно Properties посредством щелчка на кнопке Pro-

perties (Свойства).
3. Задайте новое имя элемента в строке Name указанного диалогового окна.
4. Нажмите клавишу Enter или щелкните мышью где-нибудь вне области

окна.

Перемещение элементов управления
При необходимости переместить элемент управления установите на нем курсор
мыши и, удерживая левую кнопку мыши нажатой, перетащите его в нужную по-
зицию. Но сделать это можно только в том случае, если приложение находится
в режиме конструктора. Кнопка Design Mode (Режим конструктора), осуществляю-
щая переключение между режимами, находится на панели инструментов Control
Toolbox (Элементы управления).

Перемещение элементов управления
1. Воспользовавшись кнопкой Design Mode (Режим конструктора) панели

инструментов Control Toolbox (Элементы управления), перейдите в ре-
жим конструктора,

2. Установите на элементе управления курсор мыши и, удерживая левую
кнопку мыши нажатой, перетащите его в нужную позицию.

Форматирование элементов управления ActiveX
Для того чтобы отформатировать элемент управления ActiveX, необходимо вос-
пользоваться двумя окнами:

О с помощью окна Format Control (Формат элемента управления) определяются
цвет и вид линий контура, размеры, позиция и некоторые другие параметры
элемента управления;

О в окне Properties задаются его свойства.

Некоторые свойства, в частности Height (высота) и Width (ширина), можно задать
в обоих окнах. Большинство свойств, определяющих формат элементов управле-
ния (где и как эти элементы должны отображаться на рабочем листе), следует за-
давать в окне Format Control (Формат элемента управления), а свойства, опреде-
ляющие тип и поведение элемента управления, - в окне Properties.

Окно Format Control
Для того чтобы отобразить окно Format Control (Формат элемента управления),
в режиме конструктора щелкните правой кнопкой мыши на элементе управления
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в рабочем листе и выберите в контекстном меню команду Format Control (Формат
объекта) или же выделите этот элемент управления и вызовите команду Format t
Control (Формат * Элемент управления).

Для каждого элемента управления панели ControLToolbox (Элементы управления)
окно Format Control (Формат объекта) имеет одинаковый вид и содержит четыре
вкладки: Size (Размер), Protection (Защита), Properties (Свойства) и Web (Веб).

На вкладке Size (Размер) в области Size and rotate (Размер и поворот), точнее в по-
лях Height (высота) и Width (ширина), задаются высота и ширина элемента управ-
ления (рис. 10.4). В области Scale (Масштаб), в полях Height (по высоте) и Width
(по ширине), устанавливается высота и ширина элемента управления в процен-
тах от исходного размера. Если активизирован флажок Lock aspect ratio (сохра-
нить пропорции), то высота и ширина элемента изменяются синхронно, то есть
при изменении высоты автоматически изменяется ширина и наоборот. При работе
с элементами управления флажок Relative to original picture size (относительно ис-
ходного размера) недоступен, он применяется только при работе с изображениями.

х;
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Рис. 10.4. Вкладка Size диалогового окна Format Control

На вкладке Protection (Защита), представленной на рис. 10.5, находится флажок
Locked (Защищаемый объект), при установке которого становятся невозможными
такие действия, как изменение размера элемента управления, его перемещение и
удаление — но лишь при условии, что включена защита листа. А чтобы защитить
лист, необходимо вызвать команду Tools > Protection > Protect Sheet (Сервис > За-
щита > Защитить лист).

На вкладке Properties (Свойства), в области Object positioning (Привязка объекта
к фону), находятся переключатели, определяющие поведение элемента управле-
ния при перемещении и изменении размеров ячеек таблицы. Предназначение пе-
реключателя Move but don't size with cells (перемещать, но не изменять размеры)
понятно из его названия. Если активизирован переключатель Don't move or size
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with cells (не перемещать и не изменять размеры), то перемещение и изменение
размера ячеек не влияет на размер и положение элемента управления. При акти-
визации переключателя Move and size with cells (перемещать и изменять объект
вместе с ячейками) элементы управления будут изменять свои размеры при из-
менении размеров ячеек. На этой же вкладке находится флажок Print object (Вы-
водить объект на печать), отвечающий за то, будет ли элемент управления выве-
ден на печать (рис. 10.6).

Рис. 10.5. Вкладка Protection диалогового окна Format Control

Fomut Control

Рис. 10.6. Вкладка Properties диалогового окна Format Control
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На вкладке Web (Веб) находится поле Alternative text (Замещающий текст), где
вводится текст, применяемый в том случае, если книгу или рабочий лист предпо-
лагается использовать как веб-страницу (рис. 10.7).

I orni.i1 Conlrol

Рис. 10.7. Вкладка Web диалогового окна Format Control

Окно Properties
Свойства — это атрибуты, которые определяют характеристики объекта, такие
как цвет, размер и позицию. Кроме того, они могут задавать внешний вид текста.
Каждый элемент управления в Excel обладает рядом свойств, перечень которых
можно увидеть в окне Properties, открывающемся в результате щелчка на кнопке
с таким же именем панели инструментов Control Toolbox (Элементы управления).

Обычно свойства изменяют в режиме конструктора, устанавливая нужные значе-
ния в окне Properties. Кроме того, свойствам можно присваивать значения в про-
грамме — в таком случае они будут изменяться во время работы приложения.

При создании элемента управления всем его свойствам автоматически присваи-
ваются значения, принимаемые по умолчанию. На рис. 10.8 в окне Properties пока-
заны настройки, заданные для объекта Label (Надпись). В верхнем текстовом поле
отображаются имя объекта и его тип. После щелчка мышью на имени любого
свойства таковое будет выделено, и если рядом с ним появится стрелка, то, щелк-
нув на ней, вы сможете выбрать нужный элемент в появившемся списке. В про-
тивном случае, то есть при отсутствии такого списка, исходное значение можно
заменить путем ввода нового значения.

Если существуют два объекта класса Label (Надпись), то в списках их свойств бу-
дут содержаться одни и те же атрибуты, но, возможно, с разными значениями.
К примеру, объекты могут находиться в разных местах таблицы, поэтому их свой-
ства Тор и Left будут различаться. Кроме того, у них могут быть разные размеры,



Элементы управления ActiveX 313

а значит, различными будут и свойства Width, Height. Это следует из парадигмы
объектно-ориентированного программирования, согласно которой объекты, яв-
ляющиеся экземплярами одного класса, могут иметь разные атрибуты.

Рис. 10.8. Диалоговое окно Properties

Вам не понадобится запоминать свойства всех элементов управления, поскольку
обычно используется только часть из них. Свойства объектов класса Label (Над-
пись), с которыми пользователям приходится чаще всего оперировать, перечис-
лены ниже.

О Name — определяет имя, под которым объект фигурирует в программе.

О Accelerator — содержит один из символов, составляющих значение свойства
Caption (описано ниже) и предназначен для быстрого доступа к объекту Label
(Надпись) с помощью клавиатуры. В заголовке элемента управления данный
символ будет подчеркнут. Для перехода к элементу управления следует на-
жать клавишу Alt в сочетании с подчеркнутым символом.

О AutoSize — автоматически изменяет размеры элемента управления таким обра-
зом, чтобы на экране был виден весь его заголовок.

О BackColor — определяет цвет фона.

О BackStyle — указывает, будет ли метка прозрачной.

О BorderColor — задает цвет рамки элемента управления.
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О BorderStyle - определяет, выводится ли рамка на экран. Если это так, то ее цвет
зависит от свойства BorderColor.

О Caption — выводит текст заголовка.

О Enabled — определяет, можно ли выделить объект Label (Метка).

О Font — открывает диалоговое окно Font (Шрифт), в котором можно изменить
стиль и размер шрифта.

О ForeColor — определяет цвет текста заголовка.

О Height — устанавливает высоту элемента управления, которую можно изме-
нить и путем перетаскивания с помощью мыши маркеров размера.

О Left — устанавливает расстояние между левым краем элемента управления
и левым краем рабочего листа.

О MousePointer - определяет вид указателя мыши, когда он находится на элемен-
те управления. Если вы щелкнете на стрелке рядом с этим свойством, на экра-
не появится список, из которого можно выбрать новый вид указателя.

О Picture - предоставляет возможность выбрать рисунок, который затем будет
помещен на элемент управления.

О Shadow — принимает значение True или False в зависимости от того, имеет ли
объект тень.

О SpecialEffect — определяет вид объекта.

О Тор — указывает расстояние между верхними краями элемента управления
и рабочего листа. Это свойство можно также изменить, перетаскивая с помо-
щью мыши маркеры размера объекта.

О Visible — определяет, является ли элемент управления видимым.

О Width — задает ширину объекта, которую, кроме того, можно изменить, исполь-
зуя маркеры размера.

О WordWrap — предназначено для размещения заголовка на объекте оптимальным
образом. В зависимости от размера объекта заголовок может быть расположен
вертикально или горизонтально, в одной или нескольких строках. Свойство
принимает значение True или False.

Текст заголовка элемента управления задается, как вы поняли, с помощью свой-
ства Caption и поясняет назначение объекта. Так, посредством свойства Caption
объекта Label (Надпись) этому объекту присваивается текст метки, посредством
свойства Caption объекта Command Button (Кнопка) — текст, появляющийся на
кнопке. Не все элементы управления обладают этим свойством. В частности, оно
отсутствует у элемента управления SpinButton (Счетчик).

Чтобы весь текст заголовка, заданного с применением свойства Caption, гаранти-
рованно был выведен на элемент управления, присвойте свойству AutoSize значе-
ние True. В результате ширина и высота объекта изменятся таким образом, что
весь заголовок будет виден. Для демонстрации того, как влияет значение свойст-
ва AutoSize на внешний вид объекта и расположенного на нем заголовка, ниже по-
казаны две кнопки, свойство AutoSize первой из которых имеет значение False,
а второй — значение True.
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Настройка элемента управления ActiveX
1. Находясь в режиме конструктора, выделите необходимый элемент

управления.

2. Щелкните на кнопке Properties (Свойства) панели инструментов Control
Toolbox (Элементы управления).

3. В открывшемся диалоговом окне Properties задайте необходимые пара-
метры в соответствующих полях.

ИЛИ

Щелкните правой кнопкой мыши на нужном элементе управления,
выберите в контекстном меню команду Format Control (Формат объек-
та) и задайте необходимые параметры форматирования в диалоговом
окне Format Control (Формат элемента управления).

Самостоятельная работа
1. Разместите элемент управления ActiveX Scroll Bar (Полоса прокрутки) на ра-

бочем листе.

2. Переместите указанный элемент управления с помощью мыши в какое-либо
другое место рабочего листа.

3. Откройте диалоговое окно Properties и установите в поле LinkedCell связь эле-
мента управления Scroll Bar (Полоса прокрутки) с ячейкой А1.

4. Сделайте так, чтобы при щелчках на кнопках со стрелками вверх и вниз значе-
ние в ячейке А1 изменялось с шагом, равным 2.
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Элементы управления панели инструментов Forms

Как уже говорилось, элементы управления, расположенные на панели Forms (Фор-
мы), предназначены для обеспечения совместимости с документами старых вер-
сий Excel, использующими только эти элементы управления. В общем их функ-
ции аналогичны функциям элементов управления ActiveX, однако они обладают
значительно меньшими возможностями.

Панель инструментов Forms
Для вызова панели инструментов Forms (Формы), которую вы видите на рис. 10.9,
необходимо щелкнуть правой кнопкой мыши на любой другой панели инстру-
ментов и в появившемся контекстном меню выбрать команду Forms (Формы) или
вызвать команду View > Toolbars > Forms (Вид > Панели инструментов > Формы).

Рис. 10.9. Панель инструментов Forms

Перечислим лишь те кнопки панели инструментов Forms (Формы), которых нет
на панели инструментов Control Toolbox (Элементы управления).

Кнопка Group Box (Группа) используется для создания на рабочем листе рам-
ки для группы элементов управления.

ыр С помощью кнопки Control Properties (Свойства элемента управления) от-
*w°' крывается диалоговое окно Format Control (Формат элемента управления),
в котором задаются параметры элемента управления.

j:::; Назначение кнопки Toggle Grid (Сетка) - сокрытие или отображение на ра-
& бочем листе сетки.

Четыре кнопки панели инструментов Forms (Формы), а именно Edit Box (Тексто-
вое поле), Combination List-Edit (Поле со списком), Combination Drop-Down Edit (Поле
с раскрывающимся списком) и Run Dialog (Отобразить окно), в последних верси-
ях Excel стали недоступными.

(ПРИМЕЧАНИЕ Принцип добавления и перемещения элементов управления панели инстру-
ментов Forms (Формы) ничем не отличается от принципа добавления и пере-
мещения элементов управления ActiveX. Следует лишь помнить, что для вы-
деления элемента управления панели инструментов Forms (Формы) необхо-
димо щелкнуть на нем мышью при нажатой клавише Ctrl.

Настройка элементов управления панели Forms
Настройка элементов управления панели инструментов Forms (Формы) осущест-
вляется в диалоговом окне Format Control (Формат элемента управления). Для того
чтобы открыть это окно, необходимо щелкнуть правой кнопкой мыши на нужном
элементе и в появившемся контекстном меню выбрать команду Format Control
(Формат объекта).
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Диалоговое окно Format Control (Формат объекта) для элементов панели инстру-
ментов Forms (Формы), в отличие от такого же окна для элементов управления
ActiveX, содержит больше вкладок, причем у различных элементов их количест-
во разное. В названном окне могут быть представлены вкладки Colors and Lines
(Цвета и линии), Font (Шрифт), Alignment (Выравнивание), Margins (Поля), Size
(Размер), Protection (Защита), Properties (Свойства), Web (Веб), Control (Элемент
управления).

В связи с тем, что отдельные вкладки диалогового окна Format Control (Формат
объекта) уже были описаны в этом уроке, мы остановимся на тех из них, о кото-
рых еще не упоминалось.

Вкладка Colors and Lines (Цвета и линии) является стандартной для всех графиче-
ских объектов Excel. На ней устанавливаются цвет и прозрачность фона, а также
цвет и стиль рамки (рис. 10.10).

Format Control

ч*,

Рис. 10.10. Вкладка Colors and Lines диалогового окна Format Control

Вкладка Font (Шрифт) доступна только при работе с элементом управления
Button (Кнопка). Здесь выбирается шрифт текста на кнопке и устанавливаются
его параметры (рис. 10.11).

В области Text alignment (Выравнивание) на вкладке Alignment (Выравнивание)
задается выравнивание текста по вертикали или по горизонтали (рис. 10.12).
В области Orientation (Ориентация) устанавливается ориентация заголовка кноп-
ки — путем выбора прямоугольника с текстом нужной ориентации. Если устано-
вить флажок Automatic size (Автоматический размер), то кнопка будет автомати-
чески изменять свой размер в зависимости от объема текста, который необходимо
на ней разместить. В области Right-to-Left (Направление текста) устанавливается
направление текста на кнопке: Right-to-left (справа налево), Context (по контек-
сту) и Left-to-right (слева направо).
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Рис. 10.11. Вкладка Font диалогового окна Format Control

:

1

Рис. 10.12. Вкладка Alignment диалогового окна Format Control

На вкладке Margins (Поля), которая доступна только для элемента управления
Button (Кнопка), в полях Left (слева), Right (справа), Тор (сверху), Bottom (снизу)
задается расстояние от краев кнопки до расположенного на ней текста (рис. 10.13).
При установке флажка Automatic (автоматические) это расстояние задается авто-
матически.
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Рис. 10.13. Вкладка Margins диалогового окна Format Control

Вкладка Control (Элемент управления) диалогового окна Format Control (Формат
объекта) является индивидуальной для каждого элемента. Это значит, что здесь
задаются специальные настройки конкретного элемента управления.

На вкладке Control (Элемент управления) элемента управления Check Box (Фла-
жок) в области Value (Значение) располагаются переключатели Unchecked (снят),
Checked (установлен) и Mixed (смешанное), которые отвечают за состояние флаж-
ка (рис. 10.14). В поле Cell link (Связь с ячейкой) устанавливается связь флажка
с одной из ячеек рабочего листа. Путем установки флажка 3-D shading (Объемное
затенение) элементу управления можно придать объемный вид.

Рис. 10.14. Диалоговое окно Format: Control элемента управления Check Box
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Настройки элемента управления Option Button (Переключатель) на вкладке Control
(Элемент управления), как вы сможете убедиться, аналогичны настройкам эле-
мента управления Check Box (Флажок).

На вкладке Control (Элемент управления) элемента управления List Box (Список)
в поле Input range (Формировать список по диапазону) указывается диапазон яче-
ек (вертикальный), на основе которого формируется список (рис. 10.15). В поле
Cell link (Связь с ячейкой) устанавливается связь списка с ячейкой листа.

Рис. 10.15. Диалоговое окно Format Control элемента управления List Box

Если переключатель Selection type (Возможен выбор) установлен в положение
Single (одинарного значения), то в списке можно выделить только один элемент.
При необходимости выделить все элементы списка следует установить переклю-
чатель в положение Multi (набора значений); при повторном щелчке на элементе
выделение снимается. Если переключатель установлен в положение Extend (спи-
ска значений), работа со списком осуществляется точно так же, как и с обычным
списком Windows.

На вкладке Control (Элемент управления) элемента управления Combo Box (Поле
со списком) переключатель Selection type (Возможен выбор) отсутствует, но есть
дополнительное поле Drop down lines (Количество строк списка), в котором можно
указать общее количество строк списка.

На вкладке Control (Элемент управления) элементов управления Scroll Bar (Поло-
са прокрутки) и Spinner (Счетчик) поле Cell link (Связь с ячейкой) выполняет те
же функции, что и у других элементов управления. В полях Minimum value (Мини-
мальное значение) и Maximum value (Максимальное значение) устанавливается
диапазон изменения значения элемента управления (рис. 10.16). В поле Incremen-
tal change (Шаг изменения) задается шаг, с которым изменяется значение элемента
управления при щелчке на кнопке со стрелкой. В поле Page change (Шаг изменения
по страницам) указывается шаг, с которым значение элемента управления будет
изменяться при перелистывании страниц полосы прокрутки. Для счетчика это
поле недоступно.
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Рис. 10.16. Диалоговое окно Format Control элемента управления Scroll Bar

Настройка элемента управления панели инструментов Forms
1. Выделите элемент управления посредством щелчка на нем кнопкой

мыши, удерживая при этом нажатой клавишу Ctrl.

2. Щелкните на этом элементе правой кнопкой мыши и в появившемся
контекстном меню выберите команду Format Control (Формат объекта).

3. Задайте в открывшемся диалоговом окне Format Control (Формат эле-
мента управления) необходимые параметры элемента управления.

Самостоятельная работа
1. Разместите на рабочем листе элемент управления Spinner (Счетчик).

2. Установите связь указанного элемента с ячейкой А1,

3. Задайте максимальное значение счетчика равным 50.

4. Сделайте так, чтобы при вставке или удалении ячеек счетчик не перемещался
и не изменял свои размеры.

Подведение итогов
В этом уроке мы научились:

0 добавлять элементы управления на рабочий лист;

0 перемещать элементы управления;

0 настраивать элементы управления ActiveX и элементы управления панели ин-
струментов Forms (Формы).

11 Зак. 345
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Если вы уверены, что созданный вами документ на бумаге будет выглядеть имен-
но так, как требуется, можете сразу вывести его на печать, щелкнув на кнопке
Print (Печать) панели инструментов Excel. В противном случае отобразите доку-
мент целиком, используя режим предварительного просмотра, внесите необходи-
мые изменения и только после этого отправляйте его на принтер. Ведь вид страниц
документа — важный фактор, от которого зависит, как документ будет восприни-
маться и насколько легко его будет читать. Поэтому обязательно изучите воз-
можности программы, которые позволяют устанавливать параметры принтера
и управлять печатью.

Подготовка принтера к работе

Excel может использовать для печати любой принтер, установленный в Windows.
•Вам необходимо выбрать принтер, который в наибольшей степени соответствует
требованиям, предъявляемым к печатаемому документу. Просмотрите список
имеющихся в наличии и доступных принтеров, щелкните на кнопке Start > Printers
and Faxes (Пуск > Принтеры и факсы) и в открывшемся окне найдите тот, который
вы хотели бы использовать для печати (рис. 11.1).

yjij Add a printer

§Й See what's printing

ЦЛ Select printing preferences

HJ' Pause printing

Ĵ . Share this printer

X Delete this printer

Ж Set printer properties

Kyocera FS-3750 (KPDL-2) on
zaplatkinaZ
0

Microsoft Office Document
Image Writer
0

Рис. 11.1. Окно Printers and Faxes
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Установка принтера
Может случиться так, что значок нужного принтера в окне Printers and Faxes (Прин-
теры и факсы) будет отсутствовать. Это означает, что принтер не установлен и вы
должны произвести эту операцию самостоятельно. Вызовите мастер установки,
активизировав сылку Add a printer (Установка принтера) в области задач принтера
Printer Tasks (Задачи принтера). Далее следуйте указаниям мастера и отвечайте на
вопросы, которые появляются в его окнах. Завершив работу, щелкните в его по-
следнем окне на кнопке Finish (Готово), и мастер выполнит подключение.

Чтобы получить справочную информацию о подключении и установке принтера,
вызовите команду Help Topics (Вызов справки) меню Help (Справка).

Вы можете подключить к своему компьютеру несколько принтеров. Один из них
должен быть принтером, используемым по умолчанию. Именно его имя и адрес
будут появляться в строке Name (Имя) диалогового окна Print (Печать), которое
открывается с помощью одноименной команды меню File (Файл). Это окно пока-
зано на рис. 11.2.

ĵ S \\2aplatWna2\Kyocera F5-3750 (KPDL-2)

У at*к: Idle

' Wh№r LPTl:
1

Рис. 11.2. Диалоговое окно Print

(ПРИМЕЧАНИЕ Чтобы напечатать открытый документ с учетом параметров, установленных
по умолчанию, достаточно щелкнуть на кнопке Print (Печать) стандартной
панели инструментов.

Если вы хотите воспользоваться каким-либо другим принтером из числа уста-
новленных на вашем компьютере, выберите его в поле Name (Имя) диалогового
окна Print (Печать), просмотрите имеющуюся о нем информацию, если нужно, пе-
реопределите его свойства, а затем произведите настройку параметров печати.
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Установка принтера
1. В области задач принтера Printer Tasks (Задачи печати) окна Printers and

Faxes (Принтеры и факсы) задайте команду Add a printer (Установка
принтера). Откроется первое окно мастера установки принтеров, со-
держащее справочную информацию. Перейдите во второе окно и выбе-
рите тип подключения принтера — локальный или сетевой. При ло-
кальной установке, активизировав флажок Automatically detect and install
my Plug and Play (Автоматическое определение и установка принтера
«Plug and Р1ау&), можно воспользоваться средствами Plug and Play.

2. Если вы отказываетесь от автоматической установки принтера с приме-
нением технологии Plug and Play, можете сделать это вручную. Щелк-
ните на кнопке Next (Далее) и в следующем, третьем, окне мастера
(рис.11.3) выберите из представленного перечня один из портов под-
ключения принтеров или, если это необходимо, создайте новый (ло-
кальный либо TCP/I Р-порт).

3. Откройте четвертое окно мастера (рис. 11.4) и в его левой части ука-
жите производителя оборудования, а в правой — конкретную модель
принтера. Нажмите кнопку Next (Далее).

4. В следующих окнах поочередно присвойте принтеру имя, задайте его в
качестве используемого по умолчанию, разрешите коллективный дос-
туп к нему, выполните пробную печать, а также добавьте краткое опи-
сание принтера.

5. Для завершения процесса установки принтера откройте последнее ок-
но мастера, где будет отображена вся введенная вами информация,
просмотрите ее еще раз и щелкните на кнопке Finish (Готово).

Add Printer Wizard

Select a Piintei Port
Computers conminicate tvilh piinteit through ports.

Miciosdt Document Imaging Wiitei Poll: (Local Po

LPT1: [Recommended Printer Port)
к Port)

[Printer Port)
COM1: [Serial Port)
COM2: (Serial Port]
COM3: (Serial Port)
COM4: (Setial Port)
FILE: IPrinl to File]

TSOD1 [ISTETSENKO: PRN2)
TS002 USTETSENKD: PRN1)
TS003HSTETSEHKO: PRN31

Рис. 11.3. Диалоговое окно Select a Printer Port
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ftdd Printer Wizard

Inttall Printer Software
The manufacturer and model determine î tiich printer software to use.

inotronic 230

i§rtjnotionic230v52.3

inolronlc 260 v52.3

Рис. 11.4. Диалоговое онко Install Printer Software

Удалить (отключить) установленный принтер очень просто. Для этого достаточ-
но выделить его в окне Printers and Faxes (Принтеры и факсы) и вызвать команду
Delete this printer (Удаление этого принтера) в области задач Printer Tasks (Задачи
печати) или команду Delete (Удалить) в контекстном меню принтера.

Настройка принтера
После выбора принтера вам, скорее всего, понадобится установить его парамет-
ры. Внешний вид окна параметров принтера и набор доступных в нем элементов
определяются его типом и моделью.

Настройка параметров принтера
Для того чтобы можно было приступить к установке параметров, принтер должен
быть доступен в локальной сети или подключен непосредственно к вашему ком-
пьютеру. Откройте диалоговое окно Printers and Faxes (Принтеры и факсы) и выбе-
рите в нем нужный принтер. В области задач PrinterTasks (Задачи печати) отобра-
зится список команд, используемых при работе с ним (рис. 11.5).

О двух из них — команде Add a printer (Установка принтера) и команде Delete this
printer (Удаление этого принтера) — мы уже рассказали, теперь речь пойдет об ос-
тальных. Используя команду Select printing preferences (Настройка параметров пе-
чати), можно задать формат, размер бумаги и установить параметры качества пе-
чати. Назначение следующих двух команд понятно из их названий — Pause printing
(Приостановка печати) позволяет остановить печать до момента, пока не будет
активизирована команда Resume printing (Продолжение печати).

Команда Set printer properties (Установка свойств принтера) используется для вы-
зова диалогового окна Properties (Свойства), в котором производится установка
параметров принтера. Перечислим вкладки, доступные в этом окне (рис. 11.6),
и возможности, которые они предоставляют.
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Рис. 11.5. Область задач печати Printer Tasks
окна Printers and Faxes

Ш HP t.-isci-Jet 4/4M Plus PS baa on Inbath? ff мр.чнсч

Ill i ...• . . . . • ,>•- ; . :• § i

i ..-.:... l i u

. S '••

Siaait- Ho

Рис. 11.6. Вкладка General диалогового окна Properties

О Вкладка General (Общие) содержит информацию о скорости печати, макси-
мальном формате используемой бумаги, разрешении, а также о возможности
двухсторонней печати и параметрах цветности (рис. 11.6). На этой вкладке
можно ввести общие комментарии, в частности, сведения о местонахождении
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принтера, а также изменить, если возникнет такая потребность, дополнитель-
ные параметры печати и выполнить пробную печать.

О Вкладка Sharing (Доступ) используется для организации совместного исполь-
зования принтера в сети.

О Вкладка Ports (Порты) предназначена, как следует из ее названия, для выбора
одного или нескольких портов.

О Вкладка Advanced (Дополнительно) используется для установки приоритета
и времени доступа, определения правил печати документов, находящихся
в очереди, указания режима ускорения печати, а также для замены драйвера.
Кроме того, при нажатии соответствующих кнопок задаются параметры Prin-
ting Defaults (По умолчанию), Print Processor (Отработчик печати) и выбирается
страница-разделитель Separator Page (Страница-разделитель), используемая
при выводе на печать нескольких документов.

О Вкладка Security (Безопасность) предназначена для определения прав доступа
пользователя или группы пользователей к управлению принтерами и доку-
ментами, установки разрешения на управление принтером, печатью или доку-
ментами для каждого конкретного пользователя или группы пользователей.

О Вкладка Device Settings (Установка параметров) содержит специфичные пара-
метры для каждого типа принтера (например, первый доступный лоток, фор-
мат бумаги для всех лотков и т. д.).

Назначение команды Share this printer (Совместный доступ к принтеру) - быстрый
доступ к вкладке Sharing (Доступ).
Команда See what's printing (Просмотр очереди печати) используется для отмены
операции печати документов.

Настройка параметров печати
Excel предоставляет в ваше распоряжение множество параметров, позволяющих
настроить конечный внешний вид напечатанной страницы. Установка этих пара-
метров производится в диалоговом окне Document Properties (Параметры докумен-
та), вид которого зависит от модели выбранного принтера.

Установка параметров принтера
1. В диалоговом окне Print (Печать) щелкните на кнопке Properties (Свой-

ства), чтобы открыть окно свойств выбранного вами принтера.
2. На вкладках Layout (Расположение) и Paper/ Quality (Бумага/Качество)

укажите ориентацию страниц — альбомная или книжная (см. раздел
«Ориентация печати, размер бумаги^), способ подачи бумаги и коли-
чество страниц документа, печатаемых на одном листе (рис 11.7).

3. Щелкните на кнопке Advanced (Дополнительно) и задайте формат бу-
маги, число копий, качество печати (разрешение в точках на дюйм),
шрифт, масштаб, установите режим экономной печати и т. д. (количе-
ство параметров зависит от модели принтера).

4. Щелкните на кнопке О К, и текущие параметры принтера будут уста-
новлены (рис 11.8).
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d rtu (KPDL-?) or ,?АР1ЛТККЧА2 Document Ctoperties

Г Uar.Huh;,ni

Рис. И.7. Диалоговое окно задания параметров печати

Kyocera FS-3750 (КРСИ-2) Advanced Options

Kyocera FS-37SO (KPDL-2) Advanced Document Settings

Oa Paper/Output

Copy Count:

j Graphic

Print Quality: SQgDots per 1

-... Scaling: 100%

TrueType Font: Substitute with Device Font

Document Options

Дополнительнье параметры печати; Включеис

Параметры PostScript

Свойства принтера

-.-.-- EcoPrint; Off

— - ResduBon Enhancement:

l~- Output Bin: Too Tray (Foes-Down)

| Job Spooling:

i Auto Tray 5witch: Printer Def

Рис. 11.8. Диалоговое окно установки дополнительных
параметров печати документов

I ПРИМЕЧАНИЕ Диалоговое окно настройки параметров печати можно открыть и с помощью
команды Printing Preferences (Настройка печати) контекстного меню прин-
тера в диалоговом окне Printers and Faxes {Принтеры и факсы),

Самостоятельная работа
1. Воспользовавшись локальной сетью организации, в которой работаете, уста-

новите доступный вам по сети принтер кого-либо из коллег.
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2. Рассмотрите перечень моделей принтеров, поддерживаемых Windows. Озна-
комьтесь с их свойствами и составьте заявку на приобретение новой техники
для своей организации.

Установка параметров страницы

Внешний вид документа в немалой степени зависит от параметров его страницы.
Для их установки выберите команду File > Page Setup (Файл * Параметры страни-
цы), после чего на экране отобразится диалоговое окно Page Setup (Параметры
страницы), показанное на рис. 11.9. Оно содержит четыре вкладки: Page (Страни-
ца), Margins (Поля), Header/Footer (Колонтитулы) и Sheet (Лист).

Рис. 11.9. Диалоговое окно Page Setup

На вкладке Page (Страница) диалогового окна Page Setup (Параметры страницы)
задается ориентация листа (книжная или альбомная), масштаб относительно
оригинала, формат бумаги и разрешение в точках на дюйм. Здесь же можно ука-
зать, как и на каком количестве страниц должен быть расположен документ.

Вкладка Margins (Поля) позволяет задать размеры полей страницы и выровнять
печатаемый документ по центру.

На вкладке Header/Footer (Колонтитулы) можно выбрать стандартный или соз-
дать новый колонтитул. Для создания нового колонтитула предоставляется боль-
шой набор шрифтов и изображений.

Вкладка Sheet (Лист) предназначена для выбора области печати, определения сквоз-
ных строк и столбцов, используемых в качестве заголовков, указания порядка
вывода страниц на печать. Здесь также можно задать печать сетки, черно-белую
или черновую печать, ввести комментарии.

На каждой вкладке доступны три кнопки управления, назначение которых по-
нятно из их названий: Print (Печать), Print Preview (Просмотр) и Options (Свойства),
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Теперь подробно опишем, как на каждой вкладке диалогового окна Page Setup
(Параметры страницы) устанавливаются требуемые параметры.

Поля страницы
Размеры полей страницы документа устанавливается на вкладке Margins (Поля)
(рис. 11.10).

Рис. 11.10. Вкладка Margins диалогового окна Page Setup

Полем называется пустое пространство на листе за пределами области печати
или же отступ от края листа до области печати. По умолчанию размер левого и пра-
вого полей составляет 1,9 см (3/4 дюйма), верхнего и нижнего — 2,5 см (1 дюйм).
Изменить эти значения можно при помощи специальных полей счетчиков.

Задание полей страницы
1. Выберите в меню File (Файл) команду Page Setup (Параметры страни-

цы) и в открывшемся диалоговом окне перейдите на вкладку Margins
(Поля).

2. Задайте требуемые размеры в полях Тор (Верхнее), Bottom (Нижнее),
Left (Левое) и Right (Правое). Указав эти параметры, вы можете сохра-
нить таблицу в качестве шаблона.

3. Определите расстояние между колонтитулом и краем листа в поле
Header (верхний колонтитул) и поле Footer (нижний колонтитул). За-
даваемые значения должны быть меньше размера соответствующих по-
лей, но больше непечатаемой области, определямой моделью принтера.

4. Вызовите команду Print Preview (Предварительный просмотр) и в поя-
вившемся окне щелкните на кнопке Margins (Поля), чтобы удостове-
риться в корректности выполненных установок.
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Для того чтобы выровнять документ по центру страницы, установите флажки
Horizontally (по горизонтали) и Vertically (по вертикали) в области Center on page
(Центрировать на странице).

Поля страницы можно задавать сразу для нескольких листов книги Excel. Но для
этого их сначала необходимо выделить.

Области печати
Электронная таблица, подготовленная к печати, может не помещаться на одном
листе бумаги. В этом случае программа автоматически разобьет таблицу на не-
сколько прямоугольных диапазонов ячеек, которые будут выводиться на печать
на отдельных листах бумаги. Разбивка выполняется таким образом, чтобы каж-
дый диапазон полностью помещался на листе бумаги. На экране все эти диапазо-
ны помечаются пунктирной линией. По умолчанию Excel выводит на печать пря-
моугольный диапазон от начальной ячейки (А1) до последней ячейки рабочего
листа, содержащей текст или числовое значение. Несмежные диапазоны выво-
дятся на отдельных страницах.

Последовательность вывода на печать многостраничных таблиц определяется на
вкладке Sheet (Лист) диалогового окна Page Setup (Параметры страницы), пред-
ставленной на рис. 11.11.

blank>
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Рис. 11.11. Вкладка Sheet диалогового окна Page Setup

Задание параметров печати в области Print titles (Печатать на каждой странице)
позволяет вывести на каждой странице одинаковые строки или столбцы, которые
в дальнейшем будут применяться в качестве заголовков. Щелкните на значке в пра-
вой части поля или на самом поле Rows to repeat at top (Сквозные строки), затем
выберите нужные строки в таблице. Аналогичным образом с помощью поля Co-
lumns repeat at left (Сквозные столбцы) укажите столбец, содержимое которого бу-
дет использоваться как заголовок печатаемых страниц документа.
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Для того чтобы вывести на печать диапазон ячеек, предварительно выделите его
мышью, а затем вызовите команду File » Print Area > Set Print Area (Файл > Область
печати > Задать). Но самый простой способ задать область печати — щелкнуть на
значке в правой части поля Print Area (Выводить на печать диапазон) вкладки
Sheet (Лист), а затем выделить мышью требуемый диапазон на рабочем листе.
Отмеченный диапазон печати можно будет просмотреть, щелкнув на кнопке
Preview (Просмотр).

| ПРИМЕЧАНИЕ Параметры диапазона печати, сквозных строк и столбцов можно ввести в диа-
логовом окне Page Setup > Sheet (Параметры страницы > Лист), которое от-
крывается с помощью команды File > Page Setup (Файл > Параметры страни-
цы) или View > Headerand Footer (Вид > Колонтитулы). Эти параметры недос-
тупны, если окно Page Setup (Параметры страницы) открыто из окна предва-
рительного просмотра или диалогового окна Print (Печать).

Диапазон печати можно быстро выбрать и непосредственно перед печатью. Та-
кой способ выбора имеет самый высокий приоритет, поэтому все предыдущие ус-
тановки будут отменены. Чтобы произвести данную операцию, отметьте требуе-
мый диапазон, затем вызовите с помощью меню File (Файл) диалоговое окно Print
(Печать) и установите флажок Selection (Выделенный диапазон).

Таким образом, область печати на одном рабочем листе может состоять из не-
скольких диапазонов различного размера. Задать такую область можно с помо-
щью любого из трех описанных выше средств: команды File > Print Area > Set Print
Area (Файл > Область печати > Задать), ноля Print Area (Выводить на печать диа-
пазон) вкладки Sheet (Лист) в окне Page Setup (Параметры страницы) и переклю-
чателя Selection (Выделенный диапазон) диалогового окна Print (Печать), вызывае-
мого из меню File (Файл).

Колонтитулы
Колонтитулы применяют с целью снабдить каждый лист информацией общего
и специального назначения. Это может быть название всего документа или его
рубрик, имя автора, дата создания и т. д. Колонтитулы позволяют пользователю
легко ориентироваться в напечатанном документе. По умолчанию при выводе на
печать в Excel колонтитулы отсутствуют, однако в случае необходимости их мож-
но добавить на страницу.

Параметры колонтитулов задаются на вкладке Header/Footer (Колонтитулы), по-
казанной на рис. 11.12.

I ПРИМЕЧАНИЕ Выбрав команду View t Header and Footer (Вид > Колонтитулы), вы можете
открыть вкладку Header/Footer (Колонтитулы), минуя диалоговое окно Page
Setup (Параметры страницы).

Вкладка Header/Footer (Колонтитулы) содержит поля списков Header (Верхний
колонтитул) и Footer (Нижний колонтитул), в которых можно выбрать один из
встроенных колонтитулов.
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Рис. 11.12, Вкладка Header/Footer диалогового окна Page Setup

Для создания нового колонтитула щелкните на кнопке Custom Header (Создать
верхний колонтитул) или Custom Footer (Создать нижний колонтитул), в резуль-
тате чего откроется окно для создания колонтитула (рис. 11.13).

. date, tiw$r Fteparti, н-мкм-1 £ Щ|М

Рис. 11.13. Диалоговое окно Footer

Всего существует два таких окна (для создания вехнего и нижнего колонтитулов)
и в каждом из них имеются поля Left section (Слева), Center section (В центре) и
Right section (Справа). Содержимое колонтитула, введенное в левое поле, вырав-
нивается по левому краю, в среднее — по центру, а в правое — по правому краю.

Текст колонтитула вводится и редактируется как в обычном текстовом редакторе,
а графические изображения и коды полей добавляются с помощью кнопок, рас-
положенных в центре диалогового окна. Назначение кнопок описано в табл. 11.1.
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Таблица 11.1. Кнопки, предназначенные для вставки кодов полей в колонтитулы

Кнопка Название

(Шрифт)

(Страница)

Ш Pages
(Страниц)

Щ (Дата)

(Время)

Path and File
(Путь и файл)

жД (Файл)

шщ| Sheet

Ш Insert Picture
(Вставить рисунок)

Ш Format Picture
(Формат рисунка)

Описание

Установка параметров шрифта для текста колонтитулов

Вставка номера текущей страницы

Вставка общего числа страниц документа

Вставка даты печати рабочего листа

Вставка времени печати рабочего листа

Вставка полного имени файла рабочей книги
к файлу)

Вставка имени рабочей книги

Вставка имени рабочего листа

Вставка изображения

Открытие диалогового окна редактирования
изображения

(включая путь

вставленного

Коды полей представляют собой специальные символы, которые при печати доку-
мента заменяются определенными значениями. Например, код &[FiLe] (&[Файл])
заменяется именем файла, код &[Date] (&[Дата]) - текущей датой.

^ПРИМЕЧАНИЕ Выполните команду File » Page Setup * Page (Файл > Параметры страницы »
Страница) и посмотрите на содержимое поля First page number (Номер пер-
вой страницы). Значение Auto (Авто) позволяет Excel автоматически выпол-
нять нумерацию страниц, которые выводятся на печать только в том случае,
когда номера страниц включены в колонтитулы. Набрав в поле число, можно
определить номер, который появится на первой странице листа Excel.

При необходимости отформатировать текст колонтитула, содержащего коды,
щелкните на кнопке Font (Шрифт) и установите нужные параметры в одноимен-
ном диалоговом окне.

Завершив форматирование колонтитула, щелкните на кнопке ОК и вернитесь на
вкладку Header/Footer диалогового окна Page Setup (Параметры страницы), где
в области колонтитула появится его содержимое.
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Если вы хотите вставить в колонтитул рисунок, щелкните на кнопке Insert Picture
(Вставить рисунок) и выберите таковой в открывшемся диалоговом окне. Дваж-
ды щелкните на рисунке, и он появится в текущем разделе колонтитула. Учтите,
что в одно поле колонтитула можно поместить только один рисунок. Щелкните
на кнопке Format Picture (Формат рисунка) и отфоматируйте вставленный рисунок.

Размещение листа на странице
В Excel существует возможность печатать страницы не только в натуральную ве-
личину, но и в уменьшенном или в увеличенном виде. Для изменения размера пе-
чатаемого листа применяют элементы управления, расположенные в области Sca-
ling (Масштаб) вкладки Page (Страница) диалогового окна Page Setup (Параметры
страницы).
Для пропорционального изменения размеров документа относительно его нату-
ральной величины установите переключатель Adjust to (Установить) и задайте в
его поле значение из диапазона от 10 до 400. Если это значение больше 100, доку-
мент печатается в увеличенном виде, а если меньше 100 — в уменьшенном.

Выбор переключателя Fit То (Разместить не более чем на) позволяет задать коли-
чество страниц, на которых необходимо разместить печатаемую таблицу. В этом
случае Excel подбирает масштаб документа автоматически. Поскольку необходи-
мо, чтобы документ был компактным и читабельным, он должен удовлетворять
трем достаточно противоречивым условиям. Во-первых, логически связанные
данные следует располагать рядом, а не на разных страницах. Во-вторых, при раз-
мещении информации на одной странице документ должен оставаться удобным
для чтения и наглядным. В-третьих, нужно, чтобы все страницы документа по
возможности были одинаково заполнены. Для принятия соломонова решения
Excel предоставляет такие возможности, как размещение выделенного диапазона
или всего листа на одной странице либо размещение листа на заданном количест-
ве страниц с его разбивкой по горизонтали и вертикали.

Настройка параметров печати
Приступим к настройке параметров печати.

Ввод параметров печати
1. С помощью команды File f Page Setup (Файл > Параметры страницы)

откройте вкладку Page (Страница) диалогового окна Page Setup (Пара-
метры страницы).

2. Установите на этой вкладке ориентацию страницы, ее размер и мас-
штаб, задайте качество печати принтера и номер первой страницы.

3. Щелкните на кнопке ОК, чтобы применить новые установки и запус-
тить процесс печати.

На первый взляд, реализовать все это очень просто, но во избежание проблем в бу-
дущем рассмотрим каждый этап подробнее.
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Ориентация печати, размер бумаги
Иногда при выводе документов на печать возникает необходимость изменить
ориентацию страницы, ведь оптимальный выбор формата дозволяет более эф-
фективно использовать возможности принтера и компактно размещать данные
на листе бумаги. Существуют две ориентации — книжная, при которой строки
располагаются параллельно короткой стороне страницы, и альбомная с располо-
жением строк параллельно длинной ее стороне. По умолчанию в Excel установле-
на книжная ориентация.

Изменить ориентацию страницы вы сможете с помощью переключателей Portrait
(книжная) и Landscape (альбомная) в области Orientation (Ориентация) вкладки
Page (Страница) диалогового окна Page Setup (Параметры страницы). Это можно
сделать и в области Orientation (Ориентация) вкладки Layout (Размещение) диа-
логового окна Properties (Свойства). Данная вкладка показана на рис. 11.14.

Рис. 11.14. Вкладка Layout диалогового окна Properties

При печати таблиц очень важно правильно задать формат бумаги. Перейдите на
вкладку Page (Страница) и выберите нужный размер в списке Paper Size (Размер
бумаги).

Разметка страницы
По умолчанию в Excel выводимый на печать текст разбивается таким образом,
чтобы полностью заполнить страницу. После предварительного просмотра ком-
поновку печатаемых страниц, выполненную таким способом, часто требуется из-
менить. Обычно это вызвано тем, что автоматическая разбивка страниц с точки
зрения представления информации может быть сделана некорректно (например,
имена долей будут оторваны от значений).
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Для установки режима разметки страниц выберите команду Page Break Preview
(Разметка страницы) в меню View (Вид) и просмотрите, в каких местах установ-
лены разрывы страниц (рис. 11.15). Режим разметки страницы можно также ус-
тановить щелчком на кнопке Page Break Review (Разметка страницы) в окне Print
Preview (Предварительный просмотр). В этом режиме выводимые на печать дан-
ные отображаются на белом фоне, а внутри каждого печатаемого диапазона, вы-
деленного пунктиром, указывается номер страницы. Использование режима раз-
метки позволяет контролировать не только размещение данных на печатаемых
страницах, но и порядок вывода страниц на принтер.

Понятный самоучитель работы в Интернете

•tî f".

Paste Special.,.

Insert...

Delete.,.

Clear Contents

Format Celb...

Insert Page Break

I 53tPmtArea

f£eset Print Area

Page Setup...

Рис. 11.15. Выбран режим разметки страницы Page Break Preview

На рабочем листе разрывы страниц, вставленные автоматически, показываются
пунктирными линиями. При ручной вставке линии разрыва необходимо выделить
строку или столбец, снизу или справа от которого требуется поместить линию
разрыва, и щелкнуть правой кнопкой мыши, а затем в открывшемся контекстном
меню выбрать пункт Insert Page Break (Добавить разрыв страницы). Разрывы
страниц, установленные вручную, отображаются на экране как сплошные синие
линии. Переместив разрывы страниц, обозначенные как пунктирными линиями,
так и сплошными, за пределы области печати, можно изменить диапазон печати.

При необходимости разместить на текущей странице дополнительные строки или
столбцы перетащите горизонтальный или вертикальный разрыв страницы, в ре-
зультате чего данные будут автоматически сжаты и поместятся на одной страни-
це. Затем можно еще раз выполнить предварительный просмотр и проверить, не
стал ли размер шрифта слишком маленьким. Чтобы указать, в каком месте долж-
на заканчиваться одна страница и начинаться другая, установите дополнитель-
ный разрыв — принудительный разрыв страницы.
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В режиме разметки таблицу можно редактировать точно так же, как в обычном
режиме. Вы можете удалять или добавлять ее элементы, добиваясь того, чэгобы
таблица имела в распечатанном виде оптимальную структуру.

Для удаления всех расставленных вручную разрывов страниц щелкните на лю-
бой ячейке листа правой кнопкой мыши и в открывшемся контекстном меню вы-
берите команду Reset All Page Breaks (Сброс разрывов страниц).

Выйти из режима разметки страницы и вернуться в обычный режим просмотра
можно с помощью команды View > Normal (Вид > Обычный).

Источник бумаги, копии, порядок печати
Вызвав с помощью меню File (Файл) окно Page Setup (Параметры страницы), от-
кройте любую из его вкладок, отобразите окно Options (Свойства) и задайте спо-
соб подачи бумаги — порядок вывода страниц на печать, а при необходимости по-
лучить несколько копий - печать дакумента с разбором по копиям.

Разрешение при печати
Разрешение задается в поле Print quality (Качество печати) вкладки Page (Страни-
ца) и измеряется в точках на дюйм (dpi). Чем больше его значение, тем выше ка-
чество печати, но тем медленнее она выполняется. Следовательно, если задано
высокое разрешение, некоторые низкоскоростные принтеры выводят информа-
цию довольно долго. Поэтому при печати пробных экземпляров рекомендуется
применять ускоренные режимы печати (см. раздел «Уменьшение времени печати»).

Печать заголовков
Если на вкладке Sheet (Лист) окна Page Setup (Параметры страницы) установить
флажок Row and Column Headings (Заголовки строк и столбцов), то на печать будут
выведены номера строк и названия столбцов.

Самостоятельная работа
1. Откройте любую рабочую книгу и центрируйте первый рабочий лист на стра-

нице по горизонтали и вертикали и проверьте правописание.

2. Сначала создайте верхний колонтитул и поместите в него свое имя и имя фай-
ла книги, а затем создайте нижний колонтитул с текущими значениями даты и
времени, выровненными по левому краю, и названием рабочего листа, выров-
ненным по правому краю. Добавьте в нижний колонтитул цветной рисунок.

3. Используя режим предварительного просмотра, проверьте правильность оформ-
ления рабочего листа. Напечатайте рабочий лист с несколькими значениями
разрешения.

4. Напечатайте черно-белый вариант и черновик рабочего листа, а затем сравни-
те результаты с результатами, полученными в пункте 3.

5. Перейдите на второй рабочий лист книги, установите режим разметки страни-
цы и добавьте два новых столбца и одну строку.
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6. Измените ориентацию страницы с книжной на альбомную и установите раз-
мер верхнего поля равным 4 сантиметрам.

7. Добавьте горизонтальный разрыв страницы, с тем чтобы содержимое рабочего
листа было напечатано на двух страницах, и задайте печать названия рабочего
листа и заголовков столбцов на всех страницах.

8. Перейдите в режим предварительного просмотра, чтобы увидеть результаты
работы, а затем напечатайте текущий рабочий лист с линиями сетки.

Предварительный просмотр страниц

Чтобы оценить внешний вид документа, подлежащего печати, воспользуйтесь ре-
жимом предварительного просмотра рабочих листов. Применение данного режи-
ма особенно полезно при работе с большим документом, который должен быть на-
печатан на нескольких страницах. Еще раз напомним, что внешний вид таблицы
на экране и в напечатанном документе различен.

Работа в режиме предварительного просмотра
Для установки режима предварительного просмотра щелкните на кнопке Print
Preview (Предварительный просмотр). Откроется окно (рис. 11.16), в котором со-
держимое рабочего листа — текст, числовые значения, рисунки, формулы и т. д. —
будет выглядеть так, как на напечатанной странице.

В режиме предварительного просмотра всегда отображается только одна страни-
ца. Чтобы увидеть последующие либо предыдущие страницы, необходимо щелк-
нуть соответственно на кнопке Next (Далее) или Previous (Назад). Эти кнопки не-
доступны, если все выбранные для печати данные поместились на одной страни-
це. Для одновременного просмотра нескольких рабочих листов их необходимо
отметить до вызова режима предварительного просмотра — лишь при этом усло-
вии, используя кнопки Next (Далее) и Previous (Назад), вы сможете перелистать
весь документ, подготовленный к печати.

При необходимости просмотреть диапазон ячеек в увеличенном масштабе щелк-
ните на кнопке Zoom (Масштаб). Указатель мыши приобретет форму лупы. Для
просмотра отдельных деталей документа подведите указатель к нужному месту
и щелкните, в результате чего интересующий вас фрагмент будет увеличен. Та-
ким образом можно перелистать всю книгу и получить полное представление
о документе.

Когда лист содержит встроенную диаграмму, в окне предварительного просмотра
отображаются и сам лист, и диаграмма. Перемещение и изменение размеров диа-
граммы возможно как в обычном режиме, так и в режиме разметки страницы.
Если в окне просмотра необходимо отобразить только диаграмму, выделите ее,
а затем нажмите кнопку Print Preview (Предварительный просмотр).
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Рис. 11.16. Окно предварительного просмотра приложения Excel

В режиме предварительного просмотра доступны все операции по подготовке до-
кумента к печати. Более того, без выхода из этого режима документ можно отпра-
вить на печать, щелкнув на кнопке Print (Печать).

Коррекция полей и ширины столбцов
В режиме предварительного просмотра можно изменять размеры полей и колон-
титулов, а также ширину столбцов.

Для задания размеров полей щелкните на кнопке Margins (Поля), а когда на стра-
нице появятся черные маркеры полей и столбцов (рис. 11.17) установите указатель
на любой границе поля таким образом, чтобы он принял вид двунаправленной
стрелки, и нажмите кнопку мыши. В строке состояния появится название пара-
метра и его текущее значение, например Left Margin: 1,80 (Левое поле: 1,80). Чтобы
изменить размер поля, перетащите соответствующую границу поля. (По умолча-
нию размеры полей задаются в сантиметрах.) Для выхода из режима корректи-
ровки полей и ширины столбцов нужно еще раз щелкнуть мышью на кнопке Mar-
gins (Поля).
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Рис. 11.17. Установка размеров полей в режиме предварительного просмотра

Функциональные возможности кнопок панели инструментов окна предваритель-
ного просмотра описаны в табл. 11.2.

Таблица 11.2. Кнопки панели инструментов окна предварительного просмотра

Кнопка Название Описание

Next
(Далее)

Previous
(Назад)

Zoom
(Масштаб)

Print
{Печать}

Отображает следующую страницу. Если кнопка
нажата и при этом в книге выделено несколько
рабочих листов, то по достижении последней
страницы текущего листа Excel отобразит первую
страницу следующего выделенного листа

Отображает предыдущую страницу. Если кнопка
нажата и при этом в книге выделено несколько
рабочих листов, то по достижении первой страницы
текущего листа Excel отобразит последнюю
страницу предыдущего выделенного листа

Позволяет переключаться между полностраничным
режимом просмотра и режимом увеличения,
используется только для экранного просмотра.
Осуществить переключение между режимами можно
также, щелкнув в любой области рабочего листа.
В зависимости от разрешения монитора при
полностраничном режиме просмотра некоторые
графические элементы могут не отображаться

Применяется для установки параметров печати
и вывода на печать выделенного рабочего листа
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Кнопка Название Описание

Setup
(Страница)

Margins
(Поля)

Page Break Previous
(Разметка страницы)

Normal View
(Обычный режим)

Close
(Закрыть)

Используется для установки параметров страницы
печатаемых листов

Отображает или скрывает маркеры полей, которые
можно перетаскивать для настройки полей
страниц, полей верхнего и нижнего колонтитулов
и ширины столбцов

Позволяет переключиться в режим разметки
страницы, где можно установить разрывы страниц
на активном рабочем листе, а также изменить
область печати и данные на листе. После возврата
в режим предварительного просмотра это название
кнопки будет заменено названием Обычный режим

Отображает активный рабочий лист в обычном
режиме

Закрывает окно предварительного просмотра
и возвращает к предыдущему режиму просмотра
активного рабочего листа

Печать документа
Вывод документа на принтер — это, как правило, завершающий этап вашей рабо-
ты над документом или отчетом. В настоящем разделе будет подробно рассмот-
рен процесс печати документа с использованием диалогового окна Print (Печать).

Выполнение печати
Чтобы напечатать документ, с которым вы работаете, достаточно щелкнуть на
кнопке Print (Печать), представленной во многих диалоговых окнах, или вызвать
одноименную команду из меню FUe (Файл). После любого из этих действий на
экране появится диалоговое окно Print (Печать) (см. рис. 11.2).

В поле Name (Имя) этого окна указан принтер, используемый по умолчанию; при
необходимости вы можете его заменить. Область Print range (Печатать) использу-
ется для ввода значений диапазона печатаемых страниц. В области Pri nt what (Вы-
вести на печать) определяется та часть рабочего листа или рабочей книги, кото-
рую необходимо напечатать. Чтобы вывести на печать несколько копий документа,
введите нужное значение в поле Number of copies (Число копий). При необходи-
мости установите флажок Collate (Разобрать по копиям).

При необходимости выполнить печать в файл выберите в меню File (Файл) ко-
манду Print (Печать), затем в поле Name (Имя) области Printer (Принтер) укажите
принтер, на котором будет печататься файл. После этого установите флажок Print
to file (Печать в файл) и щелкните на кнопке ОК. В поле Output File Name (Имя фай-
ла для вывода) введите имя создаваемого файла печати.
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ПРИМЕЧАНИЕ Если в дальнейшем вы будете применять принтер, отличный оттого, который
использовался при печати документа в файл,то разрывы страниц и размеры
шрифта могут измениться.

Печать документа
1. Откройте диалоговое окно Print (Печать), используя команду File >

Print (Файл > Печать).

2. В списке Name (Имя) выберите принтер.
3. В поле Print what (Вывести на печать) посредством переключателей Se-

lection (Выделенный диапазон), Active sheet(s) (Выделенные листы)
и Entire workbook (Вся книга) укажите данные, подлежащие выводу на
печать.

4. В поле Copies (Копии) введите нужное число копий и при необходимо-
сти установите флажок Collate (Разобрать по копиям).

5. В поле Print rang (Печатать) задайте диапазон страниц для печати или
оставьте установленный по умолчанию переключатель All (Все).

6. Щелкните на кнопке ОК, и процесс печати будет запущен.

Уменьшение времени печати

Режим ускорения печати устанавливается на вкладке Sheet (Лист) диалогового
окна Page Setup (Параметры страницы). Существует три способа сокращения вре-
мени вывода документа на печать: печать в черновом режиме, в черно-белом ре-
жиме и без отображения сетки.

Печать в черновом режиме
Для ускорения печати нужно выбрать минимальное разрешение. Если же разре-
шение принтера не известно, используйте для повышения скорости печати ре-
жим черновика, при котором на печать не выводятся линии сетки и большинство
графических объектов. Чтобы включить данный режим, установите на вкладке
Sheet (Лист) флажок Draft Quality (Черновая).

Печать в черно-белом режиме
На черно-белых принтерах цвета отображаются в виде оттенков серого. Если вы
работаете с цветным принтером, то можете сократить время печати документа
Excel, используя режим черно-белой печати. Для этого установите флажок Black
and White (Черно-белая) на вкладке Sheet (Лист). При печати в таком режиме
текст и рамки будут выведены черным цветом, фон ячеек — белым, а рисунки и диа-
граммы — серым,

Печать без линий сетки
Ускорить вывод на печать больших документов Excel можно еще одним спосо-
бом — не отображая линии сетки. Для того чтобы убрать сетку, следует задать
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команду Tools > Options (Сервис > Параметры) и сбросить флажок Gridlines (Сет-
ка) на вкладке View (Вид), которая показана на рис. 11.18.

Рис. 11.18. Вкладка View диалогового окна Options

Отсутствие в напечатанном рабочем листе сетки сделает данный документ более
легким для восприятия. Учтите, что установка или отключение этого флажка не
влияет на отображение сетки на экране.

Диспетчер отчетов
Данные таблицы можно вывести на печать в виде отчета, при составлении кото-
рого использовалось несколько сценариев. Сценарием называется именованный
набор входных значений, который подставляется в электронную таблицу. В виде
сценария в листе рабочей книги сохраняются различные группы значений. Лис-
ты, представления и сценарии объединяются в сводные отчеты. Сформирован-
ный таким образом отчет сохраняется вместе с книгой, поэтому его можно распе-
чатать и позднее.

Просмотрев результаты работы диспетчера сценариев Scenario Manager (Диспет-
чер сценариев), окно которого представлено на рис. 11.19, выберите сценарий,
подключаемый к диспетчеру отчетов Report Manager (Диспетчер отчетов).

Если сценариев несколько, отчет составляется из листов, каждый из которых соз-
дается на основе одного из этих сценариев и распечатывается на отдельной стра-
нице в заданной пользователем последовательности. Оформление листов может
быть различным,

Представление — это именованный набор параметров отображения и печати, ко-
торый можно применить к книге. Для создания и сохранения представления ис-
пользуется показанное на рис. 11.20 диалоговое окно Custom Views (Представле-
ния), которое вызывается одноименной командой из меню View (Вид). В книге
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можно создать несколько представлений. В представлении сохраняются области
печати, установленные ранее для листов книги Excel. Если лист не содержит эти
области, он будет напечатан целиком.

Scenario Manager

Рис. 11.19. Диалоговое окно Scenario Manager

Рис. 11.20. Диалоговое окно Custom Views

Создание и обработка отчетов осуществляются с помощью команды Report Mana-
ger (Диспетчер отчетов) меню View (Вид), которая доступна только в том случае,
если в диалоговом окне Add-Ins (Надстройки) меню Tools (Сервис) установлен
флажок Report Manager (Диспетчер отчетов). Если в меню View (Вид) названная
команда отсутствует, загрузите программу-надстройку Report Manager с веб-узла
http://ofRce.m7crosoft.com/rus/DownLoads/default.aspx.

Задайте команду Report Manager (Диспетчер отчетов) меню View (Вид), после чего от-
кроется диалоговое окно для текущей рабочей книги отчетов (рис. 11.21). Щелкнув
в этом окне на кнопке Add (Добавить), вы перейдете в окно Add Report (Добавить
отчет), показанное на рис. 11.22.

В поле Report Name (Имя отчета) укажите имя создаваемого отчета. Установив
в области Section to Add (Раздел) флажки View (Представление) и Scenario (Сцена-
рий), выберите в соответствующих списках используемые представления и сце-
нарии для текущего листа. После нажатия кнопки Add (Добавить) в отчет будет
добавлен новый раздел и его имя появится в поле Section in this Report (Разделы в
этом отчете). Созданные аналогичным образом дополнительные разделы будут
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выводиться на печать в последовательности их размещения в поле Section in this
Report (Разделы в этом отчете). Изменить порядок расположения разделов можно
с помощью кнопок Move Up (Вверх) и Move Down (Вниз). Для того чтобы задать
сквозную нумерацию страниц составного отчета, установите флажок Use Conti-
nuous Page Numbers (Последовательная нумерация страниц). Добавив при необхо-
димости дополнительные сценарии и представления, завершите создание отчета,
щелкнув на кнопке ОК, после чего его имя появится в диалоговом окне Report Ma-
nager (Диспетчер отчетов).

Рис. 11.21. Диалоговое окно Report Manager

Расчет
яЕИЯи
Движение средств, (None), (None]

Рис. 11.22. Диалоговое окно Add Report

Выделите в списке этого окна отчеты, подлежащие выводу на печать, и щелкните
на кнопке Print (Печать).

Печать отчета сводной таблицы
Помимо задаваемых в диалоговом окне Page Setup (Параметры печати) парамет-
ров печати, которые применимы ко всем листам документа, Excel содержит пара-
метры печати, относящиеся к отчетам сводных таблиц. Их удобно использовать
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при печати больших отчетов. Чтобы получить доступ к встроенному формату от-
чета со сложной структурой, щелкните на кнопке AutoFormat (Формат отчета) па-
нели инструментов PivotTable (Сводная таблица), после чего отобразится пока-
занное на рис. 11.23 диалоговое окно AutoFormat (Автоформат). Выберите подхо-
дящий формат и щелкните на кнопке ОК.

Рис. 11.23. Диалоговое окно AutoFormat

Печать отчета сводной таблицы
1. Выделите диапазон ячеек, содержащих нужный отчет.
2. В окне Page Setup (Параметры страницы) установите параметры стра-

ницы (поля, заголовки и колонтитулы).
3. Для того чтобы заголовки отчета повторялись на каждой странице, ука-

жите сквозные строки и столбцы в полях Rows to repeat at top (Сквозные
строки) и Columns repeat at left (Сквозные столбцы) на вкладке Sheet
(Лист).

4. При необходимости установите на рабочем листе принудительные раз-
рывы страниц.

5. Просмотрите страницу, внесите изменения, если возникнет необходи-
мость, повторно задайте разметку страниц и отправьте отчет на печать.

Заголовки строк и столбцов можно напечатать на каждой странице отчета — для
этого достаточно установить в окне PivotTable Options (Параметры сводной табли-
цы) флажок Repeat item labels for each printed page (повторять подписи на каждой
странице печати). Но прежде необходимо очистить поля сквозных строк и столб-
цов в области Print titles (Печатать на каждой странице) на вкладке Sheet (Лист)
диалогового окна Page Setup (Параметры страницы). В заголовках страниц, выво-
димых на печать, указываются имена полей, строк, столбцов и данных.
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На рис. 11.24 и 11.25 приведены фрагаенты отчетов, первый из которых создан
с помощью мастера сводных таблиц, а второй — с использованием диспетчера
сценариев по данным сводной таблицы.

OlJ Fit Li* №« if»*! 1'tfTM
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- i yr* а зик:™ (в l*fc * _ в' X
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Рис. 11.24. Отчет сводной таблицы, созданной с помощью мастера сводных таблиц

Рис. 11.25. Отчет сводной таблицы, созданной с помощью диспетчера сценариев
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Если макет отчета изменится таким образом, что заголовки окажутся в других
строках и столбцах, при выводе отчета на печать автоматически будут печататься
новые заголовки.

Подведение итогов
В этом уроке мы научились:

0 устанавливать и настраивать принтеры;
0 задавать параметры страницы;
0 размечать документы;

0 просматривать документы перед печатью;
И работать с диспетчером отчетов.
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Большинство пользователей постепенно осваивают те возможности Excel, которые
наиболее пригодны для создания документов нужного им типа. Определив для
себя оптимальное количество требуемых инструментов, они, как правило, оставля-
ют без внимания множество средств и функций программы. Наиболее честолюби-
вые пользователи, для того чтобы облегчить доступ к привычным командам, изме-
няют пользовательский интерфейс Excel. Но дальше этого они не идут.

Автоматизация рабочих процессов

Две области, которые многие пользователи, к сожалению, оставляют без внима-
ния, — это запись макросов и программирование в среде VBA (Visual Basic for
Applications — Visual Basic для приложений). В недалеком прошлом макросы
имели настолько плохую репутацию, что многие не желали даже связываться
с ними. Однако сейчас макросы очень просто записывать и выполнять. Применив
минимум усилий, вы сможете избежать выполнения действий, которые могут
привести к утрате данных или, скажем, к повреждению операционной системы
(именно этого больше всего опасаются начинающие пользователи). Но тот, кто
не отважится работать с макросами и программами VBA, лишит себя возможно-
сти «изменить жизнь к лучшему» за счет использования форм (настраиваемых
диалоговых окон), которые предназначены для представления информации и по-
лучения данных от пользователя, а также применяются в качестве графических
средств для работы с настраиваемой процедурой или приложением.

VBA является единой средой разработки приложений во всех программах Microsoft
Office 2003. Основные принципы работы в среде VBA и в среде Visual Basic 2003
идентичны. Перечислим главные преимущества, получаемые в результате приме-
нения языка VBA.

Во-первых, с помощью VBA можно записывать последовательности повторяющих-
ся команд, характерных для какого-либо приложения, и назначать правила (ус-
ловия), в соответствии с которым эти последовательности (процедуры VBA) бу-
дут вызываться в приложении. Например, после нажатия некоторой кнопки,
рабочий лист Excel будет отформатирован с учетом ваших требований, записан-
ных на VBA и сохраненных в рабочей книге или шаблоне.

Во-вторых, применив средства VBA, можно обеспечить нестандартный диалог
с пользователем, создавая диалоговые формы и обрабатывая реакцию пользова-
теля на событие в приложении.

Наконец, использование единого языка программирования способствует более
тесному взаимодействию Excel с продуктами Microsoft Office. С помощью VBA
можно разрабатывать приложения, одновременно применяющие компоненты не-
скольких программ.

Макрорекордер

В Excel существует возможность создавать собственные макросы и таким обра-
зом автоматизировать выполнение основных операций. Макрос представляет со-
бой последовательность команд и функций, записанных в модуле VBA. Насколько
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сложными могут быть макросы, можно судить по входящим в пакет поставки
Excel надстройкам, при создании которых использовались средства макропро-
граммирования.

Существует два способа создания макроса: записывать свои действия во время
работы с листом Excel или же написать макрос, используя редактор Visual Basic.
Наиболее простым способом создания макрокоманды является ее запись с помо-
щью макрорекордера, и для этого вовсе не нужны глубокие знания по програм-
мированию. Работа макрорекордера во многом напоминает работу обычного маг-
нитофона, осуществляющего запись и воспроизведение звука. Макрорекордер
протоколирует все выполняемые пользователем действия и представляет их в виде
VBA-кода.

Однако следует помнить, что «собственноручно* написанные макросы позволяют
создавать гораздо более мощные и гибкие программы, чем макросы, записываемы-
ми с помощью макрорекордера, но, конечно, записать макрос гораздо проще, чем
создать его программный код.

Процесс записи макроса с помощью макрорекордера можно условно разбить на
три следующих этапа:

О запуск макрорекордера;

О присвоение макросу имени;

О выполнение записываемых операций;

О завершение записи.

Как создаются макросы, мы рассмотрим на примере. Попробуем создать с помо-
щью макрорекордера макрос, выполняющий такую последовательность дейст-
вий: отображение окна рабочей книги в полноэкранном представлении; удаление
с экрана сетки; изменение шрифта, применяемого для оформления данных в ячей-
ках; присвоение ячейкам денежного формата.

Начало записи
Прежде чем записывать свой макрос, определитесь, что вы хотите получить в ре-
зультате. Подумайте, какие действия он должен осуществлять, и настройте при-
ложение таким образом, чтобы можно было беспрепятственно выполнить после-
довательность команд, подлежащих записи. Например, прежде чем приступить
к созданию макроса, предназначенного для редактирования текста, убедитесь,
что окно с нужным документом находится на переднем плане. (Вы можете приос-
тановить процесс записи макроса при необходимости выполнить операцию, кото-
рую не следует записывать, но лучше спланировать свои действия заранее.)

Кроме того, вам придется протестировать макрос, потому что при записи фикси-
руются все действия, в том числе и ошибочные. И обязательно определите, в ка-
ких условиях будет работать макрос.

Для того чтобы начать запись макроса, необходимо активизировать чистый рабо-
чий лист, выбрать в меню Tools (Сервис) команду Macro (Макрос), а в открывшемся
подменю — команду Record New Macro (Начать запись). На экране появится диало-
говое окно Record Macro (Запись макроса), в котором следует указать имя макроса,
ввести его краткое описание, задать комбинацию клавиш для запуска создаваемого

12 Зак. 345
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макроса и определить место его хранения (рис. 12.1). По умолчанию макросу при-
сваивается имя Macro ft (Макрос*), где символ диеза соответствует порядковому
номеру макроса. Имя макроса отображается в поле Macro name (Имя макроса).
Это имя можно оставить без изменения, но при желании можно заменить его дру-
гим, которое описывало бы действия макроса. При выборе имени макроса и ком-
бинации клавиш для его запуска следует придерживаться следующих правил.

О Имя макроса может состоять максимум из 255 символов. Оно не должно со-
держать пробелов и специальных символов. Между фрагментами длинных
имен макросов вместо пробелов вставляются символы подчеркивания (__).

О При назначении комбинации клавиш для запуска макроса учитывается ре-
гистр символов. Следовательно, количество комбинаций клавиш для запуска
макросов может вдвое превысить количество клавиш с буквами алфавита.

Record Macro

='CtflfP"n>|rhi5Wcii^ook

ion;
JMacro recorcrded 02.09,2003 by Lebedko

Рис. 12.1. Диалоговое окно Record Macro

Информация о создаваемом макросе вводится в поле Description (Описание). Она
пригодится в дальнейшем — при идентификации макроса и при его вызове. Обя-
зательно укажите, какие условия необходимо создать для успешной работы мак-
роса. После щелчка на кнопке ОК в диалоговом окне Record Macro (Запись макро-
са) на экране появляется панель инструментов с двумя кнопками, показанная на
рис. 12.2. Это является свидетельством того, что запись макроса началась.

Рис. 12.2. Панель инструментов
Stop Recording

Для того чтобы остановить процесс записи макроса, нужно щелкнуть на кноп-
ке Stop Recording (Остановить запись) указанной панели.

С помощью кнопки Relative Reference (Относительная ссылка) определяется
режим адресации при записи макросов, то есть какие ссылки на ячейки -

абсолютные или относительные - используются. Если эта кнопка не активизи-
рована, по умолчанию применяются абсолютные ссылки.
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В процессе записи макроса в строке состояния окна программы появляется сооб-
щение Recording (Запись) (рис. 12.3). Таким образом программа напоминает поль-
зователю, что все выполняемые им действия записываются макрорекордером.

Рис. 12.3. Сообщение о записи макроса в строке состояния

Теперь вам предстоит выполнить последовательность действий, которые должен
записать макрорекордер:

О установить полноэкранное представление для окна рабочей книги;

О отменить отображение сетки путем снятия флажка Gridlines (Сетка) на вклад-
ке View (Вид) диалогового окна Options (Параметры);

О выделить рабочий лист и задать для всех ячеек денежный формат;

О установить вид и размер шрифта текста ячеек.

Выполнив перечисленные действия, вы должны остановить запись, и поскольку
запись макроса завершена, сообщение Recording (Запись) из строки состояния ис-
чезнет.

Панель инструментов для работы с макросами
В том случае, когда необходимо записать несколько макросов, целесообразно ис-
пользовать специальную панель инструментов — Visual Basic (рис. 12.4), открыть
которую можно с помощью команды View > Toolbars > Visual Basic (Вид > Панели
инструментов ¥ Visual Basic).

Рис. 12.4. Панель инструментов Visual Basic
для работы с макросами

Описание кнопок данной панели инструментов приведено в табл. 12.1.

Таблица 12.1. Назначение кнопок панели инструментов Visual Basic

Кнопка Название Описание

Run Macro
(Выполнить макрос)

Record Macro
(Записать макрос)

Открывает диалоговое окно Macros (Макрос), в котором
можно выбрать макрос для запуска или
редактирования. Кроме того, расположенная здесь
кнопка Edit (Изменить), позволяет открыть окно
редактора Visual Basic, а кнопка Organizer
(Организатор) — окно приложения Organizer
(Организатор)

Открывает одноименное диалоговое окно. Во время
записи макроса эта кнопка остается активной, поэтому,
щелкнув на ней, запись макроса можно остановить

продолжение
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Таблица 12.1 (продолжение)

Кнопка Название Описание

Security

(Безопасность)

Visual Basic Editor
(Редактор Visual Basic)

Control Toolbox
(Элементы управления)

Design mode
(Режим конструктора)

Microsoft Script Editor
(Редактор сценариев)

Открывает одноименное диалоговое окно, в котором
можно задать уровень защиты от макровирусов
и указать надежных разработчиков макросов

Запускает редактор или активизирует его, если он уже
запущен

Выводит на экран или удаляет с него одноименную
панель, которая необходима для вставки в документы
приложения элементов управления

Устанавливает режим конструктора для текущего
документа, а также выводит на экран панели Control
Toolbox (Элементы управления) и Exit Design mode
(Выход из режима конструктора). Данная кнопка
действует как выключатель. Но если вы воспользуетесь
ею для выхода из режима конструктора, панель Control
Toolbox (Элементы управления) останется на экране

Запускает редактор Microsoft Script Editor, который
понадобится для создания HTML- и XML-страниц

Чтобы начать запись первого макроса, нужно щелкнуть на кнопке Record Macro
(Записать макрос) панели инструментов Visual Basic. В результате на ее месте поя-
вится кнопка Stop Recording (Остановить запись). После завершения записи мак-
роса и нажатия кнопки Stop Recording (Остановить запись) панель инструментов
Visua l Basic остается открытой, а пользователь может без промедления приступать
к записи следующего макроса.

Запуск макроса
Перед запуском нового макроса текущий документ рекомендуется сохранить, так
как в случае какого-либо сбоя во время записи результаты могут оказаться не-
ожиданными. Если была допущена ошибка, макрос можно изменить и записать
под тем же именем еще раз.

/ПРИМЕЧАНИЕ Перед запуском макроса необходимо открыть тот рабочий лист, для которого
должны быть выполнены записанные в макросе операции.

В Excel существует несколько способов запуска макроса, но мы опишем только
два из них — те, которые используются чаще всего.

Во-первых, это можно сделать путем выбора имени макроса. Активизируйте ко-
манду Tools > Macro > Macros (Сервис > Макрос * Макросы), отметьте имя нужного
макроса (в нашем примере — MacrolJ в диалоговом окне Macro (Макрос), где со-
держится перечень всех существующих макросов (рис. 12.5), и щелкните на кноп-
ке Run (Выполнить).
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Рис. 12.5. Диалоговое окно Macro

Во-вторых, макрос можно запустить посредством нажатия клавиши Ctrl в комби-
нации с клавишей, назначенной в поле Shortcut key (Сочетание клавиш) диалого-
вого окна Record Macro (Запись макроса). Если комбинация для запуска макроса
включает прописную букву, необходимо также нажать клавишу Shift. Клавишу
CapsLock при запуске макроса использовать нельзя. Если вы не знаете, какая ком-
бинация клавиш применяется для запуска данного макроса, щелкните в окне
Macro (Макрос) на кнопке Options (Параметры) и информация об этом будет ото-
бражена в поле Shortcut key (Сочетание клавиш) окна (рис 12.6).

Часго Options

Macro recorded £5,08,2003 by Lebedko

Рис. 12.6. Диалоговое окно Macro Options

I ПРИМЕЧАНИЕ При наличии связи между макросом и кнопкой панели инструментов (или ко-
мандой меню) для запуска макроса необходимо выполнить щелчок на этой
кнопке (или на имени команды). Такой способ запуска макроса будет рас-
смотрен ниже.

Запустите макрос и проверьте, все ли записанные макрорекордером операции
выполняются.
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Редактирование макроса
При использовании макросов, записанных с помощью макрорекордера, выполне-
ние операций не всегда происходит так, как хотелось бы. Поэтому часто возника-
ет необходимость в редактировании текста макроса.

Просмотреть и отредактировать макрос позволяет команда Tools > Macro > Visual Ba-
sic Editor (Сервис > Макрос » Редактор Visual Basic), но можно также воспользо-
ваться кнопкой Visual Basic Editor (Редактор Visual Basic) панели инструментов
Visual Basic или комбинацией клавиш Alt+Fll. В любом случае после активизации
указанных элементов открывается окно Microsoft Visual Basic. Правда, содержимое
VBA-модуля в этом окне пока не отображается. Чтобы начать редактирование, необ-
ходимо в окне Project (Проект) открыть папку Modules (Модули) и выбрать имя мо-
дуля (например» Modulel) — текст макроса отобразится в окне модуля (рис. 12.7).

xpoc; эаийсаа 13.08.2GG3 'Березовский Владимир)

ActiveBindoo.DindawState • xINorroal
ActiveVindou.DisplayGridllnes - False
Cells.Select
Selection.Style = "Currency"
Jlith Selection.Font

.Name - "Bookman Old Style"

.Size = 10

.Strikethrough = False

.Superscript » False

.Subscript «= False

.OutlineFont « raise

.Shadon • False

.ITndecllne - xllTnderlineStyleNone

. Colorlndex = xlAutotnatic

End Vith

Bith Selection.Font

.Name - "Bookman Old Style"

.Siie • 20

,Strikethrough » False

.Superscript * False

Рис. 12.7. Макрос, записанный в VBA-модуле

Итак, в настоящий момент мы находимся в режиме работы с VBA-модулем. Как
уже было отмечено, редактирование VBA-модулей выполняется в среде Visual Ba-
sic for Applications, в которой пользователю предоставляются средства для разра-
ботки программ, анализа связей между объектами (VBA является объектно-ори-
ентированным языком программирования), отладки программ и их организации
в единый программный комплекс (проект).

В VBA текст макроса оформляется в виде процедуры Sub. Данная процедура соз-
дается на основе событий (таковым может быть, например, изменение размера
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окна или щелчок на кнопке) и методов. Каждому событию поставлены в соответ-
ствие методы, которые задают необходимость выполнения определенных опера-
ций при наступлении данного события. Так, при щелчке на ярлычке рабочего
листа событием является изменение активного листа. Благодаря связанному с этим
событием методу лист, на ярлычке которого был произведен щелчок, активизи-
руется и отображается на переднем плане. В зависимости от типа активизирован-
ного листа изменяются и некоторые команды меню. В VBA пользователь может
задавать собственные события и ставить им в соответствие методы.

Ниже приведен текст нашего макроса, записанный в VBA-модуле.

Sub МасгоЮ

1 Макрос! Макрос
' Макрос записан 14.08.2003 (Березовский Владимир)

ActiveWlndow.WindowState = xlNormal
ActlveWindow.DisplayGridllnes = False
Cells.Select
Selection.Style = "Currency"
With Selection.Font

.Name •= "Bookman Old Style"

.Size = 10

.Strikethrough = False

.Superscript = False

.Subscript = False

.OutlineFont = False

.Shadow = False

.Underline = xlUnderlineStyleNone

.Colorlndex - xlAutomatic
End With

With Selection.Font
.Name = "Bookman Old Style"
.Size - 20
.Strikethrough = False
.Superscript = False
.Subscript = False
.OutlineFont = False
.Shadow * False
.Underline = xlUnderlineStyleNone
.Colorlndex - xlAutomatic

End With
End Sub

Как видите, макрос начинается с оператора Sub. За ним следует имя макроса, ко-
торое служит для идентификации такового. Если это имя изменить, соответст-
вующим образом изменится имя макроса в диалоговом окне Macro (Макрос). По-
сле имени идет текст макроса, который можно редактировать, а также снабжать
комментариями. В начале каждого комментария должен стоять символ апостро-
фа ('). Завершается макрос оператором End Sub.



360 Урон 12 • Работа с макросами, основы УВД

Часто при отладке макроса возникает необходимость поэтапно проследить за его
выполнением. Для этого следует воспользоваться специальным, пошаговым, ре-
жимом выполнения макроса.

Для активизации режима отладки в диалоговом окне Macro (Макрос) нужно на-
жать кнопку Step Into (Войти), в результате чего будет открыто окно Microsoft Vi-
sual Basic (рис. 12.8), содержащее текст макроса. Здесь оператор, обрабатываемый
на очередном шаге, выделяется желтым цветом. Выполнить очередной шаг мак-
роса можно с помощью команды Step Into (Пошагово) меню Debug (Отладка) или
клавиши F8. Поскольку пошаговое выполнение может занять очень много време-
ни, в строках макроса следует установить точки останова. По достижении точки
останова обработка макроса прерывается, а на экране появляется окно отладки,
в котором можно указать, в каком режиме — пошаговом или обычном - должно
быть продолжено выполнение макроса.

•К". i.r.VH - . в X

Ь? & VBAProject (Bookl.xl$)
е-& Microsoft Office Excel Object!

B SSeetl (Sheetl)
в She«2 (Sheet!)
ih Sheets [Sheet!)
%] TWsWwkbook
Modules

(Сел™ I) I

Kanpaci Еакрос
йакрс>с запксаз 14.08.iGG3 {Березовсга1Й Бладяиир)

ActiveHindoH.HindoirState - xlNotraal
ActiveWindox.IilsplayGrldllnes " Га1зе
Cells. Select
Selection. Style « "Cucceocy"
With Эе1есс1оп.Гопг

.Maine - "flootanan Old Style"

.Size - 10

.SErrikcthcough = Falae

.Supecacclpt - false

.Subscript » Гв1в=
-OutlineFont = False
.Shadow * False
.Underline ™ xlUndeclineStyleUone
.Colorlndex • xlAutomatio

End Bith
W i t h 3e lection. Font

- False
false

Рис. 12.8. Окно отладки макроса

Удаление макроса
1. Откройте книгу, содержащую макрос, который требуется удалить.

2. Выберите команду Tools > Macro > Macros (Сервис > Макрос > Макросы).

3. В списке Macros in (Находится в) открывшегося окна Macro (Макрос)
укажите элемент This Workbook (Эта книга).

4. В списке Macro name (Имя макроса) выберите имя макроса, который нуж-
но удалить, и щелкните на кнопке Delete (Удалить).
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Создание панелей инструментов для запуска макросов
В Excel пользователь может создавать собственные панели инструментов. Для это-
го нужно выбрать в меню Tools (Сервис) или в контекстном меню панелей инст-
рументов команду Customize (Настройка), затем на вкладке Toolbars (Панели ин-
струментов) открывшегося окна Customize (Настройка) щелкнуть на кнопке New
(Создать), а когда появится диалоговое окно New Toolbar (Создание панели инст-
рументов), показанное на рис. 12.9, ввести имя создаваемой панели и щелкнуть
на кнопке ОК. В результате имя создавемой панели инструментов появится в спи-
ске панелей, который находится в окне Customize (Настройка).

Рис. 12.9. Диалоговое окно New Toolbar

Для того чтобы вставить кнопки в новую панель инструментов, перейдите на
вкладку Commands (Команды) окна Customize (Настройка). На ней представлены
все доступные в Excel элементы панелей инструментов и все команды, которые
объединены в категории (рис. 12.10). Любую кнопку и команду можно сделать
элементом новой панели инструментов. В списке Categories (Категории) выберите
элемент Macros (Макросы), а затем из поля Commands (Команды) переместите на
новую панель инструментов кнопку Custom Button (Настраиваемая кнопка).

Г и л id,-, гптгпч ч ',; /, tot*ar' «tot a titt^ory «i »н
г;,',>„•_•!.•'. oi
,";,.,,,•, -,.

: ................... ....,r̂ .i
Name: acuslomButton ]

-т
Copy Button Image ',.

Reset Button Image

&ht Button

Change Bjjtton Image

DeFuu.lt Style

lert OrJy (Always)

Рис. 12.10. Вкладка Commands окна Customize



362 Урок 12 • Работа с макросами, основы УВД

Закрепить макрос за кнопкой можно после ее размещения на панели инструмен-
тов. Для этого необходимо сделать активным контекстное меню кнопки Custom
Button (Настраиваемая кнопка), задать команду Assign Macro (Назначить макрос)
и в открывшемся окне указать имя макроса (рис. 12.11), который нужно связать
с кнопкой панели инструментов.

-ITNs Workbook

Рис. 12.11. Диалоговое окно Assign Macro

После этого контекстное меню данной кнопки следует вновь открыть и в поле
Name (Имя) ввести имя макроса, которое будет на ней отображаться. Таким обра-
зом можно создать панель инструментов, состоящую из кнопок, предназначенных
специально для запуска макросов.

Создание меню для запуска макросов
Excel позволяет удалять и вставлять новые меню в строку меню и новые команды
в уже действующие меню. Рассмотрим принцип создания нового меню для ко-
манд запуска макросов.

Чтобы вставить новое меню в строку меню, необходимо выполнить следующие
действия: открыть диалоговое окно Customize (Настройка), перейти на вкладку
Commands (Команды), выбрать там категорию New Menu (Новое меню) и, когда
в поле Commands (Команды) появится элемент New Menu (Новое меню), перемес-
тить его в строку меню (рис.12.12). Следует помнить, что строка меню в Excel яв-
ляется разновидностью панели инструментов, в которую также можно вставлять
элементы из окна Customize (Настройка).

Новому меню по умолчанию присваивается имя New Menu (Новое меню). Если вы
хотите изменить его, щелкните на меню правой кнопкой мыши (окно Customize
(Настройка) должно быть открытым) и введите новое имя в поле Name (Имя)
контекстного меню.
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Рис. 12.12. Создание нового меню

Теперь в меню можно добавлять команды. На вкладке Commands (Команды) окна
Customize (Настройка) выберите категорию Macros (Макросы), а в поле Commands
(Команды) — элемент Custom Menu Item (Настраиваемая команда меню) и перета-
щите его в новое меню. Чтобы связать команду меню с макросом, откройте кон-
текстное меню команды (окно Customize (Настройка) должно быть открыто) и вы-
зовите в нем команду Assing Macro (Назначить макрос). Затем, если это нужно, из-
мените имя команды меню. Аналогичным образом вставьте все необходимые ко-
манды вызова макросов.

Самостоятельная работа
1. Запишите с помощью макрорекордера макрос, выполняющий форматирова-

ние выделенного фрагмента текста следующим образом: шрифт — Courier,
цвет текста — зеленый, начертание — полужирный курсив, выравнивание —
по центру ячейки.

2. Создайте новую панель инструментов.

3. Поместите на эту панель кнопку для запуска макроса. Кнопка должна иметь
надпись, информирующую о ее назначении.

4. Макрос должен запускаться и по команде Format text (Формат текста) меню
Custom (Настраиваемое). Для этого создайте это меню и добавьте в него ука-
занную команду.

5. Если созданный макрос вам не нужен, удалите его.
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Visual Basic для приложений
Visual Basic для приложений — это объектно-ориентированный язык макропро-
граммирования высокого уровня, встроенный во все программы пакета Office 2003.
Включение в указанный пакет современного полнофункционального языка про-
граммирования, инструментов для написания на нем программ, их редактирова-
ния и отладки, а также обширных библиотек стандартных программ позволяет
создавать программные продукты, способные с достаточной полнотой автомати-
зировать решение конкретных задач пользователя.

Ниже вкратце рассказывается об основных понятиях языка Visual Basic for Appli-
cations. VBA является объектно-ориентированной средой, содержащей большой
набор объектов, каждый из которых обладает множеством свойств и методов. Ко-
личество этих объектов может напугать новичка, но, к счастью, для того чтобы
начать работать, знать их всех вовсе не обязательно.

Сам объект и все инструменты, необходимые для его создания, отображения или,
скажем, уничтожения, относятся к определенному классу. Имя класса указывает
на тип объектов, которые он содержит. Классы можно рассматривать как основу
для создания других объектов этого же типа. Поэтому все объекты одного класса,
например класса TextBox, будут «действовать» одинаково. В других языках про-
граммирования вы можете сгруппировать связанные друг с другом данные и ссы-
латься на них, используя общее имя, предположим Empl oyees или Р roducts, но в со-
ответствии с объектно-ориентированной методологией класс обязательно дол-
жен включать в себя и исполняемый программный код.

Свойства и методы являются членами класса. С помощью свойств описывается,
как выглядит объект, в частности дается информация о приемах форматирования
текста, цвете и размере шрифта. Методы являются процедурами, или, другими
словами, множеством осуществляющих определенную задачу операторов, кото-
рые могут быть выполнены для объекта (процедуры создания и удаления объек-
та, процедуры событий, определяющие принцип взаимодействия объекта с поль-
зователем, и т. д.).

Объекты
При объектно-ориентированном программировании практически все компонен-
ты среды разработки являются объектами. В Excel VBA-объектом считается лю-
бой элемент приложения — ячейка, лист, рабочая книга, диаграмма. Фактически
объектом является и само приложение Excel. Объекты могут включать области
ячеек, рамки ячеек, окна, сценарии, стили, и этот список можно продолжить. Ка-
ждый класс объектов имеет свое множество свойств, функций и событий.

Когда вы добавляете объект на рабочий лист, создается экземпляр класса объек-
тов, и объекту присваиваются те значения свойств, которые определены в этом
классе. По умолчанию экземпляры одного и того ж класса имеют имя, которое со-
стоит из имени родительского класса и порядкового номера. Свойства каждого
экземпляра одного и того же класса инициализируются одними и теми же значе-
ниями, за исключением свойства Name. Так как VBA присваивает значения всем
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элементам, которые в этом нуждаются, пользователю действительно не нужно мно-
го знать, чтобы начать работать в данной среде.

Свойства
Свойство является атрибутом объекта, описывающим, как объект выглядит (его
цвет, размер и местоположение) и как он действует (является ли видимым, ссы-
лается ли на другой объект). Когда вы создаете объект, Excel выполняет процедуру
создания экземпляра этого объекта. Данная процедура, хранимая в классе объек-
тов, присваивает значения всем свойствам, что позволяет вам сразу же работать
с объектом. Если вы захотите изменить несколько свойств, то обнаружите, что
в большинстве своем они заданы именно так, как вам нужно, поэтому вносить из-
менения вам не придется. Для того чтобы в макросе VBA присвоить свойству но-
вое значение, необходимо лишь создать оператор присваивания, в котором слева
от знака равенства будут указаны имя и свойство объекта (разделенные точкой),
а справа — новое значение. К примеру, указанный ниже оператор заменит при-
своенное по умолчанию имя листа Sheetl именем Accounts (Счета):

SheetI.Name- "Accounts"

Свойство листа Name отображается на его ярлычке. Причем данное свойство вхо-
дит также во множество других классов.

Методы
Метод — это действие, которое может быть выполнено над объектом. Методы
реализуются посредством выполнения процедуры, которая является членом клас-
са объектов. Синтаксис вызова метода таков; имя объекта и имя метода, разде-
ленные точкой. К примеру, для того чтобы использовать метод Protect для защи-
ты объекта Sheetl от внесения изменений, вам следует ввести такую команду:

Sheetl.Protect

События
Всякий раз, когда пользователь взаимодействует с определенным объектом на ра-
бочем листе, совершается событие. Каждый класс объектов имеет собственную
группу событий, на которые объекты данного класса реагируют. Так, рабочая
книга имеет событие NewSheet, которое выполняется всякий раз, когда пользова-
тель добавляет в нее новый лист; событие Sel ecti onChange происходит при выборе
пользователем другой ячейки или области ячеек. При создании процедуры собы-
тия Excel автоматически добавляет в ее код первую и последнюю строки; при же-
лании вы можете самостоятельно написать программу для обработки события, на
которое должны реагировать объекты.

Как взаимодействуют объекты, свойства и методы
Когда вы создаете лист в рабочей книге, функцией-членом в классе Worksheet соз-
дается объект Worksheet. Значения свойств нового объекта присваиваются по
умолчанию (например, значение свойства Name, объект стиля ссылок А1 или R1C1),
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и с объектом можно сразу же работать. К этому объекту можно применить любой
из встроенных в класс методов, таких как Printout или Save, и создать программу
реагирования на такие события, как SheetCa leu late или, скажем, Open.

Использование свойств и методов, возвращающих объекты
Если свойство или метод возвращает объект, то доступ к свойствам и методам это-
го объекта можно получить лишь после указания его имени. В качестве примера
рассмотрим такую строку программы:

Workbooks{"Bookl").ActlveSheet.Name= "Expenses"

Метод Workbooks("Bookl").ActiveSheet возвращает объект Worksheet, который со-
держит активную на данный момент таблицу, находящуюся в рабочей книге
Bookl. Свойство Name является свойством объекта Worksheet, а не объекта Active-
Sheet. Так как лист Sheetl считается активным, то этот оператор присваивания эк-
вивалентен следующему:

Sheetl.Name= "Expenses"

Первый оператор является более общим, так как дает возможность присвоить но-
вое имя любому активному листу, в то время как второй оператор однозначно вы-
бирает рабочий лист Sheetl и присваивает ему имя вне зависимости от того, акти-
вен он или нет.

Свойство ActiveCel 1 возвращает объект Range — одну или несколько ячеек, обраще-
ние к которым необходимо произвести одновременно. Это свойство является
членом классов Application (активное приложение, в данном случае — Excel)
и Wi ndow (активное окно) и возвращает область ячеек, которая содержит активную
ячейку, находящуюся в активном окне активного приложения. Вот как это вы-
глядит в коде:

Application.ActlveWlndow.ActiveCell.Borders.Color = vbRed

Так как в каждый момент времени активной может быть только одна ячейка, то
свойства ActlveCell объектов Appl ica t ion и Window ссылаются на одну и ту же об-
ласть ячеек. Таким образом, этот оператор можно переписать по-другому — так:

ActiveWindow.ActiveCell. Borders. Color = vbRed

или так:

Application.ActiveCell.Borders.Color = vbRed

А в связи с тем, что возвращаемый объект Range определяется однозначно, опера-
тор можно переписать и следующим образом:

ActiveCell.Borders.Color - vbRed

Свойство Borders тоже относится к числу свойств, возвращающих объект. Часть
оператора ActlveCell.Borders возвращает объект Border (рамку области ячеек),
а затем свойству Color (цвет) этого объекта присваивает значение red (красный).
Префикс vb, предшествующий значению red, указывает на то, что это значение
является константой Visual Basic, в отличие от переменных, которые нужно опи-
сывать в программе.
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Объект, возвращаемый свойством Act iveCel l , - это объект Range. Таким образом,
свойство Borders задает прямоугольную рамку вокруг группы ячеек, определен-
ных в объекте Range.

Оператор

Application.ActiveWIndow.ActiveCell.Borders.Color = vbRed

станет более понятным, если прочитать его справа налево: «Цвет расположенной
в активном окне приложения рамки области ячеек, которая содержит активную
ячейку, становится красным.»

Области в Excel — объекты VBA
Объекты Range определяют ячейки или области ячеек, которым можно присваи-
вать значения, записывать в них формулы и с которыми можно работать вруч-
ную. В частности, действие оператора

ActiveCell.Borders.Color = vbRed

эквивалентно команде Cells (Ячейки) меню Format (Формат) и изменению значе-
ния в поле Color (Цвет) вкладки Border (Граница) диалогового окна Format Cells (Фор-
мат ячеек).

Кроме того, существует свойство Range, которое возвращает объект Range. Данное
свойство позволяет использовать ссылку на ячейку или область ячеек, обращаясь
к ней как к аргументу. Правда, здесь имеется одно ограничение: ссылки должны
записываться с применением относительной или абсолютной адресации только
в стиле А1:

RangeCAl")

Range("$ASl")

Класс объектов Range содержит более 150 свойств и методов. В табл. 12.2 дается
описание лишь некоторых из них (возможно, они вам уже знакомы).

Таблица 12.2. Свойства и методы объектов Range

Свойство/Метод Описание

Свойство Application Определяет приложение, содержащее область ячеек (например,
Microsoft Excel)

Метод Autofill Автоматически заполняет указанные ячейки формулами, значениями,
присваивает им стили форматирования и другие параметры исходной
ячейки

Свойство Borders Возвращает объект Borders — параметры рамки, выделяющей
область ячеек

Метод Clear Удаляет значения из области ячеек

Метод Сору Копирует содержимое указанной области ячеек в буфер

Метод Font Задает шрифт для указанной области ячеек
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Свойство Range возвращает объект Range, поэтому все свойства и методы, связанные
с этим объектом, могут быть установлены посредством данного свойства. В сле-
дующей строке программы показано, как свойство Range используется для возвра-
щения объекта Range, который применяет ссылку на ячейку А1 (свойство Value
возвращает значение ячейки А1):

RangeC'Al"). Value

Если ячейка А2 содержит формулу, то результат можно вычислить, воспользо-
вавшись методом Calculate объекта Range, который возвращает свойство Range:

RangeC"A2").Calculate

Кроме того, воспользовавшись свойством Range, можно получить доступ к несмеж-
ным областям ячеек, а затем посредством одного оператора присвоить значение
всем ячейкам. Это особенно удобно, если нужно присвоить всем ячейкам одина-
ковое значение:

Range("A3:B5.C3:D8").Value = 0

I ПРИМЕЧАНИЕ Любая ссылка а стиле А1, которую можно ввести в формулу, может быть ис-
пользована в качестве аргумента свойства Range.

Свойство Range также можно использовать с двумя аргументами, которые указы-
вают на ячейки, находящиеся в разных углах области ячеек, расположенных на
одной диагонали. В частности приведенный ниже оператор выбирает ячейки об-
ласти А1:С4:

Workbooks("Bookl").SheetsC"Sheetl") RangeC'Al","C4"}.Select

Аргументы VBA
Аргументы передаются методам и свойствам, использующим их значения при ре-
шении тех задач, для реализации которых они запрограммированы. Причем зада-
ча выполняется корректно только в том случае, если каждый элемент имеет тот
тип, который указан для данного метода. Аргументами могут служить числа, текст
и логические значения (True и False).

Excel предоставляет два способа передачи аргументов методу:

О внутренний, при котором аргументы должны быть указаны в определенном
порядке (как дано в описании);

О внешний, при котором вам не нужно беспокоиться о порядке следования аргу-
ментов.

Рассмотрим действие метода BorderAround объекта Range, который задает новые ат-
рибуты рамки вокруг указанной области. При его использовании требуется за-
дать аргументы для определения стиля линии, ее толщины и цвета. Причем свой-
ство Colorlndex позволяет определить цвет с помощью числа, а свойство Color —
с помощью константы Visual Basic.
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Внутренние аргументы

Метод BorderAround создает прямоугольную рамку вокруг области ячеек. Он мо-
жет быть вызван так:

Call Act1veCell.BorderAround(L1neStyle. Weight, Color-Index, Color)

или так:

ActiveCell.BorderAround LineStyle. Weight. Color-Index, Color

Здесь параметры LineStyle, Weight, Colorlndex и Color имеют определенные значе-
ния (например, xlContinuous, xlThick, xlColorlndexAutomatic, 0). Заметим, что если
аргументы заключены в скобки, оператор должен начинаться со слова C a l l .

Внешние аргументы

Метод можно вызвать и с внешними аргументами. Их значения задаются с ис-
пользованием двоеточия и знака равенства:

Range("Al:C74).BorderAround Colorlndex:=3. Wei grit :=xl Thick

В результате выполнения этого оператора вокруг области ячеек А1:С7 появится
жирная рамка (рис. 12.13).

#У .i^j.-j A i
С16

Рис. 12.13. Область ячеек А1:С7 в рамке

Если вы используете внешние аргументы, никакого порядка их ввода придержи-
ваться не нужно. Это особенно удобно при необходимости присвоить значение
лишь нескольким аргументам, имена которых известны. Очень скоро вы сможете
убедиться, что такой способ определения аргументов делает программу более
удобной для чтения.

Пропущенные аргументы
В VBA имеется множество методов, которым присваивать значения не обяза-
тельно, так как пропущенным аргументам автоматически присваиваются значе-
ния, используемые по умолчанию.
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Если вы передаете аргументы, не определяя их, Excel ставит им в соответствие
значения, переданные в вызове, используя в качестве разделителей запятые. Когда
программа «исчерпывает» все переданные значения, то предполагается, что ос-
тальные аргументы должны получить значения по умолчанию. Рассмотрим в ка-
честве примера оператор, в котором пропущены первый и последний аргументы:

Range("Al:C7").BorderAround . xlTnictc. 3

Обратите внимание на положение запятой. Хотя первое значение пропущено, ос-
тальные значения будут верно поставлены в соответствие аргументам. Последнее
из переданных значений присваивается аргументу Color-Index, и так как для Color
значения нет, запятую в конце можно не ставить.

СОВЕТ При необходимости вызвать метод без указания некоторых значений заме-
ните все пропущенные аргументы запятыми.

Обязательные аргументы
Существует несколько методов, отдельным аргументам которых обязательно сле-
дует присваивать значения. Эти аргументы всегда находятся в начале списка ар-
гументов. Одним из таких методов является ConvertFormula, заменяющий в фор-
муле стиль ссылки А1 стилем R1C1 и наоборот. Кроме того, этот метод позволяет
сменить тип адресации. Синтаксис данного метода:

Application.ConvertFormulaCFormula. FromReferenceStyle. ToReferenceStyle, ToAbsolute,
RelativeTo)

Первые два аргумента здесь являются обязательными, но следующие три могут
быть пропущены.

Для аргумента Formula необходимо задать значение в виде строки, содержащей
формулу, которую следует изменить. Аргументы FromReferenceStyle, ToReference-
Style указывают стиль, а их значениями являются константы Excel — хШ или
xIRlCl. Стиль А1 используется для доступа к ячейкам, которые находятся в столб-
цах из диапазона от А до IV, и в строках с номерами от 1 до 65536. В стиле R1C1
для однозначного определения ячейки служат номера строк и столбцов. Чтобы
перейти к этому стилю, выберите команду Options (Параметры) меню Tools (Сер-
вис) и установите на вкладке General (Общие), которую вы видите на рис. 12.14,
флажок R1C1 reference style (Стиль ссылок R1C1). Теперь столбцы в таблице будут
обозначены цифрами, а не буквами, что значительно облегчит работу. Если аргу-
мент ToReferenceStyl e пропущен, стиль остается неизменным.

Аргумент ToAbsolute предназначен для изменения типа адресации, и ему может
быть передана одна из следующих констант Excel: xIAbsolute, xlAbsRowRelColumn,
xl Rel RowAbsCol umn или xl Rel ati ve. Если этот аргумент пропущен, тип адресации ос-
тается неизменным. Аргументу RelativeTo присваивается объект Range, который
ссылается на ячейку.

[ПРИМЕЧАНИЕ В Excel все константы начинаются с префиксах!.
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.

^Documents and Setthgs\8erezovsky\My Doo.

Рис. 12.14. Выбор стиля ссылок

Процедуры и функции VBA

В VBA поддерживается следующая программная структура. На высшем уровне
иерархии стоит приложение, далее идут проекты, связанные с фактическими до-
кументами этого приложения. На третьем уровне находятся модули (модули при-
ложения, модули пользователя, модули класса, модули форм и модули ссылок),
а на последнем — их процедуры и функции. Схематически такая иерархия пока-
зана на рис. 12.15.

Приложение

—Проект

-Проект2

-ПроекгЛ/

—Модуль

—Модуль2

—МодульЛ/ —

- Объявление

— Процедура!

— Прцедура2

— Процедура^

Рис. 12.15. Структура программы в VBA

Модуль — это часть программы, оформленная в виде, допускающем ее независи-
мую трансляцию. Модуль состоит из двух разделов: раздела объявлений (Decla-
ration) и раздела процедур и функций. В первом разделе описываются глобаль-
ные переменные, типы, определенные пользователем, и перечисляемые типы, во
втором — процедуры и функции. Вы уже знаете, как создаются и используются
макросы. Все они сохраняются в документах или шаблонах программ Office 2003
в виде процедур, написанных на языке VBA. Процедурой называется фрагмент
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кода (минимальная семантически законченная программная конструкция), за-
ключенный между операторами Sub и End Sub. Синтаксис процедуры следующий:

[Private | Public | Friend] [Static] Sub имя_процедуры (аргунент_1, аргумент_2. ...
аргументу)

<оператор VBA>
<оператор VBA>

«оператор V8A>
End Sub

Синтаксис функций несколько отличается от синтаксиса процедур, так как для
функции необходимо указать тип возвращаемого ею значения:

[Private | Public | Friend] [Static] Function имя^функции (аргунент_1, эргумент__2, ...
аргумент^ As тип_возвращземого_значения

<оперзтор VBA>
<олератор VBA>

^ - вычнсленное_значение

End Function

Ключевое слово Private задает следующую область видимости для процедуры -
модуль, в котором она описана. Значит, ее могут вызывать только процедуры это-
го же модуля. Ключевое слово Publ ic, наоборот, объявляет процедуру доступной
для всех модулей проекта. С помощью ключевого слова Friend процедура или
функция становится видимой только в том проекте, где был описан класс, членом
которого она является. По умолчанию любая процедура общедоступна, то есть име-
ет статус P u b l i c .

За операторами объявления следует необязательное ключевое слово Static, объ-
являющее все локальные переменные статическими (что такое статическая пере-
менная, объясняется ниже).

Выполнение программного кода процедуры или функции происходит при пере-
даче ей управления. Передача управления (вызов) может осуществляться раз-
личными способами. В общем случае подпрограмма вызывается из программного
кода с помощью специального оператора Са 1 1 , в котором кроме данного ключево-
го слова указываются имя процедуры и фактические параметры вызова, список
которых заключается в круглые скобки.

Очень важную роль в программировании на VBA играет такая разновидность про-
цедуры, как процедура без параметров. Процедуры данного типа могут выступать
в роли командных макросов и процедур обработки событий. Схема работы с ко-
мандными макросами не отличается от традиционной схемы работы с макросами.
После создания подобного макроса с помощью редактора VBA ему можно назна-
чить комбинацию клавиш для вызова, сопоставить его с командой меню или
кнопкой на панели инструментов. Процедуры обработки событий представляют
собой основу механизма связи событий с программным кодом для их обработки.

Функции в VBA, как правило, содержат списки параметров. Они не могут ис-
пользоваться для обработки событий или, скажем, в качестве программных макро-
сов. Вызывать же их можно как с помощью оператора Са 1 1 , так и непосредственно
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в процессе расчета значения выражения VBA (из кода других процедур или функ-
ций) или формулы рабочего листа Excel.

Как правило, программа на языке VBA состоит из нескольких процедур и функ-
ций. Описание этих программных единиц хранится в модулях. Модули, в свою
очередь, как составные части входят в проекты. Проекты сохраняются в файлах
рабочих книг Excel 2003, но работать с ними можно лишь при наличии отдельного
приложения — редактора Visual Basic. Если нужно вызвать процедуру или функ-
цию, описание которой находится в другом модуле, ее имя при вызове указывает-
ся следующим образом: имя_модуля.иня_процедуры. Но если описание процедуры
или функции содержится в другом проекте, при ее вызове следует использовать
иной синтаксис: имя_проекта.имя_нодуля.имя_прсщедуры.

Создание пользовательских функций
С помощью языка макропрограммирования вы сможете создавать собственные
функции, доступ к которым осуществляется посредством окна мастера функций.
Попытаемся написать несложную функцию для пересчета валют.

Создайте рабочую книгу и сохраните ее. Воспользовавшись командой Visual Basic
Editor (Редактор Visual Basic) меню Tools (Сервис) откройте окно Microsoft Visual
Basic и активизируйте команду Module (Модуль) меню Insert (Вставка). Когда в об-
ласти кода появится окно Module (Модуль), введите макрофункцию, текст кото-
рой представлен на рис. 12.16.

Записан 14.08.2003
Пересчет денежных единиц

Function Dollar_in_euro(Dollar, Evro, Rate)
Evro = Dollar * Rate

End Function!

Рис. 12.16. Текст макрофункции

Функция начинается с оператора Function. После ключевого слова следует имя
макрофункции. В скобках указываются два аргумента, которые должны быть пе-
реданы макрофункции при вызове. Вызвать макрофункцию можно, введя ее имя
Dollar_1n_euro с клавиатуры.
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Такую макрофункцию можно использовать как обычную функцию Excel. Для это-
го путем вызова команды Function (Функция) меню Insert (Вставка) откройте
окно Insert Function (Мастер функций), в списке Select a function (Выберите функ-
цию) отметьте элемент User Defined (Определенные пользователем), и имя создан-
ной вами функции Dollar jn_euro будет представлено в списке имеющихся функ-
ций (рис. 12.17).

Insert Function

[type a brief description of what you want to do and then
click Go

.j. w;.: - - . .̂  -.. :. : ... ̂

Defined

Dollar in euro

iRate)

Рис. 12.17. Имя пользовательской функции в окне Insert Function

Переменные в VBA
Описанные в процедурах VBA действия выполняются над переменными или объек-
тами. Переменная — это поименованная область памяти, которая используется
для хранения данных в течение работы процедуры. Переменные VBA аналогич-
ны переменным других языков программирования.

Использованию переменной обычно предшествует ее объявление посредством
оператора D1 т, в котором указываются имя переменной и тип данных, для хране-
ния значений которого она предназначена. Хотя такой оператор не является обя-
зательным (VBA способен определять тип данных переменной по последнему
символу ее имени: !, #, $, %, &, @), тем не менее хороший стиль программирования
требует предварительного описания всех используемых переменных. Имена пе-
ременных могут иметь длину до 255 символов (используются и символы кирил-
лицы) и не должны содержать пробелов, знаков препинания и перечисленных
выше специальных символов (за исключением символа @). Они не могут совпа-
дать с ключевыми словами VBA и именами стандартных объектов.

Dim a. b As Integer
Dim birthday As Date
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В процедурах и функциях VBA могут использоваться переменные следующих ти-
пов данных:

О Boolean — логические переменные, принимающие одно из двух значений: True
или Fal se;

О Byte — целое число из диапазона от 0 до 255;

О Currency — переменные для денежных вычислений с фиксированным количе-
ством разрядов после десятичной запятой; позволяют избежать накопления по-
грешностей при округлении;

О Date — переменные для хранения даты и времени;

О Double — переменные, использующиеся для хранения значений с плавающей
точкой двойной точности;

О Integer — целые числа из диапазона от -32 768 до 32 767;

О Long - целые числа из диапазона от -2 147 483 648 до 2 147 483 647;

О Object — переменные для хранения ссылок на объекты;

О Single — переменные для хранения значений одинарной точности с плаваю-
щей точкой;

О String — переменные для хранения строк символов длиной от 0 до 64 Кбайт;

О Vari ant — переменные, тип которых определяется типом последнего присвоен-
ного им значения,

VBA предоставляет пользователю возможность наряду со стандартными созда-
вать собственные типы данных (структуры) и хранить данные в массивах (груп-
пах переменных с общим именем, различаемых по сочетанию индексов). Типы
данных описываются не только для переменных, но и для формальных парамет-
ров процедур и функций, а также для самих функций (тип возвращаемого функ-
цией значения).

Область видимости переменной — это область программы, где имя переменной
считается доступным (видимым), а значит, возможен доступ к ее значению. Об-
ласти видимости переменной VBA схематически изображены на рис. 12.18.

Пр сложение
Пр эект

Модуль

Процедура

Рис. 12.18. Область видимости переменной

Существуют три уровня видимости переменной и пять способов ее объявления.

О Процедура (областью видимости является только та процедура, в которой пе-
ременная объявлена).
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• Оператор Dim объявляет переменную в любом месте процедуры, но всегда
предшествует операторам, использующим ее. Время жизни такой перемен-
ной равно времени выполнения процедуры, то есть при входе в эту проце-
дуру под переменную выделяется память и происходит ее инициализация.
В процессе выполнения данной процедуры значение переменной может из-
меняться. После выхода из процедуры выделенная память освобождается,
а следовательно, теряется значение переменной.

• Действие оператора Static аналогично действию оператора Dim, но он объ-
являет статическую переменную. Разница в том, что при выходе из проце-
дуры память статической переменной не освобождается, а становится вре-
менно недоступной, поэтому значение переменной сохраняется.

О Модуль (область видимости — все процедуры модуля, в котором переменная
объявлена).

• Оператор Private объявляет переменную в разделе описаний Declaration
(вне процедур модуля).

• Действие оператора Dim аналогично (в данном случае) действию оператора
Private.

О Приложение (область видимости — все процедуры всех модулей активного при-
ложения).

• Оператор Publ ic объявляет переменную в разделе описаний Declaration.

Как видите, область переменных VBA определяется местом их описания. Если пе-
ременная описана внутри процедуры или функции, ее область видимости ограни-
чивается этой процедурой или функцией. Любая попытка использовать имя дан-
ной переменной вне процедуры или функции, содержащей ее описание, приведет
либо к ошибке, либо к созданию новой переменной — с тем же именем, но с дру-
гой областью видимости. Если переменная описана на уровне модуля (то есть со-
ответствующий ей оператор D i m помещен непосредственно в модуль, перед описа-
нием процедур и функций), то ее можно использовать в любой процедуре или
функции, описанной в данном модуле. Но если предполагается, что переменная
будет применяться в процедурах и функциях, описанных в различных модулях
проекта, то ее следует описать в одном из этих модулей, воспользовавшись вме-
сто оператора Dim совпадающим с ним по синтаксису оператором Public.

Управляющие конструкции VBA

Управляющие конструкции языка программирования — это инструкции и группы
инструкций, применение которых позволяет изменять по мере необходимости по-
следовательность выполнения других инструкций программы. В современных
языках программирования управляющие конструкции подразделяются на ветв-
ления и циклы. Ветвлением называется управляющая конструкция, позволяю-
щая пропускать при выполнении те или иные группы инструкций в зависимости
от значения условия (If...Else, If...Then...Else, If...Then...ElseIf...Else и Select Case).
Цикл — это управляющая конструкция, предоставляющая возможность много-
кратно выполнять группы инструкций, до наступления какого-либо события.
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Конструкция If...Then
Конструкция If...Then дает VBA указание принять простейшее из решений: если
условие I f истинно, нужно выполнить следующий за ним оператор (или операто-
ры); если же условие ложно, нужно прейти к строке, расположенной непосредст-
венно за условной конструкцией. Данная конструкция может располагаться как
в одной, так и в нескольких строках. Однострочная конструкция If...Then выгля-
дит так:

If условие Then оператор[ы]

Если условие выполняется, VBA обрабатывает оператор или операторы, которые
следуют за условием; в противном случае эти операторы пропускаются.

Конструкция If...Then, занимающая несколько строк (известна также как блок If),
выглядит следующим образом:

If условие Then
оператор
[операторы]

End If

Если условие истинно, VBA, опять-таки, выполняет оператор или операторы, а в про-
тивном случае передает управление строке, расположенной под строкой End If.

Вот пример однострочной конструкции If:

Age = InputBoxf"Укажите свой возраст.", "Возраст ")
If Age < 21 Then MsgBox "Вы не можете покупать алкогольные налитки."..

"Несовершеннолетний"

Конструкция If...Then...Else
Конструкция If ...Then — прекрасный инструмент для выполнения одного дейст-
вия, зависящего от условия. Но если приходится выбирать одно из двух возмож-
ных направлений, в которых будут производиться действия, следует воспользо-
ваться конструкцией If...Then...Else. С помощью этой конструкции выбирается
одно направление деятельности, если условие истинно, и другое, если оно ложно.
Например, конструкция If...Then...Else является очень удобным инструментом для
работы с окнами сообщений, содержащими по две кнопки.

Синтаксис рассматриваемой конструкции таков:

If условие Then
операторыJ.

Else
операторы_2

End If

Если условие истинно, VBA выполняет первую группу операторов — oneparopbij.,
но если условие ложно, осуществляется переход к строке Else, а затем выполня-
ется вторая группа операторов — операторы_2.

Вы можете создать как однострочную конструкцию If...Then...El se, так и блок кон-
струкций If ...Then. Практически во всех случаях целесообразнее создавать блок
If...Then, потому что его гораздо проще читать и отлаживать. Более того, конст-
рукция If...Then...Else намного длиннее конструкции If.„Then, а следовательно, со-
держащая ее строка, будет чрезмерно длинной.
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Конструкция If...Then...Elself...Else

Последняя из числа рассматриваемых нами здесь конструкций If — это конструк-
ция If...Then...ElseIf...Else, которую удобно применять для выбора одного из несколь-
ких направлений действий. Вы можете использовать сколько угодно строк с клю-
чевым словом El self — их количество должно зависеть от сложности проверяемо-
го условия.

Конструкции If...Then...Elself...Else также могут быть и однострочными, и блоч-
ными. И, опять-таки, практически во всех случаях блочную конструкцию If...
Then...Elself...Else проще создать, прочесть и отладить. Но, с другой стороны, од-
нострочная конструкция If...Then...ElseIf...Else, подобно прочим однострочным
конструкциям If, не нуждается в операторе End If, а блоку он необходим.

Конструкция If...Then..,ElseIf...Else имеет следующий синтаксис:

If условие_1 Then
операторы_1

Elself условие^ Then
операторы_2

[Elself условие_3 Then
операторы_3]

[Else
операторы_4]

End If

Если условиеJ. истинно, VBA выполняет опера торы_1, то есть первый блок опера-
торов, а затем переходит к строке, расположенной после оператора End If. Но
если условие_1 ложно, осуществляется переход к первому оператору Е1 se I f и про-
веряется условие_2. Если последнее истинно, VBA выполняет операторы^?, а затем
переходит к строке, расположенной за оператором End If. В том случае, когда ус-
ловие_2 ложно, управление переходит к следующему оператору Elself (если тако-
вой имеется) и проверяет очередное условие.

Далее, если во всех операторах Else l f условия ложные, VBA переходит к ключе-
вому слову El se (при его наличии) и выполняет операторы, следующие за ним.
Затем оператор End If завершает условную конструкцию, а управление переходит
к строке, расположенной после оператора End If.

В блочной конструкции можно использовать любое число операторов Elself,
снабжая каждый последующий новым условием. Но если применяемые конст-
рукции If содержат большое количество операторов El self (допустим, больше 5),
целесообразно вместо них воспользоваться конструкцией Select Case, о которой
речь пойдет ниже.

Оператор Else является необязательным, хотя в большинстве случаев будет не-
лишним указать VBA другое направление деятельности, если ни одно из усло-
вий, заданных в операторах If и Elself, не выполняется.

Конструкция Select Case

Вместо нескольких операторов Elself можно применить конструкцию Select Case,
которая позволит представить ту же задачу принятия решения в виде более сжа-
той и эффективной программы.
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Конструкцию Select Case рекомендуется использовать в том случае, если реше-
ние, которое нужно принять в программе, зависит от одной переменной иди от
выражения, имеющего не менее трех-четырех значений. Такая переменная (или
выражение) называется тестируемым случаем.

Конструкцию Select Case легче читать, чем сложные операторы If ...Then, главным
образом потому, что она более компактна. Кроме того, в нее легче вносить изме-
нения: когда нужно изменить одно или несколько используемых значений, при-
ходится просматривать меньшее количество операторов. Синтаксис оператора
Select Case таков:

Select Case проверяемое_выражение
Case вырджение_1

операторы<_1
[Case выражение_2

операторы_2]
[Case Else

операторы']
End Select

На первый взгляд данный синтаксис может показаться сложным, но это не так.
Оператор Select Case начинает конструкцию, а оператор End Select завершает ее.
Проверяемое выражение определяет, какой из операторов Case будет выполнен,
а выражение_1, выражение_2 и т. д. - это те выражения, с которыми VBA сравнивает
проверяемое. Предположим, необходимо проверить, кнопку с каким номером вы-
брал пользователь в диалоговом окне или в форме. Значит, проверяемое выраже-
ние будет связано с событием выбора кнопки. Если это первая кнопка, значение
проверяемого выражения совпадет с выражением 1. В таком случае будут выпол-
нены операторы, находящиеся в строках, следующих за оператором Case выраяе-
ние_1. Если это вторая кнопка, то значение проверяемого выражения совпадет
с выражением 2, а следовательно, будут выполнены операторы, расположенные
в строках, следующих за оператором Case вырзжение_2. То же можно сказать и об
остальных операторах Case.

Оператор Case Else подобен ключевому слову Else в операторе If. Он представляет
собой необязательный оператор, который, будучи указанным, выполняется в тех
случаях, когда ни одно из предложенных выражений не подходит.

Циклы
При создании процедур и функций часто возникают ситуации, когда одни и те же
действия требуется повторять по нескольку раз. Для повторного исполнения опе-
ратора или группы операторов предназначены специальные управляющие конст-
рукции VBA — циклы. Существует три типа циклов, а именно, с управляющим
условием, со счетчиком и циклы по структуре данных.

В циклах с управляющим условием оператор или группа операторов повторяется
до тех пор, пока такое условие не будет выполнено. По названию оператора, со-
ставляющего основу этой управляющей конструкции, такие циклы называются
циклами Do. В зависимости от типа управляющего условия и времени его провер-
ки (относительно выполнения повторяющихся операторов) различают четыре
вида циклов Do. Рассмотрим пример использования всех четырех видов цикла Do
для решения одной и той же задачи. Мы должны определить, сколько раз подряд
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из числа 25 можно извлечь квадратный корень, чтобы в результате получилось
число, не превышающее единицу более, чем на одну сотую.

Sub MainQ
Dtm число As Single
Dim повторения As Integer
повторения = О
число - 25
'Цикл Do первого типа
Do While число - 1 >= 0.01

число = Здг(число)
повторения = повторения + 1

Loop
MsgBox (повторения)
повторения = О
число - 25
'Цикл Do второго типа
Do

число • Sqr(4HCflo)
повторения = повторения + 1

Loop While число - 1 >- 0.01
MsgBox (повторения)
повторения = О
число = 25
'Цикл Do третьего типа
Do Until число - 1 < 0.01

число = Sqr(4HOio)
повторения = повторения + 1

Loop
MsgBox (повторения)
повторения = О
число = 25
'Цикл Do четвертого типа
Do

число - 5дг(число)
повторения = повторения + 1

Loop Until число - 1 < 0.01
MsgBox (повторения)
End Sub

В цикле Do первого типа условие проверяется до начала обработки повторяющих-
ся операторов. Если условие оказывается выполненным (при вычислении логи-
ческого выражения получено значение True), операторы, заключенные между
ключевыми словами Do и Loop (тело цикла), обрабатываются однократно, затем
управление снова передается ключевому слову Do и процесс повторяется. Если
управляющее условие не выполняется, то повторяющаяся группа операторов
пропускается и выполняется оператор, следующий непосредственно за ключе-
вым словом Loop.

В цикле Do второго типа условие проверяется после выполнения тела цикла.
Цикл повторяется, пока управляющее условие выполняется.

В цикле Do третьего типа условие проверяется до начала выполнения повторяю-
щихся операторов, но тело цикла выполняется только в том случае, когда управ-
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ляющее условие не выполнено (при вычислении логического выражения получа-
ется значение False).

В цикле Do четвертого типа условие проверяется после выполнения тела цикла.
Цикл должен повторяться до тех пор, пока не будет выполнено управляющее ус-
ловие.

Циклами с управляющим перечислением пользуются в тех случаях, когда зара-
нее известно количество повторений тела цикла и проверять управляющее усло-
вие нет необходимости. Циклы такого типа подразделяются на две группы: цик-
лы со счетчиком и циклы по структуре данных.

В циклах со счетчиком используется специальная переменная — счетчик, значе-
ние которой при каждом повторении тела цикла увеличивается или уменьшается
на заданную величину - шаг цикла. Цикл завершается после того, как значение
счетчика достигнет (или превысит) конечное значение счетчика цикла. Если в про-
цессе выполнения цикла значения счетчика убывают (отрицательный шаг цик-
ла), цикл завершается, когда значение счетчика станет равным или меньше ко-
нечного значения. Синтаксис цикла со счетчиком следующий:

For счетчик - начдльное__знзченне То конечное_значение Step oiarjimna
<тело цнкла>

Next счетчик

А вот пример процедуры, вычисляющей сумму значений, содержащихся в нечет-
ных ячейках первого столбца первого листа текущей рабочей книги Excel (в пре-
делах первых 10 ячеек):

Sub Loop_For()
Dim I As Integer
Dim S As Long
S = 0
For I = 1 To 10 Step 2

S = S + Application, WorksheetsCn.Cellsd. 1).Value
Next I
MsgBox CS)
End Sub

В циклах по структуре данных тело цикла поочередно повторяется для всех од-
нородных объектов, составляющих массив или семейство. В этом случае в роли
счетчика выступает объектная переменная. Синтаксис цикла данного типа:

For Each элемент In структура_данных
<тело цикла>

Next элемент

Ниже приведен пример, в котором цикл по структуре данных используется для
вывода на печать имен всех рабочих листов текущей рабочей книги Excel:

Sub loop_data()
Dim S As Worksheet
For Each S In Application.Worksheets

Debug.Print S.Name
Next S
End Sub
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Итак, мы совершили краткий экскурс в область макропрограммирования. Прав-
да, рассмотрены далеко не все возможности Excel по созданию и применению
макросов, а также опущено описание некоторых элементов языка VBA. Затрону-
тая тема слишком обширна, поэтому вам, возможно, придется обращаться к до-
полнительной литературе.

Подведение итогов

В этом уроке мы научились:

О создавать макросы с помощью макрорекордера и редактора Visual Basic;
О редактировать и запускать макросы;

О оперировать элементами VBA;

О создавать процедуры и функции;
О программно реализовать задачи принятия решений.
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Сфера применения вычислительной техники необычайно обширна, и круг задач,
которые решаются с помощью современных персональных компьютеров, непод-
властен одной, даже самой совершенной программе. Проблема обмена данными
по-прежнему остается актуальной, поскольку при решении сложных задач при-
ходится работать с несколькими приложениями. Следует также отметить, что
«жизненный цикл» компьютерного продукта непродолжителен, и проблема об-
мена данными возникает также в связи с появлением новых программ и следую-
щих версий уже существующих.

Связь Excel с другими приложениями
Приложения пакета Microsoft Office 2003 поддерживают несколько способов об-
мена данными. Понятие обмен данными у пользователей, знакомых с Windows,
как правило, ассоциируется с аббревиатурой OLE. Можно сказать, что использо-
вание технологии OLE (Object Linking and Embedding — связывание и внедрение
объектов) является одним из наиболее ярких примеров реализации концепции
обмена данными между приложениями Microsoft Office 2003. Однако не следует
забывать и о буфере обмена, с помощью которого также можно производить обмен
данными. Этот способ является самым простым и наиболее распространенным,
так как многие пользователи, к сожалению, имеют представление только о нем.

Буфер обмена
В Windows обмен данными между приложениями осуществляется в зарезервиро-
ванной области памяти, называемой буфером обмена. Для занесения данных в бу-
фер обмена применяется команда Edit > Сору (Правка > Копировать) или Edit > Cut
(Правка > Вырезать), а для их вставки в нужное место документа — команда Edit >
Paste (Правка > Вставить).

Пользователи Windows привыкли к тому, что операция копирования или выре-
зания, выполняемая в любом Windows-приложении, приводит к замене содержи-
мого буфера обмена. Во многих случаях это сопровождается определенными не-
удобствами. В пакете Microsoft Office существует собственный буфер обмена,
в который можно скопировать до 24 блоков информации (объектов). При этом
блок, залесенный в буфер первым, не исчезает в результате помещения туда вто-
рого информационного блока. В данном случае речь идет не о буфере обмена сис-
темы Windows, а о так называемом офисном буфере обмена.

Доступ к офисному буферу обмена обеспечивается из всех приложений Microsoft
Office, то есть, работая с этими приложениями, можно помещать объекты в буфер
и копировать их оттуда. Объекты размещаются в буфере в той последовательно-
сти, в которой они туда заносятся. Копировать же их из буфера можно в любом
порядке. Даже если объект помещается в буфер обмена Windows из приложения,
которое не входит в пакет Microsoft Office, он все равно автоматически становит-
ся доступным в офисном буфере обмена.

Если в буфере обмена уже содержатся 24 объекта, но пользователь вырезает или
копирует еще один, данный объект помещается в буфер, а первый из числа там
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находящихся (скопированный раньше других) удаляется из буфера обмена, что-
бы освободить место.

Ниже будет рассказано, с помощью каких средств реализуются описанные выше
возможности работы с буфером обмена. Помещается информация в буфер обме-
на традиционным способом — с помощью команды Edi t» Сору (Правка > Копиро-
вать) или комбинации клавиш CtrL+C. Вставить в документ какой-либо объект из
буфера обмена можно двумя способами. Поместив курсор в место вставки ин-
формации, вызовите команду Edit > Paste (Правка > Вставить) либо воспользуй-
тесь комбинацией клавиш CtrL+V — это первый способ. То же самое можно сделать
и по-другому: щелкните левой кнопкой мыши на значке, соответствующем тре-
буемому объекту, в области задач Clipboard (Буфер обмена), которая вызывается
командой Edit > Office Clipboard (Правка > Буфер обмена Office) (рис. 13.1).

ifi --• • • •.. '•-

Индексы

Титульные и содержание
Предисловие Введение 1.
Установка Office 2D03 2. По,,.

В верхней части указанной
области задач, рядом с ее
названием, отображается ...

Documents and Lists
(Документы и списки)

-То display ttite tasfc рапе ада иг click
Office clipboard on the Edit menu or

"

Рис. 13.1. Область задач Clipboard

В верхней части указанной области задач, слева от ее названия, отображается ко-
личество занятых ячеек буфера обмена. Здесь же расположены кнопки Paste All
(Вставить все) и Clear ALL (Очистить все), первая из которых служит для вставки
всего содержимого буфера обмена в документ, а вторая применяется для полной
отчистки буфера.

В нижней части области задач Clipboard (Буфер обмена) находится кнопка Options
(Параметры), после щелчка на которой появляется меню со списком настроек бу-
фера обмена. Этот список содержит имена пяти флажков.

13 Зак. 345
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В случае установки флажка Show Office Clipboard Automatically (Автоматическое ото-
бражение буфера обмена Office) область задач Clipboard (Буфер обмена) будет ав-
томатически открываться при выполнении операций копирования или выреза-
ния объекта.

Если установлен флажок Show Office Clipboard W h e n Ctrl+C Pressed Twice (Открывать
буфер обмена при двойном нажатии клавиш Ctrl+C) указанная область будет по-
являться на экране после каждого двойного нажатия комбинации клавиш Ctrl+C.

Когда необходимо, чтобы при записи в буфер обмена данных область задач Clip-
board (Буфер обмена) не появлялась на экране, следует установить флажок Collect
Without Showing Office Clipboard (Собирать данные без отображения буфера обмена
Office).

Если установлен флажок Show Office Clipboard Icon On Taskbar (Показать значок бу-
фера обмена Office на панели задач), то при открытии области Clipboard (Буфер
обмена) на панели задач будет автоматически отображаться значок буфера обмена.

При установке флажка Show Status Near Taskbar When Coping (Показывать состояние
около панели задач при копировании) при выполнении операции копирования
на значке буфера обмена будет отражаться состояние процесса записи данных.

Обмен данными посредством буфера обмена
1. Выделите данные, которые необходимо поместить в буфер обмена.

2. Вызовите команду Edit > Сору (Правка к Копировать) или Edit > Cut (Прав-
ка > Вырезать).

3. Перейдите в приложение, в которое необходимо поместить скопиро-
ванные или вырезанные данные, и вызовите команду Edit > Paste (Прав-
ка > Вставить).
ИЛИ

Откройте область задач Clipboard (Буфер обмена) в приложении Office,
в которое необходимо вставить данные, отметьте место для их разме-
щения и щелкните левой кнопкой мыши на значке этих данных.

Работа с фрагментами
В Excel существует возможность сохранять или передавать данные в виде фраг-
ментов документа. Фрагмент представляет собой отдельный файл, который мож-
но сохранить на жестком диске.

Для того чтобы создать фрагмент, сначала необходимо выделить часть таблицы,
которая должва стать его содержимым, щелкнуть на ней правой кнопкой мыши
и в появившемся меню выбрать команду Сору (Копировать). Затем с помощью
проводника Windows нужно найти папку, где этот фрагмент таблицы будет со-
хранен в виде файла, щелкнуть на ней правой кнопкой мыши и в появившемся
контекстном меню выбрать команду Paste (Вставить). При необходимости вста-
вить данный фрагмент в любое другое приложение Windows операции копирова-
ния и вставки следует повторить.
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I ПРИМЕЧАНИЕ Приложения, для обмена данными между которыми используются фрагмен-
ты, должны поддерживать технологию OLE.

Преимущество использования фрагментов по сравнению с применением буфера
обмена состоит в том, что при выключении компьютера содержимое буфера об-
мена теряется, а фрагменты остаются на жестком диске до тех пор, пока не будут
удалены пользователем.

Использование фрагмента

1. Выделите часть таблицы, которая должна стать содержимым фрагмента.

2. Скопируйте эти данные, щелкнув на них правой кнопкой мыши, и в поя-
вившемся контекстном меню выберите команду Сору (Копировать).

3. С помощью проводника Windows найдите папку, в которую данный
фрагмент таблицы нужно сохранить, щелкните на ней правой кнопкой
мыши и в появившемся на экране контекстном меню выберите коман-
ду Paste (Вставить).

4. Щелкните правой кнопкой мыши на файле, который содержит фраг-
мент таблицы, выберите из появившегося контекстного меню команду
Сору (Копировать).

5. Откройте чистый рабочий лист, установите указатель ячеек в том мес-
те, где должен быть размещен фрагмент, щелкните правой кнопкой
мыши и выберите из контекстного меню команду Paste (Вставить).

Связывание и внедрение данных

При использовании технологии OLE данные Excel вставляются в другие файлы,
в том числе и в Word-документы, как объекты; связь с приложением-сервером
при этом сохраняется. Чтобы запустить приложение-сервер и получить возмож-
ность обработать с его помощью объект, достаточно выполнить двойной щелчок
на данном объекте. После завершения работы с приложением-сервером объект
в приложении-клиенте обновляется. Конечно же, для этого необходимо, чтобы
приложение-клиент поддерживало технологию OLE.

Приложения, поддерживающие технологию OLE, подразделяются, как вы теперь
понимаете, на приложения-серверы и приложения-клиенты. Приложения-серве-
ры предоставляют определенный объект в распоряжение приложения-клиента.
Например, созданные в программе Paint рисунки могут быть вставлены в доку-
мент Excel (рис. 13.2), однако поместить Excel-таблицу в документ, созданный
с помощью приложения Paint, невозможно. Таким образом, Excel может выступать
и в качестве приложения-сервера, и и качестве приложения-клиента, a Paint —
только в качестве приложения-клиента. OLE-объектами могут выступать графи-
ческие изображения, текст, таблицы, аудио- и видеофайлы.
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Рис. 13.2. Рисунок, созданный в редакторе Paint вставлен в документ Excel

Интегрировать OLE-объекты в приложение-клиент можно двумя способами: пу-
тем внедрения и путем связывания.

Связывание Excel с данными другого приложения

Способ обмена данными между Excel и некоторыми другими приложениями с по-
мощью буфера обмена имеет один существенный недостаток: процесс происхо-
дит статически. Другими словами, после того как данные из Excel вставляются
в приложение-клиент, пользователь лишается возможности применять при их об-
работке функциональные возможности Excel. Конечно же, данные можно моди-
фицировать с помощью приложения-сервера, а затем опять скопировать их в прило-
жение-клиент, однако такой метод работы вряд ли можно отнести к числу эффек-
тивным.

Динамический обмен данными между приложениями осуществляется посредст-
вом связывания объектов. Для того чтобы выполнить связывание, следует в при-
ложении-сервере скопировать данные, после чего в приложении-клиенте опреде-
лить их место вставки и вызвать команду Edit > Paste Special (Правка > Специальная
вставка). В появившемся окне Paste Special (Специальная вставка) необходимо
активизировать переключатель Paste link (Связать), указать в поле As (Как) тип
данных, которые будут вставлены из буфера, и щелкнуть на кнопке ОК (рис. 13.3).
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Рис. 13.3. Диалоговое окно Paste Special программы Word

^ПРИМЕЧАНИЕ Какие типы представления будет содержать список As (Как) и сколько их бу-
дет, зависит от формата помещенных в буфер данных.

При связывании объектов в приложении-клиенте сохраняются только ссылки на
файлы этих объектов, а сами объекты обрабатываются и сохраняются в приложе-
нии-сервере. Обновление связанного объекта осуществляется либо вручную, либо
автоматически. Например, если Excel-таблица помещена в документ Word, то по-
сле модификации ее данных в Excel нет необходимости производить ее обновле-
ние в Word, поскольку при следующей загрузке Word-документа таблица будет
обновлена автоматически. При желании обновление таблицы Excel, вставленной
в документ Word, можно выполнить вручную, для чего нужно вызвать команду
Edit > Links (Правка > Связи) и активизировать в появившемся диалоговом окне
Links (Связи) переключатель Manual update (по запросу) (рис. 13.4). Для обновления
связи в этом же диалоговом окне следует нажать кнопку Update Now (Обновить)
или клавишу F9.

Рис. 13.4. Диалоговое окно Links
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По сравнению с внедрением документов связывание обладает одним существен-
ным недостатком: после сохранения связей со многими файлами процесс перено-
са этих файлов на другие компьютеры значительно затрудняется. Ведь полное
имя файла содержит ссылки на каталоги исходного компьютера, а поместив до-
кумент, в котором используются связанные объекты, на другой компьютер, необ-
ходимо заново устанавливать связи с файлами-источниками. Преимущества же,
получаемые в результате связывания объекта, заключаются в том, что данные об-
новляются автоматически и объем документа в приложении-клиенте практиче-
ски не увеличивается.

Связывание данных
1. В приложении-сервере скопируйте необходимые данные.

2. В приложении-клиенте определите место вставки этих данных и вызо-
вите команду Edit > Paste Special (Правка > Специальная вставка).

3. В появившемся окне Paste Special (Специальная вставка) активизируй-
те переключатель Paste Link (Связать), укажите в поле As (Как) тип дан-
ных, которые будут вставлены из буфера, и щелкните на кнопке ОК.

Внедрение объектов
При внедрении объекта в приложение-клиент помещается его копия, а связь с при-
ложением-сервером устанавливается каждый раз, когда выполняется обработка
объекта. Делается это посредством двойного щелчка на нем кнопкой мыши.

При использовании OLE-технологии запускать приложение-сервер для обработ-
ки объекта не требуется. Пользователь получает доступ к функциональным воз-
можностям приложения-сервера непосредственно из приложения-клиента. Так,
если объект Excel будет обрабатываться в программе Word, то после двойного
щелчка на нем, хотя приложение Excel и не будет запущено, окно Word примет
другой вид: в нем появятся строка меню и панели инструментов Excel. Таким об-
разом пользователь получит доступ ко всем функциям Excel.

Word хорошо -«подготовлен» к интеграции Excel-таблицы в документ в качестве
объекта. В стандартной панели инструментов Word для этой цели имеется кноп-
ка Insert Microsoft Excel Worksheet (Добавить таблицу Excel), после щелчка на кото-
рой появляется стилизованное изображение таблицы, где пользователь должен
указать количество строк и столбцов в создаваемой таблице. В результате в доку-
мент будет вставлена пустая таблица. Нажатие указанной кнопки приводит не
только к вставке новой таблицы, но и к замене строки меню и панелей инстру-
ментов программы Word аналогичными элементами программы Excel.

После завершения ввода данных в таблицу для «возвращения» на экран меню
и панелей инструментов программы Word достаточно щелкнуть мышью вне об-
ласти таблицы Excel Для того чтобы получить возможность обрабатывать интег-
рированную в Word таблицу, нужно дважды щелкнуть на ней мышью, в резуль-
тате чего в распоряжение пользователя вновь поступит весь набор функций Excel.
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На рис. 13.5 видно, что таблица Excel вставлена в документ Word: строка заголов-
ка окна содержит имя документа Word, а меню и панели инструментов принадле-
жат Excel.

| ЕХ-14 "Microsoft Office Word 2G05

ype s questjc-n fcf Мф

окна'содержит-имя-документа'Word/a-мйню-и-панели-ннструыентов'принадлежат

И d Табпииа Excel созданная в Word
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Рис. 13.5. Таблица Excel, интегрированная в Word-документ

Еще одну возможность интегрировать Excel-таблицу в документ Word предостав-
ляет команда Insert > Object (Вставка > Объект) меню программы Word. Выбор
этой команды приводит к появлению на экране диалогового окна Object (Вставка
объекта), аналогичного соответствующему окну программы Excel. В этом диало-
говом окне по умолчанию активизирована вкладка Create New (Новый), на кото-
рой для вставки Excel-таблицы следует выбрать элемент Microsoft Excel Worksheet
(Лист Microsoft Excel) и щелчком на кнопке ОК задать операцию вставки таблицы.

После нажатия кнопки ОК в документ Word будет вставлен пустой рабочий лист
Excel. Теперь можно начинать работать с рабочим листом, применяя команды ме-
ню и кнопки панелей инструментов. В наше распоряжение поступили все имею-
щиеся в Excel функции. При активизации Excel-объекта не изменяется только
меню File (Файл), что, конечно же, имеет свое объяснение: мы по-прежнему нахо-
димся в Word-документе. Щелчок мышью вне области объекта вернет меню и па-
нели инструментов Word на место.

В описанном выше случае в качестве объекта в Word-документ была внедрена
пустая Excel-таблица. Чтобы вставить в него уже имеющуюся таблицу (возмож-
но, содержащую какие-то данные), необходимо открыть вкладку Create from File
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(Создание из файла) диалогового окна Object (Вставка объекта), ввести в поле File
name (Имя файла) имя файла, в котором находится нужная таблица, и щелкнуть
на кнопке ОК. Обрабатывать такой объект можно обычным способом.

Если же на вкладке Create from File (Создание из файла) диалогового окна Object
(Вставка объекта) активизирована опция Link to file (Связь с файлом), объект
вставляется в документ как связанный объект, поэтому после двойного щелчка
на нем мышью запускается приложение-сервер. Завершив обработку объекта, со-
храните его.

Внедрение объекта
1. В приложении-клиенте определите место вставки объекта и вызовите

команду Insert > Object (Вставка > Объект),

2. В окне Object (Вставка объекта) на вкладке Create New (Новый), для того
чтобы вставить Excel-таблицу, выберите элемент списка Microsoft Excel
Worksheet (Лист Microsoft Excel) и щелкните на кнопке ОК.

ИЛИ

В окне Object (Вставка объекта) перейдите на вкладку Create from File
(Создание из файла), введите в поле File name (Имя файла) имя файла,
в котором находится нужная таблица, и щелкните на кнопке ОК.

Самостоятельная работа
1. Создайте или откройте таблицу Excel. Выберите и скопируйте любой диапа-

зон ячеек и поместите их в документ Word сначала в виде преобразованной
таблицы — с помощью команды Paste (Вставка), затем рисунка — воспользо-
вавшись командой Paste Special (Специальная вставка), внедренного объекта -
посредством команды Paste Special (Специальная вставка) и, наконец, в виде
связанного объекта.

2. Дважды щелкните на одном из связанных объектов и внесите какие-либо из-
менения в таблицу Excel. Вернитесь в документ Word и попытайтесь опреде-
лить, чем различаются между собой преобразованные, внедренные и связан-
ные данные.

3. Внедрите в документ Word диаграмму, созданную в Excel.

Взаимодействие Excel 2003 и Access 2003

В Microsoft Office 2003 существует возможность вставлять рабочие листы Excel
в формы и отчеты Access посредством свободных и присоединенных рамок объ-
ектов. Обмениваться данными между указанными приложениями можно и с по-
мощью специальной программы-надстройки Access! .inks. Имеется также возмож-
ность выполнять обратные операции, то есть переносить данные таблиц Access на
рабочие листы Excel.



Взаимодействие Excel 2003 и Access 2003 393

Вставка таблицы Excel в базу данных Access
Таблицу Excel можно вставить в форму или отчет Access либо связать с любым из
этих элементов. Такая таблица будет автоматически сохранена в файле базы данных.

Вставка рабочего листа в Access

Для того чтобы, находясь в Access, вставить данные Excel в форму, необходимо от-
крыть таковую в режиме Create form in Design view (Создание формы в режиме кон-
структора) и, когда на экране появится окно формы, вызвать команду Insert >
Object (Вставка ^ Объект). В результате ее выполнения будет открыто диалоговое
окно Microsoft Access, в котором после активизации переключателя Create from File
(Создать из файла) появится возможность найти нужный файл Excel (рис. 13.6).

Рис. 13.6. Диалоговое окно Microsoft Access
.

Затем щелчком на кнопке Browse (Обзор) нужно открыть диалоговое окно Browse
(Обзор), найти нужный файл и нажать кнопку ОК, после чего опять будет осуще-
ствлен переход в диалоговое окно Microsoft Access. Б результате щелчка на кнопке
ОК в окне формы появится таблица Excel, в которую можно внести требуемые из-
менения (рис. 13.7).

Если рабочий лист Excel будет помещаться в форму или отчет в виде значка, в ок-
не Microsoft Access нужно установить флажок Display as Icon (В виде значка), а для
связи объекта с приложением-сервером — флажок Link (Связь).

Для того чтобы при следующем открытии в режиме формы вставленная таблица
Excel была доступна для редактирования, необходимо щелкнуть на ней правой
кнопкой мыши, в появившемся контекстном меню выбрать команду Properties
(Свойства) и установить в одноименном окне значение свойства Enabled (Дос-
туп) — Yes (Да) и значение свойства Locked (Блокировка) - No (Нет). Теперь,
просматривая этот документ в режиме формы, вы, дважды щелкнув мышью на
таблице, сможете внести в нее любые изменения.

[ПРИМЕЧАНИЕ При вставке таблицы Excels отчет Access необходимо пошагово выполнить
действия, аналогичные тем, что вы выполняли, вставляя таблицу в форму.
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Рис. 13.7. Таблица Excel вставленная в форму Access

Вставка рабочего листа в Access
1. Откройте форму в режиме Create form in Design view (Создание формы

в режиме конструктора).

2. Когда на экране появится окно формы, активизируйте команду Insert >
Object (Вставка » Объект).

3. В открывшемся окне Microsoft Access найдите нужный файл, задайте не-
обходимые параметры для вставки и щелкните на кнопке ОК.

Вставка объекта с помощью свободной рамки
Для того чтобы вставить таблицу Excel в Access с использованием свободной рам-
ки объекта, форму или отчет следует открыть в режиме конструктора.

ц После щелчка на кнопке Unbound Object Frame (Свободная рамка объекта) па-
1 нели инструментов Toolbox (Панель элементов) необходимо разместить кур-

сор мыши в окне формы или отчета и, нажав левую кнопку мыши, задать размеры
того места, где будет размещена таблица.
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После того как кнопка мыши будет отпущена, на экране появится диалоговое окно
Microsoft Access, в котором нужно выделить файл, подлежащий вставке. При необ-
ходимости установить связь с приложением-сервером или отобразить данные
Excel в виде значка установите в этом окне описанные выше флажки. Окно фор-
мы Access со вставленными в него данными из Excel показано на рис. 13.8.
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Рис. 13.8. Таблица Excel, вставленная в форму Access с помощью свободной рамки

Вставка объекта с помощью свободной рамки
1. Находясь в программе Access, откройте форму или отчет в режиме кон-

структора.
2. Щелкните мышью на кнопке Unbound Object Frame (Свободная рамка

объекта) панели инструментов Toolbox (Панель элементов).
3. Разместите курсор мыши в окне формы или в окне отчета и, нажав ле-

вую кнопку мыши, задайте размер рамки, в которой будет размещена
таблица.

4. В появившемся на экране окне Microsoft Access отметьте нужный файл
и нажмите кнопку ОК.
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Вставка объекта с помощью присоединенной рамки

Объект, вставленный с помощью присоединенной рамки, добавляется в форму
или отчет как связанный объект.

Откройте таблицу в режиме конструктора. В столбце Field Name (Имя поля) вве-
дите имя поля, следуя соглашениям об именах объектов Access, а в раскрываю-
щемся списке столбца Data Type (Тип данных) выберите пункт OLE Object (Поле
объекта OLE). Сохраните таблицу и перейдите в режим таблицы, для чего правой
кнопкой мыши щелкните на заголовке окна таблицы и выберите в появившемся
контекстном меню команду Datasheet View (Режим таблицы). Теперь, находясь в ре-
жиме таблицы, посредством щелчка следует выделить ячейку, в которую будут
вставлены данные Excel, а затем вызвать команду Insert > Object (Вставка » Объ-
ект). В появившемся окне Microsoft Access нужно выбрать файл, который будет
вставлен в Access, и щелкнуть на кнопке ОК. Выделив ячейку таблицы, в которую
вставлен файл Excel, нужно вызвать команду File > Save As (Файл V Сохранить
как), в появившемся окне Save As (Сохранение), в списке As (Как), выбрать пункт
Report (Отчет) или Form (Форма), а затем указать имя сохраняемой формы или
отчета. После щелчка на кнопке ОК на экране отобразится объект Excel, вставлен-
ный в Access с помощью присоединенной рамки (рис. 13.9).
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Рис. 13.9. Таблица Excel вставленная в форму Access
с помощью присоединенной рамки
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Вставка объекта с помощью присоединенной рамки
1. Откройте таблицу в режиме конструктора.

2. В столбце Field Name (Имя поля) введите имя поля, следуя соглашени-
ям об именах объектов Access, а в раскрывающемся списке столбца Da-
ta Туре (Тип данных) выберите пункт OLE Object (Поле объекта OLE),
после чего сохраните таблицу.

3. Перейдите в режим таблицы, нажав правой кнопкой мыши на заголов-
ке окна таблицы и выбрав в появившемся контекстном меню команду
Datasheet View (Режим таблицы).

4. Выделите ячейку, в которую будут вставлены данные Excel, посредст-
вом щелчка на ней мышью, после чего вызовите команду Insert > Object
(Вставка >• Объект).

5. В открывшемся диалоговом окне Microsoft Access выберите вставляемый
в Access файл и щелкните на кнопке ОК.

6. Выделите ячейку, в которую были вставлены данные, и вызовите ко-
манду File * Save As (Файл > Сохранить как).

7. В появившемся окне Save As (Сохранение) в списке As (Как) выберите
пункт Report (Отчет) или Form (Форма), для того чтобы вставить объ-
ект, и нажмите кнопку ОК.

Обмен данными между Excel и Access посредством
программы-надстройки AccessLinks

Как уже было сказано, воспользовавшись программой-надстройкой AccessLinks,
вы сможете расширить возможности Excel за счет использования функций Access.
Наличие надстройки AccessLinks позволяет выполнять над данными Excel следую-
щие действия:

О преобразовывать списки Excel в базы данных Access;

О создавать отчеты Access на основе данных Excel;

О вводить данные Excel с помощью форм Access.

Для более ранних версий Excel указанную надстройку устанавливать не требова-
лось, так как она поставлялась вместе с программой, однако начиная с предыду-
щей версии Excel ее приходится загружать с веб-узла Microsoft.

После того как программа будет установлена, вызовите команду Tools > Add-Ins
(Сервис * Надстройки) и в появившемся окне Add-Ins (Надстройки) установите
в поле списка Add-Ins available (Доступные надстройки) флажок Microsoft Access-
Links Add-In (Надстройка AccessLinks) (рис. 13.10). После нажатия кнопки ОК в ме-
ню Data (Данные) появятся команды MS Access Form (Форма MS Access), MS Access
Report (Отчет MS Access), Convert to MS Access (Перенести в MS Access), обеспечи-
вающие возможность обмена данными между Excel и Access.
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Рис. 13.10. Диалоговое окно Add-Ins

Преобразование списка Excel в базу данных Access
Для того чтобы при работе с большими списками Excel пользоваться функциями
управления данными, защиты или многопользовательскими возможностями, пре-
доставляемыми программой Access, вы должны преобразовать список Excel в ба-
зу данных Access. Но прежде чем приступать к такому преобразованию, необходи-
мо убедиться в том, что каждый столбец имеет заголовок и содержит данные од-
ного типа. Внутри списка недопустимо наличие пустых строк или столбцов.

Установите указатель ячеек в области списка, вызовите команду Data >• Convert to
Microsoft Access (Данные > Перенести в MS Access), и на экране появится диалого-
вое окно Convert to Microsoft Access (Перенос данных в Microsoft Access), в котором
посредством выбора переключателя New database (В новой базе данных) или Exis-
ting database (В имеющейся базе данных) следует указать, в какую базу данных
Access — новую или уже существующую — должны быть помещены данные спи-
ска таблицы Excel (рис.13.11).

Convert lo Microsoft Access

т

Рис. 13.11. Диалоговое окно Convert to Microsoft Access
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После нажатия кнопки ОК будет запущена программа Access и появится первое
окно мастера импорта данных Import Spreadsheet Wizard (Импорт электронной таб-
лицы), в котором в случае установки флажка First Row Contains Column Headings (Пер-
вая строка содержит заголовки столбцов) первая строка таблицы будет использо-
вана в качестве заголовков создаваемой таблицы (рис. 13.12).
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Рис. 13.12. Первое окно мастера Import Spreadsheet Wizard

Нажав кнопку Next (Далее), вы перейдете ко второму окну мастера импорта дан-
ных, где следует установить переключатель In a New Table (в1 новой таблице) или
In an Existing Table (в существующей таблице). При выборе первого переключате-
ля будет создана новая таблица, а при выборе второго преобразуемые данные бу-
дут вставлены в существующую таблицу.

В третьем окне мастера (к нему вы перейдете, опять-таки, после щелчка на кноп-
ке Next (Далее)) в поле Reid Name (имя поля) имена полей при необходимости мож-
но изменять (рис. 13.13). Но сначала каждое такое поле следует выделить, щелк-
нув на нем мышью. В поле Indexed (индекс) указывается, будет ли отмеченное
поле индексированным. Если установлен флажок Do not import field (Skip) (не им-
портировать (пропустить) поле), то поле не будет импортировано в Access.

В следующем окне мастера посредством переключателей Let Access add primary key
(автоматически создать ключ), Choose my own primary key (определить ключ) и No
primary key (не создавать ключ) необходимо указать, каким образом будет создано
ключевое поле (автоматически или вручную) или таковое вообще будет отсутст-
вовать.

После нажатия кнопки Next (Далее) появится последнее окно мастера (рис. 13.14).
В поле Import to Table (Импорт в таблицу) этого окна вводится название создавае-
мой таблицы Access. Установка флажка I would Like a wizard to analyze my table after
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importing the data (Проанализировать таблицу после импорта данных) дает воз-
можность проанализировать созданную таблицу в окне Table Analyzer Wizard (Ана-
лиз таблиц). Если установить флажок Display Help after the wizard is finished (Вывес-
ти справку после завершения работы мастера), то на экран будет выведено окно
справки. После нажатия кнопки Finish (Готово) процесс преобразования списка
Excel в базу данных Access будет завершен.

Ш Import Spreadsheet Wizard

N

Haiisol 73 OE

Hanrol 730E

LG Flatron 77-fFT

LG Fiat-roil 77-3FT

LG FLatron F700B

(nhiii'i :

1124

74

[159

Il50

I

-.' I fed ."

Рис. 13.13. Третье окно мастера Import Spreadsheet Wizard
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Рис.13.14. Последнее окно мастера Import Spreadsheet Wizard
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Преобразование списка Excel в базу данных Access
1. Установите указатель ячеек в области списка и вызовите команду Data >

Convert to MS Access (Данные » Перенести в MS Access).

2. В появившемся окне Convert to Microsoft Access (Перенос данных в Micro-
soft Access) активизируйте переключатель New database (В новой базе
данных) или Existing database (В имеющейся базе данных), в зависимо-
сти от того, куда должны быть вставлены данные Excel, после чего на-
жмите кнопку ОК.

3. Далее следуйте указаниям мастера импорта данных Import Spreadsheet
Wizard (Импорт электронной таблицы).

Создание отчета Access на основе данных Excel
При необходимости обобщить или организовать данные Excel в виде отчета Access
также можно воспользоваться программой-надстройкой AccessLinks, позволяю-
щей создать такой отчет на основе списка Excel. Для этого нужно установить ука-
затель ячеек в области списка и задать команду Data > MS Access Report (Данные »
Отчет MS Access), с тем чтобы вызвать знакомое вам окно Convert to Microsoft
Access (Перенос данных в Microsoft Access). Укажите, где должен быть создан от-
чет — в новой базе данных или в уже существующей. Нажав кнопку ОК, вы перей-
дете к мастеру создания отчетов Report Wizard (Создание отчетов). В первом окне
мастера следует определить, какие поля будут добавлены в отчет. Для этого необ-
ходимо переместить их из списка Available Fields (Доступные поля) в список
Selected Fields (Выбранные поля), воспользовавшись кнопкой со стрелкой вправо
(рис. 13.15).

Рис. 13.15. Первое окно мастера Report Wizard
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В следующем окне мастера, которое открывается после щелчка на кнопке Next
(Далее), производится группировка данных отчета — посредством щелчков на
кнопках со стрелками.

Перейдя к третьему окну мастера, следует выполнить сортировку полей по воз-
растанию либо по убыванию значений (можно отсортировать не более четырех
полей). Появится ли в следующем, четвертом, окне мастера кнопка Summary Op-
tions (Итоги) будет зависеть от того, как вы отсортировали данные. Щелкните на
данной кнопке, для того чтобы открыть одноименное окно (рис. 13.16). В данном
окне, если это необходимо, посредством установки флажков можно произвести
дополнительные вычисления. Для того чтобы на экране отображались только ре-
зультаты вычислений, без данных таблицы, необходимо активизировать пере-
ключатель Summary Only (только итоги). После щелчка на кнопке ОК вы верне-
тесь в окно мастера.

Summary Options

What summary valuta w>ir!d у .ч ;ih-. tint;

V/g I

Рис. 13.16. Диалоговое окно Summary Options

В пятом окне мастера посредством установки соответствующих переключателей
выполняется настройка внешнего вида отчета (рис. 13.17). Чтобы задать для него
один из предлагаемых стилей, необходимо перейти к следующему окну мастера.

В последнем окне мастера нужно указать имя создаваемого отчета. При необходи-
мости просмотреть этот отчет или изменить его внешний вид следует выбрать пе-
реключатель Preview the report (Просмотреть отчет) либо Modyfi the report's design
(Изменить макет отчета). Щелкните на кнопке Finish (Готово), и отчет будет создан.

Когда отчет Access будет готов, в Excel рядом со списком данных, на основе кото-
рых он построен, появится кнопка Viwe MS Access Report (Отчет MS Access), предна-
значенная для открытия программы Access с этим отчетом.
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Repoit Wi?eird

Orientation

Рмс. 13.17. Пятое окно мастера Report Wizard

Создание отчета Access на основе данных Excel
1. Установите указатель ячеек в области списка и вызовите команду Data >

MS Access Report (Данные v Отчет MS Access).

2. В появившемся диалоговом окне Convert to Microsoft Access (Перенос
данных в Microsoft Access) активизируйте переключатель New database
(В новой базе данных) или Exsisting database (В имеющейся базе дан-
ных), указав таким образом, куда отчет должен быть помещен, и щелк-
ните на кнопке ОК.

3. Далее следуйте указаниям мастера создания отчетов Report Wizard (Соз-
дание отчетов).

Создание формы для ввода данных в Excel
Если для работы со списком Excel вам понадобится настраиваемая форма для вво-
да, поиска и удаления данных, создайте форму Access. С помощью такой формы
можно, например, вводить данные в список Excel в порядке, отличном от порядка
столбцов на рабочем листе. Кроме того, вы сможете пользоваться всеми функцио-
нальными возможностями, доступными в Access.

Установите курсор ячеек в области списка данных и вызовите команду Data > MS Ac-
cess Form (Данные > Форма MS Access), в результате выполнения которой появит-
ся первое окно мастера Form Wizard (Создание форм), идентичное первому окну
мастера создания отчетов. Установив здесь все необходимые параметры, перехо-
дите к следующему окну, в котором путем активизации соответствующего пере-
ключателя задается внешний вид формы (рис. 13.18).
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Рис. 13.18. Второе окно мастера Form Wizard

В третьем окне мастера создания форм из предложенного списка выбирается стиль
формы. А в последнем его окне, также идентичном последнему окну мастера соз-
дания отчетов, щелкнув на кнопке Finish (Готово), вы сможете увидеть результа-
ты своего труда — форму Access, созданную на основе данных Excel.

Запустите форму, щелкнув на кнопке Viwe MS Access Form (Форма MS Access), рас-
положенной рядом со списком данных Excel (рис. 13.19), на основе которого она,
эта форма, была создана. При изменении данных в форме автоматически будут из-
меняться и данные в Excel.

•
\>-

'

Рис. 13.19. Кнопка для запуска созданной формы
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Создание формы для ввода данных в Excel
1. Установите курсор ячеек в области списка данных и вызовите команду

Data > MS Access Form (Данные » Форма MS Access).

2. Далее следуйте указаниям мастера создания форм Form Wizard (Созда-
ние форм).

3. Для того чтобы открыть созданную форму, перейдите в Excel и щелк-
ните на кнопке Viwe MS Access Form (Форма MS Access), расположенной
рядом со списком данных Excel, на основе которых эта форма была по-
строена.

Перенос базы данных Access на рабочий лист Excel
Выполнив перечисленные ниже действия, вы сможете переместить базу данных
Access или какую-то ее часть на рабочий лист Excel. Откройте нужную базу дан-
ных в приложении Microsoft Access и выделите таблицу, которую необходимо пе-
реместить в Excel. Вызовите команду Tools > Offise Links > Analyze It with Microsoft Ex-
cel (Сервис » Связи с Offise > Анализ в Microsoft Excel), и Access перенесет нужную
информацию на рабочий лист с тем же названием, что и у таблицы (рис, 13.20).
Сохраните созданную таблицу в формате Microsoft Excel Workbook (Книга Microsoft
Excel).

Ш Microsoft Office Excel 2003 - Employees

IjDavolio _ INapcy ; Sales Representative - .
2IFuiier JAndrew ; Vice President. Sales I Dr

08-ГрМ968; 01-Тра-
-1952!"~ 14-Cep- i

Sales Representa|jy9

??l?s .̂ ?.P ?̂?̂ y?
Sales Manager ;MrSjBucnanan

i Michael
.J Robert

S'Calfahan Mura
9iDodsworth ;Anne

Sales Representative
Sales Regresentabye
nside Saj_es Coordinator iMs

Sales Representativ

Рис. 13.20. Таблица, перенесенная из базы данных Access
на рабочий лист
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Перенос базы данных Access
на рабочий лист Excel
1. Откройте базу данных в Access и выделите таблицу, которую необхо-

димо перенести в Excel.
2. Вызовите команду Tools > Offise Links » Analyze It with Microsoft Excel (Сер-

вис > Связи с Offise > Анализ в Microsoft Excel).

Самостоятельная работа
1. Вставьте таблицу Excel в базу данных Access, после чего отредактируйте ее.

2. Пользуясь специальной программой-надстройкой AccessLinks, создайте в Ac-
cess форму на основе списка данных Excel.

3. Запустите эту форму из программы Excel и отредактируйте с ее помощью таб-
лицу Excel.

Взаимодействие Excel 2003 и Outlook 2003

Приложение Microsoft Outlook 2003 входит в состав пакета Microsoft Office 2003.
Это эффективное средство организации совместной работы, с помощью которого
можно отправлять и получать электронные сообщения. Outlook упрощает выпол-
нение задач, связанных с управлением информацией.

В настоящем уроке мы рассмотрим такие возможности Outlook, как вложение дан-
ных Excel в электронное сообщение и связывание рабочего листа Excel с задачей
Outlook.

Вложение данных Excel
в электронное сообщение

Б электронное сообщение можно вложить как всю рабочую книгу Excel, так и от-
дельные ее части. Как это делается, рассказано ниже.

Откройте Outlook 2003 или Outlook Express. Для того чтобы вложить в сообще-
ние электронной почты файл рабочей книги целиком, необходимо в окне програм-
мы Outlook 2003 вызвать команду File > New > Mail Message (Файл > Создать > Со-
общение) или нажать комбинацию клавиш Ctrl+N. Появится окно Message (Сооб-
щение), где следует заполнить поля ввода То (Кому) и Subject (Тема) и ввести
текст сообщения (рис. 13.21). Для вложения файла рабочей книги в Excel вызо-
вите команду Insert > Insert File (Вставка > Файл), в открывшемся окне Insert File
(Вставка файла) выберите необходимый файл Excel и нажмите кнопку ОК. Под
полем Subject (Тема) появится дополнительное поле, слева от которого располо-
жена кнопка Attach (Вложить). С ее помощью к электронному сообщению можно
прикрепить дополнительные файлы.
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Рис. 13.21. Вожение файлов Excel в электронное сообщение

Вложение данных в электронное сообщение
1. Откройте Outlook 2003 и вызовите команду File > New > Mail Message

(Файл > Создать > Сообщение) или нажмите комбинацию клавиш Ctrl+N.

2. В появившемся диалоговом окне Message (Сообщение) заполните поля
ввода То (Кому) и Subject (Тема) и введите текст сообщения.

3. Вызовите команду Insert > Insert File (Вставка * Файл).

4. В открывшемся окне Insert File (Вставка файла) выберите необходи-
мый файл Excel и щелкните на кнопке ОК.

Связывание рабочего листа Excel с задачей Outlook
Задачей Outlok называется поручение личного или служебного характера, за вы-
полнением которого можно проследить. Задача может быть разовой или повто-
ряющейся.

Существует возможность связать файл рабочей книги Excel с задачей. Для этого
в программе Outlook сначала посредством вызова команды File » New v Task (Файл >
Создать > Задача) нужно открыть окно Task (Задача) и создать новую задачу.

Ш Далее нужно установить курсор в поле для ввода текста и вызвать команду
Insert t File (Вставка * Файл) или нажать кнопку Insert File (Вставка файла)

на стандартной панели инструментов, выбрать в открывшемся диалоговом окне In-
sert File (Вставка файла) нужный файл Excel и нажать кнопку Insert (Вставка).
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Вставленный файл отобразится в виде значка в текстовом поле (рис. 13.22). При
двойном щелчке мышью на этом значке откроется рабочая книга Excel, которую
можно просмотреть и отредактировать.

м-.--. .

Sodovgy otchet.xh
(15KB)

Рис. 13.22. Задача Outlook, связанная с рабочей книгой Excel

Связывание рабочего листа Excel с задачей Outlook
1. С помощью команды File > New > Task (Файл > Создать > Задача) открой-

те в программе Outlok окно Task (Задача) и создайте новую задату.

2. Установите курсор в поле ввода текста и вызовите команду Insert > File
(Вставка > Файл) или щелкните на кнопке Insert File (Вставка файла)
стандартной панели инструментов.

3. Отметьте в открывшемся окне Insert File (Вставка файла) нужный файл
Excel и щелкните на кнопке Insert (Вставка).

Самостоятельная работа
1. Выделите часть какой-либо таблицы и создайте фрагмент документа.

2. Откройте программу Outlook и вложите фрагмент в электронное сообщение.

3. Создайте в Outlook новую задачу и поместите в нее фрагмент документа.

Возможности Excel по импорту и экспорту данных

Excel поддерживает различные форматы файлов, которые используются при экс-
порте и импорте данных. Это позволяет более гибко организовать работу с данны-
ми за счет применения многих приложений.
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Приведем перечень основных форматов, поддерживаемых Excel: Microsoft Excel
2.1, 3.0,4.0 Worksheet - *.xls; Microsoft Excel 4.0 Workbook - *.xlw; Microsoft Ex-
cel 5.0/95 - * jds, *.xlt); Microsoft Excel 97-Excel 11& 5.0/95 Workbook - *.xls, *.xlt;
Formatted Text (Space delimited) - *.prn; Text (Tab delimited), Unicode Text и Text
(MS-DOS) - *.txt; CSV - *.csv; DIP - *.dif, DBF2,3,4 - *.dbf; SYLK - *.slk.

Открытие в Excel файлов в других форматах
В Excel существует возможность открывать файлы, сохраненные в других форма-
тах (см. предыдущий раздел). Делается это следующим образом. Сначала нужно
вызвать команду File > Open (Файл * Открыть) и в появившемся диалоговом окне
Open (Открытие документа), в списке Files of type (Тип файлов), сначала указать
тип файла, который необходимо открыть, а затем выбрать его имя и щелкнуть на
кнопке Open (Открыть) (рис. 13.23)
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Рис. 13.23. Диалоговое окно Open

Открытие в Excel файлов других форматов
1. Вызовите команду File t Open (Файл > Открыть).
2. В списке Files of type (Тип файлов) появившегося окна Open (Открытие

документа) укажите тип открываемого файла.

3. Отметьте имя этого файла и щелкните на кнопке Open (Открыть).
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Импорт данных
.

В Excel импорт данных из большинства источников производится посредством
команды Data > Import External Data > Import Data (Данные > Импорт внешних дан-
ных > Импортировать данные). Вызовите эту команду, а затем в диалоговом окне
Select Data Source (Выбор источника данных) укажите, какие данные должны быть
импортированы, и нажмите кнопку Open (Открыть) (рис. 13.24).

Select Data Source

MSN MoneyCentrd Investor Major tnocies
MSN MorieyCentral tnvestor stock Quotes

Рис. 13.24. Диалоговое окно Select Data Source

Мастер подключения данных Data Connection Wizard (Мастер подключения данных),
запускающийся при нажатии в диалоговом окне Select Data Source (Выбор источ-
ника данных) кнопки New Source (Создать), позволяет импортировать данные из
внешних источников, недоступных из диалогового окна Select Data Source (Выбор
источника данных). Это могут быть источники данных OLE DB (включая служ-
бы OLAP и серверы обмена) и любые иные источники, поставляемые системным
администратором. С помощью мастера подключения данные невозможно ни от-
фильтровать, ни объединить.

По умолчанию при импорте данных с помощью мастера подключения соединение
устанавливается через поставщиков OLE DB. Создаваемые при этом ODC-файлы
можно открыть для просмотра в обозревателе Microsoft Internet Explorer, а для
их редактирования следует использовать Excel.

^ПРИМЕЧАНИЕ Импортировать внешние данные в Excel можно лишь при наличии доступа
к ним. Если внешний источник данных находится на другом компьютере, воз-
можно, понадобится получить у администратора внешней базы данных па-
роль, право доступа или сведения, требующиеся для доступа к базе данных.
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Импорт данных
1. Вызовите команду Data > Import External Data > Import Data (Данные f Им-

порт внешних данных > Импортировать данные).

2. В открывшемся диалоговом окне Select Data Source (Выбор источника
данных) отметьте данные, которые требуется импортировать, и щелкни-
те на кнопке Open (Открыть).

ИЛИ

Если необходимо импортировать данные внешних источников, недос-
тупных из диалогового окна Select Data Source (Выбор источника дан-
ных), щелкните в этом окне на кнопке New Source (Создать).

3. Далее следуйте указаниям мастера подключения данных Data Connec-
tion Wizard (Мастер подключения данных).

Экспорт данных
Экспортирование Excel-файлов в другие программы происходит приблизительно
по той же схеме, что и импортирование файлов других форматов, за исключением
того, что вместо команды File > Open (Файл > Открыть) вызывается команда File V
Save As (Файл > Сохранить как). В диалоговом окне Save As (Сохранение докумен-
та) (рис, 13.25) нужно выбрать тип сохраняемого файла в списке Save as type (Тип
файлов), диск и папку, в которой этот файл будет сохранен, ввести имя файла и на-
жать кнопку Save (Сохранить).

^Контроль объема
*Э Копия Процессоры

&Р1С11П

^Russian
1пя главы 2
ten рис к 11

Опеределки

т за 2-е полугодие
^Погода
^Погода!
S Примерчик
^Процессоры
Ш Процессоры 1

тчет эа 2-н полугодие

Tsit (Tab delimited)
LVifcoda Ten

Microsoft Excel 37- Excel 11 Beta a 5.0,45 Workbook
CSV (Comma delimited)
Microsoft Excel 4.0 Worksheet

Рис. 13.25. Диалоговое окно Save As
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При экспортировании файлов Excel может использовать конверторы и графиче-
ские фильтры. Все фильтры и конверторы, установленные в программе, а также
расширения, присваиваемые именам файлов, перечислены в списке форматов
Save as type (Тип файлов).

Большинство из поставляемых с Excel конвертеров и графических фильтров по-
зволяют сохранять только активный лист рабочей книги. Если книга состоит из
нескольких рабочих листов, каждый лист, предназначенный для экспортирова-
ния, следует сохранить в отдельном файле.

Исключение из этого правила возможно лишь при экспорте файлов Excel в HTML-
формат. В этом случае (при выборе в списке форматов элемента Web Page (веб-ар-
хив)) можно указать, что будет экспортироваться — рабочий лист или целая кни-
га Excel.

1 ПРИМЕЧАНИЕ Excel преобразует свои «родные» файлы в документы формата XML. Этот стан-
дарт обладает бол ее широкими возможностями, чем HTML. Многие приложе-
ния позволяют экспортировать свои файлы в различные веб-форматы, то есть
в такие, которые воспринимаются браузерами.

Если программе не удается конвертировать экспортируемые данные, на экране по-
является сообщение об ошибке, содержащее адрес ячейки, в которой она была об-
наружена. Вносить изменения в процессе конвертирования нельзя, поэтому следу-
ет сначала устранить ошибку, а затем начать процесс конвертирования сначала.

При полной инсталляции программы конверторы и графические фильтры поме-
щаются в лапку Excel автоматически. В случае применения пользовательского
сценария инсталляции компонент, который содержит фильтр, может быть удален.
Если этот компонент необходим для последующей работы, его следует устано-
вить, запустив процесс инсталляции.

Экспорт данных
1. Вызовите команду File > Save As (Файл » Сохранить как).
2. В появившемся диалоговом окне Save As (Сохранение документа) вы-

берите тип сохраняемого файла в списке files of type (Тип файлов),
диск и папку, в которой файл будет содержаться, введите имя файла и
щелкните яа кнопке Save (Сохранить).

Самостоятельная работа
1. Сохраните какой-либо документ с расширением .txt в программе Word, после

чего откройте его в Excel.

2. Теперь выполните обратные действия: сохраните таблицу Excel с расширени-
ем .txt и откройте этот файл в программе Word.

3. Воспользовавшись мастером Data Connection Wizard (Мастер подключения дан-
ных), импортируйте в Excel внешние данные.
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Совместное использование файлов Microsoft Excel

К файлам и папкам, хранящимся на компьютере, в локальной сети или в Интер-
нете, можно предоставлять общий доступ. Делается это по-разному, в зависимо-
сти от того, кому требуется предоставить доступ, а также от того, с какого компь-
ютера другой пользователь будет обращаться к файлам,

Совместное использование файлов на одном компьютере
Если на одном компьютере работают несколько пользователей, то файлы, к кото-
рым требуется предоставить доступ, как правило, помещаются в папку Shared docu-
ments (Общие документы). Файлы, хранящиеся в этой папке и ее подпапках, все-
гда доступны другим пользователям данного компьютера.

(ПРИМЕЧАНИЕ На компьютере, подключенном к сетевому домену, папка Shared documents
(Общие документы) недоступна.

Совместное использование файлов в одной сети
В локальной сети папка, которая расположена на одном из компьютеров, может
быть доступной всем пользователям. Но вы, конечно же, можете запретить (или
разрешить) другим пользователям изменять файлы в общей папке. Для этого нуж-
но щелкнуть на этой папке правой кнопкой мыши, выбрать в появившемся кон-
текстном меню команду Properties (Свойства), в диалоговом окне Source Properties
(Свойства) перейти на вкладку Sharing (Доступ), активизировать переключатель
Share this folder (Открыть общий доступ к этой папке), после чего установить все
необходимые параметры (рис. 13.26).

Source Properties

„.,,« ,„, ',iVi.n., ;>.. >,!,, V [; ' ИГ

.

t\ .; r^u'-ii- ! ••• i.i ,r ,. № '

Рис. 13.26. Диалоговое окно Source Properties
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Совместное использование файлов в одной сети
1, Щелкните правой кнопкой мыши на папке, для которой хотите устано-

вить общий доступ, и выберите в появившемся контекстном меню ко-
манду Properties (Свойства).

2. В открывшемся диалоговом окне Source Properties (Свойства) перейди-
те на вкладку Sharing (Доступ), активизируйте переключатель Share this
folder (Открыть общий доступ к этой папке) и установите нужные па-
раметры.

Доступ к файлам посредством Интернета
Чтобы предоставить доступ к файлам через Интернет, необходимо опубликовать
эти файлы в сети, воспользовавшись услугами мастера веб-публикаций. Эти фай-
лы должны храниться в частной сетевой папке, управляемой ее владельцем. Но
вы можете скопировать их, а также папки, в которых они хранятся, в личную пап-
ку, расположенную в сети Microsoft Network (MSN).

Для получения доступа к файлам, которые помещены в сетевую папку, необходи-
мо предъявить свой паспорт Net. Passport (Net. Паспорт), обеспечивающий персо-
нальный доступ к хранилищу файлов в MSN и другим службам, а также к ряду
веб-узлов, с помощью адреса электронной почты пользователя. Откройте папку
My computer (Мой компьютер), отметьте в ней документ, который необходимо
опубликовать, и выделите его, один раз щелкнув кнопкой мыши. В группе File and
Folder Tasks (Типичные задачи для файлов и папок), которая находится в левой
части окна, активизируйте ссылку Publish this file to the Web (Опубликовать файл
в вебе), а далее следуйте инструкциям мастера веб-публикаций.

Доступ к файлам посредством Интернета
1. Откройте папку My computer (Мой компьютер).
2. Найдите документ, который необходимо опубликовать, и выделите его,

один раз щелкнув кнопкой мыши.

3. В группе File and Folder Tasks (Типичные задачи для файлов и папок),
активизируйте ссылку Publ ish this file to the Web (Опубликовать файл
в вебе).

4. Далее следуйте инструкциям мастера веб-публикаций.

Самостоятельная работа
1. Сделайте так, чтобы все пользователи сети имели доступ к определенным

файлам.

2. Сделайте доступной для всех пользователей сети какую-либо папку.

3. Опубликуйте файлы в Интернете.
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Подведение итогов
В этом уроке мы научились:

О использовать буфер обмена для обмена данными;

О связывать и внедрять данные;
О использовать прогрумму-надстройку для обмена данными между программами

Excel и Access;

О вкладывать данные Excel в электронные сообщения;

О связывать рабочий лист Excel с программой Outlook;

О импортировать и экспортировать данные;

О совместно использовать файлы Excel.



Интернет-технологии
в Excel

О Отправка рабочей книги
по электронной почте

П Маршрутизация сообщений

О Работа в сети

П Обмен данными с FTP-узлами

О Публикация рабочей книги
в Интернете
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Постоянное совершенствование систем коммуникаций, повсеместное объедине-
ние компьютеров в корпоративные сети и их подключение к Интернету стимули-
руют развитие технологий обмена данными. Теперь становится необходимым, что-
бы средства для доступа к удаленным источникам данных и для коллективной
работы пользователей над одним проектом или документом входили в состав са-
мых различных программ. На этом уроке рассказывается о средствах, которые вхо-
дят в состав приложения Microsoft Excel 2003.

Обмен документами с помощью электронной почты

Используя последнюю версию Microsoft Excel и одну из программ электронной
почты (Microsoft Exchange, Microsoft Mail, Microsoft Outlook, Microsoft Outlook
Express и др.), можно производить оперативную рассылку документов. При этом
существует возможность направить документ всем адресатам одновременно или
послать его поочередно нескольким из них.

Отправка сообщений
Для того чтобы отправить файл Excel по электронной почте, факсу или в качест-
ве списка рассылки, совершенно не обязательно переключаться между приложе-
ниями. Достаточно выполнить команду File > Send To » Mail Recipient (Файл » Отпра-
вить > Сообщение) и в открывшемся окне E-mail (Электронная почта), показан-
ном на рис. 14.1, выбрать вариант дальнейших действий: Send the entire workbook as
an attachment (Отправить всю книгу как вложение) или Send the current sheet as the
message body (Включить текущий лист в текст сообщения).

Send the a-nent Ф< i4 х- >Jv iTif.-^s,v|f >-»iy

J f since!

Рис. 14Л. Диалоговое окно E-mail

Отправка рабочей книги как вложения

Если вы выберете в окне E-mail (Электронная почта) переключатель Send the enti-
re workbook as an attachment (Отправить всю книгу как вложение), то получите та-
кой же результат, как после выполнения команды File > Send to > Mail Recipient (as
Attachment) (Файл > Отправить > Сообщение (как вложенное)). Например, при ис-
пользовании Microsoft Outlook Express для отправки рабочей книги Price (Цены)
это будет выглядеть, как показано на рис. 14.2.

14 Зак. 345
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р price.*!* - Meswcje (HTML)

Рис. 14.2. Окно сообщения при отправке файла Excel

О порядке заполнения полей этого окна мы расскажем ниже, а пока отметим осо-
бенности выбранного способа отправки сообщений.

О Файл рабочей книги уже присоединен как вложение в отдельном окне сообще-
ния (что не мешает дополнительно вставить в это же сообщение еще несколь-
ко файлов).

О Поле Subject (Тема) содержит имя файла, отправляемого как вложение. При
желании значение данного поля можно изменить.

О Текст сообщения пока отсутствует, его вы будете вводить сами.

О Для отправки документа используется кнопка Send (Отправить), расположен-
ная на панели инструментов окна сообщения.

О В качестве формата текста сообщения будет принят формат сообщения, исполь-
зуемый по умолчанию.

Совершенно иначе производится отправка сообщения с открытым листом Excel,
включенным в текст сообщения,

Включение текущего листа рабочей книги Excel в текст сообщения

Выбор переключателя Send the currentsheet as the message body (Включить текущий
лист в текст сообщения) в окне E-maiL (Электронная почта) приведет к тому же
результату, что и щелчок на кнопке E-mail (Электронная почта) на панели инст-
рументов Standard (Стандартная). При этом произойдет переход в режим электрон-
ной почты и изменится вид окна Microsoft Excel (рис. 14.3).
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Рис. 14.3. Окно Excel при отправке текущего листа как текст сообщения

Перечислим особенности этого способа отправки сообщения.

О До самого момента отправки можно выполнять все допустимые в Excel дейст-
вия: работать с формулами, строить диаграммы, вставлять и переименовывать
листы и т. д.

О Поле Subject (Тема) по умолчанию является пустым.

О Посредством кнопки Insert File (Добавить файл), отображаемой на панели в ви-
де скрепки, в подготавливаемое сообщение можно добавлять другие файлы
как вложения.

О Для отправки сообщения используется кнопка Send this Sheet (Отправить лист),
которая расположена на панели инструментов электронного сообщения. При
этом в сообщение будет включено только содержимое активного листа.

О Send this Sheet,

О Отправляемое сообщение будет представлено в формате HTML.

Заполнение полей адресатов сообщения
При отправке сообщений с помощью электронной почты или факса поле То (Ко-
му) должно содержать как минимум один адрес. Однако в окне сообщения име-
ются еще и поля для указания адресатов, которым направляются копии.
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Чтобы заполнить (изменить) все или одно из полей адресов, указываемых в сооб-
щении и имеющихся в вашей адресной книге либо в разделе с информацией о кон-
тактах (в зависимости от используемого приложения), выполните действия пере-
численные ниже.

Заполнение полей адресатов сообщения

1. Щелкните на значке рядом с названием нужного поля, после чего на эк-
ран будет выведено окно Select Names (Выбор имен), представленное на
рис. 14.4.

2. Если потребуется создать новый адрес (контакт), щелкните на кнопке
Advanced (Дополнительно) и в открывшемся меню выберите команду
New (Создать). После того как отобразится окно Entry (Новая запись),
выберите элемент New Contact (Новый контакт) и щелкните на кнопке
ОК. Затем в открывшемся окне заполните необходимые поля и верни-
тесь в диалоговое окно Select Names (Выбор имен).

3. Выделите имена адресатов и нажмите кнопку То (Кому).

4. Если нужно послать копии, выделите имена их получателей и щелкни-
те на кнопке СС (Копия).

5. В случае необходимости отправить скрытые копии выделите имена их
адресатов и нажмите кнопку Вес (СК).

6. Для подтверждения сделанного выбора щелкните на кнопке ОК,

Ronddo(ronald0®5rea.., ronaldo@ireal.com
Zidane (zidane@real.c,.. z id sneered, com

g «Jj= If ж! {Qnopko fopopkoiasuperplayer.neO:
"-—""̂  i , . •• • >: - - - • - - '-••

Рис. 14.4. Окно Select Names
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Чтобы просмотреть свойства адреса или контакта, можно щелкнуть на кнопке Ad-
vanced (Дополнительно) в окне Select Names (Выбор имен) и выбрать в открыв-
шемся меню команду Properties (Свойства).

Маршрутизация сообщения
Продукты Microsoft Office 2003 поддерживают функции электронного докумен-
тооборота, в частности маршрутизацию. Предположим, что вам требуется создать
шаблон сводки о деятельности фирмы за определенный период, после чего этот
шаблон должны по очереди заполнить представители всех отделов, а затем его
необходимо передать директору. При решении такой задачи можно использовать
средства Microsoft Excel.

План выполнения задачи включает следующие пункты: создание шаблона, опре-
деление списка рассылки, отправка рабочей книги, содержащей шаблон, по элек-
тронной почте. Допустим, что первый пункт плана вами уже выполнен. Теперь не-
обходимо задать список рассылки.

Задание списка рассылки
1. Активизируйте команду File > Send To > Routing Recipient (Файл > Отпра-

вить > По маршруту), с помощью которой формируется список рассыл-
ки, и на экране отобразится диалоговое окно Routing Slip (Маршрут),
показанное на рис. 14.5.

2. Щелкните на кнопке Address (Адрес), после чего на экране появится диа-
логовое окно Address book (Адресная книга).

3. Посредством кнопки То (Кому) переместите в список получателей со-
общения имена всех тех, кому оно предназначено.

4. Щелкните на кнопке ОК. Вновь откроется окно Routing Slip (Маршрут),
причем список получателей в нем будет уже заполнен.

5. Если это необходимо, можно изменить порядок рассылки сообщения.
Для этого выделите имя адресата в списке и переопределите последо-
вательность рассылки, воспользовавшись кнопками Move (Порядок).

6. В нижней части окна расположен блок переключателей Route to recipi-
ents (Порядок рассылки). Если требуется, чтобы все адресаты получи-
ли сообщение одновременно, установите переключатель в положение
ALL at once (всем сразу), в противном случае выберите положение One after
another (по очереди), и документ будет доставлен адресатам по очереди.

7. Если вы установите флажок Return when done (Возврат по окончании),
то сообщите Excel, что после просмотра и внесения исправлений в до-
кумент всеми адресатами его необходимо вернуть обратно.

8. Установив флажок Track status (Отслеживать состояние), у вас появит-
ся возможность непрерывно следить за дальнейшей рассылкой доку-
мента, получая электронные уведомления.

9. Выполните все необходимые настройки и щелкните на кнопке Add SLip
(Добавить маршрут).
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Рис. 14.5. Диалоговое окно Routing Slip

Теперь к документу присоединен список рассылки (маршрут). На следующем эта-
пе нам необходимо отправить документ по указанному маршруту.

Отправка документа по заданному маршруту
1. Выберите команду File > Message > Next recipient (Файл > Отправить >

Следующий адресат).
2. В открывшемся диалоговом окне выберите положение переключателя

Route document to (Направить документ). (Если вы установите данный
переключатель в положение Send copy of document without using the rou-
ting slip (Послать копию документа, не используя маршрутный лист),
то программа вместо того, чтобы отослать документ очередному адре-
сату маршрута, отобразит окно выбора следующего адресата, где мож-
но указать любой адрес независимо от маршрута.)

3. Щелкните на кнопке ОК.

Самостоятельная работа
1. Создайте рабочую книгу с таблицами и диаграммами.

2. Отправьте первый рабочий лист книги как часть сообщения электронной поч-
ты одному адресату.

3. Перешлите эту рабочую книгу как вложение по электронной почте другому
адресату.

4. Создайте список рассылки и в соответствии с ним отправьте рабочую книгу
нескольким адресатам.
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Работа с файлами в сети
В данном разделе содержатся основные сведения о работе с файлами в Интернете
или в корпоративной сети. Для такой работы в Microsoft Excel 2003 предназначе-
на встроенная панель инструментов Web (Веб-узел).

Панель инструментов Web
Активизируйте команду View * Toolbars * Web (Вид > Панели инструментов * Веб-
узел), и на экране отобразится панель инструментов Web (Веб-узел), показанная
на рис. 14.6.

Рис. 14, б. Панель инструментов Web

Элементы управления этой панели и их описание приведены в табл. 14.1.

Таблица 14.1. Назначение элементов управления панели Web

Элемент Команда
управления

Описание

Favorites

Bookl

Back
(Назад)

Forward
(Далее)

Stop
(Остановить)

Refresh
(Обновить)

Start page
(Начальная страница)

Search
(Найти в Интернете)

Favorites
(Избранное)

Goto
(Переход)

Show Only Web Toolbar
(Отображать только
веб-панель)

URL
(Адрес)

Возврат к предыдущей веб-странице

Переход к следующей веб-странице

Остановка загрузки веб-страницы

Обновление веб-страницы

Переход на домашнюю веб-страницу

Поиск в Интернете

Список избранных ресурсов

Переход вперед, назад, на начальную
веб-страницу и т. п.

Сокрытие всех отображаемых панелей
инструментов, кроме самой панели Web

Строка с URL веб-страницы
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Запуск браузера посредством панели Web
С помощью панели инструментов Web (Веб-узел) браузер можно запустить сле-
дующими способами:
О нажать кнопку Start page (Начальная страница) для загрузки начальной стра-

ницы;
О щелкнуть на кнопке Search (Найти в Интернете), чтобы перейти на страницу

поиска Microsoft;

О выбрать элемент списка Favorites (Избранное);

О ввести URL нужного документа в поле адреса.

Перемещение между веб-страницами
Панель инструментов Web (Веб-узел) для перемещения между веб-страницами
(документами) предоставляет несколько возможностей:

О можно переходить от одной веб-страницы к другой, используя приемы, обыч-
но применяемые в браузерах;

О допускается перемещение между различными документами одного приложе-
ния или документами разных приложений;

О можно добавить в список Favorites (Избранное) наиболее часто используемые
веб-страницы (документы), повысив тем самым скорость обращения к ним.

Открытие рабочей книги в Интернете
или в корпоративной сети

Работая с.Microsoft Excel 2003, вы можете открывать рабочие книги в корпора-
тивной сети или на узлах сети Интернет — конечно, при условии, что компьютер
подключен к необходимой сети.

Существует два способа открытия файла документа: посредством команды Open
(Открыть) меню File (Файл) и с помощью инструмента панели Web (Веб-узел).
Рассмотрим второй из них.

Введите полный путь к открываемому файлу в поле Address (Адрес) панели инст-
рументов Web (Веб-узел), скажем такой:

http://www.magazin.ru/price.xls

или такой:

f11е://work/manager/examplе.xls

или такой:

D:\pricol\price.xls

и нажмите клавишу Enter.

Занесение открытого файла в список избранных файлов
При работе с Microsoft Excel часто возникает необходимость занести открытый
файл в палку Favorites (Избранное). Перечислим несколько таких ситуаций: рабо-
чая книга часто используется при расчетах или анализе; текущий лист содержит
открытую в Интернете страницу; в текущем листе существует ссылка на документ,
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хранящийся на данном компьютере, в сети Интернет или корпоративной сети ва-
шей организации. Чтобы каждый раз не вводить адрес для доступа к этой книге,
занесите ее в список избранных файлов.

Занесение открытого файла в список избранных файлов
1. Активизируйте команду Favorites > Add to Favorites (Избранное > Помес-

тить в папку Избранное) панели инструментов Web (Веб-узел).

2. Укажите необходимые подкаталог и имя файла, а затем нажмите кноп-
ку Add (Добавить).

Теперь можно быстро открыть файл, воспользовавшись одной из трех команд:

О File > Open (Файл к Открыть) - в открывшемся диалоговом окне Open (Откры-
тие документа) нажать кнопку Favorites (Избранное) на панели в левой части
окна, найти ярлык нужного файла в папке и произвести на нем двойной щел-
чок или нажать кнопку Open (Открыть);

О Favorites > Open Favorites (Избранное > Открыть папку Избранное) панели инст-
рументов Web (Веб-узел) — в открывшемся диалоговом окне найти ярлык
файла и дважды щелкнуть на нем или нажать кнопку Open (Открыть);

О соответствующей командой меню Favorites (Избранное) панели инструментов
Web (Веб-узел) — в открывшемся меню, последовательно выбирая папки, доб-
раться до нужного ярлыка и активизировать его.

Повторное открытие веб-файлов в одном сеансе работы
Чтобы открыть файлы, уже просмотренные в данном сеансе работы в сети, ис-
пользуйте кнопки панели инструментов Web (Веб-узел) — Back (Назад) и Forward
(Далее) с изображением стрелки, направленной влево и вправо соответственно.

Обмен данными с РТР-узлами
Если ваш компьютер подключен к корпоративной сети или к Интернету, можно
организовать обмен документами по протоколу FTP. Этот протокол позволяет об-
мениваться документами с удаленным компьютером, называемым РТР-узлом
или FTP-сервером. В отличие от обмена данными посредством электронной поч-
ты, обмен данными по протоколу FTP производится в обоих направлениях.

Для пересылки файлов необходимо предварительно установить связь с удаленным
компьютером (он должен находиться в состоянии готовности) и зарегистриро-
ваться на FTP-узле, для того чтобы получить к нему доступ. Все зарегистриро-
ванные пользователи имеют пароль, который необходимо указать для установле-
ния соединения.

Добавление адреса FTP-узла в список доступных узлов

Итак, для обмена данными по протоколу FTP необходимо знать:
О адрес FTP-узла;
О имя, под которым вы зарегистрированы на нем;
О пароль для установления соединения.
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1ПРИМЕЧАНИЕ Из этого правила есть исключение. Пользователь с именем anonymous ука-
зывает в качестве пароля (если таковой запрашивается) свой адрес элек-
тронной почты. Но такой пользователь может получить доступ только к опре-
деленному каталогу,

Добавление адреса FTP-узла в список доступных узлов
1. Активизируйте команду Open (Открыть) меню File (Файл).

2. В списке Look in (Папка) отобразившегося диалогового окна Open (От-
крытие документа) выберите элемент Add/Modify FTP locations (Доба-
вить/изменить адреса FTP).

3. В открывшемся одноименном диалоговом окне (рис. 14.7), в поле Name
of FTP site (Имя узла FTP) укажите адрес FTP-узла..

4. Если вы зарегистрированы на данном FTP-узле, выберите переключа-
тель User (под именем) и в расположенном рядом поле укажите свое
регистрационное имя, В противном случае активизируйте переключа-
тель Anonimus (в режиме анонимного доступа), но учтите, что пользо-
вателю с таким именем разрешен доступ не на каждый FTP-узел.

5. В поле Password (Пароль) введите пароль для установления соединения.
Если этого не сделать, то придется вводить пароль при каждом соеди-
нении с FTP-узлом.

6. Когда все необходимые параметры будут заданы, щелкните на кнопке
Add (Добавить).

A'ld/Modify FTP Location*

Рис. 14.7. Диалоговое окно Add/Modify FTP locations
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Запись и открытие рабочей книги на РТР-узле
После добавления адреса FTP-узла в список доступных узлов на него можно по-
местить рабочую книгу, а потом открыть ее.

Запись рабочей книги на РТР-узел
1. Используя команду Save As (Сохранить как) меню File (Файл), открой-

те диалоговое окно Save As (Сохранение документа).
2. В поде списка Save in (Папка) выберите элемент FTP Locations (Адреса

FTP), и в окне откроется список адресов FTP-узла (рис. 14.8).

3. Выполните двойной щелчок на необходимом адресе, после чего начнет-
ся процесс установления соединения. По его завершении отобразится
окно с перечнем папок FTP-сервера.

4. Выберите папку для сохранения книги и щелкните на кнопке Save (Со-
хранить).

:-,J i ' •- FTP Locations
..„-w.--..;.,.,....,..,,-,..̂ ,....., .... *ij

lftp:y/10.7.2.1

^ftp://ftp.microsoft.com

||вооК1.х1Г

Save a* t̂ ||M!troscf t Of f te Excel Wcrtoook (*.xls)

Рис. 14.8. Диалоговое окно Save As со списком FTP-узлов

Открытие рабочей книги на РТР-узле
1. Вызовите из меню File (Файл) команду Open (Открыть).

2. Выберите в поле списка Look in (Папка) элемент FTP Locations (Адреса
FTP) и укажите FTP-сервер, на котором хранится нужная книга.

3. После установления соединения отобразится список доступных палок.
Откройте ту из них, в которой находится документ, и выберите в спи-
ске необходимый файл.
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Удаление адреса узла из списка доступных РТР-узлов
Если используемый FTP-узел вам больше не понадобится, можете его удалить из
списка доступных узлов.

Удаление адреса узла из списка доступных РТР-узлов
1. Выберите команду Open (Открыть) меню File (Файл).
2. В списке Look in (Папка) открывшегося окна (рис. 14.9) выберите эле-

мент FTP Locations (Адреса FTP).
3. Выделите адрес узла, подлежащего удалению, и щелкните на нем пра-

вой кнопкой мыши.
4. В контекстном меню выполните команду Remove (Удалить).

|.-д ..Ч':

gAdd/Mcdfv FTP Locations

jftp: //bhv-iigmaln

шявиддвшг

в| JAII Ntoosrft Office Excel Files (*.яР; *.xb; *. A; *.htm,

Рис. 14.9. Удаление адреса узла FTP из списка узлов

Публикация данных в Интернете средствами Excel
Для осуществления обмена данными с использованием одного из рассмотренных
выше способов необходимо, чтобы участники процесса применяли либо Excel, ли-
бо другое приложение, поддерживающее технологию OLE. Но можно поступить
иначе: представить документ в таком формате, чтобы его смогли прочесть сразу все
(или почти все) пользователи Интернета. Для этого следует воспользоваться язы-
ком HTML, имеющим средства описания встроенных гипертекстовых ссылок.
Именно этот язык применяется при создании веб-страниц, то есть документов,
доступ к которым осуществляется по Веб.

Документ, созданный с помощью Excel, можно преобразовать в веб-документ. Од-
нако учтите, поскольку Excel 2003 предоставляет более широкие возможности
для форматирования документов, чем язык HTML, при сохранении документа
в HTML-формате некоторые параметры форматирования могут быть потеряны
или изменены.
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Возможность сохранять документ в формате HTML появилась в виде надстройки
к Microsoft Office 7.0, а в редакции версии 8.0 она была уже оформлена как встро-
енное средство. Эта функция была оценена по достоинству, поскольку отпала не-
обходимость изучать язык HTML и HTML-редакторы либо иметь в штате со-
трудника, занимающегося написанием HTML-кодов, да и вообще дублировать
данные в документах и на веб-сервере. Конечно, создать полноценный веб-узел
только средствами Excel 2003 невозможно, однако значительно упростить работу
вполне реально.

Сохранение документа в HTML-формате
В Excel 2002 и 2003 изменилось поведение документов, экспортированных в фор-
мат HTML, по сравнению с более ранними версиями программы.

Во-первых, подобный экспорт осуществляется встроенным в Excel (как, впрочем,
и во все другие приложения Microsoft Office) средством, а не с помощью внешней
надстройки.

Во-вторых, теперь Excel «понимает» формат HTML: сохранив свою рабочую кни-
гу в формате веб-страницы для просмотра с помощью браузера, вы можете затем
вернуться к этому HTML-файлу и отредактировать его в Excel, используя все дос-
тупные в программе инструменты. Замечательно и то, что утерянные при экспор-
те параметры (например, символы структуры таблицы) восстановятся в полном
объеме, и с рабочими листами можно будет работать, как прежде.

В-третьих, благодаря использованию веб-компонентов Excel появилась возмож-
ность публиковать на веб-страницах интерактивные элементы: таблицы, диаграм-
мы и сводные таблицы. Это позволяет без использования самого Excel, находясь
в браузере, выполнять расчеты, отображать диаграммы и зависимости между ячей-
ками, а также проводить сложный анализ.

Сохранение документа в HTML-формате
1. Выберите команду File > Save as Web Page (Файл > Сохранить как веб-

страницу). Отобразится диалоговое окно Save as (Сохранение докумен-
та), показанное на рис, 14.10.

2. Стандартным способом выберите папку и укажите, какое имя нужно
присвоить файлу, содержащему документ.

3. Щелкните на кнопке Change Title (Изменить). Откроется представлен-
ное на рис. 14.11 диалоговое окно Set Page Title (Задание заголовка).

4. Введите заголовок веб-страницы, который при просмотре будет отобра-
жаться в заголовке браузера. Щелкните на кнопке ОК в диалоговом ок-
не Set Page Title (Задание заголовка).

5. Выберите объект публикации, установив переключатель Save (Сохра-
нить) в положение Entire Workbook (Всю книгу) или Selection:List (выде-
ленное: Лист).

6. Щелкните на кнопке Save (Сохранить).
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My Data Sou cw

. _. ftf Pictures
IJMy Web Sites
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Рис. 14.10. Сохранение документа в формате HTML

Рис, 14.11. Диалоговое окно Set Page Title

Статическая публикация рабочей книги
Книгу в HTML-формате можно сохранять в виде статической страницы, не обла-
дающей возможностью обновления данных, ввода и вычисления в таблицах.

При последующем открытии такого документа в нем ничего не изменится, но в за-
головке появится новое расширение файла и, может быть, другое название. Excel
отобразит все свои элементы, панели инструментов, сетку, строку формул и т. д.,
все функции и элементы управления будут работать по-прежнему.

Однако если вы откроете данную веб-страницу в браузере, то не обнаружите мно-
гих элементов интерфейса: панелей инструментов, заголовков строк и столбцов,
линий сетки и др., а некоторые из них (например, ярлычки листов) изменят свой
внешний вид. Строки, столбцы, листы, скрытые в Excel, не будут отображаться
и в браузере. При обращении к папке вновь опубликованной веб-страницы, где на-
ходится ее файл, вы обнаружите новый каталог с именем <имя веб-стран ицы>_
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в котором находятся вспомогательные файлы. Например, для веб-страницы имя
каталога price.htm будет записано как price_fUes.htm.

Публикация отдельных элементов рабочей книги

На веб-странице можно опубликовать не только всю книгу, но и ее отдельные эле-
менты (например, листы, диапазоны, ячейки и т. п).

Публикация отдельных элементов рабочей книги
1. Выделите в Excel интересующий вас объект — рабочий лист, диапазон

ячеек, диаграмму или сводную таблицу.

2. Выберите команду File > Save as Web Page (Файл t Сохранить как веб-
страницу). Откроется диалоговое окно Save As (Сохранение документа).

3. Щелкните на папке, в которой нужно сохранить документ.

4. Установите переключатель группы Save (Сохранить) с учетом объекта
публикации (например, Selection: Sheet (выделенное; Лист), если выде-
ленным объектом является лист рабочей книги).

5. Нажмите кнопку Publish (Опубликовать), после чего отобразится пока-
занное на рис. 14.12 диалоговое окно Publish as Web Page (Публикация
веб-страницы).

6. Используя список Choose (Выбрать) группы Item to publish (Публикуе-
мые элементы), выделите те части выделенного фрагмента рабочей кни-
ги, которые нужно опубликовать.

7. Если необходимо поддерживать связь с базой данных или рабочей кни-
гой Excel либо создать интерактивный документ, установите флажок
Add interactivity with (Добавить) и выберите нужный вариант связи с по-
мощью списка группы Viewing options (Параметры просмотра). При
сброшенном флажке документ будет опубликован как статическая
страница без интерактивных возможностей.

8. Нажмите кнопку Change (Изменить) для добавления в диалоговом ок-
не Set Page Title (Задание заголовка) заголовка таблицы, отображаемого
в заголовке браузера.

9. Убедитесь, что путь к публикуемой странице введен верно. В против-
ном случае измените его в поле File name (Имя файла) или воспользуй-
тесь кнопкой Browse (Обзор).

10. Если сохраненный документ нужно открыть в отдельном окне браузе-
ра сразу после публикации, установите флажок Open published web page
in the browser (Открыть страницу в браузере).

11. Щелкните на кнопке Publish (Опубликовать).

Этот способ публикации позволяет создавать веб-страницы, не привязанные к об-
щей структуре рабочей книги Excel. Его особенности больше заметны при повтор-
ной публикации.
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Рис. 14.12. Окно Publish as Web Page

Добавление данных на существующую веб-страницу

Добавление данных на веб-страницу, опубликованную целиком, с сохранением ее
вида как в рабочей книги, можно выполнить следующим образом:

О с помощью команды File > Open (Файл > Открыть) откройте в Excel файл веб-
страницы, на которой была опубликована рабочая книга;

О выполните необходимые изменения в сеансе Excel;
О сохраните рабочую книгу целиком как веб-страницу с прежним именем.
Более сложный вариант — поэлементное добавление данных рабочей книги на веб-
страницу. Используя такой способ, можно самостоятельно формировать последо-
вательность излагаемых данных на веб-странице, не выходя при этом из сеанса
работы с Excel.

Присоединение к ранее опубликованной веб-странице
нового элемента рабочей книги

1. Выделите в Excel нужный объект — рабочий лист, диапазон ячеек, диа-
грамму или сводную таблицу.

2. Вызовите команду File > Save as Web Page (Файл t Сохранить как веб-
страницу). Откроется диалоговое окно Save As (Сохранение документа).

3. Установите переключатель Save (Сохранить) в соответствии с объектом
публикации.

4. Нажмите кнопку Publish (Опубликовать), после чего отобразится пред-
ставленное на рис. 14.13 диалоговое окно Publish as Web Page (Публика-
ция веб-страницы).

5. Убедитесь, что путь к публикуемой странице введен правильно. В про-
тивном случае измените его в поле File name (Имя файла) или восполь-
зовавшись кнопкой Browse (Обзор).
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6. С помощью списка Choose (Выбрать) области Item to publish (Публикуе-
мые элементы) выберите те части выделенного фрагмента рабочей кни-
ги, которые нужно опубликовать.

7. Щелкните на кнопке Change (Изменить) и в диалоговом окне Set Page
1 Title (Задание заголовка) введите заголовок раздела.

8. Для того чтобы добавить возможность интерактивной работы с публи-
куемым документом, используя список группы Viewing options (Пара-
метры просмотра), выберите вариант связи Spreadsheet functionality (Ра-
бота с электронными таблицами) и установите флажок Add interactivity
with (Добавить). При сброшенном флажке документ будет опублико-
ван как статическая страница.

9. Если сохраненный документ нужно открыть в отдельном окне браузе-
ра сразу после публикации, установите флажок Open published web page
in browser (Открыть страницу в браузере).

10. Щелкните на кнопке Publish (Опубликовать). Откроется окно с запро-
сом, где вы должны указать, каким образом новый элемент будет при-
соединен к веб-странице (рис. 14.14).

11. Щелкните на кнопке Add to file (Добавить в файл), и публикуемые дан-
ные будут добавлены в конец существующей веб-страницы.

*m to pub-sh

Range of cells

-Sheet 1!1B(7: JBt 10

-

Рис. 14.13. Окно Publish as Web Page при добавлении элементов публикации

Microsoft Office Excel

' already

Рис. 14.14. Окно предупреждения Excel

15 Зак. 345
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IПРИМЕЧАНИЕ Заголовок первого раздела становится заголовком страницы и отображается
в заголовке браузера, остальные публикуемые элементы также могут иметь
заголовки, которые в заголовке браузера не отображаются.

Замена опубликованных ранее данных
Заменить данные в рабочей книге, которая была опубликована целиком, достаточ-
но просто:
О с помощью команды File f Open (Файл > Открыть) нужно открыть в Excel файл

веб-страницы, где была опубликована рабочая книга;
О не выходя из сеанса Excel, выполнить необходимые изменения;

О сохранить рабочую книгу целиком как веб-страницу и с прежним именем.
Замена данных Excel, опубликованных на веб-странице в качестве отдельного
элемента рабочей книги, — задача более сложная.

Замена опубликованных ранее данных
1. Внесите необходимые изменения в исходный файл Excel, из которого

были опубликованы данные. Вы можете изменить содержимое табли-
цы или тип диаграммы рабочей книга.

2. Выберите команду File > Save as Web Page (Файл > Сохранить как веб-
страницу), и откроется диалоговое окно Save As (Сохранение документа).

3. Щелкните на кнопке Publish (Опубликовать), после чего отобразится
показанное на рис. 14.15 диалоговое окно Publish as Web Page (Публика-
ция веб-страницы).

4. Убедитесь, что путь к публикуемой странице введен правильно. В про-
тивном случае измените его в поле File name (Имя файла) или восполь-
зовавшись кнопкой Browse (Обзор).

5. В списке Choose (Выбрать) группы Item to publish (Публикуемые эле-
менты) выберите элемент Previously published items (Опубликованные
ранее документы).

6. Теперь отобразится список, в котором будут указаны ранее опублико-
ванные элементы рабочей книги. Двигаясь сверху вниз, для каждого
элемента этого списка выполните действия, указанные ниже,
О Выделите элемент.

О Убедитесь, что путь к публикуемой странице введен верно. Если это
не так, значит либо страница была перемещена или переименована,
либо этот элемент списка соответствует другой опубликованной
веб-странице, и путь указан для нее. В первом случае нужно изме-
нить путь, во втором — выбрать следующий элемент списка.

О Щелкните на кнопке Change (Изменить) и введите в окне Set Page Title
(Задание заголовка) заголовок раздела, соответствующий выделен-
ному элементу.
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О Проверьте, правильно ли выбрано значение флажка Add interactivity
with (Добавить). Если он установлен, убедитесь, что в списке груп-
пы Viewing options (Параметры просмотра) верно указан тип сохра-
няемого элемента. При сброшенном флажке элемент будет опубли-
кован как статический.

7. Удалите ненужные элементы, выделив их в этом списке и нажав кноп-
ку Remove (Удалить).

8. Если сохраненный документ нужно открыть в отдельном окне браузе-
ра сразу после публикации, установите флажок Open published web pages
in browser (Открыть страницу в браузере).

9. Нажмите кнопку Publish (Опубликовать).

Рис. 14.15. Диалоговое окно Publish as Web Page при обновлении
элементов публикации

Разумеется, ничто не мешает комбинировать несколько способов публикации -
таким образом веб-страницу, на которой опубликована рабочая книга, можно до-
полнить элементами (в том числе интерактивными) из других рабочих книг. При
этом не поребуются ни специальные знания по веб-дизайну, ни опыт работы с при-
ложением FrontPage.

Создание интерактивной веб-страницы с представлением данных
в виде рабочего листа Excel
Необходимо отметить, что обычному пользователю не нужны специальные зна-
ния о веб-компонентах — достаточно лишь иметь представление о возможностях,
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предоставляемых Excel для создания интерактивных веб-страниц. Поэтому далее
подход к созданию интерактивных веб-страниц рассматривается с точки зрения
пользователя, а не программиста. Представить рабочий лист Excel в виде интерак-
тивной веб-страницы совсем не сложно.

Представление рабочего листа Excel в виде интерактивной
веб-страницы
1. Создайте рабочий лист Excel и поместите в него данные, которые вы хо-

тите опубликовать.

2. Активизируйте команду File > Save as Web Page (Файл > Сохранить как веб-
страницу). Откроется диалоговое окно Save As (Сохранение документа).

3. Установите переключатель Save (Сохранить) в положение Selection: Sheet
(выделенное: Лист) и после этого нажмите кнопку Publish (Опублико-
вать). Теперь отобразится диалоговое окно Publish as Web Page (Публи-
кация веб- страницы).

4. В списке Chose (Выбрать) и полях ввода под ним определите те данные,
которые необходимо опубликовать.

5. Установите флажок Add interactivity with (Добавить) и в соответствую-
щем ему списке выберите строку Spreadsheet functionality (Работа с элек-
тронными таблицами).

6. Щелкните на кнопке Publish (Опубликовать).

Для публикации свободной таблицы применяется несколько иной способ.

Публикация интерактивной сводной таблицы

1. Откройте или создайте документ со сводной таблицей.

2. Выберите команду File » Save as Web Page (Файл > Сохранить как веб-
страницу), после чего отобразится диалоговое окно Save As (Сохране-
ние документа).

3. Нажмите кнопку Publish (Опубликовать). Откроется диалоговое окно
Publish as Web Page (Публикация веб-страницы).

4. С помощью элементов управления группы Item to publish (Публикуе-
мые элементы) выберите сводную таблицу, которую необходимо опуб-
ликовать.

5. Установите флажок Add interactivity with (Добавить) и в соответствую-
щем ему списке прокрутки выберите элемент PivotTable Functionality (Ра-
бота со сводной таблицей).

6. Щелкните на кнопке Publish (Опубликовать).
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Работа с гиперссылками
В Microsoft Office существует возможность создавать гиперссылки, указывающие
на элементы как открытого в данный момент документа, так и других документов,
расположенных на локальной машине, в локальной сети или в сети Интернет.

Созданные гиперссылки можно модифицировать, а также использовать в форму-
лах. Применение гиперссылок позволяет строить распределенные офисные прило-
жения для бизнеса.

Создание гиперссылок
Механизм создания гиперссылок в последних версиях Excel значительно упро-
стился и в то же время стал гораздо функциональнее.

Создание гиперссылок
1. Выделите ячейку, с которой будет связана гиперссылка.

2. Выберите команду Insert > Hyperlink (Вставка > Гиперссылка).В резуль-
тате откроется показанное на рис. 14.16 окно Insert Hyperlink (Добавле-
ние гиперссылки).

3. В поле Text to display (Текст) укажите текст, который должен выводить-
ся на месте гиперссылки.

4. Нажмите кнопку ScreenTip (Подсказка).

5. В открывшемся диалоговом окне Set Hyperlink ScreenTip (Подсказка для
гиперссылки), представленном на рис. 14.17, введите текст подсказки,
который будет появляться на экране при подведении указателя мыши
к гиперссылке.

6. Щелкните на кнопке ОК.

7. В области Linkto (Связать с), расположенной на левой панели окна In-
sert Hyperlink (Добавление гиперссылки), выберите кнопку с необходи-
мым видом гиперссылки.

О Existing File or Web Page (файлом, веб-страницей) — гиперссылка на
уже существующий файл либо веб-страницу.

О Place in This Document (местом в документе) — гиперссылка-переход
в пределах документа.

О Create New Document (новым документом) — гиперссылка на вновь
созданный документ.

О E-mail Address (электронной почтой) - гиперссылка-адрес электрон-
ной почты.

8. Установив параметры для выбранного варианта гиперссылки, щелкни-
те на кнопке ОК.
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Рис. 14.16. Окно Insert Hyperlink
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Рис. 14.17. Окно Set Hyperlink ScreenTip

Гиперссылки любого вида внешне ничем не отличаются друг от друга. Новая ги-
перссылка выделяется синим цветом, а ее текст подчеркивается. При наведении на
нее указателя мыши всплывает подсказка.

Далее описан процесс создания гиперссылок каждого вида.

Создание гиперссылок на имеющийся документ или веб-страницу

1. Щелкните на кнопке Existing File or Web Page (файлом, веб-страницей),
расположенной на левой панели диалогового окна Insert Hyperlink (До-
бавление гиперссылки).

2. В поле Text to display (Текст) укажите текст, который будет выводиться
на месте гиперссылки. При желании можете ввести текст подсказки.

3. В поле Address (Адрес) задайте URL нужного документа. Если вас инте-
ресует не весь найденный документ, а его конкретная часть, щелкните
на кнопке Bookmark (Закладка) и в открывшемся диалоговом окне Select
Place in Document (Выбор места в документе), показанном на рис. 14.18,
уточните объект и его местоположение. Затем щелкните на кнопке ОК.

4. В диалоговом окне Insert Hyperlink (Добавление гиперссылки) щелкни-
те на кнопке ОК.
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Рис. 14.18. Диалоговое окно Select Place in Document

[ПРИМЕЧАНИЕ По умолчанию Excel указывает относительный путь гиперссылки.

Можно создать гиперссылку, выполняющую переход в пределах документа. Это
очень удобно при работе с большими документами и может значительно повы-
сить производительность.

Создание гиперссылки в пределах документа
1. Щелкните на кнопке Place in This Document (местом в документе) диало-

гового окна Insert Hyperlink (Добавление гиперссылки) (рис. 14.19).

2. В поле Text to display (Текст) введите текст, который будет выводиться
на месте гиперссылки. При желании можете указать текст подсказки.

3. В поле Type the cell reference (Введите адрес ячейки) задайте лист/ячей-
ку, к которой необходимо перейти, либо воспользуйтесь полем Orselect
a place in this document (Или выберите место в документе), назначение
которого понятно из его названия.

4. Щелкните на кнопке ОК.

Рис. 14.19. Вставка гиперссылки, действующей в пределах документа
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Иногда приходится создавать ссылку на пока еще не существующий документ.
В таком случае нужно поступить следующим образом.

Создание гиперссылки на новый документ
1. На панели, расположенной в левой части диалогового окна Insert Hyper-

link (Добавление гиперссылки), щелкните на кнопке Create New Document
(новым документом) (рис. 14.20).

2. В поле Text to display (Текст) укажите текст, который будет появляться
на месте гиперссылки. При желании можете ввести текст подсказки.

3. В поле Name of new document (Имя нового документа) задайте имя соз-
даваемого документа.

4. При необходимости измените путь к файлу, воспользовавшись кноп-
кой Change (Изменить).

5. Путем установки переключателя Edit the new document later (позже) или
Edit the new document now (сейчас), из области When to edit (Когда вно-
сить правку в новый документ) определите время, когда должна осуще-
ствляться правка нового документа.

6. Щелкните на кнопке ОК.

)ПРИНЕЧДНИЕ При выборе переключателя Editthe new document now (сейчас) будет откры-
то окно приложения с вновь созданным документом для редактирования.

Insert Hyperlink

Рис. 14.20. Создание ссылки на новый документ

На веб-страницу можно поместить гиперссылку, при активизации которой будет
создаваться сообщение электронной почты. Делается это таким образом.
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Создание гиперссылки на адрес электронной почты
1. Нажмите на левой панели диалогового окна Insert Hyperlink (Добавле-

ние гиперссылки) на кнопке E-mait Address (электронной почтой).

2. В поле Text to display (Текст) укажите текст, который будет появляться
на месте гиперссылки. При желании можете ввести текст подсказки.

3. В поле E-mail address (Адрес электронной почты) задайте адрес элек-
тронной почты, по которому будет отправляться сообщение (префикс
maUto: вставляется автоматически).

4. Если необходимо, укажите в поле Subject (Тема) тему сообщения.

5. Используя список Recently used e-mail addresses (Недавно использовав-
шиеся адреса электронной почты), выберите, если считаете нужным,
адрес электронной почты, уже применявшийся в качестве гиперссыл-
ки (рис. 14.21).

6. Щелкните на кнопке ОК.

insert Hyperlink

Г

•ж 1
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Рис. 14.21. Создание гиперссылки на адрес электронной почты

Возможность создавать гиперссылку на адрес электронной почты впервые появи-
лась в версии Microsoft Excel 2000.

Оформление и изменение гиперссылок
Не исключена ситуация, когда гиперссылку придется изменить, — скажем, при
перемещении документа, на который она ссылается, или при желании оформить
ее иначе. Для этого не нужно удалять гиперссылку и создавать новую. Достаточно
воспользоваться контекстным меню, которое появляется после перемещения ука-
зателя на ячейку, в которой создана гиперссылка, и нажатия правой кнопки мыши.
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Изменение гиперссылки
1. Установите указатель на ячейке, гиперссылку в которой нужно изме-

нить, и нажмите правую кнопку мыши. Появится контекстное меню,
показанное на рис. 14.22.

2. Выберите в нем команду Edit Hyperlink (Изменить гиперссылку). Ото-
бразится окно Edit Hyperlink (Изменение гиперссылки), внешний вид ко-
торого ничем не отличается от окна Insert Hyperlink (Добавление гипер-
ссылки).

3. Отредактируйте необходимые параметры аналогично тому, как вы это
делали при вставке гиперссылки. Обратите внимание, что можйо изме-
нить и тип гиперссылки, например, вместо гиперссылки на адрес элек-
тронной почты установить гиперссылку на веб-страницу сотрудника.

Рис. 14.22. Контекстное меню, связанное с гиперссылкой

ПРИМЕЧАНИЕ Цвет и шрифт гилерссылки можно изменять. Это делается точно так же, как
при работе с ячейками, не содержащими гиперссылок.

Использование гиперссылок в формулах
В Excel 2003 предусмотрена специальная функция HYPERLINK ("URL", текст) дляис-
пользования гиперссылок в формулах (пользователи русской версии Excel могут
применять аналогичную функцию - ГИПЕРССЫЛКА). Обязательным параметром дан-
ной функции является URL документа, для которого задается гиперссылка, не-
обязательным - текст, отображаемый вместо URL. После введения этой функции
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в ячейке создается гиперссылка, функционирующая точно так же, как и создан-
ная с помощью команды Insert > Hyperlink (Вставка > Гиперссылка).

I ПРИМЕЧАНИЕ Если гиперссылка создана с помощью формулы, ее параметры можно изме-
нить, только отредактировав параметры функции. То есть к такой гиперссыл-
ке неприменимы возможности, описанные в разделе «Оформление и измене-
ние гиперссылок».

Функцию HYPERUNKO удобно использовать вместе с функцией I F C ) (ЕСЛИ()). На-
пример, гиперссылки можно сделать активизирующимися по условию

IF(C3<A5: HYPERLINK ( " h t t p : / / w o l f / e x _ h l 2 . x l s " ) : " " )

или переключающимися по условию

HYPERLINK
IF(J9<12;"http://wolf/Ex09.xl S":"http://wolf/Exll.xls")

)

Переход по гиперссылке
После создания гиперссылки ее следует проверить. Для этого наведите указатель
мыши, отображаемый в виде руки, на гиперссылку и подождите, пока не всплы-
вет подсказка — либо с текстом, либо с URL гиперссылки. Нажмите левую кноп-
ку мыши, и документ, к которому производится переход по гиперссылке, откро-
ется в новом окне соответствующего приложения, а над ним отобразится панель
Web (Веб-узел).

Самостоятельная работа
1, Создайте новый рабочий лист со ссылкой на вашу любимую веб-страницу,

2, Добавьте в рабочий лист, созданный в пункте 1, ссылку на новый документ.

3. В созданном документе составьте список ваших друзей и для каждого сделай-
те ссылку на адрес его электронной почты.

4. Предположим, что адрес электронной почты одного из ваших друзей изменил-
ся. Внесите соответствующее изменение в существующую ссылку.

Подведение итогов
В этом уроке мы научились:

0 отправлять рабочий лист в качестве сообщения электронной почты;

0 использовать возможность маршрутизации сообщений;

0 открывать рабочую книгу в сети Интернет;

0 работать с FTP-узлами;

0 публиковать данные в Интернете средствами Excel;

0 создавать и использовать гиперссылки.
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G Совместное использование
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П Просмотр журнала изменений

О Объединение изменений в рабочих
книгах

П Организация работы с документами
Excel с помощью Microsoft SharePoint
Team Services
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При организации совместной работы пользователей над Excel-документами сле-
дует опираться как на возможности самой программы Excel, так и на возможно-
сти, предоставляемые веб-узлами группы Microsoft SharePoint Team Services. Если
нужно обеспечить эффективную работу группы пользователей, предпочтение сле-
дует отдать средствам Microsoft SharePoint Team Services.

Совместная работа в Excel
Excel 2003 обеспечивает совместную работу нескольких пользователей с одной ра-
бочей книгой, что значительно облегчает процесс управления часто изменяемы-
ми списками. Например, если пользователи рабочей группы одновременно участ-
вуют в создании нескольких проектов и им требуется краткая информация о про-
деланной работе, они могут использовать список в общей книге, куда каждый из
них будет регулярно вводить сведения о проделанной работе по конкретному про-
екту. Общей, как вы наверняка догадались, называется книга, доступная для про-
смотра и внесения изменений по сети несколькими пользователями.

Совместное использование рабочих книг
Совместная работа пользователей с рабочей книгой возможна лишь при наличии
у них права на совместный доступ. Кроме того, требуемая книга должна нахо-
диться на сетевом диске. Чтобы предоставить книгу для совместного пользова-
ния, необходимо воспользоваться диалоговым окном Share Workbook (Управление
доступом к файлу), которое вызывается с помощью команды Tools > Share Workbook
(Сервис ^ Доступ к книге). При сохранении такой книги каждый пользователь ви-
дит изменения, внесенные другими пользователями.

Share Workbook

Editing i| Advanced

, 1 &llow changes by more than ong user at the same time... This:
also allows workbook merging,

Щпо has this workbook open row:
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Заметьте, что любой пользователь, открывший рабочую книгу имеет на нее моно-
польные права. Чтобы разрешить работу с книгой другим пользователям и обеспе-
чить возможность объединения всех внесенных изменений, установите на вкладке
Editing (Правка) флажок Allow changes by more than one user at the same time (Разре-
шить совместный доступ). При этом будет активизирована вкладка Advanced (Под-
робнее), предназначенная для настройки параметров отслеживания вносимых из-
менений и разрешения конфликтов. Конфликт возникает, когда два пользователя
одновременно вносят в общую книгу изменения, влияющие на одну ячейку, и со-
храняют их. Excel может сохранить только одно изменение в этой ячейке.

Предотвратить конфликты можно путем назначения для каждого пользователя
отдельной области на рабочем листе и определения в ней права на ввод информа-
ции. Если пользователи не вторгаются в чужие области, конфликты не возника-
ют даже в том случае, если для некоторых из этих областей не будет установлена
защита.
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Отслеживание изменений

Отслеживание изменений возможно только в общих рабочих книгах. Если вы ус-
тановили в журнале изменений режим регистрации вносимых исправлений, ука-
жите, сколько дней этот журнал следует хранить. По истечении данного времени
он будет уничтожен без возможности восстановления. Необходимо также опре-
делить, как часто должна осуществляться регистрация изменений. Сведения о
внесенных изменениях записываются в журнал при каждом сохранении книги на
диске. Установка переключателя Save my and see other's changes (Сохранить мои
изменения и просмотреть чужие) означает, что другие пользователи не увидят
изменений до тех пор, пока книга не будет сохранена.
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Когда два пользователя пытаются сохранить изменения, внесенные в одну ячей-
ку, у одного из них появляется окно с предупреждением о возникшем конфликте
доступа. Такое окно открывается у пользователя, который пытался сохранить из-
менение последним.

(ПРИМЕЧАНИЕ Чтобы сохранить копню общей рабочей книги со всеми вашими изменения-
ми, нажмите в диалоговом окне с сообщением о возникновении конфликта
кнопку Cancel (Отмена), выберите.команду File * Save As (Файл > Сохранить
как), а затем введите новое имя файла.

Представленные на вкладке Advanced (Подробнее) переключатели группы Conflic-
ting changes (Для противоречивых изменений) позволяют определить порядок ра-
боты при возникновении в рабочей книге противоречащих друг другу изменений.
В зависимости от того, какой из переключателей активен, Excel либо выдает за-
прос, либо автоматически принимает те изменения, которые были сохранены
первыми. Параметры фильтрации и печати, устанавливаемые для данной рабо-
чей книги каждым пользователем, сохраняются отдельно. Они не влияют на ана-
логичные параметры рабочей книги у других пользователей.

Совместное использование рабочей книги
1. В активной рабочей книге выберите команду Tools > Share Workbook (Сер-

вис > Доступ к книге).

2. На вкладке Editing (Правка) установите флажок Allow Changes By More
Than One User (Разрешить совместный доступ).

3. На вкладке Advanced (Подробнее) в областях Track Changes (Регистра-
ция изменений), Update Changes (Обновлять изменения), Conflicting Chan-
ges (Для противоречивых изменений) и Include in Personal View (Вклю-
чить в личное представление) задайте параметры регистрации и обнов-
ления изменений.

4. Щелкните на кнопке О К, и диалоговое окно будет закрыто.

После закрытия диалогового окна Excel сохраняет текущую рабочую книгу как
общую. Если она ранее не сохранялась, откроется диалоговое окно Save As (Со-
хранение документа).

—ъ.

*5< ) ПОДСКАЗКА Excel отслеживает пользователей, которым предоставляется доступ к общей
книге, по имени. Если имя, указанное в списке доступа, некорректно, его сле-
дует исправить на вкладке General (Общие) диалогового окна Options (Пара-
метры), для чего нужно вызвать команду Tools > Options (Сервис > Параметры),

Иногда доступ к рабочей книге следует ограничить, например, с помощью пароля.
Вызовите команду File > Save As (Файл > Сохранить как) и в диалоговом окне Save As
(Сохранение документа) вызовите команду Tools > General Options (Сервис > Общие
параметры). В результате ее выполнения откроется диалоговое окно Save Options
(Параметры сохранения).
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Save Options

Г" Always create [jackup

File sharing ---

Password to Qpan:
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Введите пароли, без указания которых другие пользователи не смогут открывать
или редактировать общую рабочую книгу. Помните, что при вводе пароля разли-
чаются строчные и прописные буквы, длина пароля не должна превышать 15 зна-
ков, а сам пароль может включать буквы, цифры и другие символы. Щелкните на
кнопке ОК, и книга будет сохранена с новыми условиями доступа.

ПРИМЕЧАНИЕ Не знал пароля, вы не сможете открыть или сохранить файл.

Работа с общей рабочей книгой

В общей книге, равно как и в обычной, данные можно вводить и изменять, но су-
ществует несколько отличий. При включенном режиме регистрации изменений
в общей книге любая правка фиксируется в журнале, а измененные ячейки поме-
чаются определенным образом. Например, если значение ячейки будет удалено,
в ее верхнем левом углу появится маленький треугольник. При помещении ука-
зателя мыши в ячейку появляется комментарий с сообщением о том, кто и когда
внес изменения в эту ячейку и каким было ее предыдущее значение. Excel при-
сваивает каждому пользователю, имеющему право на внесение изменений в рабо-
чую книгу, треугольник определенного цвета. Если при сохранении рабочей кни-
ги изменения будут согласованы, треугольник и примечание исчезнут.

При каждом сохранении общей книги в нее вносятся_изменения, произведенные
другими пользователями за период, прошедший с момента предыдущего ее со-
хранения на данном компьютере. При необходимости срочно просмотреть изме-
нения, внесенные всеми пользователями, книгу следует обновить, сохранив ее
(то есть не дожидаться автоматического обновления, выполняемого через строго
заданные интервалы времени).

Чаще же всего отслеживаются изменения, вносимые в содержимое ячеек, а также
изменения, обусловленные перемещением и копированием ячеек, вставкой и уда-
лением строк и столбцов. Изменения, связанные с использованием функций, не-
доступных в общих книгах, естественно, не отслеживаются. Кроме того, в Excel
не отслеживаются изменения, произошедшие в результате выполнения следую-
щих действий:

О удаления рабочих листов;
О применения условного форматирования, проверки данных;
О вставки либо удаления диапазонов ячеек, диаграмм, гиперссылок или иных

объектов, в том числе и созданных с помощью панели инструментов Drawing
(Рисование);
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О группировки данных или создания иерархической структуры таблицы;

О создания, изменения, просмотра, записи или назначения макросов.

Для того чтобы эти изменения можно было отследить, переведите книгу в г,-
польный режим, выполните нужные действия и снова предоставьте право н;
вместный доступ.

В справочной системе Excel приведен полный список ограничений, которы
дует придерживаться при работе с книгами.

Разрешение конфликтов

Способ разрешения конфликтов, заданный по умолчанию на вкладке Advanced
(Подробнее) диалогового окна Share Workbook (Управление доступом к фа:.
предусматривает открытие диалогового окна Resolve Conflict (Возник кош}
доступа). В нем подробно описываются все изменения, вносимые другими поль-
зователями, и предлагается возможный вариант правки (сохранить свои
жие изменения).

Conflicting changes b/ paste - 22.CS.2uQ3 17:43:

Accept Alt Mine Accept AH 'Others

Просмотр журнала изменений

Журнал изменений можно использовать не только для просмотра внесч
менений, но и для принятия решения о том, которую из предлагаемых редакций
правки нужно сохранить. Такая возможность особенно полезна, когдг кеско
человек редактируют один документ, а также при отправке такого до)
рецензию.

В журнале изменений сохраняется информация о произведенных запиг.
следние 30 дней. Данное ограничение позволяет влиять на размер книги,
ство дней, в течение которых информация в журнале будет сохраняться, можно
изменить. Если журнал требуется хранить очень долго, можно назначить б
шое число дней или периодически копировать сведения журнала.

При включенном режиме регистрации изменений, вызвав команду Tools v Track Chan-
ges > Highlight Changes (Сервис > Исправления > Выделить исправления), можно ^ви-
деть все внесенные изменения. Кроме того, в открывающемся в резулъта
полнения этой команды диалоговом окне Highlight Changes (Исправления) з;>
ся время, в течение которого должна производиться регистрация изменений.
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имена пользователей, внесших правку, отслеживаемый диапазон ячеек или рабо-
чий лист. Просмотреть изменения можно как непосредственно на экране, так и на
отдельном рабочем листе (листе журнала).

Highlight rhannes

Т/ad*.changes While editing. This also shares your workbocfc,

-Wgjhttght which changes •—:

When: |ftil :s'=
Г Wh£r j Every one

Г Wbsre: I

HghUght changes on screen

•

Просмотр журнала изменений
1. Выберите команду Tools > Track Changes * Highlight Changes (Сервис к Ис-

правления > Выделить исправления).
2. В диалоговом окне Highl ight Changes (Исправления) укажите тип изме-

нений, которые вы хотите просмотреть.
3. Установите либо сбросьте флажок, определяющий режим просмотра

изменений на экране или на отдельном рабочем листе.
4. Щелкните на кнопке ОК.

При просмотре журнала изменений непосредственно на листе можно получить
сведения о пользователях, которыми таковые были внесены, об их типе и време-
ни внесения. При работе с журналом изменений на отдельном рабочем листе мож-
но применять фильтры для выборки информации, например, по имени пользова-
теля или по времени внесения изменений (рис. 15.1).

Excel, как уже было сказано, сохраняет в журнале изменений информацию лишь
за указанное число дней. Их обратный отсчет производится начиная с текущей да-
ты. При каждом закрытии книги Excel удаляет часть записей журнала измене-
ний, не подпадающую под указанный период хранения.

Для сохранения журнала изменений выберите нужную информацию на рабочем
листе History (Журнал) и скопируйте ее на другой рабочий лист, который будет
сохранен вместе с рабочей книгой. При отключении режима совместного исполь-
зования рабочей книги содержимое журнала изменений автоматически сбрасы-
вается. В случае отключения журнала изменений или запрета на совместный дос-
туп к книге журнал изменений удаляется окончательно.
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Рис. 15.1. Рабочий лист с журналом изменений

Объединение изменений в рабочих книгах
При интенсивной совместной работе с книгой группы пользователей возможны
многочисленные конфликты, на разрешение которых уйдет немало вашего вре-
мени. В этом случае разумно сделать несколько копий книги, а произведенные
изменения свести в одном экземпляре позднее. Для создания копий следует, как
вы знаете, воспользоваться командой Save As (Сохранить как) и присвоить каждо-
му экземпляру имя. После того как все пользователи завершат работу, их копии
книги нужно будет объединить, но это можно будет сделать лишь при условии,
что никто из них не отключит режим совместного доступа. Кроме того, необхо-
дим полный журнал изменений. Например, если в журнале изменений хранится
информация за последние 30 дней, а пользователи работали 32 дня, то рабочие
книги объединить нельзя. Подобные ситуации следует предвидеть и устанавли-
вать больший период хранения журнала изменений.

Объединение совместно используемых рабочих книг
1. Откройте свою копию совместно используемой рабочей книги и сохра-

ните ее.

2. Выберите команду Tools > Merge Workbooks (Сервис > Объединить книги).

3. В диалоговом окне Select Files to Merge Into Current Document (Выберите,
какие файлы включить в книгу) укажите те копии совместно исполь-
зуемой рабочей книги, изменения в которых надо объединить. (Для
выбора нескольких книг в одной папке используйте клавишу Ctrl или
Shift.) Щелкните на кнопке ОК.
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Самостоятельная работа
1. Разрешите совместный доступ к какой-либо рабочей книге.

2. Включите режим регистрации изменений в этой книге.

3. Сделайте несколько копий рабочей книги, после чего внесите изменения в ка-
ждую копию.

4. Объедините все копии рабочей книги.

Организация работы с документами Excel
с помощью SharePointTeam Services

Веб-узлы группы Microsoft SharePoint Team Services представляют собой место
в Интернете, где члены одной группы могут общаться, обмениваться документа-
ми и совместно работать над несколькими проектами, Можно создать отдельный
веб-узел группы для каждого проекта, над которым работают ее участники.

Бы можете принять участие в работе веб-узла группы, воспользовавшись только
браузером (домашнюю страницу этого веб-узла вы видите на рис. 15.2). Однако
лишь при наличии клиентской программы, совместимой с Microsoft SharePoint, и
в частности Microsoft Excel 2003, можно полноценно работать на веб-узле груп-
пы, то есть сохранять там документы, редактировать в клиентской программе до-
кументы с веб-узла или, скажем, перемещать данные из клиентской программы
на веб-узел и обратно.

-ЕЛ View Favwitej

Favorites Ĵ> МьЯэ

"дЦр1?,.. lnki "
rets лгк) Lists Create

Team Web Site

Home
Modify Shared Page -

Document* . announcement» . -....,„, ,-,,.,̂ *

Shored Documents There are currently no active announcement!. To add а пен
Pictures announcement, dick "Add печ announcement11 below,

a Add пен announcementLilt*

Contacts

Tasks

BtwCurrentTajk

Discussions

Genera: OISH.SSI

Surveys

Events . , , . , . , , .

There are currently no upcoming events. To add a nev
'Add nan event* below.

• Add new event

Windows
SharePolnt Services

ф Trusted sies-"

Рис. 15.2. Веб-интерфейс узла Microsoft SharePoint Team Services
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'ПРИМЕЧАНИЕ Здесь мы рассмотрим стандартную конфигурацию веб-узла SharePoint Team
Services без адаптации к конкретной организции.

Использование браузера при работе с документами Excel
на веб-узле SharePoint Team Services

Использование при работе с документами на веб-узле SharePoint Team Services од-
ного только браузера дает возможность редактировать документы Excel, нахо-
дясь в окне браузера.

Публикация документов Excel на веб-узле

Для того чтобы организовать совместную работу над каким-либо документом
Excel на веб-узле SharePoint Team Services, этот документ сначала следует здесь
опубликовать. При открытии веб-узла в окне браузера появляется его домашняя
страница. На панели быстрого запуска Quick Launch (Быстрый запуск), находя-
щейся в левой части домашней страницы, активизируйте ссылку Documents (До-
кументы), с тем чтобы открыть страницу Documents and Lists (Документы и спи-
ски), на которой находятся библиотеки документов, изображений, а также спи-
ски рабочей группы (рис. 15.3).

Documents and list* - Чю-osoft Internet Екр|огег

Team Web Site

Documents and Lists

This page show* all the libraries., lists, J.scuSiicr. Ocards, and surveys in this «
'itrar. or int to view rW eortsnts. To create а пен libfiry 01 list, dick Create.

Document Librariei

Shared Documents Share a document with the teem ay S 21 hours s;c
adding и to ttiu docurn»nt lisran •

Piclure Libraries
Tritre are no picture libraries, To create one, dick Create

on the home paje of your

Рис. 15.3. Страница Documents and Lists веб-узла SharePoint Team Services

После щелчка на названии нужной библиотеки на странице будет отображен спи-
сок хранящихся в ней документов (рис. 15.4).

На этой странице необходимо активизировать ссылку Upload Document (Отправить
документ), а когда будет выполнен переход на одноименную страницу, щелкнуть
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на кнопке Browse (Обзор) и выбрать в открывшемся окне Browse (Выбор файла)
необходимый файл. Для того чтобы этот файл открыть, достаточно щелкнуть на
кнопке Open (Открыть).
Вернувшись на страницу Upload Document (Отправить документ), документ Excel,
имя которого указано в поле Name (Имя файла), следует сохранить, воспользо-
вавшись ссылкой Save and Close (Сохранить и закрыть). На экране появится стра-
ница библиотеки документов, на которой уже будет указано имя только что со-
храненного документа Excel.

ЕЛ Иэ* fMHOrles Toob HI

i
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Team Web Site

vJsfl Shared Documents
Zi
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г Export: to
ipreadshest

i Modify setaris!
and cclUî >r4

Притрчнк

Рис. 15.4. Страница библиотеки документов

Публикация документов Excel на веб-узле
1. Находясь на странице Documents and Lists (Документы и списки), щелк-

ните на имени библиотеки документов, в которую хотите сохранить
свой файл.

2. На появившейся странице щелкните на ссылке Upload Document (От-
править документ).

3. На странице Upload Document (Отправить документ) щелкните на кноп-
ке Browse (Обзор) и отметьте имя необходимого файла в открывшемся
окне Browse (Выбор файла).

4. Щелкните на кнопке Open (Открыть).

5. Вернувшись на страницу Upload Document (Отправить документ), со-
храните файл на веб-узле, активизировав ссылку Save and Close (Сохра-
нить и закрыть).
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Открытие и редактирование документов Excel в окне браузера
Открыть и отредактировать документ Excel можно непосредственно в окне брау-
зера. Для этого следует, находясь на странице нужной библиотеки документов,
щелкнуть на имени требуемого документа. Появится диалоговое окно Download
(Загрузка файла), в котором для открытия файла в окне браузера необходимо
щелкнуть на кнопке Open (Открыть). В результате в окне браузера появится ра-
бочая книга Excel с таблицей (рис. 15.5).
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Рис. 15.5. Окно браузера с открытой таблицей Excet

Как видите, строка меню браузера в ней заменена строкой меню Excel, то есть в ва-
ше распоряжение предоставляются все функции программы Excel.

Отредактируйте документ, а для того чтобы сохранить его, вызовите команду
File > Save As (Файл > Сохранить как). В появившемся диалоговом окне Save As
(Сохранить как) щелкните на папке My Network Places (Мое сетевое окружение),
находящейся в левой нижней части окна, откройте библиотеку документов, в ко-
торой ваш документ должен быть сохранен (рис. 15.6), и щелкните на кнопке Save
(Сохранить).
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Рис. 15.6. Диалоговое окно Save As



456 Урок 15 • Коллективная работа

Редактирование и сохранение документа Excel в окне браузера
1. Находясь на странице нужной библиотеки документов, щелкните на

имени требуемого документа левой кнопкой мыши» и на экране появит-
ся диалоговое окно Download (Загрузка файла).

2. Откройте интересующий вас файл, щелкнув в окне браузера на кнопке
Open (Открыть).

3. Отредактируйте документ, после чего сохраните его с помощью коман-
ды File * Save As (Файл > Сохранить как).

4. В появившемся диалоговом окне Save As (Сохранить как) щелкните на
папке My Network Places (Мое сетевое окружение), откройте библиотеку
документов, в которой должен быть сохранен файл, и после этого щелк-
ните на кнопке Save (Сохранить)

Импорт списков Excel на веб-узел
Существует возможность импортировать на веб-узел SharePoint Теаш Services
списки из программы Excel. Зайдите на домашнюю страницу веб-узла и активи-
зируйте на панели быстрого запуска ссылку Lists (Списки), а затем на появившей-
ся странице Documents and Lists (Документы и списки) — ссылку Create List (Соз-
дать список). В результате этих действий вы перейдете на страницу Create Page
(Страница создания), на которой необходимо активизировать еще одну ссылку,
а именно ссылку ImportSpreadsheet (Импортировать электронную таблицу), нахо-
дящуюся внизу страницы (рис. 15.7).
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Рис. 15.7. Страница Create Page
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Далее, находясь на странице New List (Создание списка), в поле Name (Имя) об-
ласти Name and Description (Имя и описание) следует ввести имя создаваемого
списка, в поле Description (Описание) — текст с его описанием. В поле File location
(Местонахождение файла) области Import from Spreadsheet (Импорт из электрон-
ный таблицы) нужно указать месторасположение импортируемого на веб-узел
списка. Для этого следует щелкнуть на кнопке Browse (Обзор), в появившемся
окне Browse (Выбор файла) отметить имя файла, в котором этот список содер-
жится, и щелкнуть на кнопке Open (Открыть). Окно, где вы находились, будет за-
крыто. Вернувшись на страницу New List (Создание списка), щелкните на кнопке
Import (Импорт). На экране появится список Excel, импортированный на веб-узел
SharePomt Team Services (рис. 15.8).

ream Web Site
Импортированный список

Рис. 15.8. Список, импортированный из программы Excel

Если созданный список понадобится отредактировать, щелкните на ссылке Edit in
Datasheet (Редактирование на листе), и страница с этим списком приобретет вид
рабочего листа.

Импорт списка Excel на веб-узел
1. Находясь на странице Documents and Lists (Документы и списки), акти-

визируйте ссылку Create List (Создать список).

2. На появившейся в результате выполнения предыдущего действия стра-
нице Create Page (Страница создания) активизируйте ссылку Import
Spreadsheet (Импортировать электронную таблицу).

3. Введите все необходимые параметры в поля страницы New List (Созда-
ние списка), укажите месторасположение списка в окне Download (Вы-
бор файла) и щелкните на кнопке Open (Открыть).
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Экспорт списков с веб-узла в программу Excel
Существует также возможность экспортировать любой список с веб-узла группы
в приложение Excel. Причем на основе экспортируемого списка в Excel можно
создавать сводные таблицы и организационные диаграммы, позволяющие анали-
зировать обрабатываемые данные, а также выполнять форматирование текста.
В Excel экспортированный список представляет собой веб-запрос, который об-
новляется при внесении изменений в исходный список на веб-узле группы.

Для того чтобы экспортировать список в Excel, достаточно открыть страницу, на
которой он содержится, и активизировать ссылку Export to spreadsheet (Экспорти-
ровать). В результате вы попадете в окно Download (Загрузка файла). Обязатель-
но сохраните экспортируемый файл. Это делается следующим образом. Щелкните
на кнопке Save (Сохранить), в появившемся диалоговом окне Save As (Сохранить
как) укажите месторасположение файла, а затем щелкните на кнопке Save (Со-
хранить). Процесс экспортирования завершен.

Экспорт списка в программу Excel
1. Откройте страницу, содержащую требуемый список, и активизируйте

ссылку Export to spreadsheet (Экспортировать).

2. В появившемся окне Download (Загрузка файла) щелкните на кнопке
Save (Сохранить).

3. В окне Save As (Сохранить как) выберите место хранения файла, после
чего щелкните на кнопке Save (Сохранить).

Работа в Excel с документами, хранящимися на веб-узле
Тесная интеграция Office 2003 и SharePoint Team Services обеспечивает среду для
совместной работы, которая доступна везде, где установлены приложения систе-
мы Microsoft Office или просто веб-браузер. При наличии веб-узла SharePoint
Team Services и пакета Office 2003 пользователь получает не только новые усо-
вершенствованные инструменты для работы над совместно используемыми до-
кументами, но и сообщения о статусе проекта, информацию о нахождении колле-
ги из группы в режиме on-line.

Загрузка документов на веб-узел
SharePoint Team Services

При необходимости разместить созданный документ Excel на веб-узле Share-
Point Team Services нужно, воспользовавшись командой File > Save As (Файл > Со-
хранить как), указать в появившемся окне Save As (Сохранение документа) имя
библиотеки документов, в которой должен быть сохранен файл.

Сохранить документ можно и другим способом. Создав таблицу, откройте об-
ласть задач Shared Workspace (Общая рабочая область), затем перейдите на вклад-
ку Documents (Документы) и введите в поле Document Workspace name (Имя доку-
мента рабочей области) имя, под которым этот документ будет сохранен на веб-уз-
ле, а в поле Location for new workspace (Месторасположение новой рабочей области)
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укажите URL веб-узла рабочей группы. Прежде чем загружать таблицу на веб-
узел, сохраните ее на компьютере. Выполнив перечисленные операции, щелкните
на кнопке Create (Создать), и документ Excel будет загружен на веб-узел группы.

Загрузка документа
1. Вызовите команду File > Save As (Файл > Сохранить как).
2. В появившемся окне Save As (Сохранение документа) укажите библио-

теку докумевлюв, в которой должен быть сохранен файл, и щелкните
на кнопке Save (Сохранить)
ИЛИ
Откройте область задач Shared Workspace (Общая рабочая область) и пе-
рейдите на вкладку Documents (Документы).

3. Введите в поле Location for new workspace (Месторасположение новой
рабочей области) указанной вкладки URL веб-узла рабочей группы.

4. Сохраните документ Excel на локальном компьютере.

5. Щелкните на кнопке Create (Создать) вкладки Documents (Документы).

Открытие документов, находящихся
на веб-узле SharePoint Team Services
Открыть документ Excel, хранящийся на веб-узле SliarePoint Team Services, мож-
но с помощью команды File * Open (Файл > Открыть). В результате ее выполнения
перед вами появится окно Open (Открытие документа), в котором нужно щелк-
нуть на значке папки My Network Places (Мое сетевое окружение) (рис. 15.9). От-
кройте необходимую библиотеку и выберите в ней требуемый документ Excel.

My Recent
Documents

Desktop

j-
My Documents

" : My Computer

^ .;,3![
•- My Network

Team Web Site
Shared Documents
Type Nsrns Msdified By Hcdifed CnecNed Out To

Щ Bookl Юрий Лобач 9/3/2003 2:31 РМ

Я») Изд_Киев0698 Victor Lebedko 9/2/2003 7; DO PM

5| Контроль объема Victor Lebedko 9/2/2003 7:1B РМ Юрий Лобач

Щ| Мониторы ЮрийЛобач 9/5/2003 4:26 РМ

all Прииерчик ЮрийЛобач 9/4/2003 6:24 РМ

File name:
_ _

FBesofJype: 1д|| Microsoft Office Excel Files Cancel

Рис. 15.9. Диалоговое окно Open
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ПРИМЕЧАНИЕ При работе с папкой My Network Places (Мое сетевое окружение) поиск папок
и файлов, хранящихся на веб-узлах, осуществляется таким же образом, как
и на локальных дисках.

Открытие документа

1. Вызовите команду File ^ Open (Файл > Открыть).
2. Откройте папку My Network Places (Мое сетевое окружение), щелкнув

на ее значке в левой части окна Open (Открытие документа).
3. В этом окне найдите нужную вам библиотеку, выделите в ней необхо-

димый документ Excel и щелкните на кнопке Open (Открыть)

Область задач Shared Workspace

При рограммге Excel документа, хранящегося па веб-узле SharePoint
Team Ser, ,'ки будет запущена область задач Shared Workspace (Об-
щая ., ;1жащ;ш шесть вкладок. Предназначение каждой из этих

чтонние) отображается информация о допущенных ошиб-
•и ьгр ишчениях, налагаемых на открытый документ.

группы) позволяет проследить, кто из членов рабочей
г.-:одлтся в режиме on-line (рис. 15.10).

! ed Workspace

\ jOnlr.e

of i)"ie m

• Not (Inline

?, Victor Labadka

|; Бикгор Пасьяз

Рис, 15.10. Вкладка Members области задач
Shared Workspace
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Ссылка Add New Members (Добавить нового члена группы) этой вкладки служит
для создания нового члена рабочей группы, а ссылка E-mail AIL Members (Отпра-
вить письмо всем членам группы) — для отправки электронных сообщений членам
группы; после ее активизации автоматически запускается программа Outlook.

На вкладке Tasks (Задачи), как видно из рис. 15.11, отображается список текущих
задач группы. При необходимости добавить новую задачу следует активизировать
ссылку Add New Task (Добавить новую задачу) и в появившемся окне Task (Задача)
ввести текст новой задачи, ее название, а также некоторые другие параметры. По-
средством ссылки Alert Me About Tasks (Предупредить о задаче) в браузере откры-
вается страница New Alert (Создать предупреждение), на которой устанавливаются
параметры сообщения, касающегося определеной задачи группы, которое будет
приходить вам по электронной почте.

: Shared Workspace

r-5 ream Web Site
*•"* "Onerl Sto ri

! J и*
Юрий

Sort by т

Last updated: 06.09.3003 11:03

Рис. 15.11. Вкладка Tasks области задач
Shared Workspace

На вкладке Documents (Документы) перечислены документы библиотеки докумен-
тов (рис. 15.12). При необходимости создать здесь новый документ нужно акти-
визировать ссылку Add New Document (Добавить новый документ), а для создания
папки в этой библиотеке документов — ссылку Add New Folder (Добавить новую
папку). Ссылка Alert Me About Documents (Предупредить о документе) использует-
ся для создания предупреждений, которые начнут приходить вам по электронной
почте в том случае, если в документы будут вноситься какие-либо изменения,

На вкладке Links (Ссылки) представлены ссылки группы пользователей. При не-
обходимости создать новую ссылку следует щелкнуть на кнопке Add New Link
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(Создать новую ссылку), а для того чтобы создать предупреждение, нужно акти-
визировать ссылку Alert Me About Links (Предупреждение) (рис. 15.13).

i Update Qp'ore...

Last Lpj3tBd:06.09.3003 11:03

Рис. 15.12. Вкладка Documents области задач
Shared Workspace

Shared Workspace

i Team Web Ste
CpanS-ta in Browser"

0,д1о-. ме About Links..

: 05. 09.200311:07

Рис. 15.13. Вкладка Links области задач
Shared Workspace
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На вкладке Document Information (Информация о документе) содержится инфор-
мация об открытом документе (рис. 15.14).

, Team Web Site
'-">! open Site n Browser

Docunerrt Information

Created By

Ч ЮоЛЛобач
jjn

Modified By

»t Юрий Лобац

Modified

! Update •) Options. .

tail HJdatad: №.09.2003 ШС7

Рис. 15Л4. Вкладка Document Information
области задач Shared Workspace

В области задач Shared Workspace (Общая рабочая область) также содержатся кноп-
ки и ссылки, общие для всех вкладок. Так, кнопка Update (Обновить) применяет-
ся для обновления информации о данных в области задач (например, в случае
удаления какого-либо документа другим членом рабочей группы этот документ
будет отображаться в области задач до тех пор, пока вы не нажмете эту кнопку).
Ссылка Team Web Site (Веб-узел рабочей группы) необходима для открытия веб-
узла рабочей группы в окне браузера.

Самостоятельная работа
1. Откройте домашнюю страницу веб-узла Microsoft SharePoint Team Services

в окне браузера.

2. Создайте новую библиотеку документов.

3. Сохраните в этой библиотеке какой-нибудь документ Excel.

4. Находясь в приложении Excel, сохраните в библиотеке документов созданную
в нем таблицу.

5. Используя область задач Shared Workspace (Общая рабочая область), создайте
новую задачу для рабочей группы.
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Подведение итогов

В этом уроке мы научились:

S3 совместно использовать рабочие книги;

2! просматривать журнал изменений;

Е объединять изменения в рабочих книгах;

0 работать с документами Excel, храшгщимися на веб-узле Microsoft SharePoint
Team Services.
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Excel предоставляет в распоряжение пользователя множество функций, призван-
ных облегчить его работу и помочь настроить программу с учетом специфики вы-
полняемых заданий.

Настройка рабочей области
В Excel можно задать целый ряд параметров, которые будут влиять на работу
программы. Большинство таких параметров устанавливаются в диалоговом окне
Options (Параметры), описанном в этом уроке. Чтобы открыть его, необходимо
вызвать команду Tools t Options (Сервис > Параметры).

Вкладка View
Сразу после открытия диалогового окна Options (Параметры) активной является
вкладка View (Вид), которую вы видите на рис. 16.1.

Color I International ) Save | Error Checbng j Spelling [ Security

LJfiew_..Jj Calculation [ Edit ] General j Transition ] Custom Lists ] Chart

Show •— - • —
:!|!:(7 aartyp Task Pane if? fiarmula bar P Status baf P" Windows^ Taskbar

Comments — ——•———---~ —— —--- —- ----- -- -- •••

f Цепе (• Comment indicator only f Comment îricfcator . ...

Objects ——————————~—— .—. —-—~—— ,_.„__ ^_ ^_^

1̂  Show all С Show placeholders *~ H^eal

Window options —

'•'•> ,Г* Page breal̂  !*• Row £k cabmn headers I? HorizoMai sad! bar" '

'Г" Rjfjnulas U? Ojjclrie symbols R j|jMtical scroll bar

W gridines 1У £ero values ЗУ

Sridlhessolorij Automatic _*J

Cancel-

Рис. 16.1. Вкладка View диалогового окна Options

В области Show (Отображать) данной вкладки можно задать и отменить отобра-
жение области задач при запуске программы, строки формул, строки состояния и
окон на панели задач.

Известно, что рабочий лист может содержать различные встроенные объекты,
в частности диаграммы и рисунки. Такие объекты иногда заслоняют отдельные об-
ласти листа, что негативно сказывается на скорости работы пользователя (напри-
мер, из-за необходимости прокручивать лист). Отображением указанных объек-
тов можно управлять с помощью переключателей из области Objects (Объекты).
По умолчанию активен переключатель Show all (отображать) и отображаются все
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объекты. Для того чтобы повысить скорость работы, в том числе скорость переме-
щения по рабочему листу, встроенные диаграммы и графические объекты нужно
представить в виде прямоугольников серого цвета. Для этого можно воспользо-
ваться переключателем Show placeholders (только очертания). Переключатель Hide
all (не отображать) позволяет скрыть как указанные, так и другие объекты, ска-
жем линии или прямоугольники.

Наибольшее число элементов вкладки View (Вид) содержит область Window op-
tions (Параметры окна).

Установив флажок Page breaks (авторазбивка на страницы), можно обозначить
пунктирной линией место разрыва страниц на рабочем листе. Разбивка на стра-
ницы выполняется в соответствии с определенными для нее параметрами. При
установленном флажке Page breaks (авторазбивка на страницы) пользователь имеет
возможность следить за изменением вида таблицы при выводе на печать.

Как правило, в ячейках рабочего листа отображается результат вычислений, а не
формула. Если в таблице, содержащей большое количество формул, появляется
ошибка, пользователь должен установить флажок Formulas (формулы) — для пе-
рехода в режим отображения формул. Это значительно облегчит поиск ошибки.
Причем программа в два раза увеличит ширину столбцов таблицы, чтобы как
можно полнее отобразить формулы.

Линии, соответствующие границам ячеек, образуют сетку, которая облегчает ори-
ентацию в рабочем листе. Однако в некоторых случаях (например, при создании
рамок для отдельных ячеек) сетку лучше убрать, сбросив флажок Gridlines (сетка).
Пользователям предоставляется также возможность изменять цвет сетки. Приме-
няемая при этом палитра находится в поле GridLines color (Цвет линий сетки).

Любую ячейку в рабочем листе можно найти по ее адресу, который представляет
собой комбинацию заголовков столбца и строки. По умолчанию заголовки столб-
цов и строк должны быть видны на экране. С помощью флажка Row & column hea-
ders (заголовки строк и столбцов) их отображение можно отменить и таким обра-
зом увеличить рабочую область листа.

При использовании функции структурирования над заголовками листов "и слева
от заголовков строк отображаются символы структуры. Они занимают довольно
много места, необходимого для более полного представления таблицы. Путем
снятия флажка Outline symbols (символы структуры) эти символы можно скрыть.

Флажок Zero values (нулевые значения) применяется для переключения в режим
отображения нулевых значений. Если данный флажок не установлен, нулевые
значения не отображаются (содержимое ячеек при этом не изменяется).

Следующие три 4>лажка — Horizontal Scroll Bar (горизонтальная полоса прокрут-
ки), Vertical Scroll Bar (вертикальная полоса прокрутки), Sheet tabs (ярлычки лис-
тов) - служат для задания/отмены отображения горизонтальной и вертикальной
полос прокрутки, а также ярлычков листов. Потребность в скрытии этих элементов
может быть связана и с необходимостью увеличить видимую часть таблицы.

Группу параметров, установленных на вкладке View (Вид), можно сохранить под
определенным именем — в таком случае их не придется заново задавать при каж-
дом просмотре книги или, скажем, при ее распечатке. Кроме того, пользователь
сможет намного быстрее активизировать такие группы параметров.
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Прежде чем создавать представления, необходимо настроить книгу, придав ей не
только необходимый внешний вид, но и установив все нужные параметры печа-
ти. Затем следует выбрать команду View > Custom Views (Вид > Представления) и,
когда откроется одноименное окно, нажать кнопку Add (Добавить), после чего
ввести в появившемся окне имя нового представления. Для установки парамет-
ров представления достаточно выбрать в списке Views (Представления) окна
Custom Views (Представления) соответствующее имя и щелкнуть на кнопке Show
(Применить).

Вкладка Calculation

На вкладке Calculation (Вычисления) устанавливаются параметры, определяю-
щие режим выполнения вычислений на рабочем листе (рис. 16.2),

.11*1
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View \ Calculation

Calculation
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. .. С Automatic except tables

Edit } Genera! f Transition Custom Lists f Chart

r Manual calc Wow.(F9)
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! • -
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\У update remote references

Г" Precision as displayed

Г" 190f date system

Maximum change: 10,001

Г? Save external [ink values

Г" Accept labefs in formulas.

• Cancel

Рис. 16.2. Вкладка Calculation диалогового окна Options

Как правило, после заполнения ячейки значения во всем рабочем листе вычисля-
ются заново, то есть таблица постоянно обновляется. Но при работе с массивами
или при итерационных вычислениях частое обновление данных во всем рабочем
листе может негативно сказаться на скорости функционирования программы.
Во избежание этого нужно установить переключатель Automatic except tables (ав-
томатически кроме таблиц) в области Calculation (Вычисления). В данном случае
вычисление значений во всех рабочих листах открытых книг будет производить-
ся только после щелчка на кнопке CaLc Now (Вычислить) в диалоговом окне Options
(Параметры) или после нажатия клавиши F9. Если вычисления должны выпол-
няться лишь в текущем рабочем листе, следует пользоваться кнопкой CaLc Sheet
(Пересчет листа).
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С помощью флажка Iteration (итерации) можно управлять вычислением по фор-
мулам с циклической ссылкой (формула в ячейке содержит ссылки на собствен-
ную ячейку) — путем указания максимального количества итераций или погреш-
ности вычислений.

Установка флажка Update remote references (обновлять удаленные ссылки) приво-
дит к автоматическому обновлению данных в рабочих книгах, которые содержат
листы с внешними ссылками. Если пользователь желает работать с необновлен-
ными значениями, этот флажок необходимо снять.

Как правило, точность вычислений в Excel составляет 15 знаков после запятой,
что при работе с большими таблицами сопряжено с увеличением длительности
вычислений. При установленном флажке Precision as displayed (точность как на эк-
ране) точность производимых вычислений соответствует числу отображаемых на
экране десятичных разрядов.

Флажок 1904 date system (система дат 1904) используется при обмене данными
с операционной системой Apple Macintosh, в которой отсчет времени начинается
с 01.01.1904, а не с 01.01.1900. Если в предназначенной для импорта/экспорта
таблице значения даты не содержатся, этот флажок устанавливать не следует.

Рабочий лист можно связывать с различными внешними документами. Как пра-
вило, данные из подобных документов копируются в рабочий лист и сохраняют-
ся в нем даже после удаления документа-источника. Но если копии имеют боль-
шие размеры, это может привести к нерациональному использованию памяти
и значительным потерям времени при открытии рабочей книги. В таком случае
следует установить флажок Save external link values (сохранять значения внешних
связей) и сохранить документ-источник отдельно.

На вкладке Calculation (Вычисления) также можно установить флажок Accept la-
bels in formulas (допускать названия диапазонов), что позволит использовать в фор-
мулах имена диапазонов ячеек.

Вкладка Edit
Установив на вкладке Edit (Правка), показанной на рис. 16.3, флажок Edit directly
in cell (Правка прямо в ячейке), вы сможете после двойного щелчка на ячейке
приступить к редактированию ее содержимого. В таком случае отпадет необходи-
мость в строке формул, которую можно скрыть для увеличения видимой части
таблицы.

В результате установки флажка Allow cell drag and drop (Перетаскивание ячеек) по-
является возможность перемещения и копирования ячеек и выделенных диапа-
зонов с помощью мыши. Если в позиции вставки ячейки или диапазона находят-
ся заполненные ячейки, то в случае установки флажка Alert before overwriting cells
(Предупреждать перед перезаписью ячеек) на экране будет появляться запрос
о том, следует ли заменить содержимое этих ячеек.

После ввода содержимого ячейки и нажатия клавиши Enter указатель ячейки сме-
щается на одну строку вниз/вверх или на один столбец вправо/влево, что зави-
сит от значения, установленного в поле Move selection after Enter (Переход к другой
ячейке после ввода). Поэтому, если после заполнения ячейки ее нужно отформа-
тировать, лучше снять флажок Move selection after Enter (Переход к другой ячейке
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после ввода). В этом случае после нажатия клавиши Enter заполненная ячейка бу-
дет оставаться активной.
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Рис. 16.3. Вкладка Edit диалогового окна Options

По умолчанию на рабочем листе отображаются только те десятичные знаки (раз-
ряды), которые были введены или получены в результате вычислений с исполь-
зованием формул. Установив флажок Fixed decimal Places (Фиксированный деся-
тичный формат при вводе), можно задать требуемое количество знаков после
запятой (программа по умолчанию выводит 2 знака). В таком случае введенное
в ячейку десятичное число в результате нажатия клавиши Enter преобразуется
в дробное. Например, число 1 будет преобразовано в 0,01. Данную функцию целе-
сообразно применять при работе с большим количеством дробных чисел.

Установка флажка Ask to update automatic links (Запрашивать об обновлении авто-
матических связей) предполагает, что программа, прежде чем обновить внешние
ссылки и связи, выдаст окно с запросом о том, нужно ли это делать, в котором
пользователь сможет отменить данную операцию.

Как правило, встроенные объекты связаны с теми ячейками, в которых они рас-
положены. При удалении, копировании и сортировке ячеек аналогичные дейст-
вия выполняются и с объектами. Чтобы вырезать, скопировать и отсортировать
объекты вместе с ячейками, следует установить флажок Cut copy, and sort objects
with cells (Перемещать объекты вместе с ячейками).

Наблюдать за действиями, происходящими на экране при выполнении операций
вставки и удаления, позволяет установка флажка Provide feedback with Animation
(Плавная вставка и удаление ячеек).
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Если установлен флажок Enable AutoComplete for cell values (Авгозаполнение значе-
ний ячеек), Excel пытается распознать вводимый пользователем текст и автома-
тически завершить операцию ввода.

Установка флажка Extend list formats and formulas (Расширять форматы и формулы
в списках) позволяет использовать для всех добавляемых в конец списка ячеек
тот же формат представления данных, который был задан ранее, для предшество-
вавших им ячеек.

Если установлен флажок Enable automatic percententry (Автоматический ввод про-
центов), все вводимые в ячейки с процентным форматом значения меньше 1 ум-
ножаются на 100 и к ним добавляется символ процента.

Использование флажка Show Paste Options buttons (Отображать меню параметров
вставки) приводит к тому, что при вставке появляется окно с дополнительными
параметрами. Аналогичное окно отображается на экране и в результате установле-
ния флажка Show Insert Options buttons (Отображать меню параметров добавления).

Вкладка Transition
Пользователи, решившие перейти к Excel после работы с Lotus 1-2-3, могут уста-
новить на вкладке Transition (Переход) целый ряд параметров (рис. 16.4), которые
помогут быстрее освоить новый программный продукт.

Color I International | Save | Error checWng | Spellffig
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files !as: Microsoft Excel Workbook
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Г* Transition Eormula evaluation

Г" transitton formula entry

,. Cancel
tJ in» n I ,>

Рис. 16.4. Вкладка Transition диалогового окна Options

В области Settings (Параметры) определяется, какие функции должны быть акти-
визированы при нажатии указанной клавиши. В случае установки флажка Tran-
sition navigation keys (Клавиши перемещения) для перемещения по рабочему лис-
ту в Excel можно использовать комбинации клавиш, которые употребляются для
этой цели в программе Lotus 1-2-3,
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При необходимости импортировать в Excel документы из программы Lotus 1-2-3
следует установить в области Sheet Options (Параметры листа) флажок Transition
formula evaluation (Производить вычисления по правилам Lotus 1-2-3). Это позво-
лит избежать ошибочной интерпретации программой содержимого ячеек при им-
порте документов.

В версии 2.2 программы Lotus 1-2-3 при вводе формул используется другой син-
таксис. После установки флажка Transition formula entry (Преобразование формул
в формат Excel при вводе) его можно использовать и при работе с Excel.

Вкладка General
На вкладке General (Общие) задаются основные параметры работы с программой,
а также параметры конфигурирования рабочей области (рис. 16.5).
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Рис. 16.5. Вкладка General диалогового окна Options

По умолчанию строки рабочего листа обозначаются цифрами, а столбцы — бук-
вами. Установка флажка R1C1 reference style (Стиль ссылок R1C1) в области
Settings (Параметры) позволяет пронумеровать столбцы. В этом случае адреса
ячеек имеют такой вид: R1C1, R2C2 и т. д. (R — row, строка; С — column, столбец).

В поле Recently used file list (Помнить список файлов, до) задается количество
пунктов в списке имен документов, открывавшихся последними (не более 9 имен).
Напомним, что этот список находится в меню Fue (Файл).

В поле Sheets in new workbook (Листов в новой книге) определяется количество
листов, которое по умолчанию будут содержать новые рабочие книги.

Возможно, вы знаете, что в Excel по умолчанию применяется TrueType-шрифт
Arial, но в поле Standard font (Стандартный шрифт) вкладки General (Общие) мож-
но выбрать другой шрифт. Там же определяется и размер стандартного шрифта.
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При инсталляции программы пользователь указывает свое имя, которое затем
фигурирует в сведениях о документе. Если сводка должна содержать другое имя,
его следует ввести в поле User name (Имя пользователя).

В поле Default file Location (Рабочий каталог) необходимо указать полное имя пап-
ки, которая по умолчанию будет использоваться программой при сохранении до-
кументов.

В поле At startup, open all files in (Каталог автозагрузки) наряду с используемой по
умолчанию папкой Мои документы можно создать дополнительную стартовую
папку. Содержащиеся в обеих папках документы автоматически открываются по-
сле запуска программы.

При использовании функции динамического обмена данными (DDE) Excel по-
сле поступления в адрес программы сообщения по каналу DDE прерывает вы-
полнение текущего процесса, с тем чтобы оценить это сообщение. В случае уста-
новки флажка Ignore other applications (Игнорировать DDE-запросы от других
приложений) все поступающие DDE-сообщения программой не учитываются.

Если установлен флажок Prompt for workbook property (Предлагать заполнение
свойств файла), то при первом сохранении документа открывается диалоговое
окно [Имя документа] Properties (Свойства: [Имя документа]), предназначенное
для ввода дополнительной информации.

Установка флажка Provide feedback with sound (Звуковое сопровождение событий)
приводит к тому, что некоторые действия в Excel (открытие файлов, обнаруже-
ние ошибок, печать и т. д.) сопровождаются звуковыми эффектами.

Если используется мышь типа IntelliMouse, необходимо установить флажок Zoom
on roll with IntelliMouse (Панорамирование с помощью IntelliMouse).

Для того чтобы при наведении указателя на какую-либо кнопку или поле со спи-
ском появлялась всплывающая подсказка с описанием этих элементов, нужно ус-
тановить флажок Function tooltips (Всплывающие подсказки для функций).

Вкладка Custom Lists
На вкладке Custom Lists (Списки) пользователь может сформировать список для
функции автозаполнения (рис. 16.6). Если в одну из ячеек ввести элемент данно-
го списка, прочие выделенные ячейки автоматически будут заполнены его остав-
шимися элементами в заданной последовательности.

Вкладка Chart
На вкладке Chart (Диаграмма) устанавливаются параметры, используемые про-
граммой при создании диаграмм (рис. 16.7),

Диаграммы создаются на основе значений определенного диапазона. Если в та-
кой диапазон входят пустые ячейки, то в области Plot empty cells as (Для пустых
ячеек) следует задать способ их интерпретации. При активизации переключателя
Not plotted (leave gaps) (точки не отображаются) пустые ячейки игнорируются,
а при установке переключателя Zero (подразумеваются нулевые значения) им при
построении диаграммы присваиваются нулевые значения. Правда, это не всегда
приводит к желаемым результатам, так как разница между нулевым значением
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пустой ячейки и положительным значением соседней ячейки может оказаться
слишком большой. Поэтому для пустой ячейки иногда целесообразно задать
среднее значение двух соседних ячеек. Это можно сделать, воспользовавшись пе-
реключателем Interpolated (значения интерполируются).
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Рис. 16.6. Вкладка Custom Lists диалогового окна Options
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Рис. 16.7. Вкладка Chart диалогового окна Options

В случае, когда часть выделенного диапазона, на основе значений которого по-
строена диаграмма, скрыта, представить диаграмму можно двумя способами -
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с учетом скрытых значений и без учета таковых. Эту возможность нам предостав-
ляет переключатель Plot visible cells only (Отображать только видимые ячейки).
Если он не активизирован, при создании диаграммы учитываются все значения
(даже скрытые), а если включен, учитываются только видимые значения. Благо-
даря этому в больших таблицах в виде диаграммы можно представить только
наиболее важные значения, причем без их копирования в отдельную область.

Размер области диаграммы можно поставить в зависимость от размеров окна.
При установке флажка Chart sizes with window frame (Масштабировать диаграмму
по размеру окна) диаграмма полностью занимает рабочую область окна. Ее раз-
мер в этом случае можно изменить только путем изменения размеров окна.

Для анализа диаграмм важной является возможность вывода на экран имени эле-
мента при установке на нем указателя мыши. Данная функция активизируется
путем установки флажка Show names (названия). Кроме того, можно задать ото-
бражение числовых значений точек диаграммы — также при установке на них
указателя мыши. Этот режим задается с помощью флажка Show values (значения).

Вкладка Color
Вкладка Color (Цвет) служит для выбора цветов, используемых при отображении
различных элементов объектов (рис. 16.8).
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Рис. 16.8. Вкладка Color диалогового окна Options

Эта вкладка содержит палитру, включающую 56 различных цветов и оттенков.
Сорок цветов (палитра Standard colors (Стандартные цвета)) можно использовать
для оформления различных объектов, а шестнадцать (палитры Chart fills (Заливка
диаграмм) и Chart lines (Линии диаграмм)) — для представления линий и диа-
грамм. Любой цвет в палитре можно изменить. Для этого необходимо выделить
квадратик с данным цветом и нажать кнопку Modify (Изменить) или выполнить
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на квадратике двойной щелчок. В любом случае будет открыто диалоговое окно
Colors (Цвета), в котором и следует установить параметры нового цвета.

Рис. 16.9. Диалоговое окно Colors

Все 56 цветов палитры «закрепляются* за рабочей книгой и сохраняются вместе
с ней. Измененную палитру можно использовать и в другой рабочей книге, но
лишь при условии, что открыты обе книги. После открытия книги, в которой со-
хранена нужная палитра цветов, на вкладке Color (Цвет) диалогового окна Options
(Параметры) следует развенуть поле списка Copy colors from (Копировать цвета
из), где будут перечислены все открытые рабочие книги, выбрать имя нужной па-
литры и нажать кнопку ОК.

Вкладка Security

Для того чтобы запретить доступ к листу посторонним, следует использовать па-
роль. Вводится он на вкладке Security (Безопасность), которую вы видите на
рис. 16.10, точнее в поле Password to open (Пароль для открытия) области File
encryption settings for this workbook (Параметры шифрования файла этой книги).
Пароль может состоять из букв (различаются строчные и прописные буквы),
цифр и других символов. Его длина не должна превышать 15 символов. Забыв
пароль, вы не сможете открыть книгу.

Введя пароль в поле Password to modify (Пароль для изменения), можно запретить
выполнение операций открытия, изменения или сохранения книги.

Если включен флажок Read-only recommended (рекомендовать доступ только для
чтения), на экран выводится запрос о том, хочет ли пользователь открыть книгу
только для чтения. В случае внесения изменений такую книгу можно будет со-
хранить лишь под другим именем.

Нажав кнопку DigitaLSignatures (Цифровые подписи), можно просмотреть журнал
пользователей, поставивших цифровые подписи в данном документе, и добавить
собственную подпись.
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Рис. 16.10. Вкладка Security диалогового окна Options

Возможно, вы посчитаете нужным несколько ограничить объем информации, ко-
торая представлена на вкладке Summary (Документ) диалогового окна [Имя доку-
мента] Properties (Свойства: [Имя документа]). В таком случае следует активизи-
ровать в области Privacy options (Личные сведения) флажок Remove personal in-
formation from file properties on save (Удалять личные сведения из файла при его
сохранении).

В области Macro security (Безопасность макросов) путем нажатии кнопки Macro
Security (Безопасность макросов) можно изменить уровень защиты от макросов.

Вкладка Spelling
В поле Dictionary Language (Язык словаря) вкладки Spelling (Орфография) указыва-
ется словарь, который будет использоваться при проверке орфографии в докумен-
тах (рис. 16.11). В поле Add words to (Добавлять слова в) можно выбрать словарь,
который будет использоваться в дополнение к основному словарю.

Для того чтобы правописание проверялось с применением всех открытых всно-
магательных словарей, необходимо снять флажок Suggest from m a i n dictionary only
(Предлагать только из основного словаря).

Если установлен флажок Ignore words in UPPERCASE (пропускать слова из ПРО-
ПИСНЫХ букв), при проверке орфографии слова, набранные прописными бук-
вами, пропускаются. А при установке флажка Ignore words with numbers (пропус-
кать слова с цифрами) не учитываются слова, содержащие цифры.

Когда установлен флажок Ignore Internet and file addresses (пропускать адреса Ин-
тернета и имена файлов), при проверке орфографии будут проигнорированы ад-
реса Интернета, имена файлов и адреса электронной почты.
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Рис. 16.11. Вкладка Spelling диалогового окна Options

После нажатия кнопки AutoCorrect Options (Параметры автозамены) пользователь
может задать параметры автоматического исправления текста в процессе ввода,
а также сохранить часто используемые его фрагменты, что, конечно же, должно
заметно ускорить работу.

Вкладка Error Checking

Если в области Settings (Параметры) данной вкладки (рис. 16.12) установлен
флажок Enable background error checking (Включить фоновую проверку ошибок),
проверка ячеек на наличие ошибок будет выполняться во время простоя. При об-
наружении ошибки соответствующая ячейка помечается зеленым треугольником
в левом верхнем углу.

В поле Error Indicator Color (Цвет отображения ошибок) задается цвет, которым
в Excel помечаются некорректные данные. По умолчанию для этой цели исполь-
зуется зеленый цвет.

При нажатии кнопки Reset Ignored Errors (Сброс пропущенных ошибок) выполня-
ется поиск ошибок, пропущенных в процессе предыдущих проверок.

В случае установки в области Rules (Проверять наличие следующих ошибок) флаж-
ка Evaluates to error value (вычисление формулы вызывает ошибку) для ячеек, со-
держащих формулы с ошибками, будет выведено предупреждение.

Если установлен флажок Text date with 2 digit years (текстовая дата с 2-значным го-
дом), формулы со ссылками на ячейки, содержащие дату в текстовом формате
с представлением года двумя цифрами, считаются ошибочными и для них при
проверке выводится предупреждение.
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Рис. 16.12, Вкладка Error Checking диалогового окна Options

Установка флажка Number stored as text (число сохранено как текст) предполагает,
что ячейки, содержащие числа в текстовом формате, и ячейки, перед которыми
стоит апостроф, считаются ошибочными, и для них выводится предупреждение.

Если установлен флажок Inconsistent formula in region (несогласующаяся формула
в области), то предупреждение появится при наличии в формуле ссылки, которая
не соответствует ссылкам, используемым в смежных формулах.

При установке флажка Formula omits cells in region (формула не охватывает смеж-
ные ячейки) ошибочными считаются ячейки с формулами, в которых вычисле-
ние производилось без учета числовых данных, хранящихся в смежных ячейках.
Например, если в диапазоне А2:А7 содержатся какие-либо числовые данные, то
при вычислении формулы =SUM(A2:A4) будет выведено предупреждение, посколь-
ку ячейки А5:А7 являются смежными и содержат числовые данные.

При установке флажка Unlocked cells containing formulas (не заблокирована ячейка,
содержащая формулу) некорректными считаются все разблокированные ячейки
с формулами.

Если установлен флажок Formulas referring to empty cells (формула ссылается на
пустые ячейки), к числу ошибочных относятся ячейки с формулами, ссылающи-
мися на пустые ячейки.

Вкладка International
Чтобы изменить используемый по умолчанию разделитель целой и дробной час-
тей числа, сначала в области Number handling (Числа) данной вкладки (рис. 16,13)
нужно снять флажок Use system separators (Использовать системные разделите-
ли), а затем задать другой разделитель. Для замены разделителя групп разрядов
также необходимо сначала снять флажок Use system separators (Использовать сис-
темные разделители), а затем ввести новый разделитель.
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Установите флажок Allow A4/Letter paper resizing (Преобразование A4/Letter) в об-
ласти Printing (Печать), для того чтобы документ, при оформлении которого ис-
пользовался формат бумаги, являющийся стандартным для одной страны (напри-
мер, А4), был правильно напечатан на бумаге, формат которой является стандарт-
ным для другой страны (например, Letter). Этот параметр используется только
при печати документа, не оказывая влияния на процесс его форматирования.

jusl
View j Calculation j Edit j General j Transition | Custom Lists ] Chart <
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Cursor movement; ff Logical

<~ Visual

Г" Show control characters

Cancel

Рис. 16.13. Вкладка International диалогового окна Options

В области Right-to-Left (Направление текста) находятся переключатели Default
direction (Направление по умолчанию). При выборе переключателя Right-to-Left
(справа налево) устанавливается направление текста справа налево, а следова-
тельно, ячейка А1 располагается в правом верхнем углу листа. Если же выбран
переключатель Left-to-right (слева на право), устанавливается направление текста
слева на право, а ячейка А1 располагается в левом верхнем углу листа.

При установке флажка View current sheet right-to-left (просматривать текущий лист
справа налево) отображение данных в направлении справа налево задается толь-
ко для листа, с которым пользователь работает в настоящее время; на других лис-
тах книги останется обычное направление текста, слева направо.

С помощью переключателей Cursor movement (Перемещение курсора) указывает-
ся, каким образом будет перемещаться курсор при наличии на листе фрагментов
текста, имеющих разное направление.

Самостоятельная работа

1. С помощью команды Tools > Options (Сервис > Параметры) откройте одноимен-
ное диалоговое окно и выполните в нем следующие действия: отмените ото-
бражение в окне Excel строки состояния и полос прокрутки; увеличьте список
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имен ранее открывавшихся файлов до 6 (список имен отображается в нижней
части меню File (Файл)); увеличьте интервал автоматического сохранения ра-
бочей книги Excel до 20 минут.

2. Создайте новый список, включив в него всех сотрудников своего отдела (чле-
нов вашей семьи). .

Конфигурирование панелей инструментов

Для быстрой активизации часто используемых команд в Excel предусмотрено
большое количество различных панелей инструментов. Панель инструментов со-
стоит из кнопок, каждая из которых связана с одной из функций программы.
Кнопки объединены в панели по тематическому признаку.

После установки Excel в окне программы по умолчанию отображаются панели
инструментов Standard (Стандартная) и Formatting (Форматирование). Чтобы ото-
бразить на экране другие панели, следует установить указатель мыши в области
панели инструментов и открыть контекстное меню. Это меню содержит названия
всех панелей инструментов, предлагаемых Excel. После щелчка на названии па-
нели таковая появляется на экране.

Рис. 16.14. Контекстное меню со списком
панелей инструментов



482 Урок 16 * Индивидуальная настройка программы

В Excel существует ряд панелей инструментов, которые активизируются при вы-
полнении операций, с которыми они связаны, например, при записи макроко-
манд. Задать отображение таких панелей можно и с помощью команды View >
Toolbars (Вид > Панели инструментов).

Как правило, Excel размещает панели инструментов под строкой меню, но поль-
зователь может перетащить их в любое другое место, как показано на рис. 16.15.
Для того чтобы изменить месторасположение панели инструментов, необходимо
установить указатель мыши в левой ее части, а когда кусор примет вид четырех-
направленной стрелки, нажать левую кнопку мыши и переместить панель в нуж-
ное место.

1 '•lirrosolt ОГ1 ire Lucel 2001 Book?
:I|P[ йен " Insert Fymat Joels [Jata ^ndow Help

,10 - в i

_ ff x

A1

Рис. 16.15. Панели инструментов в различных местах
окна программы

Состав кнопок панели инструментов также можно изменить. Например, пользо-
ватель без труда может объединить в одной панели часто используемые в работе
кнопки из нескольких панелей, добавить в нее несколько самостоятельно создан-
ных кнопок и т. д.

Содержимое панели инструментов изменяется посредством окна Customize (На-
стройка). Упомянутое диалоговое окно открывается в результате выбора одно-
именной команды в контекстном меню панели инструментов (рис. 16.16). Чтобы
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изменить содержимое указанной панели инструментов, необходимо перейти на
вкладку Commands (Команды) и в списке, расположенном в левой части окна, ука-
зать, к какой категории относится команда, кнопку вызова которой вы хотите раз-
местить на панели. В результате в правой части окна отобразится соответствующий
набор кнопок. На панель инструментов кнопка помещается следующим образом:
в диалоговом окне нужно отметить кнопку и, удерживая нажатой левую кнопку
мыши, перетащить ее на панель. Аналогичным образом, то есть путем перемещения
из панели в диалоговое окно Customize (Настройка), можно удалить ненужные
кнопки панели инструментов.

Toolbars l̂ ommarids j Options

To add a command to a toolbar : select a category and drag the
commend out of this dialog box to a toolbar.

.Categories:

Edit
View
Insert
Format
Tools
Data
Window and Help
Drawing
AutoShapes

Commands:

New..,

'.'

Open

Cbse

e
_rj Save As...

Rearrange Commands..,

dose

Рис. 16.16. Диалоговое окно Customize

Самостоятельная работа
1. Откройте на экране панель инструментов Drawing (Рисование) и закрепите ее

у левого края окна приложения.

2. Запишите несколько макросов, создайте новое меню и добавьте в него коман-
ды вызова макросов.

3. Поместите на стандартную панель инструментов кнопки для вставки в рабо-
чий лист новых строк и столбцов.

4. Создайте новую панель инструментов, присвойте ей имя Edit (Правка) и по-
местите на нее кнопки, дублирующие все команды одноименного меню за ис-
ключением тех, которые есть в панели Standard (Стандартная).

5. Удалите со стандартной панели инструментов кнопки Euro Conversion (Преоб-
разовать в евро) и MapPoint Data Service (Данные для географических карт).



484 Урок 16 • Индивидуальная настройка программы

Подведение итогов
В этом уроке мы научились:

EJ устанавливать параметры рабочей области, необходимые для комфортной ра-
боты в Excel;

0 отображать на экране различные панели инструментов, изменять их месторас-
положения;

0 изменять состав кнопок панелей, добавлят и удалять необходимые кнопки.
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диалоговое окно (продолжение)

-Goal Seek, 206

— Insert, 85

— Insert Functions, 147

— Move or Copy, 86

-ODBC Microsoft Access Setup, 180
- Open, 30

- Options, 466

- PivotTable Options, 232

— Query Wizard, 181

-Save As, 25

- Save Options, 27
— Scenario Manager, 221

— Scenario Value, 222

-Series, 82

-Show Detail, 236

-Solver, 216
-Subtotals, 194,195

— Zoom, 40

— формы данных, 165
диапазон

— несмежный, 67
— печати, 333

— смежный, 67

— ячеек, 65
диспетчер отчетов, 345

добавление

— кнопок на панель инструментов, 481

— объектов WordArt, 294

—столбцов и строк, 185

— элемента управления
на рабочий лист, 307

документы
— поиск, 33
— просмотр, 34

доступ

—к файлам посредством Интернета, 414

— ограничение паролем, 447

драйвер ODBC, 178

заголовок листа, 52

загрузка документов на веб-узел
SharePoint Team Services, 458

закрытие

— программы, 18

— рабочей книги, 29
запрос в Microsoft Query, 178

запуск и завершение
программы Excel, 18

защита ячеек и листов, 124

знак конкатенации, 128

знаки операций, 127

И
иерархическая структура таблицы, 118
изменение

— вида объемных диаграмм, 279
— высоты строки, 112

— порядка рядов диаграммы, 269

— типа диаграммы, 265
—ширины столбца, 110

имена диапазонов, 138
импорт

-данных, 178-189, 410

— списков Excel на веб-узел, 456

интернет-технологии, 416

информация о документе, 27
использование
— данных Access в Excel, 405

— режима макета, 230

— средств автозаполнения, 79
— стилей, 117

— формул, 49
— шаблонов, 32

исправление ошибок, 155
источник данных, 179

итоги
— вложенные, 197

— промежуточные, 193
— функции, 195

К
коллекция WordArt, 294
колонтитулы, 333

— вставка содержимого, 334
—печать, 333

форматирование, 335
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коллективная работа в Excel, 444
— имттольэование SharePoint Team

Service, 453
— просмотр журнала изменений, 449

— работа с документами на веб-узле, 458

команда AutoFit Selection, 53

консолидация данных, 200-203

константы, 138

контекстное меню автозаполнения, 80

конфигурирование панели
инструментов, 482

копирование данных, 73

Л

лист

—вставка и удаление, 84
—Защита, 124

— перемещение и копирование, 85

— сокрытие, 40

— управление, 85

М

макрос

—запуск, 356

— меню для запуска, 362

—редактирование, 358

маркер заполнения, 79

мастер
—диаграмм, 246

— сводных таблиц и диаграмм, 226

масштабирование изображения, 38

методы VBA, 365

Н

надписи на диаграмме, 274
надстройка Solver, 215

надстройки

— установка, 192
настройка

— программы Excel, 466

— рабочей области, 466

— элементов управления панели
Forms, 316

О
область
— Shared Workspace, 461
— видимости переменной, 375
— задач, 23
обновление
— сводной таблицы, 236
— формул, 136
обработка диаграмм, 264

объединение ячеек, 102
объект VBA, 364
ограничения при вводе данных, 160

окно
— Microsoft Query, 178
— книги, 22
округление значений, 92
операции

— адресные, 128
— арифметические, 127
— конкатенации, 128
—логические, 127
ориентация
— страницы, 337
— текста, 101
открытие
—документов, 29

— Excel в окне браузера, 455

— в Excel файлов в других
форматах, 409

— на удаленных компьютерах, 31
—находящихся на веб-узле SharePoint

Team Services, 459
— рабочей книги в Интернете, 424
относительные ссылки, 131
отображение формул, 130
отслеживание зависимостей, 156
ошибка
- #DIV/01, 154
- #N/A, 155
-######, 154

-#NAME?, 155
-#NULLI, 155
-#NUMI, 154
-#REFI, 154
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ошибка (продолжение)
~#VALUEl,155
— исправление, 155
—тип, 154

П

панель инструментов, 20
- Chart, 264
— Control Toolbox, 306
- Drawing, 285

- Forms, 316
— Formula Auditing, 157
-PivotTable, 229,239
-Web, 423
— конфигурирование, 482
— форматирования, 91
параметры печати, 328, 344

переменные VBA, 374
перемещение
—данных, 73

—диапазонов ячеек, 48
— по рабочему листу, 60
перенос текста, 102
пересчет формул, 136
печать

— в черновом режиме, 344
—диапазон, 333
— качество, 339
— колонтитулы, 333
— корректировка полей, 341
— область печати, 332
— ориентация страницы, 337
— отчетов, 345

— параметры страницы, 330
— параметры, 344
— подготовка документов, 323
—поля страницы, 331
—предварительный просмотр, 340
—рабочего листа, 57
— разметка страницы, 337
— размещение текста на странице, 336
— разрешение, 339
— сводной таблицы, 347

— ускорение процесса, 344

печать (продолжение)
—установка параметров, 328
—черно-белая, 344
подбор параметра, 204-207
подготовка документов к печати, 323

поддерживаемые Excel графические
форматы, 300

подключение принтера, 324

поиск
—документов, 33

— расширенный, 33
-решения, 215, 217, 219

— параметры, 219
— создание отчета, 219

полноэкранное представление, 38
полосы прокрутки, 23
пользовательские форматы, 93
предварительный просмотр, 340

принтер
— настройка параметров, 326, 238

—подключение, 324
—удаление, 326
— установленный по умолчанию, 324
программа-надстройка

AccessLinks, 397
прогрессия

—арифмтическая, 82
— геометрическая, 82
просмотр документов, 34
процедуры VBA, 371

Р

работа
— с гиперссылками, 437
— совместная, 445
— с файлами в сети, 423
— с фрагментами, 386
рабочая книга
—объединение изменений, 451
— совместное использование, 448
— структура, 35
рабочая область
— настройка, 466
— сохранение, 28
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рабочий лист

— вставка, 84

— группировка, 83

— копирование и перемещение, 85

— отмена группировки, 84

— переименование, 87

—печать, 57

— удаление, 84

расширенный фильтр, 175

редактирование

— изображений, 301

— содержимого ячеек, 72

—формул, 128
рекомендации по использованию

шрифтов, 102

сводная диаграмма, 240

сводная таблица

— автоформатирование , 237

—детализация, 236

—доступ к данным, 236

— из нескольких листов, 238

— области перетаскивания, 228

— обновление, 237

—на отдельном листе, 238

— параметры, 232
— печать, 347

— режим макета, 230

—управление данными, 233

свойства VBA, 365

связывание
—данных, 388

—рабочего листа Excel с задачей
Outlook, 407

сетка
— печать, 344

—удаление, 55
системное меню, 19

события VBA, 365

совместная работа, 445

— журнал изменений, 449

—использование файлов в локальной
сети, 413

совместная работа (продолжение)

— использование файлов на одном
компьютере, 413

создание

— графических объектов, 286

—диаграммы, 55, 245-253

— запросов в Microsoft Query, 178

— итогов, 194

— нового документа, 31
— новых стилей, 117

— пользовательского порядка
сортировки, 170

— сводной таблицы, 226

сокрытие

— листов и книг, 40

—столбцов и строк, 113

сортировка

— пользовательский порядок, 170

— результатов запроса, 188

— столбцов, 170

—строк, 168

сохранение

— книги, 24

— рабочей области, 28

специальная вставка, 75

список, 15,163

— заголовки, 163

— поиск записей, 166

— редактирование записей, 166

— сортировка, 161
способы выделения, 65

справочная подсистема
программы Excel, 41

ссылка

—абсолютная, 131

— гиперссылка, 448
— на листы и книги, 133

— относительная, 131

—смешанная, 133

— циклическая, 159

стили форматирования, 116

— создание, 117
страница

— ориентация при печати, 337
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страница (продолжение)

— разметка, 337

строка

— заголовка, 19

—меню, 20

— состояния, 22

—формул, 21

структура рабочей книги, 35

сценарий, 220-223

—создание .отчета, 224

Т

таблица

— обновление, 214

-подстановки, 209, 211, 213

— редактирование, 214

— с одной переменной, 209

— сортировка, 188

— таблица результатов, 184

— транспонирование, 76

— форматирование, 52, 187

типы

—диаграмм, 256

— листов, 35

—ошибок, 154

транспонирование таблицы, 76

удаление

—сетки, 55

— столбцов, 77

— строк, 77

— структуры, 122

— ячеек, 77

управление рабочими
листами, 83

ускорение процесса
печати, 344

условное форматирование, 96

установка

— надстроек, 192

— принтера, 324

Ф

фильтрация данных, 171-177

— автофильтр, 171

— расширенный фильтр, 175

форма данных, 165

— символы подстановки, 167

формат

— присвоение, 89

— создание, 89

— файла Excel, 26

форматирование

—автоматическое, 114

— графических объектов, 292

— дат, 61

— заголовков, 52

— столбцов, 110

— строк, 112

— таблицы, 52

— текстовых данных, 90

— условное, 96

— числовых данных, 90

формулы, 127

—массива, 135

— отображение, 130

— ошибки, 152

— режим пересчета, 136

функция

-FV(),205

-GROWTH(),82

-IFQ.152

-RO UND(), 152

-TREND (), 82

— автоэаполнения, 164

— автофильтра, 171

— ввод с помощью строки
формул, 145

— вложенная, 144, 150

— стандартная, 149

Ц
цветовое оформление, 108
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Ш

шаблоны рабочих книг, 32

шрифты, 102

экспорт

—данных, 411

— списков с веб-узла в программу
Excel, 458

электронная почта

- Microsoft Outlook, 407

—отправка сообщений, 417

элементы

— диаграммы, 243

— окна Excel, 19

•элементы (продолжение)
-управления

-ActiveX, 305, 309

— перемещение, 309

— присвоение имен, 308

ячейка

— ввода, 209

— влияющая, 156

—зависимая, 156

—защита, 124

— объединение, 102

— присвоение имени, 138

— ссылки, 131
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В1997 году по инициативе генерального директора Издательского дома «Питер»
Валерия Степанова и при поддержке деловых кругов города в Санкт-Петербурге
был основан «Книжный клуб Профессионал». Он собрал под флагом клуба про-
фессионалов своего дела, которых объединяет постоянная тяга к знаниям и любовь
к книгам. Членами клуба являются лучшие студенты и известные практики из раз-
ных сфер деятельности, которые хотят стать или уже стали профессионалами в той
или иной области.
Как и все развивающиеся проекты, с течением времени книжный клуб вырос
в «Клуб Профессионал». Идею клуба сегодня формируют три основные «клубные»
функции:

• неформальное общение и совместный досуг интересных людей;
• участие в подготовке специалистов высокого класса

(семинары, пакеты книг по специальной литературе);
• формирование и высказывание мнений современного профессионала

(при встречах и на страницах журнала).

КАК ВСТУПИТЬ В КЛУБ?

Для вступления в «Клуб Профессионал» вам необходимо:

• ознакомиться с правилами вступления в «Клуб Профессионал»
на страницах журнала или на сайте www.piter.com;

• выразить свое желание вступить в «Клуб Профессионал»
по электронной почте postbook@piter.com или по тел. (812) 103-73-74;

• заказать книги на сумму не менее 500 рублей в течение любого времени
или приобрести комплект «Библиотека профессионала».

«БИБЛИОТЕКА ПРОФЕССИОНАЛА»

Мы предлагаем вам получить все необходимые знания, подписавшись на «Библио-
теку профессионала». Она для тех, кто экономит не только время, но и деньги.
Покупая комплект - книжную полку «Библиотека профессионала)», вы получаете:

• скидку 15% от розничной цены издания, без учета почтовых расходов;
• при покупке двух или более комплектов - дополнительную скидку 3%;
• членство в «Клубе Профессионал»;
• подарок - журнал «Клуб Профессионал».
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И ОПЛАТЫ ИЗДАНИЙ:

Наложенным платежом с оплатой заказа при получении посылки на
ближайшем почтовом отделении. Цены на издания приведены ориентиро-
вочно и включают в себя стоимость пересылки по почте (но без учета
авиатарифа). Книги будут высланы нашей службой «Книга-почтой»
в течение двух недель после получения заказа или выхода книги из печати.
Оплата наличными при курьерской доставке (для жителей Москвы
и Санкт-Петербурга). Курьер доставит заказ по указанному адресу
в удобное для вас время в течение трех дней.

ПРИ ОФОРМЛЕНИИ ЗАКАЗА УКАЖИТЕ:

• фамилию, имя, отчество, телефон, факс, e-mail;
• почтовый индекс, регион, район, населенный пункт,

улицу, дом, корпус, квартиру;
• название книги, автора, код, количество заказываемых

экземпляров.

Вы можете заказать бесплатный
журнал «Клуб Профессионал».
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